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Safety Information

Do NOT service or repair this product unless properly qualified.
Servicing should be performed only by a qualified technician or an
authorized Audio Precision distributor.

Do NOT defeat the safety ground connection. This product is designed
to operate only from a 50/60 Hz AC power source (250 V rms maximum)
with an approved three-conductor power cord and safety grounding. Loss
of the protective grounding connection can result in electrical shock hazard
from the accessible conductive surfaces of this product.

For continued fire hazard protection, fuses should be replaced ONLY
with the exact value and type indicated on the rear panel of the instrument
and discussed on page of this manual. The AC voltage selector also must
be set to the same voltage as the nominal power source voltage (100, 120,
230, or 240 V rms) with the appropriate fuses. Different fuses are required
depending on the line voltage.

The International Electrotechnical Commission (IEC 1010-1) requires
that measuring circuit terminals used for voltage or current measurement
be marked to indicate their Installation Category. The Installation Category
is defined by IEC 664 and is based on the amplitude of transient or
impulse voltage that can be expected from the AC power distribution
network. This product is classified as INSTALLATION CATEGORY II,
abbreviated “CAT II” on the instrument front panel.

Do NOT substitute parts or make any modifications without the written
approval of Audio Precision. Doing so may create safety hazards.

This product is for indoor use—pollution degree 2.

Safety Information
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Safety Symbols

The following symbols may be marked on the panels or covers of
equipment or modules, and are used in this manual:

WARNING!—This symbol alerts you to a potentially hazardous
condition, such as the presence of dangerous voltage that could pose a risk
of electrical shock. Refer to the accompanying Warning Label or Tag, and
exercise extreme caution.

ATTENTION!—This symbol alerts you to important operating
considerations or a potential operating condition that could damage
equipment. If you see this marked on equipment, consult the User’s
Manual or Operator’s Manual for precautionary instructions.

FUNCTIONAL EARTH TERMINAL—This symbol marks a terminal that
is electrically connected to a reference point of a measuring circuit or
output and is intended to be earthed for any functional purpose other than
safety.

PROTECTIVE EARTH TERMINAL—This symbol marks a terminal that
is bonded to conductive parts of the instrument. Confirm that this terminal
is connected to an external protective earthing system.

Safety Symbols
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Chapter 1

Introduction

ATS-2: an Overview

The Audio Precision ATS-2 is a powerful computer-controlled audio test
and measurement system. The ATS-2 system consists of two key
components:

� The ATS-2 hardware, which provides the connectors and circuitry
necessary for proper signal interface and precise signal generation
and analysis. The hardware is mounted in a compact aluminum and
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Figure 1. The Audio Precision ATS-2 audio test and measurement system.



steel chassis which can be installed in a standard 19 in wide
equipment rack using optional mounting hardware.

� The ATS measurement software, which runs on a personal computer
(PC) and provides all the control, display, report and automation
functions for the ATS-2 system. The PC is not provided with ATS-2.

With the exception of the mains power switch on the rear panel, there
are no knobs, dials, controls, readouts, meters or switches on the ATS-2
chassis. All of the measurement settings and adjustments are made on the
PC.

The ATS measurement software will run under Windows 95, Windows
98, Windows ME, Windows 2000, and Windows NT 4.0.

The PC communicates with the ATS-2 chassis via a proprietary bus
interconnection called the Audio Precision Interface Bus (APIB), which
requires a dedicated APIB cable and a PC-mounted APIB interface card or
adapter. APIB interfaces can be ordered as ISA, PCI, and PCMCIA
compatible devices.

The PCI interface is only compatible with Windows 98,

Windows ME and Windows 2000. See the Compatibility

Chart in the Software area at the Audio Precision Web site at

audioprecision.com for current compatibility listings.

About This Manual

You’re reading the ATS-2 User’s Manual. This is the primary operation
and reference manual for the Audio Precision ATS-2 audio test and
measurement system.

We recommend you begin by reading the separate introductory manual,
Getting Started with ATS-2, which is discussed below.

Look in the ATS-2 User’s Manual for

� Detailed discussions of every ATS-2 feature and every software
panel, control and display;

� Reference information on audio test and measurement techniques,
sample and utility file listings and much more.

A copy of the ATS-2 User’s Manual is shipped with every ATS-2 system
and is also published in electronic form as an Adobe® Acrobat® Portable
Document Format (PDF) file, which is available on the ATS-2 CD-ROM
and as a download from the Audio Precision Web site at
audioprecision.com.

Chapter 1: Introduction About This Manual
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On the CD-ROM Installation screen, click the Manuals and
Documentation button. From the document which appears, simply click
the ATS-2 User’s Manual link to load the PDF.

ATS-2 Capabilities

ATS-2 is a comprehensive high-performance audio testing system.

� ATS-2 can make amplitude, frequency, THD+N, noise, phase,
crosstalk, bandpass, and IMD measurements for analog or digital
audio devices, and can perform a detailed analysis of individual
harmonic distortion products.

� ATS-2 can perform measurements on audio signals using fast Fourier
transform (FFT) analysis with advanced high-speed FFT analysis
techniques available, including multitone recognition and analysis
capability, frequency adjustment for bin centering, synchronous FFT
processing, and advanced post-FFT analysis. FFT analysis can also
provide time-domain, oscilloscope-type waveform display of signals.
Non-audio signals such as interface signal jitter components can also
be studied with FFT techniques.

� ATS-2 can use a combination of different measurement instruments
and parameters to perform complex sweeps, and can display and
print the results with a powerful graphing engine. ATS-2 offers control
over instrument regulation and over sweep settling parameters.
Pass/fail limits or equalization data can be attached to a sweep to
constrain a particular measurement. A variety of computations can
be performed on the measured data after acquisition. Sweep tests
can be saved and recalled, and ATS-2 measurements can be
automated by macros written in the AP Basic programming
language.

� ATS-2 can examine the digital interface signal and perform elemental
analysis of digital communication paths and assure the integrity of
digitally transmitted data. ATS-2 can extract a variety of statistics
from the digital waveform, such as the actual sample rate, the
interface waveform voltage, the active and inactive data bits and flag
bits. ATS-2 can measure the jitter in the interface signal. ATS-2 also
has the capability of transmitting and receiving the full complement
of status bits for both the AES3 (professional) and IEC60958-3
(consumer) digital audio interface signals.

� ATS-2’s sample rate may be synchronized to an external AES signal,
a squarewave, or an NTSC / PAL video source.

� The ATS-2 Performance Upgrade Option adds more power: a pair of
high-bandwidth analog-to-digital converters to extend the analog
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analysis bandwidth from 30 kHz up to 120 kHz; and an additional
Analyzer instrument called the Digital Interface Analyzer that can
more closely examine the interface signal, providing eye patterns,
histograms, waveform display and FFT spectrum analysis of the
recovered jitter signal, and triggering from a number of different
interface patterns and bits.

Conceptual Architecture of ATS-2

The functional components implemented in ATS-2 include two
DSP-implemented audio signal generators, a suite of DSP-implemented
audio, data and interface signal analysis capabilities, digital and analog
input and output modules, and modules for synchronization and APIB
communication.

All signal generation is performed in the digital domain. One of the two
DSP signal generators is dedicated to the digital output. The signal from
this generator, called the “Digital Generator,” is routed through the digital
audio interface transmitter module and to the balanced, unbalanced and
optical digital outputs. The output of the second DSP signal generator, the
“Analog Generator,” is converted to an analog signal by a digital-to-analog

Chapter 1: Introduction Conceptual Architecture of ATS-2
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converter (DAC). The two-channel output of the DAC is conditioned and
ranged for the balanced and unbalanced analog outputs.

All signal analysis is also performed in the digital domain in DSP. The
digital input is routed through a digital audio interface receiver and applied
to the Analyzer DSP. Analog inputs are first ranged and conditioned for
domain conversion, and then are sampled by a high-resolution (or,
optionally, a high-bandwidth) analog-to-digital converter (ADC) before
being applied to the Analyzer.

Other Documentation for ATS-2

Audio Precision publishes a wealth of material on our hardware and
software products, about audio theory and on specific test and
measurement techniques. Here are some important documentation
resources:

Getting Started with ATS-2

We recommend that you read Getting Started with ATS-2 before
reading any other ATS-2 documentation. It is an introductory manual
which will help you correctly set up ATS-2, install the software on your PC
and familiarize yourself with the system. Inside Getting Started with ATS-2
manual you’ll find:

� hardware and software installation instructions;

� an introduction to the ATS-2 system;

Other Documentation for ATS-2 Chapter 1: Introduction
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Analog Domain / Digital Domain

Discussions of audio technology often place the signals into one or
another of two realms: the analog domain or the digital domain. These
terms provide a useful conceptual division.

Analog audio signals are analogies of the sound waves that they
represent, varying in frequency and amplitude in a continuous fashion.
In audio electronics, these are voltages and currents that are
manipulated by modifying their amplitude or frequency. The term
analog domain refers to signals represented and processed in this
fashion.

Digital audio signals, on the other hand, are numerical
representations of the sound waves. This representation is often carried
on an electrical signal called the interface signal. Digital audio is
processed mathematically in processes gathered together under the
name of Digital Signal Processing, or DSP. The term digital domain
refers to signals represented and processed in this fashion.



� a look at the key features of the ATS-2 measurement software;

� a group of Quick Guide tutorials, putting the ATS-2 system to use in
simple tests; and

� ATS-2 specifications.

A copy of Getting Started with ATS-2 is shipped with every ATS-2
system and is also published in electronic form as an Adobe Acrobat
Portable Document Format (PDF) file, which is available on the ATS-2
CD-ROM and as a download from the Audio Precision Web site at
audioprecision.com.

On the CD-ROM Installation screen, click the Manuals and
Documentation button. From the document which appears, simply click
the Getting Started with ATS-2 link to load the PDF.

Online Help

While you are running ATS-2, you will have much of the information
contained in the ATS-2 User’s Manual available to you instantly in the
online Help system included as part of the ATS-2 system.

You can access the Help system while you are using ATS-2 in a couple
of ways:

� On the Menu bar, click Help. The Help menu offers commands to
search the Help Index, browse through the Help Topics, or select
an alternate Help library, AP Basic Language.

� ATS-2 also has context-sensitive Help available. Almost every control
and display on each software panel has a help topic associated with
it. To view the topic, simply click on the field or control, then press
the F1 function key.

The AP Basic User’s Guide and Language Reference

You can create simple or complex test and measurement macros to
automate ATS-2 using AP Basic, the programming language included with
the system. The same AP Basic language is also used to automate other
Audio Precision PC-controlled systems and to interface with other
programming languages.

The AP Basic User’s Guide and Language Reference is published in
electronic form as an Adobe Acrobat Portable Document Format (PDF) file
and is available on the ATS-2 CD-ROM and as a download from the
Audio Precision Web site at audioprecision.com.

On the CD-ROM Installation screen, click the Manuals and
Documentation button. From the document which appears, simply click
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the AP Basic User’s Guide and Language Reference link to load the
PDF.

You will also find online Help for AP Basic while running ATS-2. Click
Help > AP Basic Language Help on the Help menu.

The AP Basic Extensions Reference for ATS-2

The AP Basic Extensions Reference for ATS-2 is a large supplementary
library of OLE / ActiveX automation commands for use specifically with
ATS-2.

The AP Basic Extensions Reference for ATS-2 is published in electronic
form as an Adobe Acrobat Portable Document Format (PDF) file and is
available on the ATS-2 CD-ROM and as a download from the Audio
Precision Web site at audioprecision.com.

On the CD-ROM Installation screen, click the Manuals and
Documentation button. From the document which appears, simply click
the AP Basic Extensions Reference for ATS-2 link to load the PDF.

You will also find online Help for ATS-2 Basic Extension while running
ATS-2. Click Help > AP Basic Extension for ATS-2 Help on the Help
menu.

The Filter Design Package Manual

ATS-2 can access and use downloadable filter files. This feature enables
you to install custom DSP software filters as high-pass, low-pass and
weighting filters for use with the ATS-2 Analyzer. The Filter Design Package
manual can help you design and create your own user downloadable filter
files as well.

The Filter Design Package manual is published in electronic form as a
PDF file and is available on the ATS-2 CD-ROM and as a download from
the Audio Precision Web site at audioprecision.com.

On the CD-ROM Installation screen, click the Manuals and
Documentation button. From the document which appears, simply click
the Filter Design Package link to load the PDF.

Application Notes and TECHNOTES

From time to time Audio Precision publishes technical papers such as
AP Application Notes and TECH NOTES, which can help in your
understanding of the operation of the ATS-2 system. Hundreds of Audio
Precision technical publications are available for download from our Web

Other Documentation for ATS-2 Chapter 1: Introduction
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site at audioprecision.com. New technical papers and online solutions are
added on a regular basis.

Chapter 1: Introduction Other Documentation for ATS-2
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Viewing and Printing PDF files

Audio Precision documentation is provided in Adobe Portable
Document Format (PDF) format on the ATS-2 CD-ROM and on the
Audio Precision Web site at audioprecision.com.

You can view the PDF files using Adobe Acrobat Reader, a free
program that can be downloaded from the Audio Precision Web site or
from Adobe at www.adobe.com. You can also print PDF files using
Acrobat Reader and a Windows compatible printer.



Chapter 2

The ATS-2 Measurement Software

Overview

Most of your interaction with the ATS-2 system will be through the
ATS-2 measurement software. Once ATS-2 is plugged in, turned on and
connected to your device under test (or DUT), you will be making all your
adjustments and taking all your readings from your computer screen.

The ATS-2 measurement software is a powerful and complex program,
and most of this book is dedicated to exploring and explaining its many
capabilities. In this chapter, we’ll look at an overview of the software
features and learn the basics of operating the system.

The User Interface

Like many Windows applications, the ATS-2 user interface has a menu
bar, a status bar, toolbars, and a workspace. With these tools you can save
test and data files, export and print measurement results, configure both
the hardware and software to your needs, access online help, design and
launch automated processes and, of course, open and operate the
instrument panels where the core test and measurement work is
performed.

ATS-2 User’s Manual 9



The Workspace

The ATS-2 workspace has 5 pages that you can select by menu
commands (View > Page #) or by clicking the numbered tabs on the
Status Bar. The workspace is like a multi-layered desktop where you can
display and organize the instrument panels you are using for a particular
set of tests.

Panels can be placed on any workspace page, and duplicated on more
than one page. An instrument panel which appears on more than one
page is simply a redundant display, for your convenience. The settings and
results shown on redundant panels are identical, and a change made on
one page is reflected on the others.

The ATS-2 Panels

The real interaction with ATS-2 is done in control and measurement
windows called panels. These can be thought of rather like the physical
control panels often found on conventional test and measurement
equipment, with range, function and trigger controls, ON and OFF
switches, linear adjustment pots and sliders, numerical meter readouts, bar
meters, X-Y waveform displays, graphs and so on.

The ATS-2 panels are available through menu commands, toolbar icons
and keyboard shortcuts.

You can control ATS-2 from just one or two ATS-2 panels, if that’s all
your measurement requires. A more typical test might involve four or five
panels; a complicated test, perhaps six or seven.

Chapter 2: The ATS-2 Measurement Software The Workspace
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Although the ATS-2 panels can all be placed on one workspace page,
most users prefer to organize their workspace by placing panels on several
different pages.

You can close a panel without canceling its function or effect; for
example, you could set a signal’s output voltage and frequency on the
Analog Generator panel, turn the generator ON, then close the panel
window. The signal will continue at the settings you’ve made until you
open the panel again and turn the generator OFF.

Many of the ATS-2 panels come in two sizes, the smaller having fewer
commands and readouts visible, and the larger showing every option. The
most commonly used size for each panel is set as its default size.
Double-click on the panel title bar to expand or contract it.

Panel Settings

Settings for tests and measurements are made using several different
types of controls on the panels:

� Setting fields, which come in several versions:

� First is a text box, in which you can directly enter a value from the
keyboard.

� Second is a drop-down list box, in which you can make a selection
from a set of choices.

The ATS-2 Panels Chapter 2: The ATS-2 Measurement Software
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� Third is a combination of the first and second, a text box with an
added drop-down list from which you can choose the units to
express your value.

Setting fields display dark (black or blue) text or numbers on a white
field.

� Check boxes, which allow you to set non-exclusive conditions.

� Option buttons, which provide for exclusive conditions.

� Browser buttons, which open dialog boxes called browsers, which
allow you to navigate lists of options, search for a file by browsing
through a hierarchy of folders, and so on. Browser buttons are
identified by the ellipsis mark ( … ).

� Custom buttons that control special functions, such as GO, ON,
OFF, 1, 0 and so on.

� Sliders, with which you can continuously adjust a value. Sliders are
found on the Volume toolbar and on Bar Graph panels. Sliders can
be operated by either the mouse pointer or by using the arrow keys.

Panel Readings

Results of tests or measurements are called readings, which ATS-2 can
display in several ways, as

� Reading fields, sometimes called measurement fields or meters.
Reading fields come in two variations, with and without a drop-down
list to select units.

Reading fields always display green text or numbers on a black field.

� Bar graphs, which display values as a continuous colored bar like a
conventional analog meter.

� Status indicators, which show the presence or absence of a condition
by a small colored rectangle.

Chapter 2: The ATS-2 Measurement Software The ATS-2 Panels
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The ATS-2 Menus

The ATS-2 Menu bar extends across the top of the ATS-2 window and is
always visible. In this chapter we will take a very brief tour of the ATS-2
menus. Details of menu options, controls and submenus will be explored
in the chapters discussing specific ATS-2 functions.

The File Menu

The File menu offers commands for opening, saving, appending,
importing, exporting and printing ATS-2 files, and access to the Quick
Launch menu.

Since there are a number of different files types used by ATS-2,
submenus are available (at the small black arrows � accompanying some
menu choices) to choose, for example, whether to Save As a Test or
Data or Macro file.

The listings at the bottom of the File menu show the last tests opened by
ATS-2, and provide a convenient way to quickly launch a previously used
test. Simply click on the name of the test you would like to open.

The ATS-2 Menus Chapter 2: The ATS-2 Measurement Software
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The Edit Menu

The Edit Menu provides several groups of commands:

� Undo and Cut, Copy, and Paste provide editing functions for
ATS-2 text entries.

� Copy Panel to Clipboard places a bitmap image of the selected
ATS-2 panel on the Windows clipboard.

� The Set Analyzer and Set Generator commands provide an easy
way to set reference levels for the Analyzer panel and both reference
levels and frequencies for the Generator panels for relative
measurements. These are discussed in detail in the appropriate
chapters.

� Reset Bar-graph Max/Min clears the gray minimum/maximum
excursion bar from a selected Bar Graph display.

� The four last commands are only active when the ATS-2 Data Editor
is open and selected, and provide the means to insert, add and
delete data rows.

Chapter 2: The ATS-2 Measurement Software The ATS-2 Menus
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The View Menu

The View menu allows you to select which workspace page is visible,
and whether or not the Status bar and any combination of Toolbars are
displayed. A checkmark next to a View menu listing indicates that the
selection is visible.

The Status Bar

The Status bar runs across the bottom of the workspace and shows the
workspace page tabs and various status notes as ATS-2 operates.

The Toolbars and ATS-2 Icon Buttons

ATS-2 has 5 toolbars for quick access to panels and common functions.
The toolbars can “float” at any location you place them on the workspace,
or they can be “docked” or attached to the Menu bar. Whether docked or
floating, the toolbars appear on every workspace page.

The toolbars display icon buttons, which, when clicked with the mouse,
perform the associated functions.

The ATS-2 Menus Chapter 2: The ATS-2 Measurement Software
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The Standard Toolbar

The Standard toolbar gives you quick access to ATS-2 file, printer and
editing operations, as well as Sweep Stop/Start and FFT Time/Frequency
domain switching. The buttons on the Standard toolbar are:

New Test resets the ATS-2 measurement software to its defaults and
initiates a new test.

Open Test presents you with a file browser window to select a
previously saved test file (.ats2) for opening.

Save Test saves the current test as .ats2. If the test has not been
previously saved, you will be presented with a browser window to choose
a file name and location.

Save All saves not only the current test but any other files which are
currently open, such as data or macro files. If any file has not been
previously saved, you will be presented with a browser window to choose
a file name and location.

Print prints the current graph to your default printer with the current
settings.

Print Preview provides a preview window of your graph using the
current default printer and the current settings.

Undo allows you to “back up” one step in your text editing.

Cut removes the selected text and places it on the Windows clipboard.

Copy places the selected text on the Windows clipboard.

Chapter 2: The ATS-2 Measurement Software The ATS-2 Menus
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Paste inserts text from the Windows clipboard at the cursor location.

Go starts a sweep.

Stop ends a sweep.

Toggle FFT Time/Frequency Domain switches the graph between a
frequency-domain view (spectrum view) and a time-domain view
(waveform view) for the same input signal acquisition. This feature is only
available while using the Spectrum Analyzer, the Multitone Audio Analyzer
and the Digital Interface Analyzer.

The Panels Toolbar

The Panels toolbar gives you quick access to 17 often-used ATS-2
panels:

This button opens the Analog Generator panel. See Chapter 8.

This button opens the Analog Input panel. See Chapter 6.

This button opens the Digital Generator panel. See Chapter 9.

This button opens the Analyzer panel. See Chapter 5.

This button opens the Digital Input/Output (DIO) panel. See Chapter 7.

This button opens the Sync/Ref Input panel. See Chapter 22.

The ATS-2 Menus Chapter 2: The ATS-2 Measurement Software
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This button opens the Status Bits panel. See Chapter 7.

This button opens the Headphone/Speaker panel. See Chapter 21.

This button opens the DCX panel. See Chapter 27.

This button opens the Switcher panel. See Chapter 26.

This button opens the Trigger panel. See Chapter 22.

This button opens the Sweep panel. See Chapter 15.

This button opens the Settling panel. See Chapter 15.

This button opens the Graph panel. See Chapter 16.

This button opens the Data Editor panel. See Chapter 18.

This button opens a new Bar Graph panel. See Chapter 17.

This button opens the Macro Editor panel. See Chapter 23.

The Macro Toolbar

The Macro toolbar offers 9 one-click operations for running and editing
an AP Basic Macro. See Chapter 23, Automating Tests, for explanations
of functions initiated by Macro toolbar buttons.

Chapter 2: The ATS-2 Measurement Software The ATS-2 Menus
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The Learn Mode Toolbar

Learn mode logs all your ATS-2 operations as you perform them,
building a script for automation purposes. The Learn Mode toolbar gives
you the ability to turn the script recording function on and off with a click
of the mouse. See Chapter 23, Automating Tests, for explanations of
Learn Mode toolbar button functions.

The Quick Launch Toolbar

Quick Launch allows you to create and use custom toolbar buttons to
open ATS-2 tests, run AP Basic macros and even launch other Windows
programs.

From the Main menu, choose File > Quick Launch > Customize
Quick Launch to open the Quick Launch Configuration panel, where
you can view or edit the existing Quick Launch commands or to add new
commands of your own.

For each toolbar command, enter (or browse to) a command line with a
complete path in the Command field. Then name the command in the
Menu Text field, and choose toolbar button icon with be browser next to

The ATS-2 Menus Chapter 2: The ATS-2 Measurement Software
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the Menu Text field. If you would like a macro from the Quick Launch
toolbar to run immediately, check Automatically run when loaded.

To open the test, macro or program, click the button on the Quick
Launch toolbar.

Using Files with ATS-2

Part of the power of ATS-2 is its capability to create, store, load and run
files which contain test setup and measurement data information, similar
to the way a word processor or spreadsheet application uses document,
template or script files. The primary “document” in the ATS-2 system is the
test, although ATS-2 uses other file types as well.

The ATS-2 Folder Tree

In a default installation, the folder structure shown in Figure 6 is created
and populated with sample files. You will find tests for many applications,
data files for EQ and Limit uses, powerful macros and an array of
multitone waveforms. These are useful as examples as you use this
manual, and are also excellent “starting points” as you create and save
your own measurement procedures.

Chapter 2: The ATS-2 Measurement Software Using Files with ATS-2

20 ATS-2 User’s Manual

Sample files
(mostly test files,
with supporting
data and macro files)

Sample arbitrary
waveform files
(mostly multitone)

Macro-driven samples

DSP user filters

EQ files

Log files

Personal test, data and macro files

Custom-created multitones

Figure 6. The ATS-2 folder tree structure for a standard installation.



Test Files

When you first launch ATS-2, a default setup is loaded. You can modify
this initial setup by opening or closing panels, changing configuration,
making settings, running a sweep and so on. You can save your custom
setup as a “test” under any name, in any folder you choose. ATS-2 saves
the instrument and sweep setup information, the input and output
configuration, the panel sizes and positions, and so on. If you have run the
test and produced results, the test data is also saved in the test file.

The extension for test files is

� ATS-2 test file—.ats2

If you would like to return to a “clean slate” simply click the New Test
button or the New > Test command on the File menu. ATS-2 will discard
your current settings and data and reload the default setup.

You can open previously saved tests and sample tests and use them as
they are, or you can modify and re-save the tests under the same name or
under a new name. Dozens of sample tests are included with ATS-2, and
you can use them as examples or as starting points for your own custom
tests.

Macro Files

Another important ATS-2 file type is the macro file, sometimes called a
procedure file. As in other programs, a macro is a programming script
which can automate program functions. ATS-2 macros are written in the
programming language AP Basic, which is included with ATS-2.

The extension for macro files is

� AP Basic macro file—.atsb

Data Files

ATS-2 stores all data from test results in memory as the test is run. As
mentioned before, this information is saved along with panel and sweep
setup information in a test file. The data can also be viewed and edited in
a panel called the Data Editor, and can be saved as a separate file.

ATS-2 can open saved data files in order to attach previous data to a
current test. There are four different data file types, each of which has a
different use within ATS-2.

The extensions for data files are

� AP data file—.atsa

� AP limit file—.atsl

Using Files with ATS-2 Chapter 2: The ATS-2 Measurement Software
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� AP sweep file—.atss

� AP EQ file—.atsq

The four ATS-2 data file types are identical except for their

file name extensions. Data saved as .atsa, .atsl, .atss or .atsq

files can later be used for any data function. The different

extensions serve to help organize data files and to indicate

the intended use of the data.

It is also possible to export ATS-2 data as an ASCII text file for use in a
spreadsheet or text editor program. The extension for an ASCII data file is:

� AP ASCII data file—.atsx

Waveform Files

For certain analyzer functions performed in DSP, including FFT displays
and some types of interface analysis, ATS-2 acquires a short sample of the
digital waveform. These samples can be saved as waveform files and later
opened by ATS-2 for further use.

The extensions for waveform files are

� AP stereo waveform file (generator)—.ags

� AP stereo waveform file (analyzer)—.aas

� AP mono waveform file (generator)—.agm

� AP mono waveform file (analyzer)—.aam

� AP digital interface waveform file—.aai

The Log File

ATS-2 can generate a log file, which can contain error messages, file
activity, sweep activity, graph information and pass/fail test results. The log
file can be viewed on the screen or printed. The extension for the log file is

� AP log file—.alg

The log file is enabled and set up on the Configuration panel, and is
discussed in detail in Chapter 25.

Keyboard Shortcuts

Many of the ATS-2 Menu and Toolbar commands are also available as
keyboard shortcuts. The Sweep Start command, for example, is F9; the
Analog Generator panel can be brought to the screen with Ctrl+G.

Chapter 2: The ATS-2 Measurement Software Keyboard Shortcuts
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Keyboard shortcuts are mentioned in the chapters which discuss the
functions they command, and are shown in the ATS-2 menus. The are all
listed here as well.

Function Keys

� F1
Context-sensitive Help—brings the Help topic associated with the
currently selected panel feature to the screen.

� F2
In a Bar Graph, resets the minimum/maximum value history.

� F2
In the Data Editor, enables editing within a data cell.

� F3
Sets the Analog Generator dBr reference value to the current Analog
Generator amplitude setting.

� Ctrl-F3
Sets the Analog Generator frequency reference value to the current
Analog Generator frequency setting.

� F4
Sets the Audio Analyzer and the Harmonic Distortion Analyzer dBr
reference value to the current Analyzer amplitude reading.

� F6 (for FFT-based, batch mode instruments: Spectrum, Digital
Interface and Multitone Analyzers)
Performs a new transform on the acquired data and graphs the
results.

� Ctrl-F6 (for FFT-based, batch mode instruments: Spectrum, Digital
Interface and Multitone Analyzers)
Graphs the transform results currently in DSP memory without
performing a new transform.

� F7
Graphs the data currently in computer memory.

� Alt-F8
Stores the present trace or traces to the Graph Buffer memory.

� F8
Displays the trace or traces currently stored in the Graph Buffer
memory.

� Ctrl-F8
Deletes any trace or traces in the Graph Buffer memory.

Keyboard Shortcuts Chapter 2: The ATS-2 Measurement Software
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� F9
Starts a new Sweep; equivalent of Sweep Start or clicking the Go
button.

� Ctrl-F9
Starts a new Sweep while retaining previous data; appending the
new sweep to the old; equivalent of clicking Go when Append box
is checked.

� Alt-F9
Starts a new Sweep in repeating mode; equivalent of clicking Go
when Repeat box is checked.

� F10
The “sweep pause button.” Toggles a sweep from running to paused
and back again.

� F12
The “panic button.” Turns off all generator outputs.

� Ctrl-F12
Turns on any generator outputs previously turned off by the panic
button.

Power Recycle Time

To assure stable operation after ATS-2 is switched off or loses power,
wait 15 seconds before re-applying power.

Diagnostics

The Diagnostics panel, opened by Panels > Diagnostics, is used for
instrument service, diagnosis and other calibration at Audio Precision and
Audio Precision authorized Service Centers. It is not intended for use in
normal operation.
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Chapter 3

The ATS-2 Hardware

There are no controls or displays on the ATS-2 hardware chassis.
Instead, the ATS-2 user interface is through the controls and displays of
the ATS-2 measurement software, running on the personal computer
connected to the ATS-2 chassis by the Audio Precision Interface Bus
(APIB).

All signal generation and analysis is performed in the ATS-2 hardware,
including storage of signals acquired for DSP waveform display or FFT
analysis.

The ATS-2 Front Panel

The main digital and analog signal input and output connectors are on
the ATS-2 front panel, with a lighted “power on” indicator.

� THE DIGITAL OUTPUT
The ATS-2 digital output can be routed to the balanced XLR male “I”
connector, the unbalanced BNC connector or the optical connector
by software selections. When the dual-connector output configuration
is selected, both the “I” and “II” connectors are used together.
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� THE DIGITAL INPUT
The ATS-2 digital input can be routed from the balanced XLR female

“I” connector, the unbalanced BNC connector or the optical
connector by software selections. When the dual-connector input
configuration is selected, both the “I” and “II” connectors are used
together.

� THE ANALOG OUTPUTS
The ATS-2 analog outputs for both “A” and “B” channels are
available as balanced signals at the XLR male connectors and as
unbalanced signals on the BNC connectors.

� THE ANALOG INPUTS
The XLR female balanced connectors and the BNC unbalanced
connectors for both “A” and “B” channels are routed to the ATS-2
analog inputs.

See Chapter 4, Signal Inputs and Outputs for more information
about the ATS-2 inputs and outputs and the software panels associated
with them. Refer to the manual Getting Started with ATS-2 for detailed
input and output specifications.

The ATS-2 Rear Panel

The only switch on the ATS-2 hardware is the mains power switch. The
power switch is located on the left side of the rear panel in the power entry
module, which also contains the power cord connector, the mains voltage
selector and the power fuse(s).

The ATS-2 monitor and headphone, sync/ref, trigger, auxiliary control
and APIB connections are also mounted on the rear panel.

Chapter 3: The ATS-2 Hardware The ATS-2 Rear Panel
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� POWER ENTRY MODULE—this module includes the

� POWER SWITCH—This switch turns the main power supply to
the ATS-2 hardware ON ( I ) or OFF ( O ). To assure stable
operation after ATS-2 is switched off or loses power, wait 15
seconds before re-applying power.

� POWER CORD CONNECTOR—This is a standard grounded
connector for the mains power supply cord.

� FUSE HOLDER / MAINS SUPPLY VOLTAGE JUMPER—Open
the cover of the fuse holder (see the separate manual Getting
Started with ATS-2) for access to the mains power fuse and the
mains supply voltage configuration jumper card.

� MAINS SUPPLY VOLTAGE INDICATOR—The white tip of the
plastic indicator on the voltage configuration jumper card appears
in one of four small holes to show the mains voltage selection.

� FUSE REPLACEMENT INFORMATION—This chart lists the fuse
values required for correct operation at the four supply voltage
options.

� S / N, OPTION LABEL—This label lists the Audio Precision serial
number, date of manufacture and hardware Performance Upgrade
Option, if installed.

� HEADPHONE JACK—This is a 3.5 mm stereo jack suitable for
driving headphones or other audio monitors.

� APIB INTERFACE—This connector provides the two-way Audio
Precision Interface Bus connection between ATS-2 and the personal
computer running the ATS-2 measurement software.

� SYNC / REF IN—This connector provides an additional input for an
external digital audio signal, a squarewave or an NTSC/PAL video
signal for sample rate synchronization (“house sync”) and delay
calculations. This connector also serves as the input for the
Pass-Thru generator function.

� MONITOR OUTPUTS—These connectors provide audio signal
monitor outputs. The SOURCE monitor signals are routed from the
input of the ATS-2 Analyzer, at the Level meters; the FUNCTION
monitor signals are routed from the Analyzer Function meter,
monitoring the reading in process.

� TRIG IN—This connector provides an input to trigger or initiate
certain measurement functions.

� TRIG OUT—This connector provides an output for the purpose of
triggering an external oscilloscope.
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� AUXILIARY CONTROL OUTPUT—9-pin D-Sub connector
designated for future implementation.

� AUXILIARY CONTROL INPUT—9-pin D-SUB connector
designated for future implementation.

� GROUND CONNECTOR—This is a chassis ground connection
suitable for bare wire or banana plug connection.

Power Recycle Time

To assure stable operation after ATS-2 is switched off or loses power,
wait 15 seconds before re-applying power.
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Chapter 4

Signal Inputs and Outputs

This chapter discusses the hardware aspects of ATS-2’s main analog and
digital signal inputs and outputs. Monitor connections are discussed in
Chapter 21, while sync, reference and auxiliary connections are examined
in Chapter 22.

The primary signal input and output connectors are mounted on the
ATS-2 front panel.

The analog inputs are configured on the software Analog Input panel;
the analog outputs are controlled from the Analog Generator panel.

A digital audio signal has two aspects: the electrical interface signal and
the information carried in the interface data stream. Selection and
electrical configuration of the digital interface signal input and output is
accomplished from the Digital Input/Output (DIO) panel, as are many
characteristics of the data stream itself. Additionally, features of the audio
embedded in the data stream are controlled from the Digital Generator
panel.

See Specifications in Getting Started with ATS-2 for detailed
hardware specifications for both the analog and digital inputs and outputs.
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The Analog Outputs

The ATS-2 analog outputs can provide a balanced output signal, an
unbalanced signal or a common-mode-test signal. The software output
configuration selection affects both Channels A and B.

The balanced signal is available on the XLR male connector, with pin 2
wired to the “high” leg of the signal, pin 3 to the “low,” and pin 1 to
ground. In balanced mode the BNC connector for that channel is
disconnected.

When an output is set to unbalanced, the signal is available at both the
XLR male connector and the BNC connector simultaneously. In this
configuration pin 1 of the XLR is wired to ground; the BNC shell and pin 3
of the XLR are held to the unbalanced signal low; and the center pin of the
BNC and pin 2 of the XLR carry the signal high.

Chapter 4: Signal Inputs and Outputs The Analog Outputs
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Do not “unbalance” the balanced outputs by connecting pin 2

or pin 3 of an XLR output connector to ground, as might be

done with adapter cables. Connecting the ATS-2 balanced

outputs to an unbalanced load will produce distorted

waveforms. Use the unbalanced output connectors for an

unbalanced load.

The common-mode test signal is applied to both pins 2 and 3 of the
XLR connector, while pin 1 is grounded. The BNC connector is
disconnected in the common-mode configuration.

Output impedance can be set to either 40 � or 150 � in the balanced
configuration (40 � or 200 � for the European impedance option), and to
20 � or 50 � in the unbalanced.

Output selection and impedance are set on the Analog Generator panel,
page 84.

The Analog Inputs

The XLR female balanced connectors and the BNC unbalanced
connectors (both A and B channels) are connected to the ATS-2 analog
inputs. Input selection is made on the Analog Input panel, page 39.

The input impedance at each of the analog inputs is greater than
100 k�.

We recommend that you do not use both the balanced and

unbalanced analog inputs of either channel simultaneously.

Circuit conditions external to ATS-2 could degrade the

system performance. However, you may use the balanced

input of one channel and the unbalanced input of the other

channel at the same time.

The Analog Inputs Chapter 4: Signal Inputs and Outputs
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The Digital Output

The digital output signal is available as a balanced electrical signal at the
XLR male connectors, in either single or dual-connector configurations.
This output satisfies the electrical requirements of the AES3 professional
interface standard. Use the connector labeled “I” for the customary
single-connector configuration, and both “I” and “II” for the optional
dual-connector configuration.

The output signal is also available as an unbalanced electrical signal at
the BNC connector. This output satisfies the electrical requirements of both
the AES3id professional standard and the IEC60958-3 standard, which is
compatible with the S/PDIF consumer digital interface format.

The XLR and BNC digital outputs are calibrated with the assumption
that the signal is terminated in the proper impedance (110 � for the
balanced output; 75 � for the unbalanced). If the signal isn’t properly
terminated the actual output voltage will be different from the voltage
specified in the DIO panel.

The digital output is also provided as an optical signal compatible with
the Toslink® interface.

Digital output selection and interface configuration are set on the DIO
panel, page 43.

We recommend that you do not use the balanced and

unbalanced digital outputs simultaneously. Circuit conditions

external to ATS-2 could degrade the system performance.

However, the optical output can be used simultaneously with

either the balanced or unbalanced digital output.

The Digital Input

The digital input accommodates the same interface formats as the
digital output. The XLR female connectors provide a balanced input for
satisfying the electrical requirements of an AES3 professional format digital
audio signal in either single or dual-connector configurations. Use the
connector labeled “I” for the customary single-connector configuration,
and both “I” and “II” for the optional dual-connector configuration. Input
termination can be set on the DIO panel to HiZ (approximately 10 k�) or
to 110 �, the AES3 standard.

The BNC input connector is configured for an unbalanced digital signal
satisfying the electrical requirements of both the AES3id professional
format and the IEC60958-3 (S/PDIF) consumer interface format. Input

Chapter 4: Signal Inputs and Outputs The Digital Output
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termination can be set on the DIO panel to HiZ (approximately 10 k�) or
to 75 �.

The optical input is compatible with the Toslink® interface.

Digital input selection and interface configuration are set on the DIO
panel, page 43.

We recommend that you do not maintain connections to the

balanced and unbalanced digital inputs simultaneously.

Circuit conditions external to ATS-2 could degrade the

system performance. However, a connection to the optical

input can be maintained simultaneous to a connection to

either the balanced or unbalanced digital input.

The DIO panel will select only one input at a time.

Electrical vs. Data Characteristics Across Formats

The various standards defining digital audio interface formats cover a
broad number of characteristics, including line impedance, signal voltage,
acceptable rise-time and jitter figures, and also the information carried as
data on the interface.

Although the ATS-2 balanced and unbalanced digital connections do
satisfy the electrical requirements for certain standards, as mentioned
above, selecting the balanced or unbalanced digital input or output does
not configure the digital data stream. This is done in other fields on the
DIO panel and on the Status Bits panel. See Chapters 7 and Appendix B
for a full discussion of the digital data stream and status bits.

It is entirely possible to route digital audio data configured to the
professional format standard (AES3) to the unbalanced output with
voltage and impedance characteristics matching the consumer format
standard (IEC60958-3), as it is possible to route consumer-formatted data
to the balanced output, at the professional format voltage levels and
impedance values.

The Digital Input Chapter 4: Signal Inputs and Outputs
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Chapter 5

Signal Analysis with ATS-2

This chapter gives a brief overview of the tools ATS-2 provides for signal
analysis and serves as an introduction to test and measurement techniques
using ATS-2. ATS-2 can test and measure analog audio signals, the serial
digital interface signal, and the digital audio signal carried on the interface.

For each type of signal, ATS-2 provides the capability to generate a
variety of stimulus signals for input to the device under test (DUT), and the
capability to analyze the output of the DUT in a number of different ways.

References link the key topics introduced here to later chapters where
they are examined in detail.

Analog Audio Signals

Analog Audio Generation and Output

ATS-2 can produce a wide range of analog audio signals in the Analog
Generator (see Chapter 8) to be applied to the input of an analog DUT as
stimulus signals.

The Analog Generator panel also provides controls to select and
configure the analog outputs.

The Analog Generator and the Digital Generator (discussed below) are
similar in appearance and function.

Analog Audio Input

The ATS-2 Analog Input panel provides the means to select and
configure the analog inputs. The signals routed through the Analog Input
panel are then converted to digital audio signals for analysis, using
high-performance analog-to-digital converters (ADCs). After conversion,
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the signals are routed to the ATS-2 Analyzer, where a number of different
analysis instruments can be applied.

See Chapter 6 for detailed information on the Analog Input panel. The
Analyzer is discussed below.

The Serial Digital Interface Signal

Digital audio is transmitted and received on the serial digital interface
signal. The interface signal has characteristics which can be measured and
tested, and ATS-2 provides the capability to do this in the Digital Input /
Output (DIO) panel, and to a greater extent in the Analyzer instrument
called the Digital Interface Analyzer, which is available as a component of
the Performance Upgrade Option.

Since the interface signal carries the digital audio, some characteristics
of the interface signal can be observed by measuring the audio effects on
the embedded signal.

The DIO also configures ATS-2 to receive the data stream from the
digital input, and passes the embedded audio on to other ATS-2 functions.

All the input and output configuration of the digital interface signal is
accomplished from the DIO panel. See Chapter 7 for detailed information
on the DIO panel.

Digital Audio Signals

Digital Audio Generation

ATS-2 can produce a wide range of digital audio signals in the Digital
Generator (see Chapter 9). After generation, the digital audio is embedded
in the serial digital interface signal before being applied to the input of a
digital DUT as a stimulus signal.

As mentioned above, the digital interface signal is configured under the
control of the DIO panel.

The Digital Generator and the Analog Generator (discussed above) are
similar in appearance and function.

The Analyzer

After input conditioning, audio from the analog or the digital inputs can
be routed to the ATS-2 Analyzer. Because the Analyzer uses DSP
techniques for measurement and analysis, the audio must be in the digital
domain. The audio from the digital input can be applied directly to the
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Analyzer without need of conversion; the analog inputs, as we have seen,
are converted to the digital domain by high-performance ADCs.

Click Panels > Analyzer or the Analyzer button on the Panels
toolbar to open the Analyzer panel.

Real-Time and Batch Mode Measurements

Many of the ATS-2 meters and instruments display their results in real
time; that is, their displays update so quickly that moment-to-moment
variations can be observed on a continuous basis. There is some variation
in just how quick real-time measurements actually are; most of the ATS-2
meters have variable detector rates, and the DIO interface monitors update
at approximately 4 times per second. Within certain ranges, however,
real-time measurements provide immediate results.

Other ATS-2 instruments must first acquire a sample of the signal to be
analyzed, and then perform DSP calculations on the data before display.
These are called batch mode measurements, since the data is acquired and
processed in discrete “batches.” In batch mode there is always an initial
acquisition, after which the data is in memory and different analyses can
be performed.

Analyzer instruments which use FFT techniques, including the Spectrum
Analyzer, the Digital Interface Analyzer and the Multitone Audio Analyzer,
are all batch mode instruments.

The Analyzer Instruments

The Analyzer panel provides access to several specialized analysis tools
called instruments. Selecting an Analyzer instrument loads a specific
measurement program into the Analyzer DSPs. Each Analyzer instrument
changes the appearance of the Analyzer panel, bringing its own set of
input, setting, reading and other parameter choices.

The Analyzer instruments are discussed individually in subsequent
chapters. They are:

� The Audio Analyzer, Chapter 10.

The Analyzer Chapter 5: Signal Analysis with ATS-2
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� The Spectrum Analyzer, Chapter 11.

� The Digital Interface Analyzer, Chapter 12.

� The Multitone Analyzer, Chapter 13.

� The Harmonic Distortion Analyzer, Chapter 14.

These five chapters discuss every function, control and display available
on each Analyzer instrument panel in detail. If you are new to ATS-2, you
might want to start with the Quick Guides in Getting Started with ATS-2,
which will introduce you to the Analyzer instrument features.

Sweeps and Graphs

The Analog Generator, the Digital Generator, the Analyzer and other
ATS-2 functions can be controlled from the Sweep Panel, which
orchestrates sets of measurements and provides the means to collect,
graph, edit, constrain and modify analysis data.

See Chapter 15 for information on using sweeps, Chapter 16 for
graphing, Chapter 18 to learn about limits and Chapter 19 for performing
computations on test results.

Chapter 5: Signal Analysis with ATS-2 Sweeps and Graphs
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Chapter 6

The Analog Input Panel

The Analog Input panel selects and configures audio signals that are
applied to ATS-2’s analog inputs, and sets the sample rate and bandwidth
of the analog-to-digital converters (ADCs) that prepare the signals for
analysis. See Chapter 5, Signal Analysis, and Audio Analyzer Signal
Inputs, page 115.

Click Panels > Analog Input or the Analog Input button on the
Panels toolbar to open the Analog Input panel.

With the exception of the Converter and Sample Rate choices, the
two analog input channels can be configured independently, with Channel
A settings and readings to the left of the panel and Channel B to the right.

Source

Select the analog input source for each channel from the drop-down list.
The choices are:

� XLR-Bal
This selection attaches the input channel to the balanced XLR input
connection.
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� BNC-Unbal
This selection attaches the input channel to the unbalanced BNC
input connection.

� GenMon
This selects the generator monitor path, which bypasses the external
analog inputs and instead attaches the input channel to the Analog
Generator output via an internal connection.

See Chapter 4, Signal Inputs and Outputs, for more details
concerning the physical and electrical characteristics of the analog input
connections.

Peak Monitors

Beneath the Source selection fields are two peak-reading monitors, one
for each input channel. These monitors read the peak voltage of the
analog inputs, to confirm signal presence and to aid you in setting the
input ranging, if necessary.

Input Ranging

Practical devices have an optimum amplitude operating range in which
they exhibit their best performance. This is true for amplifiers, for
measurement instruments and for the ADC circuits used in ATS-2 domain
conversion.

ATS-2 gives you the choice of automatic ranging (or autoranging) or
manually setting a fixed maximum range.

Analog input ranging is controlled from the Analog Input panel. If you
are using the Audio Analyzer instrument, additional Analyzer ranging
controls are available on that instrument, as explained on page 119.

Autoranging

ATS-2 should normally be operated with automatic ranging, indicated
by a check mark in each the appropriate Range check boxes. This
provides operation with no possibility of clipping due to high-amplitude
signals.

Click the Range check box to defeat autoranging. The range setting
field for that meter and channel will become active, and you can enter a
fixed maximum range for that input.

Chapter 6: The Analog Input Panel Peak Monitors
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Fixed Range

Using a fixed range produces faster measurements, which can be
important when speed is at a premium, as within a repetitive routine in an
automated testing macro. However, you must know the probable range of
the signal and set a maximum above the highest expected level.

Manual range selection is also preferred when listening to program
material such as voice or music on the built-in loudspeaker or via the
headphone jack. Automatic ranging will constantly switch levels when a
complex, wide-range signal is applied. This may make it difficult to adjust
a device for minimum distortion or noise, for example.

DC Coupling

ATS-2’s analyzer circuitry can be DC-coupled from the front-panel
connectors to the input of the ADC circuits. With DC coupling enabled,
DSP acquisition of analog signals is extended down to DC.

DC coupling also provides a superior common-mode rejection ratio
(CMRR) at low frequencies, which is normally limited by the inevitable
small mismatch in the values of the coupling capacitors that serve to block
the DC.

You can choose to pass the DC component of either analog input signal
by checking the DC checkbox for either channel. If the checkbox is empty,
DC is blocked for that channel.

Converter and Sample Rate Selection

All signal analysis within ATS-2 is performed in the digital domain, and
analog input signals must be converted using analog-to-digital converters
(ADCs). In ATS-2, these are normally 24-bit high-resolution ADCs. You
can choose one of two sampling rate references for the high-resolution
ADCs from the Converter & Sample Rate drop-down list:

� HiRes@65536 Hz. This is the best choice for most audio testing.
The high-resolution converters offer better noise and distortion
characteristics than the optional high-bandwidth converters, and
when the sampling rate is set to 65,536 Hz the high-frequency
response of the analog inputs extends to 30 kHz.

� HiRes@OSR. This setting uses the high-resolution ADCs, but the
value of the sampling rate is taken from the Output Sampling
Rate (OSR) setting on the Digital Input/Output (DIO) panel. Some
tests, such as multitone analysis, require that the digital signal applied
to the DSP be synchronous with the OSR, and this selection
provides that synchronization. At the maximum OSR of 108 kHz, the

DC Coupling Chapter 6: The Analog Input Panel
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high-frequency response of the analog inputs extends to 50 kHz. See
Chapter 7, The Digital I/O Panel.

ATS-2 can be ordered with the Performance Upgrade Option installed,
which includes an additional pair of converters, the 16-bit high-bandwidth
ADCs. These converters offer considerably higher sampling rates and
available signal bandwidths, at the trade-off of less resolution. The
standard 24-bit converters provide 10 dB to 15 dB better residual
distortion.

If the high-bandwidth ADCs are installed, three more choices will be
available on the drop-down list:

� HiBW@131072 Hz. When set at a sampling rate of 131,072 Hz,
the frequency response of the analog inputs increases to 60 kHz.

� HiBW@262144 Hz. At this sampling rate setting of 262,144 Hz,
the frequency response of the analog inputs is extended to 120 kHz.

� HiBW@2xOSR. This setting uses the high-bandwidth ADCs, but
the value of the sampling rate is taken from the Output Sampling
Rate (OSR) setting on the Digital Input/Output (DIO) panel. Some
tests, such as DSP multitone analysis, require that the digital signal
applied to the DSP be synchronous with the OSR, and this selection
provides that synchronization with the high-bandwidth ADCs. See
Chapter 7, The Digital I/O Panel.

Chapter 6: The Analog Input Panel Converter and Sample Rate Selection
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Chapter 7

The Digital I/O Panel

This chapter discusses the Digital I/O panel (also called the Digital
Input/Output panel or simply the DIO panel). The DIO panel serves as the
hub for all digital signal input and output configuration. Additionally, a
number of interface signal parameters can be monitored or changed on
the DIO panel and on the linked Status Bits panel.

See Chapter 2 for an explanation of the characteristics of digital audio
signal, including the serial digital interface signal and the embedded digital
audio it carries. The digital input and output hardware connections are
discussed in Chapter 4.
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On the left of the DIO panel is the Output section, which includes
configuration settings and a number of output signal impairment
selections. The rest of the panel is the Input section, which includes input
configuration and monitoring. A button near the bottom of the panel
accesses the Status Bits panel.

The DIO Output Section

The routing and configuration of the digital interface output signal are
set in the Output section of the DIO panel. Some settings which modify
the embedded audio, such as µ-Law and Pre-emphasis, show up in this
area of the panel as well.

The controls in the bottom half of the panel enable you to impair the
digital output in several ways. An impaired digital interface signal can be
useful in testing proper operation of interface signal receivers.

Chapter 7: The Digital I/O Panel The DIO Output Section
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Format

The first setting field is Format. Select the serial digital interface output
format and connector(s) from the list.

� XLR
This is the balanced digital output. The signal voltage maximum is
5.10 Vpp, typical of the AES3 professional standard.

� BNC
This is the unbalanced digital output. The signal voltage maximum is
1.275 Vpp, typical of the AES3id professional standard and twice the
voltage of the IEC60958-3 consumer standard.

� Optical
This is the Toslink® output.

� Dual XLR
These balanced digital outputs (I and II) are used in conjunction with
each other, as explained in the Dual Connector Mode sidebar
below. In this mode the Sample rate - OSR field sets the overall
data rate, so the rate per output is 1 2OSR.

� Dual XLR 2xOSR
Similar to Dual XLR, with this difference: the Sample rate - OSR
field sets the data rate per connector, so the overall data rate is
2� OSR.

The DIO Output Section Chapter 7: The Digital I/O Panel
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Dual Connector Mode

Typically the alternate data subframes in the AES3 signal carry the
left and right audio channels. In the Dual XLR mode, each AES3
interface signal carries a monaural signal whose sub-frame rate is
double the frame rate. Two connections (I and II) are required for
2-channel audio. Normally, Connector I carries the “A” or left audio
channel and Connector II carries the “B” or right audio channel.

Figure 16. The DIO Output Format

Selections.



Output Sample Rate-OSR

The Sample rate-OSR field (labeled Rate on the small form of the
DIO panel) allows you to set a value for the output sample rate (or OSR).
The default OSR is 48 kHz. Simply click on the field and enter a new rate
from the keyboard. The OSR may be set in the range between 28.8 kHz
to 108 kHz; in Dual XLR mode the range is 57.6 kHz to 216 kHz. A
drop-down list allows you to specify the units of measurement for the
OSR.

The output sample rate set here, the OSR, is available on the Analog
Input panel as a sample rate choice for the input ADCs. OSR also shows
up on the Analog Generator panel as a sample rate selection for the DACs
used in arbitrary waveform conversion and as the Pass Thru sample rate.
OSR is also as an embedded frequency scaling factor selection in the
Scale Freq. by field in both the Output and Input sections of the DIO
panel, where it is called Output Rate.

When using the Dual Connector modes, ADCs or DACs

using OSR as a sample rate selection are clocked by the

connector rate (the cable rate). Frequency scaling is always

by the overall rate.

The output rate may be swept as part of a test by selecting Dio as the
instrument and Output Sample Rate at Source 1 or Source 2 on the
Sweep panel.

Voltage

See Figure 17 for reference.

The Voltage field displays the output amplitude of the serial digital
interface signal. Serial digital interface signal voltage is measured in volts,
peak-to-peak (Vpp).

The signal voltage maximum for the XLR connector setting is 5.10 Vpp,
typical of the AES3 professional standard; voltage maximum for the BNC
connector setting is 1.275 Vpp, typical of the AES3id professional standard
and twice the voltage of the IEC60958-3 consumer standard.

The voltage of the interface signal can be varied to simulate cable
attenuation and test the performance of an interface receiver. Type in the
Voltage field to enter a new interface voltage.

Chapter 7: The Digital I/O Panel The DIO Output Section
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The XLR and BNC digital outputs are calibrated with the assumption
that the signal is terminated in the proper impedance (110 � for the
balanced output; 75 � for the unbalanced). If the signal isn’t properly
terminated the actual output voltage will be different from the voltage
specified in the DIO panel.

The output voltage may be swept as part of a test by selecting Dio as
the instrument and Output Voltage at Source 1 or Source 2 on the
Sweep panel.

Output Resolution

The Resolution field shows the output resolution or word width. You
can set the resolution to any integer value from 8 bits to 24 bits by typing
in the value and pressing the Enter key.

Internal to ATS-2, the digital signal is generated at a word length greater
than 24 bits. When a word length is selected in the Resolution field,
dither is added at the appropriate amplitude for that length and the signal
is truncated to the specified value.

The output resolution is independent of the input resolution.

The output resolution may be swept as part of a test by selecting Dio as
the instrument and Output Resolution at Source 1 or Source 2 on the
Sweep panel.

µ-Law and A-law Compression

See Figure 18 for reference.

The field to the right of the Resolution field allows selection of µ-Law
or A-law compression. This selection overrides the normal, uncompressed
word width selected in the left Resolution field, which is grayed out
under these conditions.

Choose µ-Law or A-law to enable the compression, or Bits to return to
normal, linear PCM resolutions.

The Digital Generator outputs a 14-bit or 13-bit signal when

the Resolution is set to µ-Law or A-Law. Dither, if enabled,

is properly scaled to these word lengths..

The DIO Output Section Chapter 7: The Digital I/O Panel
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See the sidebar on µ-Law and A-law below for more information on
these companding techniques.

Preemphasis

The embedded audio of the digital output signal may be transmitted
without preemphasis, as is normal, or preemphasized according to one of
two different functions. Preemphasis is rarely used.

The consumer format has only one defined preemphasis condition, the
50/15 µs Compact Disc preemphasis. The professional format adds the
CCITT J17 preemphasis.

Either preemphasis function may be selected at normal gain, or with a
headroom allowance of –12 dB (50/15 µs) or –20 dB (J17) if there is a
concern that high-level test signals would exceed clipping (digital full
scale) after preemphasis has been applied.

Matching deemphasis and gain selections are available in the
Deemphasis field of the Input section of the DIO panel to provide
overall unity gain and flat response.

Chapter 7: The Digital I/O Panel The DIO Output Section
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µ-Law and A-Law

The International Telecommunication Union (ITU) specifies in its
standard G.711 two similar approaches for reducing the bit rate in
digital voice telephony. Called µ-Law and A-Law, these techniques have
been widely used in digital telecommunications for a number of years.

µ-Law and A-Law are known as companders, converting 14-bit
linear PCM samples (µ-Law) or 13-bit linear PCM samples (A-Law) to
an 8-bit pseudo floating-point representation via compression at the
encoder and expansion at the decoder.

ATS-2 can both transmit and receive µ-Law and A-Law encoded
digital signals through the AES3, IEC60958-3 and optical inputs and
outputs.



Figure 20. The DIO Scale Freq. by

selections

Scale Freq. by

For a digital audio signal of a given sample rate, the embedded audio
will be shifted in frequency when the digital signal is re-sampled or
converted using a different sample rate. The audio frequency will change
by the ratio of the two sample rates.

For example, a 1 kHz audio signal generated in DSP at a 48 kHz sample
rate would be converted to a 666.67 Hz signal if re-sampled at a 32 kHz
sample rate.

ATS-2 offers the capability to scale the embedded frequency
independent of the interface output or input sample rates.

In the output Scale Freq. by field you can select one of three sample
rate choices as a reference by which to scale the embedded frequency of
the digital output signal. The choices are:

� Output Rate, which is the rate set in the Sample Rate-OSR field
above.

� Meas Input Rate, which is the measured input sample rate
displayed on the Input side of the DIO panel.

� DIO Rate Ref, which is a reference value you can enter on the
Input side of the DIO.

Polarity

The polarity of the serial digital interface bitstream output can be
reversed by checking the Invert checkbox. Properly-designed AES3
receivers should function correctly with either polarity of input bitstream.

Send Errors

Four bits are sent at the end of each frame of AES3/IEC60958 data: the
Validity bit, the User bit, the Channel Status bit and the Parity bit. See the

Figure 21. The DIO Polarity selection.
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Appendix B for more information about Status Bits and the
AES3/IEC60958 interface.

ATS-2 displays and sets the Status bits on the Status Bit panel, page 62.
User bits are not displayed or set in ATS-2.

The states of the output Validity bit and the Parity bit can be changed on
the DIO panel.

Changing the Parity bit

This bit will normally be high or low to maintain even parity within the
frame. Setting a parity error by checking the Parity checkbox will invert
the state of the Parity bit (bit 31), giving each frame odd parity.

Sending a Validity bit

The Validity bit (bit 28) will normally be low, indicating valid linear PCM
audio. Checking the Invalid checkbox will set the Validity bit high,
indicating invalid (non-audio or non-linear-PCM) data.

Jitter Generation

In a digital interface data stream, jitter is a variation in time of the pulse
transitions from an ideal clock timing. ATS-2 can add sinusoidal jitter to
the serial interface bitstream.

Jitter Type

� Off
Off disables jitter generation.

Chapter 7: The Digital I/O Panel The DIO Output Section
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� Sine
Sine modulates the interface transition times with sinusoidal jitter.
The amplitude and frequency of the sinewave are set in the fields
below.

� EQ Sine
EQ Sine adds sinusoidal jitter in the same way as the previous
choice, but attaches an EQ file to the sinewave. This causes the
output jitter amplitude to vary as a function of jitter frequency,
corresponding to the values in the EQ file selected. Use the EQ
Curve browser to attach the file.

Amplitude

Enter the amplitude of the jitter in this field. The units available are UI
(unit intervals), dBUI (decibels referred to 1.00 UI) and sec (seconds).
Jitter amplitudes are calibrated in terms of the peak value of a sinewave.

It may seem unusual to measure amplitude in units of time, but jitter is a
variation in time. High levels of jitter produce large time displacements.

The unit interval is defined as the shortest nominal time interval in the
coding scheme. Since an AES3 signal has 64 bits per frame and the
bi-phase coding of the interface nominally doubles this rate, there are
128 UI per AES3 frame.

The UI is useful because it scales with the interface data rate. In the case
of a 48 kHz sample rate and an AES3 frame as described above:

� �
1

128 48000
163UI=

1

s
ns

�
� ;

or, with a 44.1 kHz sample rate:

� �
1

128 44100
177UI=

1

s
ns

�
� .

Jitter amplitude may be swept as part of a test by selecting Dio as the
instrument and Jitter Ampl at Source 1 or Source 2 on the Sweep
panel.

Frequency

Enter the frequency of the jitter sinewave in this field.

Jitter frequency may be swept as part of a test by selecting Dio as the
instrument and Jitter Freq at Source 1 or Source 2 on the Sweep
panel.

The DIO Output Section Chapter 7: The Digital I/O Panel
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EQ Curve

The jitter sinewave generator can be equalized in the same way that the
ATS-2 signal generators can.

Click the EQ Curve... button to select an EQ file to attach to the jitter
generator. See Specifying the EQ Curve on page 77 for general
information on using EQ files with generated signals.

The DIO Input Section

The routing and configuration of the digital interface input signal are set
in the Input section of the DIO panel.

At the top area of the panel, meters display the measured input sample
rate (ISR) and the interface bitstream voltage level. Some settings which
affect the reception of the embedded audio, such as Resolution and
De-emphasis, show up in this area of the panel as well.

The middle area of the panel contains data monitors, embedded audio
peak level meters and interface error flag indicators.

At the bottom of the panel are jitter measurement displays and settings,
and a button to open the Status Bits panel.

Chapter 7: The Digital I/O Panel The DIO Input Section
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Format

The first setting field is Format. Select the serial digital interface input
format and connector(s) from the list.

� XLR (bal)
This is the balanced digital input. When the impedance at Z-In is set
to 110 �, this input satisfies the electrical aspects of the AES3
professional standard.

� BNC (unbal)
This is the unbalanced digital input. With impedance at Z-In is set to
75 �, this input satisfies the electrical aspects of the AES3id
professional standard; with impedance at HiZ, this input satisfies the
IEC60958-3 consumer standard.

� Optical
This is the Toslink® optical input.

� GenMon
This selects the generator monitor path, which bypasses the external
digital input connector and instead attaches the digital input to the
Digital Generator output via an internal connection.

� Dual XLR (bal)
These balanced digital inputs (I and II) are used in conjunction with
each other, as explained in the Dual Connector Mode sidebar on
page 45.

Input Impedance
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Figure 25. The DIO Input Format

Selections.

Figure 26. The DIO Input Impedance / Connector I /

Connector II selections.



To the right of the Format selection field is the Z-In field, which allows
you to choose the input impedance for the digital input. The impedance
choices are different for the balanced and unbalanced inputs.

� 110 � is the low-impedance selection for the balanced input, which
satisfies electrical aspects of the AES3 professional standard.

� 75 � is the low-impedance selection for the unbalanced input, which
satisfies the AES3id professional standard.

� HiZ is the high-impedance selection, which when used with the
unbalanced input satisfies the IEC60958-3 consumer standard.

Bitstream Selection in Dual-Connector Mode

See Figure 26.

The Connector I / Connector II buttons allow you to choose which
interface bitstream is selected for interface measurements.

In the normal, single-connector input mode, these selections have no
effect whatsoever. All measurements are made from the “I” digital inputs.

When Dual XLR is selected in the Format field, the Connector I and
Connector II selections have no effect on the embedded audio. For
embedded audio in dual-connector mode, the selected Analyzer
instrument (Audio Analyzer, Spectrum Analyzer, Multitone Audio
Analyzer, or Harmonic Distortion Analyzer) always analyzes left
channel audio from Connector I and right channel audio from
Connector II.

However, the DIO panel input sample rate (ISR) and Voltage displays,
the Jitter Measurement reading and all Digital Interface Analyzer
measurements of the digital interface characteristics are of the signal
selected by the Connector I or Connector II buttons. See Chapter 12,
The Digital Interface Analyzer.

Input Sample Rate-ISR

The Sample rate-ISR field (labeled Rate on the small form of the DIO
panel) displays the measured input sample rate (or ISR) at the
Connector I digital input. In dual-connector mode, the ISR displays the
sample rate of either the Connector I or Connector II inputs, as
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selected. Input sample rates from 28.8 kHz to 108 kHz are accepted. A
drop-down list allows you to specify the units of measurement for the ISR.

The input sample rate displayed here, the ISR, is also available as an
embedded frequency scaling factor selection in the Scale Freq. by field in
both the Output and Input sections of the DIO panel, where it is called
the Meas Input Rate.

The input sample rate may be used to control a sweep as part of a test
by selecting Dio as the instrument and selecting the reading Input
Sample Rate at Source 1 or Source 2 on the Sweep panel.

Voltage

See Figure 27 for reference.

The Voltage field displays the input amplitude of the serial digital
interface signal. Serial digital interface signal voltage is measured in volts,
peak-to-peak (Vpp). The Voltage field does not display when Optical is
selected as the digital input Format.

The serial interface input voltage may be used to control a sweep as
part of a test by selecting Dio as the instrument and selecting the reading
Input Voltage at Source 1 or Source 2 on the Sweep panel.

Input Resolution

The actual resolution or word width of the incoming digital signal is
shown in the Active Bits display below.

The Resolution field shows the resolution or word width to be
enforced on the incoming digital signal. You can set the resolution to any
integer value from 8 bits to 24 bits by typing in the value and pressing the
Enter key.

If the value entered in the Resolution field matches or exceeds the
resolution of the incoming digital signal, the signal is passed on
unchanged. If the value entered is lower than the incoming resolution, the
signal is truncated at the LSB.

The value of quantization noise and distortion of the audio of digital
input signals measured by the Analyzer instruments will be affected by the
Input Resolution setting.
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If the input signal being measured is using the Aux bits for another
signal, the Input Resolution must be set to 20 bits or fewer to strip off
the Aux signal before measurement by one of the Analyzer instruments.
See Chapter 2 for an explanation of Aux bits in the digital audio word.

The input resolution is independent of the output resolution.

The input resolution may be swept as part of a test by selecting Dio as
the instrument and Input Resolution at Source 1 or Source 2 on the
Sweep panel.

µ-Law and A-law Expansion

See Figure 28 for reference.

The right field of the Resolution section allows selection of µ-Law or
A-law expansion. This selection overrides the word width selected in the
left Resolution field, which is grayed out under these conditions.

Choose µ-Law or A-law to enable the expansion, or Bits to return to
normal, linear PCM resolutions.

See the sidebar on µ-Law and A-law on page 48 for more information
on these companding techniques.

Deemphasis

A digital signal transmitted with preemphasis must be deemphasized on
reception. Since preemphasis is rarely used, deemphasis, is rarely needed.

See Preemphasis on page 48.

To properly deemphasize a signal you must select deemphasis curves
and gain (50/15 µs Compact Disc at 0 dB or +12 dB; or CCITT J17 at
0 dB or +20 dB) that are complementary to the preemphasis conditions,
to provide overall unity gain and flat response.

The deemphasis (and gain, if any) is implemented after the Channel A
and Channel B Peak Monitors, so the monitor readings will not be
affected as deemphasis is turned on and off.
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Scale Freq. by

ATS-2 must normalize the frequency of an incoming digital audio signal
to a local sample rate before display, whether the signal is to be displayed
numerically or as a frequency component on an FFT graph. Depending on
the application, there are several sources of sample rate which may be
appropriate for normalization.

ATS-2 offers the capability to select one of four sample rate choices as a
reference by which to scale the embedded frequency of the digital input
signal. The choices are:

� Output Rate, which is the rate set in the Sample Rate - OSR
field.

� Meas Input Rate, which is the measured input sample rate (ISR).

� Status Bits A, which is the value of the sample frequency encoded
into the received Channel A status bits.

� DIO Rate Ref, which is a reference value you can enter on the
Input side of the DIO.

Generally, Meas Input Rate will be used as the scaling source so that
audio signal frequency measurements follow any changes in sample rate
from the source.

If the actual measured value is unstable, you may enter the nominal
incoming sample rate in the Rate Ref field and select DIO Rate Ref for
stable audio frequency scaling.

The Output Rate selection can be used to measure the frequency-
shifting effects of digital processors and sample rate converters.

The Status Bits selection refers frequency measurements to the
nominal, standard sample rate (if in fact the sample rate is actually
encoded into the status bits) and will be independent of any moment-to-
moment variations in the actual received sample rate.
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Figure 32. The DIO Peak

Monitors.

Figure 33. The DIO

Data Bit Indicators.

Rate Ref

Rate Ref is a reference field. A sample rate entered here can be
selected as a reference for digital input or output frequency scaling. The
acceptable range for Rate Ref is 28.8 kHz to 216.00 kHz.

Peak Monitors

The DIO panel provides the capability to view the peak levels of the
embedded audio signals. These meters indicate the digital input levels
prior to the application of deemphasis, if used.

The Mode field between the numeric display fields permits selection
among four types of responses:

� Pos. Peak
displays the greatest positive value during each measurement
interval, which is approximately 1/4 second for all peak monitor
response modes.

� Neg. Peak
displays the greatest negative value during each measurement
interval.

� Abs. Peak
displays the absolute value of the greatest positive-going or
negative-going value during each measurement interval. Abs. Peak
is always positive.

� ½ Pk-Pk
displays the value which is one-half the peak-to-peak range
measured during the measurement interval.

Data Bit Indicators
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The Data Bit indicators show a bit-by-bit view of the embedded data in
the digital signal audio word for each subframe. The two subframes
correspond to Channel A and Channel B.

The bits are labeled from the left from the most significant bit (MSB, or
bit 24 of the word) to the least significant bit (LSB, or bit 1 of the word) on
the right. The Data Bit indicators examine the signal in repeated periods of
approximately 1/4 second.

The Data Bit indicators have two modes, selectable by the option
buttons to the right of the indicator rows.

When Data Bits is selected, the indicators display green for a bit that is
at data 1 at the moment of measurement, and black for a bit that is at data
0.

When Active Bits is selected, the indicators display green for a bit that
has changed state during the measurement period, and black for a bit that
has not.

Error Indicators

The ATS-2 DIO panel contains four error indicators for characteristics of
the serial digital signal. The indicators are labeled Confidence, Lock,
Coding, and Parity. Proper operation is indicated when none of the
indicators is lighted. When an indicator lights, it shows that some
characteristic of the digital input signal is marginal or unacceptable.

Both the Digital Interface Analyzer and the Main Trigger panel can select
a Parity, Coding, Lock, or Confidence error flag to act as a trigger.

Two more indicators, labeled Ch A invalid and Ch B invalid, light
when the Validity bit (bit 28, the V bit) in either subframe is asserted.

The Confidence Indicator

The Confidence indicator lights when the ratio between the amplitude
of the 3 UI-long pulse and the following 1 UI-long pulse in a subframe
preamble becomes large enough to cause an increasing probability of
errors when “slicing” the input signal into logic high and low values. This
large ratio occurs when the transmission bandwidth has been reduced to
marginal or unacceptable values.
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The Lock Indicator

The Lock indicator lights when the digital input phase-locked loop is
unable to lock to the incoming signal.

The Coding Indicator

The Coding indicator shows a deviation from proper bi-phase coding
in the input serial bitstream. Since the subframe preambles deliberately
deviate from the bi-phase coding rules in order to provide a unique
synchronization signal, preambles are excluded from the function of the
Coding indicators.

The Parity Bit Indicator

The Parity bit indicator indicates a parity error within a subframe.
Correct parity is determined by comparing the parity bit (bit 31, the “P”
bit) with the sum of the remaining 31 bits in each subframe. Any one bit
error or odd number of bit errors introduced in transmission will cause a
Parity error indication.

A deliberate parity bit error (the “P” bit set high) can be transmitted
from the ATS-2 digital output by checking Parity in the DIO Output Send
Errors section.

Unfortunately, even numbers of bit errors within a subframe cannot be
detected by the parity technique.

The Validity Bit Indicators

Two additional indicators show whether the Channel A and B validity
bits (bit 28, the “V” bit) are asserted or not.

A validity bit is associated with each subframe. Exactly how (or if) the
validity bit is set depends upon the design of the particular digital device
being measured. For example, a DAT machine may set its “V” bit to
invalid (“V” bit set high) when the tape is not playing and to valid (set low)
when the tape is moving.

The “V” bit transmitted by ATS-2 can be set high (both Channel A and
B are set together) by checking Invalid in the DIO Output Send Errors
section.
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Jitter Measurement

The jitter of the digital interface signal is shown in the DIO Panel Jitter
Measurement display. This measurement is made from the error signal of
the AES receiver input phase lock loop, and is sensitive to jitter of the total
signal, including transitions in both the preamble and the data sections of
the frames. Jitter measurements may be displayed in units of UI (unit
intervals) or Sec (seconds, typically nanoseconds).

You can choose one of two detector responses, Pk (peak) and Avg
(average) for the jitter meter. Both detectors are calibrated in terms of the
peak value of a sinewave.

The averaging detector is typically used for making frequency response
plots of the jitter signal, while the peak detector should be used for
characterizing actual interface jitter. Peak jitter measurements will almost
always give a higher number than average, depending upon the crest
factor of the jitter waveform.

Jitter is often dominated by low-frequency noise, so the value of jitter
measured is likely to be a strong function of the bandwidth of the
measurement. Four bandwidth selections may be selected for jitter
measurements:

� 50 Hz–100 kHz

� 120 Hz–100 kHz

� 700 Hz–100 kHz, and

� 1200 Hz–100 kHz.

Jitter may be plotted on a graph as a function of some swept parameter
such as time or transmitted jitter amplitude; choose Dio as the Sweep
Data instrument and Interface Jitter as the parameter.

Using the Spectrum Analyzer instrument you can select the Jitter
signal and display either the jitter waveform or an FFT spectrum analysis
of the jitter signal. See Spectrum Analyzer Signal Inputs on page 146.

Jitter may also be measured according to an entirely different

technique by the Digital Interface Analyzer instrument,

described in Chapter 12.
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The Status Bits panel

Channel status bits are administrative or “housekeeping” data carried in
the AES3 and IEC60958 serial digital interfaces. Each subframe has one
“C” (Channel Status) bit, bit number 30. The bits are gathered and
arranged into channel status blocks of 192 bits, marked off by the block
start code which occurs in the interface preamble at intervals of 192
subframes.

Bit 0 in the status block identifies the format as professional or
consumer. The information in the status blocks differs, for the most part,
between the two formats. See page 400 for more information about
Channel Status.

The ATS-2 Status Bits panel gives you the ability to both view received
status bits and to set transmit status bits to any condition. Choose Panels
> Status Bits to open the panel, or click the Status Bits button on the
Toolbar or on the DIO panel.
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Transmit Status Bits

The left side of the status bits panel has a number of fields to select
status bit conditions for the transmitted serial interface signal appearing at
the ATS-2 digital output.

The first three option buttons select whether the settings you make
operate on Channel A, Channel B or both.

To select the format, click Consumer or Professional. Since the
consumer and professional formats vary greatly in the status bit fields
available, the choice of format will bring an entirely different set of options
to the panel. We will look at the Consumer format options first.

Consumer Format Status Bits

With the option buttons and drop-down lists shown here, you can set
any of the consumer format status bit conditions. See page 400 for more
information about Channel Status and for detailed tables of the consumer
format status bit fields and interpretations.
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Professional Format Status Bits

With the option buttons and drop-down lists shown here, you can set
any of the professional format status bit conditions. See page 400 for more
information about Channel Status and for detailed tables of the
professional format status bit fields and interpretations.

Local Address and Time of Day entry

If the Auto box is checked, ATS-2 automatically enters a continuously
increasing count, in audio samples, in both the Local Address and the
Time of Day fields. The count begins at the moment the professional
format is selected, or at the moment the Auto box is checked, whichever
occurs later.

If the Auto box is not checked, you may enter a fixed number into
either field.
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CRC entry

The AES3 professional standard defines status byte 23 as a cyclic
redundancy code (CRC) byte, to assist the receiver in detecting errors in
the first 23 bytes (bytes 0–22). If the CRC Enable box is checked, ATS-2
automatically computes a CRC byte based on the data in bytes 0–22, and
transmits that byte as status byte 23. This is normal operation.

If the CRC Enable box is not checked, the CRC is not computed and
you may enter arbitrary values into byte 23 of the Hex Transmit field to
test the error detection capability of the receiver in the DUT.

Receive Status Bits

The right side of the Status Bits panel displays the conditions read in the
incoming interface data. This display is updated approximately four times
per second.

The Reliability Flags display OFF (black) for normal received data
and ON (green) for unreliable data. The CRC Valid flags are ON (green)
for valid received CRC, and OFF (black) for invalid CRC.
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Hex Control and Display

At the bottom of the Status Bits panel are hexadecimal status bit setting
fields and displays. The hex codes for the channel status conditions are
detailed in the AES3 and IEC60958 standards.

The hex fields set (white with black text) and display (black with green
text) the same status conditions as are set and displayed above in the
high-level English display. A setting made in a high-level transmit field will
be echoed in the corresponding hex transmit field; a setting made in a hex
transmit field will be echoed in the corresponding high-level transmit field.

To make an entry in a hex field, click the cursor in the field desired and
move back and forth with the arrow keys. Overtype the hex code or codes
shown with the new value, and press the Enter key to make the change.

Dual Connector Mode and Status Bits

In single-connector mode Channel A and Channel B status bits
(corresponding to the A and B subframes in the data stream) can be set
and read.

In dual-connector mode, the Channel A labels on the Status Bits panel
refer to the Connector I signal, and the Channel B labels refer to the
Connector II signal.

In this mode the received status bits are read from subframe A on each
of the two signals; subframe B status bits are ignored. Transmitted status
bits, in dual-connector mode, are identical in both subframes.
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Chapter 8

The Analog Generator

Test Signal Generation in ATS-2

Most audio testing requires that a stimulus signal be applied to the
device under test (DUT). At its simplest, the stimulus may be just a
mid-frequency sinewave at a nominal level; a step up would be a sweep of
frequencies, or the combination of tones used for intermodulation
distortion (IMD) testing. An example of a very complex stimulus is a
multitone burst, which has many precisely generated frequencies at a
range of specific levels.

The signal generation systems in ATS-2 use digital signal processing
(DSP) techniques to create a wide range of stimulus signals.

Two Audio Signal Generators

ATS-2 has two independent audio signal generating systems: the Analog
Generator, which provides signal to the Analog Outputs, and the Digital
Generator, which is the source of the audio embedded in the Digital
Output signal.

The Analog and Digital generators both produce their signals in DSP,
and they are similar in operation and in the settings available on their
respective instrument panels. The two generators are completely
independent and can generate different waveforms simultaneously.

See Chapter 9 for more information on the Digital Generator.

Signals for Analog Measurements

The Analog Generator creates audio signals in DSP that are converted
to the analog domain with two high precision digital-to-analog converters
(DACs). The resulting analog signals are then buffered and conditioned
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and routed to the analog output circuitry. The outputs are configured by
settings on the Analog Generator panel.

The Analog Generator Panel

Open the Analog Generator panel by choosing Panels > Analog
Generator, by clicking the Analog Generator button on the Panel
toolbar or by the keyboard shortcut Ctrl+G. Like most ATS-2 panels, the
Analog Generator can be viewed in two sizes. Double-click the panel Title
Bar to change sizes.

The Analog Generator panel is divided into three areas:

� The upper area, which provides fields for choosing waveforms,
setting amplitude and attaching EQ curves;

� the center area, which provides controls for bandwidth and output
configuration, and

� the lower area, which provides fields to set references.

We will first look at general topics of setting frequency and amplitude
and turning the generator ON and OFF; then we will examine the many
waveform selections available in detail; then we will look at configuring the
analog outputs and setting the analog references.
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Figure 42. Setting the Analog Generator

Frequency

Figure 43. Analog Generator On / Off

Frequency Units

Frequency may be expressed in absolute units (hertz) and in a variety of
units relative to the value entered in the Reference: Freq field. See
Analog Generator References on page 85 and Frequency Units on
page 386.

Changing units does not change the frequency of the generator. The
existing frequency will simply be re-stated in the new units. Also, the value
displayed after pressing Enter may differ slightly from the value you typed
in, since ATS-2 will step to the nearest frequency increment.

Output On/Off and Channel Selection

The Analog Generator signal outputs are toggled ON and OFF by the
OUTPUTS button. Additionally, each channel output can be switched
individually on and off by the CH A and CH B buttons on either side of
the OUTPUTS button. Both the main OUTPUTS button and an individual
channel button must be switched on to route signal to the analog output
circuitry.
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Amplitude Control and Units

If the Track A checkbox is checked, the amplitudes of both Channel A
and Channel B are set by the Channel A Amplitude setting.

If the Track A checkbox is not checked, the amplitudes of the two
Analog Generator channels can be controlled individually. Type a value in
the Amplitude setting field for either Channel A or Channel B and press
Enter.

You can choose an amplitude unit of measurement from the units
drop-down list, shown in Figure 44. Changing a unit of measurement will
not change the audio amplitude, only the expression of the value. See
Analog Amplitude Units, page 386.

The value displayed after pressing Enter may differ slightly from the
value you typed in, since ATS-2 will step to the nearest amplitude
increment.

The Analog Generator will not permit an output amplitude entry greater
than 16 Vrms (22.62 Vp) when configured for a balanced output; or
8 Vrms (11.31 Vp) when configured for an unbalanced output. If you
enter a value greater than these maximum values, or a combination of
values (in EQ Sine mode, for example) which results in a greater value,
an error message is displayed.

Waveforms other than a sinewave are calibrated in peak equivalent
sinewave terms; that is, the Amplitude setting field is calibrated to show
the rms value of a sinewave with same peak value as the waveform
selected. Selecting a squarewave with an Amplitude value of 1.000 Vrms
on the Analog Generator panel, for example, produces a 1.414 Vp
squarewave signal.

Choosing an Analog Generator Waveform

The Analog Generator offers a wide choice of test waveforms selectable
from the primary and secondary waveform lists.
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These list selections are, for the most part, sorted by the shape of the
waveform, such as sinewave, squarewave, noise, and so on. Most
waveform choices have an associated secondary list, from which you
make your final waveform selection.

This chapter organizes the waveforms by shape. The variations
available on the secondary lists are described under each section.

Sine waveforms

This section describes the sine waveforms available to the Analog
Generator, which cover the frequency range from 2 Hz to either 30 kHz or
60 kHz, depending on the Bandwidth setting. See page 84 for
information on setting the Analog Generator bandwidth. Sinewave
frequency can be set in hertz or in a variety of relative units; see
Frequency Units, page 386.

Wfm: Sine: Normal

The normal sine waveform is the standard waveform for most audio
testing, and is the default generator waveform.
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Wfm: Sine: Var Phase

This choice produces the selected frequency at both Channel A and B
outputs, but the phase of the Channel B output is variable from –180º to
+179.99º with respect to the Channel A output, as controlled by the
Phase B-A field.

A positive value entered in the Phase B-A field will cause the Channel
B output to lead the Channel A output. A negative value entered in the
Phase B-A field will cause the Channel B output to lag the Channel A
output. See the illustration below:
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Sine Var Phase

Figure 49. Sine: Var Phase, triggered on Channel A (the larger waveform).

–90.00 deg has been entered in Phase B–A field,

causing B (the smaller waveform) to lag A.



Wfm: Sine: Stereo

This waveform selection produces independent sinewaves on Channel
A and Channel B. The Frequency field sets the frequency of the Channel
A signal, and the Frequency 2 field sets the frequency of the Channel B
signal. Their amplitudes are independently set by the two Amplitude
fields unless the Track A box is checked, in which case the amplitudes are
equal and controlled by the Channel A Amplitude field.

Wfm: Sine: Dual

This selection produces two independent sinewaves which are summed
to create a complex waveform. This complex waveform is sent to both
channel outputs.

The Frequency and Frequency 2 fields permit each component
sinewave frequency to be set independently. The Dual Ampl Ratio field
enables you to set the ratio by which the secondary (Frequency 2)
sinewave component amplitude will be attenuated with respect to the
amplitude of the primary (Frequency) sinewave component.

In Sine: Dual, the amplitude setting determines the sum of the
amplitudes of the two components. A 1 V amplitude setting with a 25%
ratio produces a waveform which is the sum of a 800 mV sinewave and a
200 mV sinewave.

The Sine: Dual signal is particularly useful as a calibration signal for
harmonic distortion analyzers, where the Frequency signal at reference
amplitude represents the fundamental signal. The secondary (Frequency
2) sinewave can be set to any desired harmonic of the primary
(Frequency) “fundamental” sinewave, at an amplitude to represent any
desired distortion level. For example, setting the primary (Frequency) at
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1 kHz and the secondary (Frequency 2) at 3 kHz with a Dual Amp ratio
of –40.0 dB (1%) produces a 1 kHz signal with third harmonic distortion
of 1.0%.

Wfm: Sine: Shaped Burst

A tone burst is an audio signal (usually a sinewave) that is keyed on and
off. Tone bursts are often used as stimulus signals, and can reveal
characteristics of a DUT’s performance which are not observable with
continuous tones.

The Analog Generator Sine: Shaped Burst signal is essentially
identical to the Digital Generator Sine: Shaped Burst signal, and both
are similar to the Digital Generator Sine: Burst signal.

For both generators, the Sine: Shaped Burst has a raised-cosine
shaped envelope, creating a relatively narrow energy spectrum around the
sinewave frequency. The Digital Generator Sine: Burst has a rectangular
envelope with fast rise and fall times and consequently a wider spectrum of
energy.

The frequency of the sinewave is set in the Frequency field. The
Amplitude field sets the generator amplitude at the maximum burst ON
level.
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Refer to Figure 54 for definitions of the following settings:

� Burst
Enter a value in the Burst On field to set the duration of the tone
burst. The maximum Burst On duration is 65,535 cycles of the sine
waveform, if Interval is set to its maximum; the minimum is 1 cycle.
Burst On can be set in units of Cycles or secB (seconds, Burst).
Only Burst On durations which are less than the Interval durations
can be entered.

� Interval
Enter a value in the Interval field to set the period between the
onset of the tone burst and the onset of the next burst. The maximum
Interval is 65,536 cycles of the sine waveform; the minimum is
2 cycles. Interval can be set in units of Cycles or secB.

Interval does not describe the time between the end of a

burst and the beginning of the next, but the entire period from

the beginning of one burst until the beginning of the next.

� Low Level
When a tone burst is ON, the level of the sinewave in the burst is the
same as the current Amplitude setting for the Analog Generator.
When a tone burst is OFF, the low level is the ON level multiplied by
the value set in the Low Level field. The OFF level is a ratio of the
ON level, set here in units of X/Y ratio, dB, % (per cent), or PPM.
See Ratio Units, page 392.
If Low Level is set to equal the burst high-level amplitude, no burst
effect will occur and the output will be a continuous sinewave.
At large amplitude ratios, the amplitude resolution of Low Level
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becomes poorer. The display will show the actual available resolution
steps, rather than the value entered.

Zero-Crossing

The beginning and ending of any tone burst are always at the
positive-going zero-crossing points of the sinewave, which eliminates
transients from the output.

Because of the zero-crossing nature of the tone bursts, only integer
numbers of cycles can be entered as a Burst On or Interval setting; if
you are using secB units, only time durations which represent multiples of
the full period of a cycle of the selected sinewave can be entered as a
Burst On or Interval setting.

Wfm: Sine: EQ

Generator Equalization

The Sine: EQ setting outputs a normal sinewave, with equalizing
amplitude changes made in the generator level according to an attached
EQ data file. This enables you to make a frequency sweep where the
generator amplitude varies as instructed by the data in the attached file.

When you select Sine: EQ and attach an EQ file (see below), a new
field call Post EQ appears on the Analog Generator panel. The Post EQ
field displays the generator amplitude to be applied to the DUT, which is
value entered in the Amplitude field corrected by the value (at that
frequency) of the correction factor in the attached EQ file.

When Sine: EQ is selected, the values in the Amplitude field

are displayed in blue rather than black.

Chapter 8: The Analog Generator Choosing an Analog Generator Waveform

76 ATS-2 User’s Manual
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To set the output amplitude, you can enter a value in either the
Amplitude field or the Post EQ field, and the value in the other field will
be properly adjusted according to the correction factor.

The Analog Generator will not permit an output amplitude entry greater
than 16 Vrms (22.62 Vp) when configured for a balanced output, or
8 Vrms (11.31 Vp) when configured for an unbalanced output. If the value
of the normal (pre-EQ) Amplitude field as modified by the equalization
file would attempt to produce an amplitude greater than these maximum
values, an error message is displayed.

If a frequency value outside the frequency range span of the EQ file is
entered on the generator panel or occurs during a sweep, the Post-EQ
amplitude will go to 0 V.

Specifying the EQ Curve

The EQ curve is embodied in an AP data file (usually an EQ file, with
the extension .atsq) which lists frequencies in Column 1 and the
corresponding amplitude changes in Column 2 (or another column of
your choice).

Click the EQ Curve button to open the Equalization Curve dialog box,
then click the browser button to open the Equalization Curve file browser.

When you have selected an EQ file, it will be attached to the generator
panel and the file name will appear in the Equalization Curve dialog box.
The default amplitude data column is Column 2; you can choose another
column from the drop-down list in the Equalization Curve dialog box.
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If you would like to view or edit the EQ file, click the Edit button to
open the Attached File Editor (see page 295).

You can create custom EQ curves by manually creating an ATS-2 EQ
file, or by using the current sweep data in memory and a Compute
function to produce an appropriate EQ file. See Chapters 18 and 19 for
more information on saving data files and modifying EQ data from a
sweep using Compute functions.

Typical EQ Applications

The most common applications of generator equalization are to produce
a nominally flat output from a device which contains a known equalization
function. Typical examples include FM and TV aural broadcast transmitters
with 50 µs and 75 µs preemphasis curves.

By attaching an equalization curve to the ATS-2 generator that is the
inverse of the nominal curve used in the device under test, the resulting
measured output should be flat. Small variations from flatness will be a
measurement of the accuracy of equalization in the device, since the .atsq
curves provided are accurate to better than 0.01 dB and the specified
generator flatness is of the same order.

Squarewave

Wfm: Square

The frequency range for squarewaves is from 2 Hz to 20 kHz.

The squarewave amplitude is calibrated in peak equivalent sinewave
terms. See Amplitude Control and Units on page 70.

Intermodulation Distortion (IMD)

Intermodulation distortion (IMD) testing requires a stimulus which is a
combination of two waveforms, and a specific analysis technique to
evaluate interaction of the waveforms within the DUT.

ATS-2 provides two versions of the SMPTE/DIN standard IMD test
signals.
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Waveform.



Figure 58. Analog Generator IMD

Waveform Selections

IMD signal amplitude is set in the Analog Generator Amplitude field.
The IMD composite waveform amplitude is calibrated in peak equivalent
sinewave terms. See Amplitude Control and Units on page 70.

Wfm: IMD: SMPTE/DIN 4:1

This selection produces a signal which is the linear combination of two
sinewaves. The first sinewave, set in the IM-Freq field, is a
lower-frequency tone that can be assigned any frequency in the range of
40 Hz to 500 Hz. The frequency of the second sinewave, set in the High
Freq field, can be anywhere in the range from 2 kHz to 60 kHz.

The low-frequency sinewave is linearly combined in 4:1 amplitude ratio
with the high-frequency sinewave.

Wfm: IMD: SMPTE/DIN 1:1

This is the same as the Wfm: IMD: SMPTE/DIN 4:1 selection, except
that the amplitude ratio of the low-frequency sinewave to the
high-frequency sinewave is 1:1.

Noise Waveform

The ATS-2 Analog Generator offers a DSP-generated white noise signal.

The DSP-generated noise is pseudo-random and has a length of 220 or
1,048,576 samples, which means that with the Analog Generator
Bandwidth set to 30 kHz (a sample rate of 65.536 kHz) the noise pattern
repeats about every 16 seconds. The noise has a zero mean, a crest factor
of 1.73 and a rectangular probability distribution function. The spectrum of
the noise is flat from just above 0 Hz to 30 kHz or 60 kHz, depending on
the Bandwidth selection (see page 84).
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The noise waveform amplitude is calibrated in peak equivalent
sinewave terms. See Amplitude Control and Units on page 70.

Arbitrary Waveforms

The generator arbitrary waveform function allows you to load a
properly formatted digital waveform file into the ATS-2 DSP and route the
waveform to the Analog Generator outputs.

Arbitrary waveforms files provided with ATS-2 include single tones, tone
combinations for IMD testing, multitone waveforms and calibration tones,
and other useful waveforms.

Waveform files must be of the Audio Precision .agm (Generator Mono)
or .ags (Generator Stereo) file types. You may also make custom arbitrary
waveform files using a file creation utility provided with ATS-2 or with
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Figure 60. Loading an arbitrary waveform.

White Noise Characteristics

The spectral distribution of white noise is characterized by equal
noise energy per hertz. This means that the spectral range between
100 Hz and 200 Hz will have the same energy as the range between
10,000 Hz and 10,100 Hz.

If analyzed by a constant-bandwidth spectrum analyzer such as a
superheterodyne or FFT analyzer, white noise will show a flat energy
characteristic versus frequency (up to the bandwidth limitation).

Analysis of white noise with a constant-percentage-bandwidth
(constant Q) filter such as in the Audio Analyzer Bandpass mode (or
as in most real-time analyzers) will show a rising characteristic versus
frequency, at the rate of 3 dB per octave.



third-party applications such as MATLAB. See Multitone Creation on
page 219.

Setting the DAC Sample Rate

To load a waveform file and then output the waveform so that the
embedded audio tones are at the intended frequencies, the sample rate of
the Analog Generator DACs must be set to the same sample rate that was
used in creating the file.

If you use a sample rate different from the sample rate at which the file
was created, the frequency of the audio tones embedded in the output
signal will be shifted by the ratio of the two sample rates.

When Arb Wfm is selected, a Sample Rate field appears on the lower
portion of the Analog Generator panel.

You can select from 4 sample rate choices for the DACs:

� 65536, which is the lower fixed sample rate for the Analog
Generator DACs.

� 131072, the higher fixed sample rate.

� OSR, the Output Sample Rate set in the DIO panel. ATS-2 offers
two methods of setting DAC sample rates using the OSR selection.
Go to the first tab of the Configuration panel at Utilities >
Configuration to set the method you prefer, as follows:

� If the Set sample rate when loading generator waveforms
checkbox is checked, ATS-2 will automatically set the DIO OSR to
the sample rate of the file being loaded.

� If this checkbox is unchecked, you must manually enter the
sample rate you desire in the OSR field on the DIO panel.

� ISR, the Input Sample Rate read from ATS-2’s digital input and
displayed on the DIO panel.
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Sample Rate.



Figure 62. Analog Generator Special

Waveform Selections

The Arbitrary Waveform generation memory buffers of the

Analog Generator and Digital Generator are shared. If both

generators have Arb Wfm selected as the waveform, the

same waveform file will be used for both and the same signal

will be produced at both the analog and digital generator

outputs.

Special Waveforms

Wfm: Special: Polarity

The polarity waveform is designed to be obviously asymmetrical, so that
it is easily apparent if signal is inverted or not. The waveform is the sum of
the fundamental tone set in the Frequency field and its second harmonic,
in a fixed phase relationship.

When the output of the DUT is viewed using an oscilloscope or the
ATS-2 Spectrum Analyzer in the time-domain view, the signal will reveal
whether or not there has been a polarity inversion in the DUT or in the
signal interconnections.

Figure 63. Analog Generator Special

Polarity
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The only setting available for the polarity waveform is Frequency.

Wfm: Special: Pass Thru

The Special: Pass Thru selection does not cause a waveform to be
generated; instead, it converts the digital audio signal connected to the
rear panel SYNC/REF IN BNC connector to an analog signal and passes
it through to the Analog Generator outputs.

This is a convenient way to convert a digital test signal (from a CD, for
example) to an analog test signal. If the REF IN signal is stereo, the output
signal will also be stereo.

In Pass Thru mode, the sample rate of the Analog Generator DACs is
set to the ATS-2 Output Sample Rate (OSR), indicated by the Sample
Rate field on the generator panel which shows OSR in this mode. The
OSR, which is set on the DIO panel, has a range of 28.8 kHz to 108 kHz.
The REF IN signal is sample rate converted to the OSR.

The REF IN signal sample rate must be between 28.8 kHz and
108 kHz. Additionally, the ratio of the REF IN sample rate to the OSR
must fall in the range between 1:3 to 3:1; or, stated another way,

OSR
REF IN SR OSR

3
3� � � .

The sample rate converter is controlled by ATS-2 to maintain the REF
IN embedded audio at its original frequency. As a result, changing the
OSR setting will not shift the audio frequency of the REF IN signal, but it
will affect the signal’s bandwidth. REF IN audio at frequencies above
approximately 047. � OSR will be greatly attenuated.
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The default setting of the OSR is 48 kHz. To preserve bandwidth, for
most Pass Thru audio testing the OSR should not be set lower than
44.1 kHz.

The amplitude relationship between the REF IN signal and the Analog
Generator output is such that a REF IN signal of 1.00 FS (0 dB FS) will
result in a correctly calibrated analog output signal; that is, the signal will
have peaks equal to those of a sinewave of the rms value set in the Analog
Generator amplitude field.

Setting the Analog Generator Bandwidth

For Sine and Noise waveforms, the Analog Generator bandwidth is
dependent upon the sample rate set for the DACs used to convert the
DSP-generated signals to analog audio. These DACs have two sample rate
selections resulting in two different bandwidth options, set in the
Bandwidth field near the bottom to the Analog Generator panel.

� 30k sets the sample rate of the DACs to 65,536 Hz, providing a
generator bandwidth of approximately 0 Hz–30 kHz. This bandwidth
setting provides the Analog Generator’s lowest possible distortion.

� 60k sets the sample rate of the DACs to 131,072 Hz, providing a
generator bandwidth of approximately 0 Hz–60 kHz, with slightly
higher residual noise and distortion than in the 30k mode.

Configuring the Analog Outputs

The analog output configuration is controlled from the Analog
Generator panel. Both A and B outputs are configured together. The
choices are

� Bal XLR, a balanced signal on the XLR male connectors (pin 2
high).

� UnBal BNC/XLR, an unbalanced signal available on both the BNC
and the XLR male connectors (pin 2 high).

� CMTST XLR, a common-mode test signal on the XLR male
connectors (both pins 2 and 3 high).
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Figure 65. Selecting the Analog Generator

Bandwidth.



Figure 67. Analog Generator References

You can also choose one of two output impedances using the option
buttons. The impedances available for the balanced and common-mode
configurations are 40 � and 150 �; if your ATS-2 was ordered with the
Euro impedance option, the choices are 40 � and 200 �. The
impedances available for the unbalanced configuration are 20 � and
50 �.

Do not “unbalance” the balanced outputs by connecting pin 2

or pin 3 of an XLR output connector to ground, as might be

done with adapter cables. Connecting the ATS-2 balanced

outputs to an unbalanced load will produce distorted

waveforms. Use the unbalanced output connectors for an

unbalanced load.

See Chapter 4 for more information about the ATS-2 Analog Outputs.

Analog Generator References

With the appropriate choice of units, amplitude and frequency settings
in the Analog Generator can be made relative to reference values. These
references are entered manually in the Analog Generator References
area. Freq and dBr references can also be entered “on the fly” from the
current generator settings, as explained below.

dBr Reference

The dBr (which is shorthand for “decibels relative to a reference”)
reference is an easy way to set a nominal level against which your settings
or readings are made. Enter a reference value in the References: dBr
field, or load it “on the fly” from the current generator amplitude setting
using the menu command Edit > Set Generator dBr Ref or the
keyboard shortcut F3.

You can set an Analog Generator dBr reference in V, dBV or dBu
units.
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Balanced



Frequency Reference

The relative units of measurement for the Analog Generator are F/R,
dHz, %Hz, cent, octs, decs, d%, and dPPM.

In a relative expression, the frequency setting or reading is expressed in
relation to a second reference frequency. For Analog Generator relative
frequency settings, this reference frequency is entered in hertz in the
Analog Generator References: Freq field, or it can be entered “on the
fly” from the current generator frequency setting with the menu command
Edit > Set Generator Freq Ref, or with the keyboard shortcut
Ctrl+F3.

Watts Reference

Because the watt is a unit of power, a voltage reading in Watts units will
only have meaning if the circuit impedance is known.

To use watts levels, select Watts as the Amplitude unit of
measurement, and then set the Watts impedance reference to the correct
impedance value for your application. The default value is 8 �.
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Chapter 9

The Digital Generator

Test Signal Generation in ATS-2

Most audio testing requires that a stimulus signal be applied to the
device under test (DUT). At its simplest, the stimulus may be just a
mid-frequency sinewave at a nominal level; a step up would be a sweep of
frequencies, or the combination of tones used for intermodulation
distortion (IMD) testing. An example of a very complex stimulus is a
multitone burst, which has many precisely generated frequencies at a
range of specific levels.

The signal generation systems in ATS-2 use digital signal processing
(DSP) techniques to create a wide range of stimulus signals.

Two Audio Signal Generators

ATS-2 has two independent audio signal generating systems: the Analog
Generator, which provides signal to the Analog Outputs, and the Digital
Generator, which is the source of the audio embedded in the Digital
Output signal.

The Analog and Digital generators both produce their signals in DSP,
and they are similar in operation and in the settings available on their
respective instrument panels. The two generators are completely
independent and can generate different waveforms simultaneously.

See Chapter 8 for more information on the Analog Generator.

Signals for Digital Measurements

The Digital Generator creates audio signals in DSP that are then
embedded in a digital audio interface data stream, such as described in the
AES3 or IEC60958 standards. This interface signal is configured for output
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by settings made in the Digital Input/Output (DIO) panel, which is
discussed in detail in Chapter 7. See Appendix B for more information on
the digital audio signal.

The Digital Generator Panel

Open the Digital Generator panel by choosing Panels > Digital
Generator, by clicking the Digital Generator button on the Panel
toolbar or by the keyboard shortcut Ctrl+D. Like most ATS-2 panels, the
Digital Generator can be viewed in two sizes. Double-click the panel Title
Bar to change sizes.

The Digital Generator panel is divided into three areas:

� The upper area, which provides fields for choosing waveforms,
setting amplitude and attaching EQ curves;

� the center area, which offers control of dither, and

� the lower area, which provides fields to set references.

We will first look at general topics of setting frequency and amplitude
and turning the generator ON and OFF; then we will examine the many
waveform selections available in detail; last we will look at choosing the
dither type and setting the digital references.
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Figure 69. Setting the Digital Generator

Frequency

Frequency Units

Frequency may be expressed in absolute units (hertz) and in a variety of
units relative to the value entered in the Reference: Freq field. See
Digital Generator References on page 110 and Frequency Units on
page 386.

Changing units does not change the frequency of the generator. The
existing frequency will simply be re-stated in the new units. Also, the value
displayed after pressing Enter may differ slightly from the value you typed
in, since ATS-2 will step to the nearest frequency increment.

Output On/Off and Channel Selection

The Digital Generator signal outputs are toggled ON and OFF by the
OUTPUTS button. Additionally, each channel output can be switched
individually on and off by the CH A and CH B buttons on either side of
the OUTPUTS button. Both the main OUTPUTS button and an individual
channel button must be switched on to route signal to the digital output
circuitry.

Channel Invert

ATS-2 maintains correct absolute polarity throughout the system. You
can invert the polarity of either audio channel by clicking the Invert
checkbox for that channel. When neither or both Invert boxes are
checked, both channels have the same polarity.

Polarity inversion of one channel with respect to the other can be used
to create the stereo “difference” signal which modulates the subcarrier in
some stereo multiplex systems.

Figure 70. Digital Generator On / Off
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Amplitude Control and Units

If the Track A checkbox is checked, the audio amplitude of both
Channel A and Channel B are set by the Channel A Amplitude setting.

If the Track A checkbox is not checked, the audio amplitudes of the
two Digital Generator channels can be controlled individually. Type a
value in the Amplitude setting field for either Channel A or Channel B
and press Enter.

You can choose an amplitude unit of measurement in either the analog
or digital domains from the units drop-down list, shown in Figure 71. The
ability to state a digital audio amplitude in analog terms makes it easy to
work with the analog output values while testing a D-to-A converter, for
example, when the full scale analog output of that converter is known.
Enter the DUT voltage which corresponds to digital full scale in the
References: Volts/FS field (see page 110).

Changing a unit of measurement will not change the audio amplitude,
only the expression of the value. See Digital Amplitude Units, page
390, and Analog Amplitude Units, page 386.

The value displayed after pressing Enter may differ slightly from the
value you typed in, since ATS-2 will step to the nearest amplitude
increment.

The Digital Generator will not permit an output amplitude entry greater
than 1.000 FFS (0 dB FS). If you enter a value greater than 1.000 FFS or
a combination of values (in EQ Sine or Sine+Offset modes, for
example) which would result in a value greater than 1.000 FFS, an error
message is displayed.

Waveforms other than a sinewave are calibrated in peak equivalent
sinewave terms; that is, the Amplitude setting field is calibrated to show
the rms value of a sinewave with same peak value as the waveform
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selected. Selecting a squarewave with an Amplitude value of 100.0 Vrms
on the Digital Generator panel, for example, produces a 141.4 mVp
squarewave signal.

Choosing a Digital Generator Waveform

The Digital Generator offers a wide choice of test waveforms selectable
from the primary and secondary waveform lists.

These list selections are, for the most part, sorted by the shape of the
waveform, such as sinewave, squarewave, noise, and so on. Most
waveform choices have an associated secondary list, from which you
make your final waveform selection.

This chapter organizes the waveforms by shape. The variations
available on the secondary lists are described under each section.

Sine waveforms

This section describes the sine waveforms available to the Digital
Generator, which cover the frequency range from 2 Hz to just under 50%
of the sample rate (which is approximately 24 kHz at a 48 kHz sample
rate). The frequency can be set in hertz or in a number of relative units;
see Frequency Units, page 386.
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Waveform Selections

Figure 73. Digital Generator Sine Waveform

Selections



Figure 74. Digital Generator Sine Normal

Wfm: Sine: Normal

The normal sine waveform is the standard waveform for most audio
testing, and is the default generator waveform.

Wfm: Sine: Var Phase

This selection produces the selected frequency at both Channel A and B
outputs, but the phase of the Channel B output is variable from –180º to
+179.99º with respect to the Channel A output, as controlled by the
Phase field.

A positive value entered in the Phase B-A field will cause the Channel
B output to lead the Channel A output. A negative value entered in the
Phase B-A field will cause the Channel B output to lag the Channel A
output. See the illustration below:
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Wfm: Sine: Stereo

This waveform selection produces independent sinewaves on Channel
A and Channel B. The Frequency field sets the frequency of the Channel
A signal, and the Frequency 2 field sets the frequency of the Channel B
signal. Their amplitudes are independently set by the two Amplitude
fields unless the Track A box is checked, in which case the amplitudes are
equal and controlled by the Channel A Amplitude field.
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Figure 76. Sine: Var Phase, triggered on Channel A (the larger waveform).

–90.00 deg has been entered in Phase B–A field,



Wfm: Sine: Dual

This selection produces two independent sinewaves which are summed
to create a complex waveform. This complex waveform is sent to both
channel outputs.

The Frequency and Frequency 2 fields permit each component
sinewave frequency to be set independently. The Dual Ampl Ratio field
enables you to set the ratio by which the secondary (Frequency 2)
sinewave component amplitude will be attenuated with respect to the
amplitude of the primary (Frequency) sinewave component.

The Sine: Dual signal is particularly useful as a calibration signal for
harmonic distortion analyzers, where the Frequency signal at reference
amplitude represents the fundamental signal. The secondary (Frequency
2) sinewave can be set to any desired harmonic of the primary
(Frequency) “fundamental” sinewave, at an amplitude to represent any
desired distortion level. For example, setting the primary (Frequency) at
1 kHz and the secondary (Frequency 2) at 3 kHz with a Dual Amp
Ratio of –40.0 dB (1%) produces a 1 kHz signal with third harmonic
distortion of 1.0%.

Wfm: Sine: Shaped Burst

A tone burst is an audio signal (usually a sinewave) that is keyed on and
off. Tone bursts are often used as stimulus signals, and can reveal
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Figure 79. Digital Generator Sine Shaped

Burst

Figure 78. Digital Generator Sine Dual



characteristics of a DUT’s performance which are not observable with
continuous tones.

The Digital Generator Sine: Shaped Burst signal is essentially
identical to the Analog Generator Sine: Shaped Burst signal, and both
are similar to the Digital Generator Sine: Burst signal.

For both generators, the Sine: Shaped Burst has a raised-cosine
shaped envelope, creating a relatively narrow energy spectrum around the
sinewave frequency. The Digital Generator Sine: Burst has a rectangular
envelope with fast rise and fall times and consequently a wider spectrum of
energy.

Refer to Tone Bursts, page 97, for information on making tone burst
settings.

Wfm: Sine: EQ

Generator Equalization

The Sine: EQ setting outputs a normal sinewave, with equalizing
amplitude changes made in the generator level according to an attached
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shaped burst
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EQ data file. This enables you to make a frequency sweep where the
generator amplitude varies as instructed by the data in the attached file.

When you select Sine: EQ and attach an EQ file (see below), a new
field named Post EQ appears on the Digital Generator panel. The Post
EQ field displays the generator amplitude to be applied to the DUT, which
is the value entered in the Amplitude field, corrected by the value (at that
frequency) of the correction factor in the attached EQ file.

When Sine: EQ is selected, the values in the Amplitude field

are displayed in blue rather than black.

To set the output amplitude, you can enter a value in either the
Amplitude field or the Post EQ field, and the value in the other field will
be properly adjusted according to the correction factor.

The Digital Generator will not permit an output amplitude entry greater
than 1.000 FFS (0 dB FS). If the value of the normal (pre-EQ) Amplitude
field as modified by the equalization file would produce an amplitude
greater than 1.000 FFS, an error message is displayed.

If a frequency value outside the frequency range span of the EQ file is
entered on the generator panel or occurs during a sweep, the Post-EQ
amplitude will go to 0 FFS.

Specifying the EQ Curve

The EQ curve is embodied in an ATS-2 data file (usually an EQ file,
with the extension .atsq) which lists frequencies in Column 1 and the
corresponding amplitude changes in Column 2 (or another column of
your choice).
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Figure 82. EQ file

attachment and editing.



Click the EQ Curve button to open the Equalization Curve dialog box,
then click the browser button to open the Equalization Curve file browser.

When you have selected an EQ file, it will be attached to the generator
panel and the file name will appear in the Equalization Curve dialog box.
The default amplitude data column is Column 2; you can choose another
column from the drop-down list in the Equalization Curve dialog box.

If you would like to view or edit the EQ file, click the Edit button to
open the Attached File Editor (see page 295).

You can create custom EQ curves by manually creating an ATS-2 EQ
file, or by using the current sweep data in memory and a Compute
function to produce an appropriate EQ file. See Chapters 18 and 19 for
more information on saving data files and modifying EQ data from a
sweep using Compute functions.

Typical EQ Applications

The most common applications of generator equalization are to produce
a nominally-flat output from a device which contains a known equalization
function. Typical examples include FM and TV aural broadcast transmitters
with 50 µs and 75 µs preemphasis curves.

By attaching an equalization curve to the ATS-2 generator that is the
inverse of the nominal curve used in the device under test, the resulting
measured output should be flat. Small variations from flatness will be a
measurement of the accuracy of equalization in the device, since the .atsq
curves provided are accurate to better than 0.01 dB and the specified
generator flatness is of the same order.

Wfm: Sine: Burst

The frequency of the sinewave is set in the Frequency field. The
Amplitude field sets the generator amplitude at the maximum burst ON
level.
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Refer to Figure 54 for definitions of the following settings:

� Burst
Enter a value in the Burst On field to set the duration of the tone
burst. The maximum Burst On duration is 65,535 cycles of the sine
waveform, if Interval is set to its maximum; the minimum is 1 cycle.
Burst On can be set in units of Cycles or secB (seconds, Burst).
Only Burst On durations which are less than the Interval durations
can be entered.

� Interval
Enter a value in the Interval field to set the period between the
onset of the tone burst and the onset of the next burst. The maximum
Interval is 65,536 cycles of the sine waveform; the minimum is
2 cycles. Interval can be set in units of Cycles or secB.

Interval does not describe the time between the end of a

burst and the beginning of the next, but the entire period from

the beginning of one burst until the beginning of the next.

� Low Level
When a tone burst is ON, the level of the sinewave in the burst is the
same as the current Amplitude setting for the Digital Generator.
When a tone burst is OFF, the low level is the ON level multiplied by
the value set in the Low Level field. The OFF level is a ratio of the
ON level, set here in units of X/Y ratio, dB, % (per cent), or PPM.
See Ratio Units, page 392.
If Low Level is set to equal the burst high-level amplitude, no burst
effect will occur and the output will be a continuous sinewave.
At large amplitude ratios, the amplitude resolution of Low Level
becomes poorer. The display will show the actual available resolution
steps, rather than the value entered.
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Zero-Crossing

The beginning and ending of any tone burst are always at the
positive-going zero-crossing points of the sinewave, which eliminates
transients from the output.

Because of the zero-crossing nature of the tone bursts, only integer
numbers of cycles can be entered as a Burst On or Interval setting; if
you are using secB units, only time durations which represent multiples of
the full period of a cycle of the selected sinewave can be entered as a
Burst On or Interval setting.

Wfm: Sine+Offset

This waveform is a combination of a sinewave with a digital DC signal.
Digital DC is essentially the same digital code sent for every sample; see
Wfm: Special: Constant Value on page 108. The frequency of the
sinewave for the Sine+Offset waveform, like the other Digital Generator
sinewaves, can be set to the range of 10 Hz to 50% of the sample rate; the
sinewave level is set in the Amplitude field(s).

The digital DC signal amplitude, which can have a positive or negative
value, is set in the Offset field. The sum of the sinewave and DC
amplitudes may not exceed positive or negative full scale (FS). If the
sinewave amplitude is 0 FS the Offset value may be set anywhere in the
range between –1.0 FS and +1.0 FS; if the sinewave amplitude is at full
scale, the Offset must be 0 FS.

Although the sinewave amplitude may be set independently for
Channel A and Channel B, the Offset value is common to both channels.

A low-amplitude sinewave with an Offset value that positions the
sinewave at a major bit-switching point of a ladder-type D-to-A converter
is particularly useful for testing linearity at various points in the converter’s
operating range.
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Intermodulation Distortion (IMD)

Intermodulation distortion (IMD) testing requires a stimulus which is a
combination of two waveforms, and a specific analysis technique to
evaluate interaction of the waveforms within the DUT.

ATS-2 provides two versions of the SMPTE/DIN standard IMD test
signals.

IMD signal amplitude is set in the Digital Generator Amplitude field.
The IMD composite waveform amplitude is calibrated in peak equivalent
sinewave terms. See Amplitude Control and Units on page 90.

Wfm: IMD: SMPTE/DIN 4:1

This selection produces a signal which is the linear combination of two
sinewaves. The first sinewave, set in the IM-Freq field, is a
lower-frequency tone that can be assigned any frequency in the range of
40 Hz to 500 Hz. The frequency of the second sinewave, set in the High
Freq field, can be anywhere in the range from 2 kHz to 50% of the sample
rate.

The low-frequency sinewave is linearly combined in 4:1 amplitude ratio
with the high-frequency sinewave.

Wfm: IMD: SMPTE/DIN 1:1

This is the same as the Wfm: IMD: SMPTE/DIN 4:1 selection, except
that the amplitude ratio of the low-frequency sinewave to the
high-frequency sinewave is 1:1.

Squarewave
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Wfm: Square

The squarewave amplitude is calibrated in peak equivalent sinewave
terms. See Amplitude Control and Units on page 90.

The frequency range for squarewaves is from approximately 2 Hz to 1/6
of the sample rate (8 kHz at a 48 kHz sample rate; 7.35 kHz at a 44.1 kHz
rate).

In order for the squarewave be synchronous with the sample rate and
have a time-symmetric duty cycle, the available squarewave fundamental
frequencies within that range are limited to even integer submultiples of
the sample rate, with the highest frequency being SR/6 and the lowest
being SR/224.

For example, at a 48 kHz sample rate, the highest squarewave
frequencies are:

� 8 kHz (48000/6)

� 6 kHz (48000/8)

� 4.8 kHz (48000/10)

� 4.0 kHz (48000/12)

� 3.42857 kHz (48000/14), and so on.

White Noise

Wfm: Noise

The ATS-2 Digital Generator offers a DSP-generated white noise signal.

The DSP-generated noise is pseudo-random and has a length of 220 or
1,048,576 samples, which means that with the DIO OSR set to a sampling
rate of 48 kHz the noise pattern repeats about every 22 seconds. The
noise has a zero mean, a crest factor of 1.73 and a rectangular probability
distribution function.

The spectrum of the noise is flat from just above 0 Hz to just below half
the sampling rate, and consists of spikes spaced at SR/220 Hz.
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Arbitrary Waveforms

The generator arbitrary waveform function allows you to load a
properly-formatted digital waveform file into the ATS-2 DSP and route the
waveform to the Digital Generator outputs.

Arbitrary waveforms files provided with ATS-2 include single tones, tone
combinations for IMD testing, multitone waveforms and calibration tones,
and other useful waveforms.

Waveform files must be of the Audio Precision .agm (Generator Mono)
or .ags (Generator Stereo) file types. You may also make custom arbitrary
waveform files using a file creation utility provided with ATS-2 or with
third-party applications such as MATLAB. See Multitone Creation on
page 219.
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Figure 89. Loading an

arbitrary waveform.

White Noise Characteristics

The spectral distribution of white noise is characterized by equal
noise energy per hertz. This means that the spectral range between
100 Hz and 200 Hz will have the same energy as the range between
10,000 Hz and 10,100 Hz.

If analyzed by a constant-bandwidth spectrum analyzer such as a
superheterodyne or FFT analyzer, white noise will show a flat energy
characteristic versus frequency (up to the bandwidth limitation).

Analysis of white noise with a constant-percentage-bandwidth
(constant Q) filter such as in the Audio Analyzer Bandpass mode (or
as in most real-time analyzers) will show a rising characteristic versus
frequency, at the rate of 3 dB per octave.



To load a waveform file and then output the waveform so that the
embedded audio tones are at the intended frequencies, the DIO output
sample rate (OSR) must be set to the same sample rate that was used in
creating the file. ATS-2 offers two sampling rate options for loading an
arbitrary waveform, which are set on the Configuration panel at Utilities
> Configuration.

If the Set sample rate when loading generator waveforms
checkbox on the Configuration panel is checked, ATS-2 will automatically
set the DIO OSR to match the sample rate of the file being loaded. If this
checkbox is unchecked, you must manually enter the sampling rate you
desire in the OSR field on the DIO panel.

If you enter a sampling rate different from the sampling rate at which the
file was created, the frequencies of the audio tones embedded in the
output signal will be shifted by the ratio of the two sampling rates.

The DSP processes in the multitone audio analyzer require that the
multitone be precisely correct for synchronous operation. If the tones have
been frequency-shifted, the Multitone Analyzer FFTs will not be
synchronous, and FFT windows will be necessary. See Chapter 13 for
more information on multitone testing.

The Arbitrary Waveform generation memory buffers of the

Analog Generator and Digital Generator are shared. If both

generators have Arb Wfm selected as the waveform, the

same waveform file will be used for both and the same signal

will be produced at both the analog and digital generator

outputs.

Special Waveforms
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Figure 92. Polarity waveform, normal polarity shown.

Wfm: Special: Polarity

The polarity waveform is designed to be obviously asymmetrical, so that
it is easily apparent if signal is inverted or not. The waveform is the sum of
the fundamental tone set in the Frequency field and its second harmonic,
in a fixed phase relationship.

When the output of the DUT is viewed using an oscilloscope or the
ATS-2 Spectrum Analyzer in the time-domain view, the signal will reveal
whether or not there has been a polarity inversion in the DUT or in the
signal interconnections.

The only setting available for the polarity waveform is Frequency.
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Wfm: Special: Pass Thru

The Special: Pass Thru selection does not cause a waveform to be
generated; instead, it passes the digital audio signal connected to the rear
panel SYNC /REF IN BNC connector through to the Digital Generator
output.

Since the sample rate at the Digital Generator output is set at the DIO
OSR, this is a convenient way to synchronize an external test signal with
ATS-2. You can also use Pass Thru to convert an external signal from one
sample rate to another, as might be necessary when working at a 48 kHz
sample rate but using a Compact Disc with test signals at a 44.1 kHz
sample rate as a source.

The REF IN signal sample rate must be between 28.8 kHz and
108 kHz. The ratio between the OSR and the REF IN signal sample rate
is calculated by ATS-2 and a sample rate converter is used to maintain the
output audio frequency at the REF IN audio frequency value. The Digital
Generator output signal is then synchronized and frame-synced to the
converted REF IN signal. Additionally, the ratio of the REF IN sample
rate to the OSR must fall in the range between 1:3 to 3:1; or, stated
another way,

OSR
REF IN SR OSR

3
3� � � .

The range of the OSR is 28.8 kHz–108 kHz.

If the REF IN signal is stereo, the output signal will also be stereo.
Status bytes are not passed through to the output, but are set on the Status
Bytes panel as usual. You can choose whether or not to dither the
re-sampled REF IN signal.

The amplitude relationship between the REF IN signal and the Digital
Generator output is controlled by the Digital Generator output amplitude
setting. A setting of 1.00 FS (0 dB FS) will pass the REF IN signal
unattenuated, and lower settings of generator amplitude will attenuate the
audio level.
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Wfm: Special: Monotonicity

Monotonicity is a low-amplitude “staircase” waveform. It consists of five
complete cycles of squarewave at each of the ten lowest non-zero digital
amplitude states, plus the same time period at zero. Since this definition is
with reference to the minimum possible amplitude, the absolute amplitude
of the steps depends on the Output: Resolution value (word width, in
bits) on the DIO panel.

The squarewave half-cycle duration is controlled by the Samples/Step
field. For example, with a Samples/Step value of 10 at a 48 kHz sample
rate, the squarewave half-period is 10/48,000 seconds, or 208.3 µs; each
equal-amplitude section is ten half-periods long, or 2.083 ms; and each
eleven-step repetition occurs at a rate of 11 2083� . ms, or every 22.92 ms.

Dither is disabled when the Monotonicity waveform is selected.
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10 samples/step, 48 kHz sample rate.
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The Monotonicity waveform is used principally in testing low-level
linearity of D-to-A converters and digital domain devices by viewing their
output in the time domain, using the Spectrum Analyzer instrument.

In the Spectrum Analyzer instrument panel, Select Digital

Gen as the Trigger: Source. The Wave Display field on the

panel should be set to either Display Samples or Absolute

Value, but not Interpolate. See Chapter 11 for more

information about using the Spectrum Analyzer.

Non-linearity is shown by unequal step-to-step amplitudes.
Non-monotonicity is indicated by a reversal in direction of the pattern of
constant decrease from step to step.

Figure 94 shows an example of the Monotonicity waveform under such
conditions, with 24-bit word width.

Wfm: Special: J-Test

J-Test is a waveform which produces a maximum amount of
data-induced jitter on low-bandwidth digital transmission links. J-Test
consists of a squarewave at one-fourth the sample rate, combined with a
second, low-frequency low-amplitude squarewave that has a digital DC
offset.

Dither is disabled for J-Test and no amplitude control is available, since
the signal definition specifies exact data values. The J-Test signal would
normally be transmitted while measuring jitter at the receiving end of a
cable or digital transmission system, to estimate the worst-case magnitude
of jitter caused by reduced bandwidth of the transmission link.

Wfm: Special: Walking Ones and Walking Zeros

Walking Ones is a signal in which only one bit is at logical “one” at
any moment, with the others all at logical “zero.” The position of the bit
which is at logical “one” is stepped continuously through the word from
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LSB to MSB to LSB and back to MSB again, at a rate controlled by the
Samples/Step field.

Walking Zeros is similar except that only one bit is at logical “zero”
and all others are at logical “one.”

Walking Ones and Walking Zeros are typically used in
troubleshooting circuitry where the digital word appears in parallel format,
in order to find “stuck bits.” Dither is disabled for Walking Ones and
Walking Zeros, and the amplitude is fixed.

The walking waveforms can be observed on the DIO panel by viewing
the bit indicators in the Data Bits mode (rather than Active Bits mode).
Set the Samples/Step value to approximately half the sample rate
(24000 for a 48 kHz rate), which results in a 0.5 second per step walking
rate. Slower computers may require a larger Samples/Step value for
proper display on the DIO panel.

Wfm: Special: Constant Value

The Special: Constant Value waveform provides essentially the same
digital code at every sample. This is the digital domain equivalent of an
analog DC signal. Digital DC is usually dithered, like most digital
waveforms, so the actually values at each sample will vary slightly by the
amount of the applied dither.

There is no frequency control field for the Constant Value waveform.
The output Amplitude fields set the amplitude of the DC for each
channel.

Wfm: Special: Random

Special: Random is a specific, predictable pseudo-random waveform
uniformly distributed across the entire range of code values between plus
and minus full scale. It is intended for error-rate testing of communications
links, AES3 interfaces, and digital recorders.
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Random is identical to the Bittest Random waveform of Audio
Precision Systems One and Two and the RAND waveform of Portable
One Dual Domain; it may be used with the bit error analysis capability of
any of those instruments.

Dither is disabled for the Random waveform.

Dither

Dither is low-level noise that is combined with the signal to improve
linearity, reduce distortion at low amplitudes, and extend the linear
operating range below the theoretical minimum for undithered PCM
signals of any particular resolution.

The dither noise is introduced before quantizing and serves to
randomize the quantization distortion and produce an undistorted signal
with a slightly higher noise floor. The elimination of quantization noise
results in a more acceptable audio signal.

Dither Type

The Dither Type list on the Digital Generator panel allows you to select
three types of dither for the generator output signal, or none. The dither
type names “rectangular” and “triangular” describe the shape of the
graphs of the probability distribution function (PDF) of the noise signal
chosen for dither. The effects of dither on a digital audio signal change
with the level of dither applied and with the PDF of the dither noise signal.

The Output Resolution field on the DIO panel controls the amplitude
of the dither added to the digital generator output. Proper dither amplitude
for a 16-bit system, for example is obtained by entering 16 in the Output
Resolution field.

The Dither Type list choices are:

� Triangular. Triangular probability distribution function (TPDF) dither
is the default setting in ATS-2, and is recommended for most
measurement applications. It produces a slightly higher noise floor
than RPDF dither, but it imparts no noise modulation effect to the
audio. Triangular dither can add or subtract up to one LSB peak
amplitude at the selected resolution.
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� Rectangular. Rectangular probability distribution function (RPDF)
dither provides a better signal-to-noise ratio than triangular dither,
but suffers from noise modulation effects. Rectangular dither can add
or subtract up to one-half LSB peak amplitude at the selected
resolution.

� Shaped. Shaped dither is TPDF dither shaped through a filter,
resulting in a dither signal with a rising 6 dB-per-octave slope, set
with the 0 dB effect point at one-half the sampling rate. This places
most of the dither power at higher frequencies, where much of the
resultant noise falls out-of-band for most devices, and where
audibility is lower.

� None. No dither is applied.

Certain generator waveforms, such as Monotonicity, J-Test, Walking
Ones or Zeros, and Random waveforms are only usable with no dither.
When one of these waveforms is selected, dither is automatically disabled
and the Dither Type field is not available.

Digital Generator References

With the appropriate choice of units, amplitude and frequency settings
in the Digital Generator can be made relative to reference values. These
references are entered manually in the Digital Generator References area.

Volts for Full Scale Reference

Digital full scale (FS) is defined as the rms value of a sinewave whose
peaks just touch the maximum values of the coding scheme. When
expressed in analog domain units, there must be a reference given to
establish the level relationship between the two domains. For Digital
Generator settings, that reference is entered as the rms voltage which is to
correspond to a full scale digital audio signal.

Set the Digital Generator volts for full scale reference in the
References: Volts/FS field.
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Frequency Reference

The relative units of measurement for the Digital Generator are F/R,
dHz, %Hz, cent, octs, decs, d%, and dPPM.

In a relative expression, the frequency setting or reading is expressed in
relation to a second reference frequency. For Digital Generator relative
frequency settings, this reference frequency is entered in hertz in the Digital
Generator References: Freq field.

dBr Reference

The dBr (which is shorthand for “decibels relative to a reference”)
reference is an easy way to set a nominal level against which your settings
or readings are made. Enter a reference value in the References: dBr
field.

You can set a Digital Generator dBr reference in FFS, %FS, dBFS,
bits, V, Vp, Vpp, dBu, dBV, dec or hex units.
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Chapter 10

The Audio Analyzer

Overview

The Audio Analyzer is a DSP instrument selection on the Analyzer
panel. It is one of the key audio analysis tools available in ATS-2. The
Audio Analyzer can measure audio level, frequency, noise, THD+N,
crosstalk, phase and more, with a wide selection of filters and detector
characteristics. For many measurements, the Audio Analyzer is the only
instrument you will need.

ATS-2 User’s Manual 113

Digital

Input

Analog

Inputs

AES
Receiver

PEAK
METERS

FREQUENCY
METERS

LEVEL
METERS

FUNCTION
METERS

DIO Analog Input Panel

Audio Analyzer Panel

----- Vp
CHANNEL A

CHANNEL B

----- V
CHANNEL A

CHANNEL B

CHANNEL A

CHANNEL B

----- kHz
CHANNEL A

CHANNEL B

Ranging

CHANNEL A

CHANNEL B

Peak
Detectors

CHANNEL A

CHANNEL B

A-to-D
Converters

CHANNEL A

CHANNEL B

Detectors:
RMS

& Fast RMS

CHANNEL A

CHANNEL B

Ranging

CHANNEL A

CHANNEL B

Digital
AC-DC

Coupling

CHANNEL A

CHANNEL B

Ranging

CHANNEL A

AC
Coupling

CHANNEL A

Low Pass
Filters

CHANNEL A

Highpass
Filters

CHANNEL A

Detectors:
RMS, Fast RMS

& Q-Peak

Detectors:
RMS, Fast RMS

& Q-Peak

CHANNEL A

Ranging

CHANNEL B CHANNEL B

Frequency
References

Amplitude
References

Detector
Settings

Analog
AC-DC

Coupling

CHANNEL A

CHANNEL B

AC
Coupling

Highpass
Filters

CHANNEL B CHANNEL B CHANNEL B

Low Pass
Filters

----- V

----- V
Variable

Measurement Function

Figure 99. Conceptual Block Diagram, Audio Analyzer.



This chapter examines each function, control and display of the Audio
Analyzer in detail. If you are new to ATS-2, you might want to start with
the Quick Guides in Getting Started with ATS-2, which will introduce you
to Audio Analyzer features.

The Audio Analyzer will measure either digital or analog domain
audio input signals, as selected by the Input field. It is a two-channel
instrument, capable of performing measurements on both channels of a
stereo signal at the same time. For an analog signal, the Audio Analyzer
can measure a frequency range from DC to about 045. � FS , where FS is
the sample rate of the inputs ADCs set on the Analog Input panel; for
digital signals, the Audio Analyzer can measure a frequency range from
DC to 05. � FS .

There are three pairs of meters on the Audio Analyzer which measure
the input signal simultaneously:

� the Level meters,

� the Freq. (frequency) meters, and

� the Function meters.

As on other ATS-2 panels, you can select the units of measurement you
prefer for each reading display. Other fields on the Audio Analyzer panel
allow you to choose coupling, filter, detector and level reference options.
Some of these options, however, apply only to the Function meters, as
you will see later in this chapter.

Loading the Audio Analyzer

To use the Audio Analyzer, first open the Analyzer panel. The
Analyzer panel is a command selection on the Panel menu, and is also
available by the keyboard shortcut Ctrl+Y, or by clicking the Analyzer
button on the Toolbar.
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The Audio Analyzer is loaded in the Analyzer panel as the default
instrument. If another Analyzer instrument is loaded, drop down the list
and choose Audio Analyzer.

Signal Inputs

The Input field of the Audio Analyzer offers two signal input
selections: Digital and Analog. These choices access signals from the
Digital Input/Output (DIO) panel or the Analog Input panel, respectively.

Digital signals are sent directly to the Audio Analyzer DSP; analog
signals are first digitized by precision ADCs (selected on the Analog Input
panel) before being sent to the Audio Analyzer.

To select digital input connectors, digital input format and configure
other aspects of the serial interface, go to the DIO panel (see Chapter 7).
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To select analog input connectors, range, coupling, and ADCs, go to
Analog Input panel (see Chapter 6).

You will notice that as you select Digital or Analog the appearance of
the Audio Analyzer panel changes as well, displaying a different set of
settings, units and references.

The Level Meters

Two Level meters are located near the top of the Audio Analyzer
panel, one for each input channel. The Level meters display the audio
amplitude of the input signals. These meters are true rms instruments,
using the normal or the fast rms detector as selected in the Detector (Det)
field lower on the panel.

The meter detectors are discussed in more detail on page 132.

Note: Detector choices affect both the Level meters and the

Function meters. However, the Q-Peak choice is only

effective on the Function meters. If Q-Peak is selected, the

Level meters use the normal rms detector.

Level Meter Units

If you click on the arrow to the right of either Level meter reading field,
a list of measurement unit choices will drop down. The units shown on the
list depend upon whether Analog or Digital is selected in the Input field.

With Digital selected, the units list includes

� digital domain units: FFS, dBFS, %FS and Bits;

� relative units: dBr A and dBr B;

� and units relative to the analog domain: V, dBu, and dBV.
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These analog domain units are calculated relative to the value you enter
in the V/FS field in the References area of the panel, and can be helpful in
cross-domain measurements. When measuring an ADC, for example, you
could enter the full-scale analog input voltage of the converter into the
V/FS field and view your results here using one of the analog domain units
available.

With Analog selected, the units list includes

� analog domain units: V, dBu, dBV, and W (watts).

� relative units: dBr A, dBr B, dBg A, dBg B;

� and units relative to the digital domain: FFS, dBFS and %FS.

For an explanation of the units of measurement used in ATS-2 and the
references for the relative units, go to Appendix A, Units of
Measurement.

AC and DC Coupling

There are a few issues to consider when examining AC and DC signal
coupling in ATS-2.

� For signals in the analog domain, capacitors can be switched in and
out of the input circuits to block or pass DC. When Analog is
selected as the Audio Analyzer Input, AC or DC coupling is
controlled from the Analog Input panel, as explained in Chapter 4.

� For signals in the digital domain, blocking or passing DC is
accomplished in DSP. When Digital is selected as the Audio
Analyzer Input, DSP AC or DC coupling is controlled from the
Audio Analyzer panel, as explained below. This selectable coupling
affects the readings shown on the Audio Analyzer Level and
Frequency meters; the Function meters, as you will see below,
always have a high-pass filter implemented, effectively blocking DC
to the various Function readings under all circumstances.

Also refer to the block diagram in Figure 99.
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With Input set to Digital, the selections on the Audio Analyzer panel
operate as follows:

� When the check box for either channel is unchecked, DC is blocked
in DSP for that channel;

� When the check box for either channel is checked, DC is passed for
that channel.

Common-Mode Testing and Coupling Issues

When making common-mode tests, small DC offsets from the DUT can
result in significantly different measurements. If your goals do not require
measurements that extend below the audio range to DC, it is usually
advisable to use AC coupling to block any DC offset.

For analog inputs, it’s usually best to use the Function meters, which are
always AC-coupled. This is because the use of the Level meters in an
AC-only mode requires that the DC be blocked in the Analog Input
circuitry; but even with carefully-chosen, high-tolerance components, any
tiny mismatch in the DC-blocking capacitors can adversely affect
common-mode measurements.

For digital inputs, either uncheck the DC checkboxes and use the
readings on the Level meters, or use the Function meters, which are
always AC-coupled.

The Frequency Meters

The frequency readings of the signals on the two channels are shown in
the Freq meter fields, just below the Level meter readings. In ATS-2, the
frequency meters are sometimes called frequency counters.

The units of measurement include

� the absolute frequency in Hz, and
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� a variety of relative frequency units: F/R, dHz, %Hz, cent, octs,
decs, d% and dPPM.

All the relative frequency units are computed with respect to the Freq
value entered in the References: Freq field lower on the panel. For specific
definitions of these relative frequency units, see the Frequency Units
discussion on page 386.

Meter Ranging

Practical devices have an optimum amplitude operating range in which
they exhibit their best performance. ATS-2 gives you the choice of
automatic ranging (or autoranging) or manually setting a fixed maximum
range.

Ranging is controlled independently at two different points within the
Audio Analyzer instrument, as shown on Figure 99. The upper set of
Ranging controls acts on the A and B signals applied to the Level meters
and Frequency meter displays. The lower set of Ranging controls acts on
the two channels of the Function meter.

There is an additional set of ranging circuits in the analog

input circuits controlled from the Analog Input panel,

discussed on page 40. If you are using the analog input to

the Audio Analyzer, these ranging controls will also affect

your measurement.

Autoranging

The Audio Analyzer is normally be operated with automatic ranging,
indicated by a check mark in each of the appropriate Range check boxes.
This provides operation with no possibility of clipping due to
high-amplitude signals.

Click the Range check box to defeat autoranging. The range setting
field for that meter and channel will become active, and you can enter a
fixed maximum range for that input.

Fixed Range

Using a fixed range produces faster measurements, which can be
important when speed is at a premium as within a repetitive routine in an
automated testing macro. However, you must know the probable range of
the signal and set the fixed range maximum above the highest expected
level.

Manual range selection is also preferred when listening to program
material such as voice or music on the built-in loudspeaker or via the
headphone jack. Automatic ranging will constantly switch levels when a
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complex, wide-range signal is applied. This may make it difficult to adjust
a device for minimum distortion or noise, for example.

ATS-2 ranges are implemented in discrete steps. When selecting a fixed
range, enter the maximum expected value into the Range field. ATS-2 will
select the next range which accommodates that value.

The Function Meters

The Level meters examined previously display the rms amplitude of the
signal applied to the Audio Analyzer.

The Function meters, which are located in the center of Audio
Analyzer, are separate instruments which can measure the input signal in
a number of different ways by applying different measurement functions.
The Function meters also add the option of using signal filtering, as well
as an additional detector selection.

The Function meters are the real power of the Audio Analyzer. Most
of the measurements you will make with the Audio Analyzer will be
using the Function meters, with the Level meters as convenient
secondary signal monitors.

Function Meter Measurement Functions

The Function meter measurement function selections are:
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� Amplitude

� 2-Ch Ratio

� Crosstalk

� THD+N Ratio

� THD+N Ampl

� Bandpass

� SMPTE/DIN

� Phase

Each function is discussed in detail below.

Amplitude Function

Figure 107 shows a conceptual block diagram of the Audio Analyzer
with the Amplitude function selected.
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The Amplitude function measurements are similar to the Level meter
measurements. In certain configurations the Amplitude function readings
will be identical to the Level meter readings.

Amplitude measurements can differ from Level meter measurements
for two reasons:

� Amplitude measurements are affected by the highpass, lowpass,
and weighting filter selections made in the BW and Fltr fields, while
Level meter readings are always unfiltered.

� In addition to the two rms detectors, Amplitude function
measurements may be made with the quasi-peak detector; the Level
meters always use one of the rms detectors.

Since the Level meters have no equalization or filtering available, you
must use the Amplitude function for weighted or band-limited noise
measurements.

2-Channel Ratio Function

Figure 108 shows a conceptual block diagram of the Audio Analyzer
with the 2-Channel Ratio function selected.
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The 2-Ch Ratio function displays the ratio of the signal amplitudes in
the two channels, A and B. The Channel A Function meter shows the ratio
A/B, and the Channel B Function meter shows the ratio B/A.

2-Ch Ratio may be expressed in %, dB, or X/Y units. The 2-Ch
Ratio function is useful while balancing stereo channels, for example; or
for measuring gain or loss by connecting the Audio Analyzer A channel
across the DUT input and the B channel across the DUT output.
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Crosstalk Function

Figure 109 shows a conceptual block diagram of the Audio Analyzer
with the Crosstalk function selected.

The Crosstalk function measures the leakage, or crosstalk, of a
sinewave from one channel to the other. A typical crosstalk test uses a
stereo stimulus, with each channel driven with a sinewave of different
frequency.

For each analyzer channel, a bandpass filter is steered to the frequency
in the opposite channel. The amplitude measured at this frequency is the
absolute crosstalk value. The percentage of the opposite channel’s signal
amplitude (as measured by the Level meter) represented by the absolute
crosstalk value of the channel under consideration is displayed in the
channel’s function meter.

For example, consider a stimulus with a 1 kHz sinewave on Channel A
and a 2 kHz sinewave on Channel B. In the Audio Analyzer, the Channel
A bandpass filter is steered to 2 kHz, a measurement is made, and the
percentage of the Channel B Level meter reading this crosstalk
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measurement represents is computed and displayed in the Channel A
Function meter display.

Likewise, the Audio Analyzer Channel B bandpass filter is steered to
1 kHz, a measurement is made, and the percentage of the Channel A
Level meter reading this crosstalk measurement represents is computed
and displayed in the Channel B Function meter display.

Crosstalk is a ratio, expressed as:

Crosstalk from B A
Level of F in A

Level of F in B
into � 1

1

When only one channel is driven, a Crosstalk percentage reading for
the driven channel will display absurdly high percentages, since the
denominator of the fraction (the un-driven channel level) is very close to
zero. Also, since the source of the denominator is a Level meter, which is
unfiltered, spurious frequencies and out-of-band noise may produce
erroneous Crosstalk ratios. In this case, a pre-analyzer filter may be
useful.

Crosstalk may be expressed in %, dB, or X/Y units. The Channel A
Function meter shows the percentage of the signal crossed from B into A,
and the Channel B Function meter shows the percentage of the signal
crossed from A into B.

Since the bandpass filter will reject most wide-band noise, the
Crosstalk function provides more accurate measurements of
low-amplitude signals in the presence of noise. The filter must be tuned to
the frequency of the signal on the opposite channel; see BP/BR Filter
Tuning on page 140.

The BW (high-pass and low-pass) and Fltr (weighting) filter selections
are not available for the Crosstalk function.

THD+N Functions

The two THD+N (total harmonic distortion plus noise) functions use
bandreject (notch) filters to remove the fundamental sinewave signal so
that the detector can measure the remaining harmonic distortion products
and noise.

The bandreject filter center frequencies may be fixed, or may track one
of several parameters. See BP/BR Filter Tuning on page 140.

Figure 110 shows a conceptual block diagram of the Audio Analyzer
with the THD+N functions selected.
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THD+N Ratio Function

The THD+N Ratio function expresses the sum of the distortion
products and noise amplitudes relative to the amplitude of the unfiltered
signal (as measured by the Level meter); in other words, the result is a
THD+N-to-signal ratio. Units of % and dB (decibels below the
fundamental) are ordinarily used with the THD+N Ratio function.

THD+N Ratio is the common way to express distortion. However, in
an amplitude sweep THD+N Ratio appears to show increasing distortion
and noise with decreasing signal amplitude because the distortion and
noise is stated as a ratio to the decreasing signal. The THD+N Ampl
function may be more useful for amplitude sweeps.

Results using the THD+N Ratio function may be expressed in %, dB,
or X/Y units.
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THD+N Amplitude Function

The THD+N Ampl (amplitude) function expresses the amplitude of
the distortion products and noise in absolute units, independent of the
amplitude of the fundamental signal. Although the previous function,
THD+N Ratio, is used much more commonly, THD+N Ampl is
particularly useful when performing amplitude sweeps of audio devices,
since it helps make clear that the noise component is at a constant
amplitude and is unrelated to the signal amplitude.

When using the THD+N Ampl function the list of units and their
references for both analog and digital signals are the same as described
above in the Level Meter Units topic on page 116.

Bandpass Function

The Bandpass function is a selective voltmeter (a function sometimes
called a wave analyzer) implemented by DSP techniques. Each channel
includes a narrow bandpass filter of approximately 1/13 octave (Q=19,
–3 dB bandwidth approximately 5.2% of center frequency). The bandpass
filter center frequency may be fixed, or may track one of several
parameters. See BP/BR Filter Tuning on page 140.

Figure 111 shows a conceptual block diagram of the Audio Analyzer
with the Bandpass function selected.
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The filter may be tuned to the steering source fundamental frequency or
to its 2nd, 3rd, 4th, or 5th harmonic. This harmonic tracking ability
permits swept measurements of individual harmonic distortion products,
limited in frequency to a maximum value of 47% of the sample rate.

The BW (high-pass and low-pass) filter selections are not available for
the Bandpass function.

SMPTE/DIN IMD Function

Figure 112 shows a conceptual block diagram of the Audio Analyzer
with the SMPTE IMD function selected.

SMPTE IMD (intermodulation distortion to the SMPTE or DIN
standards) measures the amplitude of the IMD residuals created below the
high-frequency component of a two-tone test signal. These are recovered
by first passing the signal through a 2 kHz high-pass filter and then
demodulating and filtering the sidebands. Appropriate two-tone test signals
can be generated by the Analog or the Digital Generator. The combined
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amplitude of the recovered sidebands is stated as a ratio to the amplitude
of the high-frequency tone, with units of % or dB being the most common.

The BW (high-pass and low-pass) filter selections are not available for
the SMPTE/DIN function.

Phase Function

Figure 113 shows a conceptual block diagram of the Audio Analyzer
with the Phase function selected.

The Phase function measures the phase difference between the signals
(which must be the same frequency) on the two input channels. The phase
difference, always expressed in degree units, is shown in the left-hand
Function meter display.

The value displayed is “phase B–A,” the same expression used for the
Sine: Var Phase waveforms of the Digital and Analog Generators. If
Channel B leads Channel A, the display will show a positive reading; if
Channel B lags Channel A, the display will show a negative reading.
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When using Phase, the right-hand Function meter display becomes a
setting field, with a list of four options: Auto, –180+180 deg, 0+360
deg, and –90+270 deg.

In Auto, ATS-2 reads absolute phase error. Delays in the DUT can
cause signals to lag or lead by many waveform cycles, and for swept
measurements Auto will correctly show and plot readings well beyond
±360 degrees. When viewing phase error in Auto without sweeping, the
reading is reset at each waveform cycle and the phase error will always be
displayed as less than ±360 degrees.

The –180+180 deg, 0+360 deg, and –90+270 deg choices
express the phase error in “windows” of 360º, with the window for each
selection placed along a scale at a different positions in relation to 0º. See
Figure 114.

The BW (high-pass and low-pass) filter selections are not available for
the Phase function.
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Function Meter Units

As with the Level meters, the units available for the Function meters
depend upon whether the Analyzer Input is set to Digital or Analog.
The measurement function you choose for the Function meters will
change the unit options as well.

� In the amplitude measurement functions (Amplitude, THD+N
Amplitude, and Bandpass), the analog input and digital input
units and their references are exactly as described above under Level
Meter Units on page 116.

� In the various ratio-measurement functions (2-Channel Ratio,
Crosstalk, THD+N Ratio, and SMPTE IMD), the available units
are %, dB, and X/Y, independent of whether Analog or Digital
input is selected.

� In Phase function, the only unit available is degrees.

For an explanation of the units of measurement used in ATS-2 and the
references for the relative units, go to Units of Measurement, Chapter 1.

Function Meter Ranging

Like the Level meters, the Function meters have a set of amplitude
ranging controls, which are located lower on the Audio Analyzer panel
beneath the Function meter reading fields.

The Function meter ranging control operate in exactly the same
manner as the Level meter ranging controls, which are discussed in detail
on page 119.
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Detector Type

The right-hand field following the “Det” label permits selection of
detector type for the Function meter of the Audio Analyzer. The available
selections are RMS, Fast RMS, and Quasi-Peak.

Note: These choices also affect the Level meters. When

either rms detector is selected for the Function meters, the

Level meters use the same type of detection. When

Quasi-Peak is selected for the Function meters, the Level

meters use normal RMS detection.
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Detectors and Crest Factor

3.5000 VDC is always 3.5000 VDC. But AC voltages, by definition,
are always changing. We must agree to measure AC (including audio
signals) in a way that is consistent and appropriate for the use at hand.
Historically, AC was simply rectified with a diode (a detector, in radio
terms) for measurement. But what kind of a detector? Half-wave?
Full-wave? How quickly should our detector respond? How long do we
gather signal before we report the voltage?

As time went on, standard AC measurement terms including
“peak,” “peak-to-peak,” “average” and “rms” were agreed upon. For
many purposes, rms (root mean square) AC measurements were often
the most useful, especially for audio work.

The decision to use one or another detector is dependent on what
aspect of an audio signal you are interested in measuring. Different
detectors, and signals with different crest factors, will give you different
results.

Crest factor is the ratio of a signal’s peak amplitude to its rms
amplitude. Crest factor is a term describing, in simple terms, how

“peaky” or “smooth” a waveform is. A signal with many large, narrow
transients (such as Gaussian white noise) has a high crest factor; a
consistent waveform (such as a flute tone) has a low crest factor.

Figure 115. The Audio Analyzer

Detector selections.



� RMS
The RMS choice provides conventional true rms detection with a
measurement time approximately the reciprocal of the selected
reading rate.

� Fast RMS
The Fast RMS selection provides synchronous rms detection for
periodic signals such as sinewaves and squarewaves, making
accurate measurements in as little as one cycle of signal. Fast RMS
is useful for very rapid frequency response sweeps.
The measurement period is synchronized with zero crossings of the
signal waveform and will always be an integer number of signal
cycles. The actual measurement time is the reciprocal of the detector
reading rate value plus the time necessary for completion of the cycle
of signal in progress when the reading rate period expires. For
example, if the reading rate is set to 64/sec (a period of 15.6 ms)
and the signal being measured is a 500 Hz signal (which has a 2 ms
period), the total time of each measurement could vary between 15.6
ms to almost 17.6 ms, depending on the phase of the signal.

� Quasi-Peak provides a response conforming to the IEC468
specification for noise measurements, and is normally used with the
CCIR (IEC468) weighting filter.

Detector Reading Rate

The left-hand field following the “Det” label controls the detector
reading rate, the rate at which all the Audio Analyzer meters update. This
is also called integration time. The selections are Auto, 4/sec, 8/sec,
16/sec, 32/sec, 64/sec, 128/sec, and 256/sec.

The actual measurement time for a given selection depends on the
detector response type selected. For RMS and Quasi-Peak, the
measurement time will be approximately the period of the selected rate
(for example, about 125 ms at 8/sec). For the Fast RMS detector, the rate
selected will set the minimum measurement period. The actual period may
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be longer, since with Fast RMS the measurement continues until the next
positive-going zero crossing of the signal cycle.

Normally, Auto will be your best choice, with the most important
exception being noise measurements, discussed below. The Auto
algorithm takes into account the signal frequency being measured and
whether or not the bandpass filter is in use, and then selects the fastest
reading rate which will deliver the specified accuracy under these
conditions.

For noise measurements, the 4/sec selection is recommended to
provide integration of noise over a longer period. You might also choose
4/sec when measuring periodic waveforms for the best accuracy and
repeatability at very low frequencies.

The 8/sec, 16/sec, 32/sec, 64/sec, 128/sec, and 256/sec choices
provide progressively faster measurements. If you are watching a bargraph
display while making adjustments to a DUT, for example, the faster rates
better approximate real-time readings and will give you better feedback.

However, low-frequency measurement accuracy is reduced at faster
rates. Each step faster in reading rate raises the low-frequency limit to
accurate measurement. Faster reading rates are also less tolerant of noise
in the signal.

The Bandwidth and Filter Fields

Beneath the detector fields are three fields which allow selection of
various filter options for the Function meters. The first two are labeled
“BW” for bandwidth, and consist of highpass and lowpass filter options.
The third field is labeled “Fltr” and provides weighting filter selections for
some instrument functions and detailed control over the
bandpass/bandreject filters for other functions. Graphs of all the filter
curves are shown in the Specifications chapter in Getting Started with
ATS-2.

BW: The Highpass Filter
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There are two BW (bandwidth) filter control fields. The left field is the
highpass field.

The highpass filter is effective in all Function meter functions except
Crosstalk, Bandpass, SMPTE and Phase. This field allows you to
select essentially flat response at low frequencies (the <10 Hz selection),
specific highpass filters at 22 Hz, 100 Hz, 400 Hz, or a User HP. A
highpass filter, when selected, is connected in the measurement paths of
both Function meter channels, but does not affect the Level or
Frequency meters.

The 22 Hz and 100 Hz high-pass filters are four-pole (24 dB/octave)
designs in all functions of the Function meter.

In the two THD+N functions, the 400 Hz filter also has four poles;
however, in the Amplitude or 2-Ch Ratio functions, the 400 Hz filter
becomes an extremely sharp, high-rejection ten-pole elliptical high-pass
filter. Selecting the 400 Hz filter in these functions permits quantization
noise and distortion measurements of ADCs and digital systems.

You can also use a custom highpass filter file by selecting User HP. See
User Filters, page 138.

BW: The Lowpass Filter

The right BW (bandwidth) filter control field is the lowpass field.

The lowpass filter is effective in all Function meter functions except
Crosstalk, Bandpass, SMPTE and Phase. This field allows you to
select essentially flat response at high frequencies (the Fs/2 selection),
specific lowpass filters at 20 kHz, 15 kHz, or a User LP. Fs refers to the
currently selected sample rate, as determined in the settings in the DIO
panel for digital signals; or in the Analog Input panel for analog signals.
Any lowpass filter, when selected, is connected in the measurement paths
of both Function meter channels, but does not affect the Level or Freq.
meters.

The 20 kHz and 15 kHz lowpass filters are six-pole elliptic designs.
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Selection of a 15 kHz or 20 kHz lowpass filter when making THD+N
measurements is particularly important in measuring converters with large
amounts of noise shaping.

Performance of the 15 kHz and 20 kHz lowpass filters is independent of
sample rate at sample rates above approximately 44 kHz. As sample rates
decrease toward twice the corner frequency of the selected filter, it
essentially becomes the same as the Fs/2 selection.

You can also use a custom lowpass filter file by selecting User LP. See
User Filters, page 138.

The “Fltr” Field

The field labeled “Fltr,” just beneath the bandwidth filter fields, has
different operations in different functions of the Function meter.

� In the Amplitude, 2-Ch Ratio, and the two THD+N functions, this
field allows selection of weighting filters, as discussed below.

� In the Bandpass function, the field permits selection of whether the
bandpass filter is tuned to the fundamental frequency of the source
being tracked, or to the 2nd, 3rd, 4th, or 5th harmonics. See BP/BR
Filter Tuning on page 140.

� In the Crosstalk, SMPTE/DIN and Phase functions, the field
disappears.

Fltr: Weighting Filters

Weighting filters provide response curves which are relevant to the
characteristics of human hearing. Weighting filters are frequently required
for meaningful noise measurements and sometimes for THD+N as well.
Standards often specify weighting filters for measurements. See the
Specifications chapter in Getting Started with ATS-2 for graphs of the
filter curves.
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Several selections are provided in the weighting filter field—None, “A”
Weighting, CCIR Weighting, “F” Weighting, CCITT Weighting,
C-message Weighting, HI-2 Harmonic Weighting and User
Weighting Filter. When any of these weighting filters is selected, it affects
the Function meter measurement paths of both channels. The Level and
Frequency meters are always unfiltered.

� None applies no weighting filter.

� “A” Weighting processes the signal through a psophometric
weighting filter meeting the ANSI A-weighting specification. An
A-weighting filter in combination with the THD+N function is
frequently used for dynamic range measurements of ADCs.

� CCIR Weighting processes the signal with the weighting filter
described in IEC468. It is normally used in one of two ways:

� When used with an rms detector, this filter produces
measurements satisfying the Dolby and ARMS recommendations.

� When used with the Q-Peak detector at a reading rate of 4/sec,
this filter produces measurements satisfying the IEC468 standard.

The IEC468 standard specifies that the unity gain point in the

test intersect the weighting curve at 1 kHz, rather than the

2 kHz intersection specified in the Dolby and ARMS

recommendations. ATS-2 automatically makes the 6 dB level

adjustment to accomplish this when IEC468 Weighting and

Q-Peak are selected together.

� The “F” Weighting filter is based on psychoacoustic research and
relates to typical human hearing sensitivity at a sound pressure level
of 15 phons.

� CCITT Weighting and C-message Weighting filters are
essentially voice-band filters sometimes required for
telecommunications applications.

� The HI-2 Harmonic Weighting filter is intended for use only when
the Function meters are in THD+N Ratio or THD+N Amplitude
functions. The primary purpose of the Harmonic Weighting filter is
for rub and buzz measurements on loudspeakers. This filter has a
rising 12 dB/octave response with the unity gain frequency four times
higher than (two octaves above) the frequency of the THD+N notch
filter, which means it emphasizes the effect of signals above the fourth
harmonic and reduces the effect of signals below the fourth
harmonic. Maximum gain of the Harmonic Weighting filter is
limited to 28 dB.
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� User Weighting provides a way to insert a custom weighting filter
into the Function meter paths. See User Filters, below.

The A, IEC468, and F weighting filters are specified to

20 kHz; at sample rates below 44 kHz, their response within

a few kilohertz of Fs/2 will deviate from specification.

Weighting filter responses are perfectly accurate at the following sample
rates:

Sample rates that produce precise filter responses.

32.000 kHz 65.536 kHz 131.072 kHz

44.100 kHz 86.200 kHz 176.400 kHz

48.000 kHz 96.000 kHz 192.000 kHz

At any other sample rate, the filter shape is preserved but the filter
“slides” up or down in frequency by the ratio of the actual sample rate in
use to the nearest sample rate from the list above.

User Filters

User downloadable filters (or user filters), are custom-designed software
filters which can be designed for use in any of the three Audio Analyzer
filter groups.

You can select a user downloadable filter for the Audio Analyzer in the
same way that you choose one of the standard DSP filters.

The low-pass and high-pass filters are selected in the two fields to the
right of the BW (bandwidth) designation. The weighting filters are selected
in the Fltr (filter) field.

DSP filters are not available in every measurement function

of the Audio Analyzer. Set the Function meter function to

Amplitude, 2-Channel Ratio or one of the two THD+N

modes to choose DSP filters.

Click the arrow to drop down the list of filters for any of these fields. The
last filter option on all lists selects the downloadable filter type appropriate
for that setting: User HP, User LP or User Weighting Filter.

Although you can save many different user filter files for use in ATS-2,
you can only select one user file for each of the three filter positions at any
one time. When ATS-2 is launched, by default no user filter files are
selected. To choose your filters, click the browser button to the right of the
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Fltr field. A file browser opens that enables you to select filter files for any
of the three filter types: low-pass, high-pass and weighting. You can also
view the filter Info string for any of the three selected filters.

When you have chosen downloadable filters and closed the browser,
notice that the BW and Fltr fields have been automatically set to User to
reflect your choices. As long as you do not exit the ATS-2 measurement
software or load a test file, these downloadable filter files will remain
attached to their filter lists. You still have the option, however, of choosing
other ATS-2-provided filters (or None) from the lists without losing the link
to the file you have selected.

A test saved with an attached user filter will re-attach the filter to the
Audio Analyzer when the test is loaded.

If you select User from any of the three filter lists and a user filter file
has not been previously selected for that setting, the user filter file browser
will appear and prompt you to choose a filter file.

Audio Precision includes a utility program called APFDP on the ATS
CD-ROM as an aid to creating your own downloadable filters. Several
Matlab functions are also provided, which will be very helpful to Matlab
users in creating properly-formatted downloadable filter files for ATS-2.
See Appendix D for more information.
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Bandpass/Bandreject Filter Tuning

The BP/BR Fltr Freq (bandpass/bandreject filter frequency) controls
affect only the Function meters, and only in certain functions, as listed
below. The filter does not affect the Level meter or Freq. counter
readings.

This is a highly selective filter of approximately 1/13 octave bandwidth.
Q=19, giving a –3 dB bandwidth of 5.2% of the center frequency. The
filter is tunable across the audio spectrum from 0.04% to 42% of the
sample rate (20 Hz to 20 kHz at a 48 kHz sample rate).

The bandpass or peaking form of the filter is used in two Audio
Analyzer functions:

� Crosstalk and

� Bandpass.

The bandreject or notch form of the filter is used in two other Audio
Analyzer functions:

� THD+N Ratio and

� THD+N Ampl.

Either the bandpass or bandreject form of the filter may be fixed in
frequency, or may be “steered” to automatically track a parameter during
a sweep test. You can select the source of frequency steering information in
the BP/BR Filter Freq field, located in the lower-right area of the Audio
Analyzer panel. The selections are:

� Counter Tuned

� Sweep Track

� AGen Track
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� DGen Track and

� Fixed.

When the Audio Analyzer is using the Bandpass function, you can
further modify the filter steering source value by changing the setting in the
“Fltr” field, located beneath the BW (bandwidth) setting fields. See
Selecting Harmonics in Bandpass on page 141.

� When Counter Tuned is selected, the frequency value measured by
the Frequency counter becomes the filter steering source. You would
use this when making THD+N or Crosstalk measurements from an
external signal such, as playback of a compact disc or reception of a
signal from a distant source.

� When Sweep Track is selected, the filter tracks the frequency of
whichever generator is selected in the Source 1 or Source 2 fields
of the Sweep panel.

� When AGen Track is selected, the bandpass/bandreject filter tracks
the frequency of the Analog Generator. This mode is useful for testing
ADCs driven from ATS-2’s analog output.

� When DGen Track is selected, the filter will automatically track the
frequency of the Digital Generator. This mode is normally used when
sweeping input-to-output through a digital device with the stimulus
tone coming from ATS-2’s Digital Generator.

� When Fixed is selected, the field immediately below (which is grayed
out in other modes) becomes active. The filter will be set at the
frequency entered in this field.
It is also possible to vary the filter frequency in this mode as part of a
sweep test. Although this is similar to the Sweep Track choice
above, in this case the filter can be swept independent of generator
frequency.
To sweep the filter frequency during a test, first be sure you have
selected Fixed in the BP/BR Filter Freq field here on the Analyzer
panel. Then, go to the Sweep panel and open the Source 1 or
Source 2 browser and choose Analyzer. Click on Bandpass A or
Bandpass B in the right-hand browser window (Settings selected)
and click OK. See Chapter 15 for more information on sweeps.

Fltr: Selecting Harmonics in Bandpass

In Bandpass function, the Fltr field offers the selections of Narrow,
Narrow, Freq x2, Narrow, Freq x3, Narrow, Freq x4, and Narrow,
Freq x5.
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The default setting, Narrow, sets the filter at the source frequency. The
other choices (Narrow, Freq x2; Narrow, Freq x3 and so on) move the
filter to multiples of the source frequency, allowing you to make individual
harmonic distortion measurements of the 2nd through 5th harmonic.

The filter bandwidth is fixed at the normal 5.2% bandwidth value under
all of these selections, but its center frequency is steered to different integer
multiples of the BP/BR Source steering frequency. See BP/BR Filter
Tuning on page 140.

References

The bottom area of the Audio Analyzer panel includes six fields (with
Input: Analog) or four fields (Input: Digital) in which you can enter
reference values. Each reference serves as a basis for its corresponding unit
of measurement on the panel. The Freq. and V/FS references are the
same for both the Analog and Digital inputs; the other reference fields
will change with the input configuration.

Analyzer Analog References

� dBr A and dBr B
When the Analyzer Input is set to Analog, the dBr A and dBr B
values serve as the analog references for the dBr A and dBr B units
selectable at any meter measuring amplitude.

� Freq
The frequency (Freq) value serves as the reference for the relative
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frequency units (octaves, decades, % Hz, etc.) of Analyzer
frequency meters.

� V/FS
In some setups when ATS-2 is measuring a signal in one domain
(digital or analog), you may find it more convenient to enter or view
the equivalent of the signal in the other domain. The V/FS (volts for
full scale) value is the analog-to-digital scaling value.
When testing an external ADC, for example, enter the value of
analog input voltage that produces digital full scale output into this
field. Then you can select amplitude meter units as V, Vp, Vpp,
dBu, or dBV to express the measured digital amplitude in terms of
the analog input value to the converter.
In the same way, the dBr A and dBr B reference values may also be
entered as digital or analog domain units, with the V/FS reference
value being used to scale the references.

� Watts
The watt is a unit of power, not voltage. Since power calculations are
dependent on the circuit impedance, the load impedance
encountered in your test must be entered as a reference for accurate
display of watts (W) measurements. 8 � is the default impedance
for the watts reference.

Analyzer Digital References

� dBr A and dBr B
When the Analyzer Input is set to Digital, the dBr A and dBr B
values serve as the digital references for the dBr A and dBr B units
selectable at any meter measuring amplitude.

� Freq
The frequency (Freq) value serves as the reference for the relative
frequency units (octaves, decades, % Hz, etc.) of Analyzer
frequency meters.

� V/FS
In some setups when ATS-2 is measuring a signal in one domain
(digital or analog), you may find it more convenient to enter or view
the equivalent of the signal in the other domain. The V/FS (volts for
full scale) value is the analog-to-digital scaling value.
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When testing an external ADC, for example, enter the value of
analog input voltage that produces digital full scale output into this
field. Then you can select amplitude meter units as V, Vp, Vpp,
dBu, or dBV to express the measured digital amplitude in terms of
the analog input value to the converter.
In the same way, the dBr A and dBr B reference values may also be
entered as digital or analog domain units, with the V/FS reference
value being used to scale the references.
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Chapter 11

The Spectrum Analyzer

Introduction

The Spectrum Analyzer is a DSP instrument selection on the Analyzer
panel. It is named “FFT” on instrument browser lists and in OLE
references.

The Spectrum Analyzer is a general-purpose waveform display and
spectrum analyzer for ATS-2. It provides both

� time domain (oscilloscope) display of waveforms, and

� frequency domain (spectrum analyzer) views.
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The Spectrum Analyzer can analyze and display analog input signals
up to 120 kHz (with the optional high bandwidth ADCs) and digital signals
up to 108 kHz.

Features include large, dedicated memory buffers, flexible triggering,
averaging techniques, waveform processing, selectable display methods, a
wide choice of FFT windowing functions, and the capability of shifting a
sinewave signal to a bin center for synchronous analysis.

This chapter examines each function, control and display of the
Spectrum Analyzer in detail. If you are new to ATS-2, you might want
to start with the Quick Guides in Getting Started with ATS-2, which will
introduce you to Spectrum Analyzer features.

See Appendix C for a conceptual overview of FFTs.

Loading the Spectrum Analyzer

To use the Spectrum Analyzer, first open the Analyzer panel. The
Analyzer panel is a command selection on the Panel menu, and is also
available by the keyboard shortcut Ctrl+Y, or by clicking the Analyzer
icon on the Toolbar.

Now select FFT Spectrum Analyzer from the list on the Analyzer
panel. This loads the Spectrum Analyzer program into DSP.

Signal Inputs

The Input field of the Spectrum Analyzer offers four signal input
selections:

� Digital, and
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� Analog.
These choices access the signals routed from the Digital Input/Output
(DIO) panel or the Analog Input panel, respectively.

� ChA Analog/ChB Jitter (UI), and

� ChA Analog/ChB Jitter (sec).
These choices apply the Channel A signal from the Analog Input
panel to the Spectrum Analyzer Channel A input, and the jitter
signal from the DIO to the Channel B input. The only difference
between the two choices are the units selected for the jitter
measurements, unit intervals (UI) or seconds.

Digital signals are applied directly to the Spectrum Analyzer DSP;
analog signals are first digitized by precision ADCs (selected on the Analog
Input panel) before being applied to the Spectrum Analyzer.

To configure analog input connectors, range, coupling, select ADCs,
bandwidth, and so on, go to the Analog Input panel (see Chapter 6). To
configure digital input connectors, digital input format and other aspects of
the interface, go to the DIO panel (see Chapter 7).

Peak Level Monitors

The two Peak Mon meters on the Spectrum Analyzer panel
continuously display the peak amplitude of the digital signal as it is
presented to the Spectrum Analyzer. Only digital domain units (FFS,
dBFS, %FS, or bits) are available for these meters.

The primary purpose of the peak monitors is to avoid overload of the
input analog-to-digital converters (ADCs). When signal is being acquired
from the analog source and Auto Range is in use on the Analog Input
panel, ADC overload should never be a problem. If any of the Analog
Input range controls is fixed, you must verify that the maximum signal
amplitude never exceeds digital full scale.

Acquiring, Transforming and Processing

The Spectrum Analyzer instrument acquires, transforms, processes and
displays data in distinct steps. For a frequency domain (spectrum) view,
there are three steps:
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� acquiring the data,

� performing the FFT, and

� processing the results for graphing.

Often all these steps are performed in quick succession for each
spectrum display. At other times, only the last step or two are performed
on an acquisition or set of transform results already in memory.

For a time domain (oscilloscope) view, there are only two steps:

� acquiring the data, and

� processing the results for graphing.

Three sets of commands control the Spectrum Analyzer processes:

� Sweep > Start / Go / F9
These commands are all equivalent, and perform all three steps: a
new acquisition is made, the data is transformed, and the results are
processed for display.

� Sweep > Transform w/o Acquire, / F6
These two commands are equivalent, and perform the two last steps:
the acquired data is transformed, and the results are processed for
display. No new acquisition is made.

� Sweep > Reprocess Data / Ctrl-F6
These two commands are equivalent, and perform the last step: the
results are processed for display. No new acquisition is made and no
new transform is performed.

For the time domain view, F6 and Ctrl-F6 have the same result.

Making a new acquisition is usually the most time-consuming step in the
process; performing the transform is next and processing the results for
display is usually the fastest step. When time becomes an important
consideration, as in repeated automated processes, you should take care
to include only necessary FFT steps.
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The Acquisition Record

See Appendix C for a conceptual overview of FFTs, including a
discussion of the acquisition record and FFT length.

In performing an FFT ATS-2 first acquires data, taking a brief sample of
the signal to be analyzed. This acquired data is called the acquisition
record, and it is stored in a location in ATS-2’s DSP memory called the
acquisition buffer. The two channels of a stereo acquisition are maintained
in two separate acquisition buffers.

Acquiring the data and performing the FFT are two separate steps. You
can choose to acquire new data with each execution of an FFT, or you can
re-transform the same acquired data repeatedly, using different processing
or timing settings with each FFT.

When using the Spectrum Analyzer, the Sweep > Start (F9)
command both acquires new data and performs the FFT. Additional menu
commands Sweep > Transform data w/o Acquire (F6) and Sweep >
Reprocess Data (Ctrl+F6) provide you with other options. These
commands are discussed in more detail on page 147.

The acquired signal may be viewed in the frequency domain by
selecting FFT.Frequency for Source 1 and choosing the desired Start
and Stop values on the Sweep panel.

Any portion of the acquired signal may be viewed in the time domain
by selecting FFT.Time for Source 1 and choosing the desired Start and
Stop values on the Sweep panel.

You can easily set up a new FFT and then toggle between time domain
and frequency domain views using the Sweep Spectrum/Waveform
Button, which is discussed on page 172.

Both channels of the acquired waveform remain in the DSP acquisition
buffer until one of the following events occurs:
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� a Sweep > Start (or Go or F9) command is issued to acquire new
waveforms;

� a different Analyzer instrument is loaded;

� power is turned off to ATS-2; or

� a different acquisition waveform is loaded from disk as described in
Loading Acquired Waveforms on page 174.

While the waveform is still present in the acquisition buffer, full flexibility
exists to change back and forth between time and frequency domain
analysis. You may view different time portions of the record, perform FFTs
of different transform lengths, position the transform starting point at
different places in the record, change window functions, change FFT post-
processing modes, change time domain processing modes, etc. The results
of any and all of these different modes of analysis may be saved as .ats2
test files.

Saving a test file, however, does not save the acquired waveform, only
the test setup and results. It is possible to also save the acquired waveform,
which can be reloaded at a later time for further analysis. See Saving
Acquired Waveforms on page 173.

Acquisition Length

Set the length of the acquisition by selecting a value from the Acquire
list. The acquisition lengths are stated in samples; the duration of the
acquisition will depend on the sample rate in use. At a sample rate of
48 kHz, a 256k acquisition will have a duration of 5.46 seconds.
Acquisitions can be equal to or longer than the FFT length you intend to
use. A longer acquisition enables you to perform transformations at
different points along the length of the acquired record.

By choosing Track FFT, you can set ATS-2 to acquire only the amount
of data needed for the present transform length, which is set in the FFT
field to the left. This provides faster performance than acquiring more data
than is needed. See Transform Length, below.
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Transform Length

The transform length and sample rate determine the bin width (or
frequency resolution) of an FFT. See Appendix C for a conceptual
overview of FFTs, including a discussion of the relationship between
transform length, sample rate and bin width.

Select an FFT length from the FFT list. Your choices are 256, 512,
1024, 2048, 4096, 8192, 16384, and 32768 samples.

When you are performing an FFT on an acquisition record which is
longer than the transform length, only the number of samples specified in
the FFT field will be transformed.

Spectrum Analyzer Window Selection

See Appendix C for a conceptual overview of FFTs, including basic
information on FFT windowing.

The window selections for the Spectrum Analyzer are

� Blackman-Harris

� Hann

� Flat-top

� Equiripple

� None
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� None, move to bin center

� Hamming

� Gaussian

� Rife-Vincent 4, and

� Rife-Vincent 5.

Each window function has a different set of trade-offs in effective
selectivity and in potential amplitude measurement error.

The Hamming and Hann windows, for example have the best selectivity
near the top of the window but limited rejection of signals more distant
from the center. The Blackman-Harris, Equiripple, and Rife-Vincent
windows have much better rejection of more distant signals. The Flat-Top
window has the poorest selectivity, but virtually no amplitude error across
the center three bins.

See Figures 132 and 133 for comparison of the close-in selectivity
curves of the Spectrum Analyzer FFT windowing choices.

The window function is applied after signal acquisition and before the
transform, which means that you can change the FFT Window selection
and re-transform the data using the F6 command, without making another
acquisition. You can compare the effects of several different window
functions on the same signal acquisition by checking the Append box on
the Sweep panel and using F6 to re-transform the data with new window
settings.
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Hann Window

The Hann window is a raised cosine window named after its inventor,
Austrian meteorologist Julius von Hann. It provides good selectivity near
the top of the main lobe (about –6 dB one bin away from center and
about –30 dB two bins away), with no sidelobes. Its skirts more than 3 bins
off center are not as steep as the Blackman-Harris window. The Hann
window causes approximately –1.5 dB maximum amplitude error due to
window attenuation, if the signal is at the extreme edge of the bin.

Blackman-Harris Window

The Blackman-Harris 4-term minimum sidelobe window was developed
by R. B. Blackman and F. J. Harris. Compared to the Hann window, it is
not quite as selective across the central several bins (about –3 dB in the
adjacent bins and about –14 dB two bins off), but has steeper skirts
beyond that point. The Blackman-Harris window has sidelobes below
–92 dB (response fall-off is not monotonic). It has a reasonably flat top
with a maximum amplitude error of about –0.8 dB if the signal is at the
extreme edge of the bin.

Flat-Top Window

The Flat-Top window is designed for the greatest amplitude
measurement accuracy. It provides a maximum amplitude error due to
window attenuation of less than –0.02 dB. However, its selectivity is
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poorer than the other windows. The Flat-Top window is the appropriate
window for accurate amplitude measurements (such as when measuring
individual harmonics) except when signals are so closely spaced that its
selectivity becomes a problem.

Equiripple Window

The Equiripple window, developed at Audio Precision, is an
approximation to the Dolph-Chebyshev window that has the narrowest
main lobe width for a given maximum sidelobe depth. The main lobe is
approximately 12 bins wide; that is, the first null is about six bins from the
main lobe center. The first sidelobe, which is also the highest, is –147 dB
from the main lobe. The maximum amplitude error with a signal at the bin
boundary is about 0.5 dB.

Hamming Window

The Hamming window has the sharpest selectivity of all the windows
provided. Adjacent bins average about –7 dB and two bins away the
response is about –40 dB. Amplitude error is about –1.7 dB for a signal at
the extreme edge of a bin. The sidelobes of the Hamming start at only
–40 dB to –50 dB below the top of the main lobe, about 4 bins away from
the center bin. The response fall-off is not monotonic.

Gaussian Window

The Gaussian window main lobe width is only slightly wider than the
Blackman-Harris window and the nearby rejection is considerably better
than Blackman-Harris, reaching an average of –100 dB down in the fifth
bin away from center. The sidelobes are down more than –130 dB,
compared to about –100 dB for Blackman-Harris. Maximum amplitude
error is about –0.7 dB for a signal at bin edge.

Rife-Vincent Windows

Both Rife-Vincent windows have smooth, monotonically-falling
responses with no sidelobes. The Rife-Vincent 4 window has about
–0.6 dB maximum amplitude error, is about –100 dB at 7 bins off center
and about –150 dB at 15 bins off. The Rife-Vincent 5 is slightly wider at
the top of the main lobe, with about –0.5 dB maximum amplitude error. It
has sharper skirts with attenuation reaching about –106 dB at 7 bins off
center and about –150 dB at 12 bins off.
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None (No Window or Rectangular Window)

The None selection (sometimes called a rectangular window) does not
apply any window function before the FFT. This mode is normally used
only with synchronous signals; it is not generally useful for non-
synchronous signals since energy will be spread across the entire spectrum
unless the signal is exactly at bin center. The amplitude error due to the
rectangular window attenuation is about 4 dB.

None, move to bin center

This choice also does not apply a window function, but it is not
restricted to signals that are synchronous. None, move to bin center
may be used with any signal which consists only of a single sinewave and
any harmonically-related distortion products. For signals that are
non-synchronous, this selection modifies the signal so that it becomes
synchronous.

None, move to bin center shifts the fundamental frequency of the
signal to the center of the nearest bin, which is the same as stretching or
compressing the waveform so that an integer number of cycles fits exactly
in the transform length. See Appendix C for a conceptual overview of
FFTs, including basic information on synchronous FFTs.

When used with a single sinewave, this technique results in excellent
selectivity, with the signal spreading to the adjacent FFT bin normally
120 dB down or more. Due to the correction, the signal in the DSP buffer
will now be at an exact bin center and NOT at the original frequency.

Here’s an example: assume that you want to test an ADC operating at a
48.00 kHz sample rate, using a test signal frequency of 997 Hz. This
frequency is often chosen because it is non-synchronous with the sample
rate and causes the converter under test to be exercised through a large
number of its possible states.

With an FFT length of 16,384 samples, the two nearest synchronous
frequencies are 996.09375 Hz (exactly 340 cycles in the buffer) and
999.0234375 Hz (exactly 341 cycles). The None, move to bin center
mode of the FFT program will shift the frequency of the acquired 997 Hz
signal in DSP memory down to 996.09375 Hz (the nearest synchronous
frequency) and then perform a windowless FFT.

The result: the ADC under test was exercised at 997 Hz, as desired; and
the frequency correction yielded an unwindowed FFT with high selectivity,
as if the signal had been at the synchronous frequency of 996.09375 Hz.

The frequency correction technique has a maximum correction range of
±4%. At the low end of the frequency range there will be frequencies
which are more than 4% from a bin center. For example, with a
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16,384-sample transform and 48 kHz rate, 37 Hz is approximately the
lower limit above which a sinewave at any arbitrary frequency can be
guaranteed to be brought to a synchronous frequency.

The technique will work at still lower frequencies if the signal frequency
is within 4% of a synchronous bin center frequency. Bin center frequencies
may be computed from the equation

� �
Frequency

N Sample Rate

Transform Length
�

�
,

where N is the integer number of cycles in the transform.

For example, with N = 7 (exactly seven complete cycles in the FFT
buffer), a transform length of 16,384 and a 48 kHz rate, the synchronous
frequency is 20.5078125 Hz. A ±4% range around that frequency extends
from approximately 19.7 Hz to 21.3 Hz, and a sinewave within that range
will be corrected to the synchronous frequency.

When using Sweep Append and Sweep Repeat with None, move to
bin center as the Window selection, the frequency shift will be
performed only once and not with every Append or Repeat operation.

Quasi-AC Coupling

The Spectrum Analyzer can be dc coupled to the input signal, or can
operate in one of two modes of quasi-ac coupling. The field at the right of
the Window selection field offers three choices:

� DC Coupled

� Subtract Avg
When Subtract Avg is selected, the DSP computes the average
value of all samples in the acquisition buffer and subtracts that
computed value from the value of each sample, before the FFT or
waveform display is performed. For noisy signals, the Subtract Avg
selection generally results in better dc rejection than the Subtract ½
pk-pk selection.

� Subtract ½ pk-pk.
The Subtract ½ pk-pk selection computes the maximum difference
between positive and negative peak values in the acquisition buffer
and subtracts half that amount from each sample, before the FFT or
waveform display is performed. For symmetric, low-noise signals, the
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Figure 134. ATS-2 Spectrum Analyzer

coupling selections.



Subtract ½ pk-pk selection generally results in better dc rejection
than the Subtract Avg selection.

The general effect of either of these selections is similar to having used
ac coupling before acquiring the signal, as long as no signal peaks
exceeded digital full scale.

Use of either of the quasi-ac coupling functions may be valuable when
examining low-level signals that have large dc offsets, particularly in time
domain (oscilloscope) presentations where the dc offset might otherwise
cause the signal to be off-screen. Either selection may introduce dc error,
particularly on very low frequency signals.

Also see Triggering with Quasi-AC Coupling on page 172.

Averaging

The Spectrum Analyzer provides two fundamentally different averaging
techniques for better ability to measure program material and noise, or
low-level and other noisy signals. These are:

� synchronous averaging, and

� power (spectrum) averaging.

Both techniques average the signal over a specified number of
acquisitions. They do this by summing the signals from all acquisitions and
dividing the result by the number of acquisitions.

Synchronous averaging operates on the time-domain signal, which
makes it useful not only for time-domain (oscilloscope) display but also for
frequency-domain (spectrum) analysis, since the source of the signal for
spectrum analysis is the time-domain signal.
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Power (spectrum) averaging operates only on the frequency-domain
result. After each FFT is performed, the spectra for all passes are summed
and then divided by the number of passes.

During an averaging process, the Status Bar at the lower left of the
ATS-2 workspace counts down through the number of acquisitions as they
are performed.

Averaging factors from 2 to 4096 are available. A selection of 1
disables averaging.

Synchronous Averaging

The primary purpose of synchronous averaging is to reduce noise levels
in order to provide more accurate measurements of signals which would
otherwise be lost in the noise.

Synchronous averaging is performed on the acquired (time domain)
signal, so it can be used when viewing noisy signals in the time domain in
oscilloscope view.

Figure 136 shows a time domain display of –85 dBFS and –100 dBFS
16-bit sinewave signals with normal triangular dither and no averaging. All
that can really be seen is that one signal occupies the five lowest-amplitude
digital codes and the other occupies the three lowest codes.
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Figure 136. A time-domain view of –85 dBFS and –100 dBFS

16-bit sinewave signals, normal dither, no averaging.



Figure 137 is the same signal with 256x synchronous averaging,
triggered from the digital generator. The sinusoidal waveform is now
clearly visible.

Signal Alignment for Synchronous Averaging

In order for the amplitude of coherent signals to be preserved during
synchronous averaging, each new acquisition must be accurately
time-aligned with the previous acquisitions before it is added to the
accumulating signal in DSP memory. For some signals, time alignment
may be accomplished by proper triggering at acquisition. Other signals
may require a DSP re-alignment process. Also see Triggering with
Synchronous Averaging on page 170.

Because of the frequency-shifting that occurs using the None, move to
bin center Spectrum Analyzer Window selection, the synchronous
averaging choices change with the FFT windowing mode. For all FFT
Window selections except None, move to bin center the synchronous
choices are:

� Sync, re-align and

� Sync.

If None, move to bin center is selected as the FFT Window, there
are four synchronous choices:

� Sync, re-align, move center first

� Sync, re-align, average first

� Sync, move center first, and
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normal dither, 256x synchronous averaging, triggered from digital generator.



� Sync, average first.

Sync (without re-align)

When you are confident that nature of the signal and the triggering
selections on the Spectrum Analyzer panel are sufficient to cause each
acquisition to start at the same relative point on the waveform, choose one
of the synchronous selections that do not re-align. The “sync without
re-align” options require less digital signal processing and are faster.

Sync, re-align

For some signals, re-alignment may be necessary for synchronous
averaging. Choose one of the Sync, re-align options to select this
technique.

With re-align, signal is first acquired with any triggering selection
(including Free-running, which is untriggered). The DSP then “slides” the
signal forward or backward in time until it is aligned with the sum of
already-accumulated signals.

The final averaged result will start at the value set in the Delay field and
continue from that point for the Length value. Any signal before and after
is erased.

For example, if 8192 is selected in the FFT field and 100 ms is
entered in the Delay field (assuming that the Acquire field value is
sufficiently long to contain 100 ms plus 8192 samples), the final averaged
result will start at 100 ms and continue for a bit more than 8192 samples
beyond that point (to approximately 271 ms at a 48 kHz sample rate). A
time domain view or an FFT may then be made anywhere within that
8192 samples.

An FFT of a synchronously-sampled signal will be correct only if the
signal transformed, as determined by FFT Start Time and Length, lies
completely within the occupied portion of the buffer. In the example
above, any FFT Start Time less than 100 ms would produce erroneous
data. Any combination of Start Time and Length extending beyond the
271 ms point would also produce bad data.

Synchronous Averaging for “Move to bin center” operations

With None, move to bin center in the Window field, time aligning is
more complicated because of the frequency shift imposed upon the
acquired signal. The two “average first” selections will provide faster
operation since the “move to bin center” operation is only done once,
following all acquisitions and averaging. The “move center first”
selections perform the bin centering operation at each acquisition,
increasing the measurement time.
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However, if the signal frequency changes from acquisition to acquisition
because of flutter or drift, the move center first selections may provide
more accurate measurements. Frequency changes during synchronous
averaging will result in amplitude errors since the signals will not be
time-aligned at the end of the buffer even if they are synchronized at their
initial zero crossing.

Synchronous Averaging and Frequency Domain Views

As stated before, synchronous averaging is performed on the signal
acquisition in the time domain. Since the frequency domain (spectrum)
view uses this time domain acquisition, synchronous averaging is also
useful for frequency domain views.

With synchronous averaging and time alignment via proper triggering or
the Sync, re-align mode, coherent components will be unchanged by the
averaging process. The average value of noise components will be reduced
by 3 dB for each doubling of the averaging factor. Figures 138 and 139
show the same signal conditions, but Figure 139 has been averaged over
128 acquisitions using synchronous averaging. Note that the peak-to-peak
variance of the noise is still approximately as it was with no averaging, but
the average level of the noise is now approximately –180 dBV. This
lowered noise floor makes clearly visible a 9 kHz distortion product,
another peak at 12 kHz and the hint of another at 6 kHz.
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Power (Spectrum) Averaging

Spectrum averaging operates only on the frequency domain (amplitude
vs. frequency) results following an FFT. It will not operate if a time domain
display (FFT.Time at Source 1) has been selected.

The primary purpose of spectrum averaging is to provide a more
accurate measurement of the amplitude versus frequency characteristics of
varying signals. ATS-2 uses power-law (root-mean-square) averaging to
correctly average noise signals.

Averaging over many seconds or minutes of noise or of program
material such as music or voice is very useful in order to determine the
long-term average amplitude vs. frequency distribution.

Coherent (steady or continuous) signals will be unaffected by spectrum
averaging. Variable signals such as noise and program material will
converge to their average values at each frequency as the averaging factor
is increased. The result is that the peak-to-peak variance in the displayed
noise floor or program material is reduced while coherent signal
amplitudes are unchanged. The average level of the noise floor is not
changed.
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Figure 139. Low-level signal viewed in the frequency domain, averaged with 128x

synchronous (time domain) averaging. Average noise level is reduced from noise level

shown in Figure 138, with no change in noise variance.



Figure 140 shows the same signal illustrated in Figure 138 after 128x
spectrum averaging. Note that the average level of the noise is about
–160 dBV in either case, but the peak-to-peak variance in the noise has
been reduced by the spectrum averaging. The slight rise in noise levels at
high frequency due to noise-shaped dither is visible in the averaged result
but not on any single acquisition and FFT.

Coherent signals very near the noise floor, such as the distortion product
at 9 kHz in Figure 140, may become visible as the noise converges to its
average value.

Spectrum averaging is selectable in the field to the right of the Avgs
label as Power (spectrum only).

If a time domain view is selected following a spectrum

averaging process, the Reprocess Data command (Ctrl+F6)

must be used to view the time domain data, rather than the

Transform Data w/o Acquire (F6) command. Only the last

acquisition of the series of averaged acquisitions will be

viewed. See page 147 for more information.

Display Processing

Waveform (time domain) Display Processing

Four modes are available in the Spectrum Analyzer for processing the
amplitude-versus-time relationship of a sampled signal before displaying
the waveform. These modes are applicable only to time domain
(oscilloscope) views and have no effect on frequency domain FFT
spectrum analysis views.

Display Processing Chapter 11: The Spectrum Analyzer

ATS-2 User’s Manual 163

Figure 140. Low-level signal viewed in the frequency domain, 128x Power (spectrum

Only) averaging. Noise variance is reduced from noise variance shown in Figure 138,

with no change in average noise level.



The display processing setting determines how the data is modified for
display when the spacing of the sweep points is different from the spacing
of sample points in the acquisition.

The four modes available in the Wave Display field are:

� Interpolate

� Display Samples

� Peak Values, and

� Absolute Values.

Interpolate

When Interpolate is selected the DSP compares the density of sweep
points requested with the density of sample points available in the
acquisition, for the time span of the current sweep and graph.

If the requested points are much fewer than the acquisition points, the
DSP uses a bipolar peak sensing mode to eliminate potential graphic
aliasing problems; otherwise, it interpolates. See Graphic Aliasing on
page 166.

In the bipolar peak sensing mode, the signal waveform is not faithfully
represented but is replaced with an approximation indicating the positive
and negative peak excursions of the signal.

If you use the graph Zoom and Zoomout commands, the time span
represented on the graph changes. When Interpolate is selected, Wave
Display automatically switches between bipolar peak sensing mode and
interpolation mode for the best display.

The Interpolate selection produces a much more accurate display of
the signal waveform than the Display Samples mode when the signal
frequency is high (such as sample rate/100 or higher).

Display Samples

When Display Samples is selected, for each display point requested
the DSP sends the amplitude of the nearest-in-time acquired sample to the
computer for plotting. Acquisition sample values may be repeated or
dropped, depending upon the relationship of acquisition sample density to
display point density.

This mode is useful when examining the true, quantization-limited
waveforms of very low amplitude digital domain signals.

When the signal frequency is low compared to the sample rate, Display
Samples will produce an acceptable representation of the original signal
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waveform. At high signal frequencies, the waveform may be entirely
unrecognizable because of graphic aliasing (see page 165); in such a case,
the Interpolation mode should normally be used.

Peak Values

When Peak Values is selected, the DSP searches all sample amplitudes
in the acquisition buffer between each pair of X-axis time values plotted,
and sends to the computer for plotting the largest positive or negative
value in that span, preserving the sign.

Since all sample values are examined, no signal peaks can be missed.

Absolute Values

When Absolute Values mode is selected, the DSP searches all sample
amplitudes in each plotted-point-to-plotted-point span as it does in Peak
Values mode, but takes the absolute value of the largest positive or
negative value, always sending a positive number to the computer.

Logarithms may be computed when all the numbers involved are
positive, so Absolute Values mode brings the advantage that decibel
units may be used on the Y-axis to display the waveform.

Waveform display with Absolute Values mode can create a wide-
dynamic-range oscilloscope view that displays the envelope of an audio
signal, calibrated in units such as dBV, dBu, and so on.

Absolute Values mode is most effective at representing the

signal envelope when the X-axis span and the Sweep panel

Points values are selected to produce approximately two

plotted points per cycle of the waveform being graphed. For

example, if an envelope display of tone burst waveforms of a

1 kHz signal (1 ms period) is being plotted across a 50 ms

span, the Points value on the Sweep panel should be set to

approximately 100.
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Graphic Aliasing

When the density of samples is high compared to the density of graph
points requested by the sweep Steps setting, many samples will be
skipped and not plotted. Depending upon the signal and settings,
waveforms very different from the signal waveform may be displayed. This
is called graphic aliasing.

ATS-2 has provided several display processing modes (discussed in
detail previously) that minimize graphic aliasing problems. You can help
avoid graphic aliasing in the following ways, as appropriate to your test:

� Use a larger number of sweep Steps.

� Use a shorter sweep span.

� Use the Interpolate display processing mode. Interpolate
automatically switches from interpolation to bipolar peak sensing to
avoid graphic aliasing.

� Use the Peak Values or Absolute Values modes, if appropriate.

The Display Samples display mode is most likely to exhibit graphic
aliasing. If you use Display Samples, be sure that the number of graph
points is sufficient to correctly display the number of sample points in the
time span.

Spectrum (frequency domain) Display Processing

If the distance between the Steps in a sweep is greater than the width
of one bin, plotted points are selected by a mechanism called peak picking.
With peak picking, the DSP searches all bins between the previous plotted
point and the current point, and plots the highest bin amplitude within that
range. This ensures that no peaks are missed. Peak picking is used for all
ATS-2 FFT-generated frequency domain displays.
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Figure 141. An example of graphic aliasing, where a large number of samples is

represented by a small number of graph points, resulting in the display of an alias

waveform.



FFT Start Time

You can select any point in the acquired signal record as the beginning
of the portion to be transformed. This is the FFT Start Time.

The FFT is then computed for the contiguous section of samples starting
at the sample at the start time, and continuing for the number of samples
chosen in the Length field. This permits selective spectrum analyses of
different sections of complex signals such as program material, or special
test signals such as sinewave bursts.

To change the value of FFT Start Time, click in the field and type in a
new number from the keyboard. The acceptable range of numbers
depends upon the sample rate of the input signal for any particular
acquisition buffer length, in samples. At a 48 kHz sample rate with a
16,384 sample acquisition buffer, for example, the FFT Start Time field
will accept numbers up to 341 ms.

If the original signal acquisition was made with a negative value in the
trigger Delay field, negative values up to and including that same value
may be used as FFT Start Time values, permitting spectrum analysis of
the pre-trigger section of the acquired record.

Triggering

The Trigger section of the Spectrum Analyzer consists of the Source
field, a Sens (sensitivity) or Lev (level) field for certain trigger Source
selections, and the Slope option buttons to select positive or negative
slopes. Acquisition of signal into the FFT acquisition buffer may start
immediately at Sweep Start, or may wait for a trigger event, depending
upon the setting of the Source field.

The selections are:

� Free Run
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� ChA Auto

� ChA Fixed Sens

� ChB Auto

� ChB Fixed Sens

� Trig In (Ext)

� Digital Gen

� Analog Gen

� Line (Mains)

� Jitter Gen

� ChA Fixed Lev

� ChB Fixed Lev

Free Run

When Free Run is selected, signal acquisition begins immediately after
Sweep Start (F9 or Go) is initiated, regardless of signal amplitude.

Auto

The ChA Auto and ChB Auto selections will cause triggering at
one-half the peak-to-peak value if the selected channel has a signal
amplitude greater than digital infinity zero.

Fixed Sensitivity

ChA Fixed Sens and ChB Fixed Sens use the value set in the Sens
(sensitivity) field as the triggering threshold. The Sens field appears only
when one of these two selections is made.

An FFT acquisition will trigger on the first zero crossing of the selected
slope (positive or negative, set with the adjacent option buttons) that
occurs after the signal amplitude is sufficient to swing both through zero
and the Sens value.

If the signal contains a sufficient DC offset such that it does not swing
through zero, no triggering will take place. In this case, use one of the
quasi-AC coupling modes (Subtract Avg or Sub ½ pk-pk) that will
cause the processed signal to pass through zero and permit triggering to
function.
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Trig In (Ext)

The Trig In (Ext) selection refers to the TRIG IN BNC connector on
the rear of the ATS-2 chassis. The trigger circuitry is edge-sensitive, and an
FFT acquisition will trigger on a positive-going or negative-going edge on
the signal at this connector, depending upon the setting of the trigger
Slope buttons.

Digital Gen

If the Digital Generator is outputting any waveform except an Arbitrary
Waveform, a Digital Gen trigger occurs at each cycle of the waveform.

If the Digital Generator is outputting an Arbitrary Waveform (that is, a
signal from a waveform file), a Digital Gen trigger occurs at the first
sample of the waveform.

Analog Gen

If the Analog Generator is outputting any waveform except an Arbitrary
Waveform, an Analog Gen trigger occurs at each cycle of the waveform.

If the Analog Generator is outputting an Arbitrary Waveform (that is, a
signal from a waveform file), an Analog Gen trigger occurs at the first
sample of the waveform.

Line (Mains)

The Line (Mains) provides a trigger at each cycle of the AC waveform
of the mains line powering ATS-2.

Jitter Gen

The Jitter Gen selection provides a trigger at each cycle of the
waveform selected in the Jitter Generation section on the DIO panel.
This provides stable viewing of the jitter waveform generated by ATS-2.

Fixed Level

The ChA Fixed Lev and ChB Fixed Lev fields operate identically to
conventional oscilloscope triggering.

When either of these trigger selections is chosen, a level (Lev) setting
field is displayed. Positive or negative values may be entered into this field.
An acquisition will be triggered the first time the signal with the specified
slope (positive or negative) passes through this level.
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Trigger Delay Time

If a negative value was entered in the trigger Delay field

before Sweep Start was pressed, the portion of the record

selected for transform by the FFT Start Time field can

extend back into the pre-trigger portion of the record by

entering a negative value in the FFT Start Time field.

The Spectrum Analyzer instrument has the ability to fill the
acquisition buffer with signal samples beginning at the moment of the
triggering event, or starting at a defined time before or after the trigger
occurs. This time is set in the trigger Delay field.

This enables analysis of signal conditions both before and after the
triggering event.

A negative value entered in the Delay field determines the length of
time prior to the trigger event signal that samples are retained. The total
length of signal acquired will be as defined in the Length field, with the
remainder of the acquisition buffer filled after the trigger.

For example, with the Acquire set to 24k the length of the acquisition
buffer for each channel is 512 ms at a 48 kHz sample rate. If the trigger
Delay time value is –50 ms, then 462 additional milliseconds of signal
following the trigger will also be acquired to fill the entire 512 ms buffer.

Trigger Slope

See Figure 143.

To the right of the trigger Source field are the trigger Slope buttons.
Selecting Pos causes triggering to occur on a positive-going portion of the
trigger source signal, while Neg causes triggering on a negative-going
waveform.

Triggering with Synchronous Averaging

Synchronous averaging, which depends on the precise alignment of
many acquisitions, requires careful consideration of triggering techniques.
See Synchronous Averaging on page 157.
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Figure 143. ATS-2 Trigger Delay and

Slope selections.



Without Re-alignment

If synchronous averaging without re-align mode is used, proper
triggering is absolutely essential. Random, untriggered acquisitions will not
be aligned in time, resulting in cancellation of coherent signals and large
amplitude errors.

In stimulus-response testing from ATS-2, either the Analog Gen or
Digital Gen (as appropriate) FFT trigger sources should be used. If an
external signal is presented from another signal source, one of the ChA or
ChB selections should be used as trigger source.

If signals are being acquired on both channels without re-align, they
must be at the same frequency or must have harmonically-related
frequencies. Sync without re-align will properly measure only signals
harmonically related to the trigger source. A signal whose frequency is not
related to the trigger source may have large amplitude errors or may
entirely disappear.

With Re-alignment

The re-align mode should be used for accurate amplitude
measurements on all signals above about 10% of the sample rate. Without
realignment, the random time relationship between the signal itself and
ATS-2’s sample clock will cause random misalignment up to ½ clock
period, resulting in partial cancellation that becomes objectionable at high
frequencies. Realignment works with interpolated versions of the signal
and aligns accurately, producing accurate amplitude measurements even
at high frequencies.

The re-align mode works independently on each channel. If the two
channels carry different frequency signals, re-align mode must be used.

The primary disadvantage of the re-align mode is the additional time
taken by the DSP to do the operation after each acquisition.

The synchronous averaging with re-align

� acquires signal according to whatever triggering selections are in use,

� interpolates the acquired signal between the actual sample values,

� locates the first positive-going zero crossing in the interpolated data,

� time-aligns that with the first zero crossing in the accumulated record,
and

� adds the signal from that point onwards into the averaging buffer.

This process is carried out after each of the series of acquisitions to be
averaged, resulting in precise time alignment.
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Triggering is not critically important in this mode if the signal is not noisy
and the signal repetition rate is relatively high, since the necessary
alignment takes place in the DSP buffer after acquisition.

Noisy signals may not be correctly aligned by this mode, resulting in
amplitude error.

Triggering with Quasi-AC Coupling

The Spectrum Analyzer’s quasi-ac coupling (see page 156) occurs
before acquisition triggering, so the selection must be considered when
attempting to trigger on a low-level portion of a signal.

In the synchronous averaging mode, the DSP must find a zero crossing
in order to time-align waveforms for averaging. If the waveform contains
sufficient dc, there will be no zero crossings. If this dc is removed before
averaging there will be zero crossings, permitting alignment.

The Subtract Avg mode may introduce error on low frequency signals
that could be a problem for the DSP in finding zero-crossing locations. For
well-behaved signals the Subtract ½ pk-pk function should produce
acceptable results.

References

Analog and digital amplitude and frequency references for the Spectrum
Analyzer are the same as for other Analyzer instruments. See Analyzer
Analog References on page 142 and Analyzer Digital References on
page 143.

The Sweep Spectrum/Waveform Button

ATS-2 provides a dedicated FFT button for simplified Sweep panel
setup and easy switching between frequency domain and time domain
viewing. This button is called the Sweep Spectrum/Waveform button
and is located on the Standard Toolbar. It is available when the Spectrum
Analyzer, the Multitone Audio Analyzer or the Digital Interface Analyzer is
the Analyzer instrument, and is grayed out under other conditions.

In a new test, first select the Spectrum Analyzer as the Analyzer
instrument, then click the Sweep Spectrum/Waveform button. This will
automatically enter Sweep panel settings for a two-channel FFT spectrum
display. Click Sweep Start and you will see the FFT plot on the Graph
panel.
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Click the Sweep Spectrum/Waveform button again, and the Sweep
panel settings will be re-set for a two-channel waveform display. Click
again and the display will toggle back to a spectrum display.

Clicking the Sweep Spectrum/Waveform button does not acquire or
re-acquire data; it only re-transforms the acquired waveform for time
domain or frequency domain display. Click Sweep Start to acquire new
data.

Once an FFT spectrum or waveform view has been set up on the
Sweep panel, a new button appears on the panel. In waveform view, this
button is labeled Spectrum; in spectrum view, it is labeled Waveform.
This button controls the same toggling functions as the Sweep
Spectrum/Waveform button.

Acquired Waveform Files

As with other ATS-2 tests, you can save the setup and results of any
Spectrum Analyzer tests as an .ats2 test file. The acquired waveform in the
FFT acquisition buffer, however, is not saved as part of a test. If you want
to keep the acquired data record for further analysis, you must save it as
an .aam (Audio Precision Acquisition Mono) or .aas (Audio Precision
Acquisition Stereo) acquired waveform file.

Single-channel “mono” waveforms saved at different times can later be
individually loaded into the two channels of the FFT acquisition buffer to
become “stereo” acquisitions for comparison in the time or frequency
domains.
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Figure 144. ATS-2 Sweep panel showing

“Waveform” toggle button.



Saving Acquired Waveforms

To save an acquisition, select the File > Save As menu command,
choosing either the Stereo Waveforms (.aas) or Mono Waveforms
(.aam) as the file type.

A stereo acquisition waveform file consists of two waveforms joined
together into a single file; a mono acquisition waveform file contains a
single waveform. To simultaneously save the waveforms from both
acquisition buffer channels A and B, select the stereo choice. To save only
one of the channels, select mono.

The left half of the dialog box defines what will be saved into the first
section of a waveform file and the right half defines what will go into the
second section of a stereo waveform. If the File > Save As > Mono
Waveform option was selected, the right half of the dialog will be gray.

You can save the entire acquisition record or just the portion currently
designated for transformation from either the channel A or channel B
acquisition data. If the transform length is shorter than the acquisition
record length, the waveform file will be correspondingly smaller.

Opening Acquired Waveforms
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Figure 146. ATS-2 Spectrum Analyzer

Open Stereo Waveform dialog box.

Figure 145. ATS-2 Spectrum Analyzer

Save Stereo Waveform dialog box.



To open an acquired waveform file, select the File > Open menu
command, choosing either the Stereo Waveforms (.aas) or Mono
Waveforms (.aam) as the file type.

You can load one waveform or simultaneously load both waveforms
into memory from a stereo file, and you can choose to assign the
waveform to either FFT channel and to the acquisition or the transform
buffers. A mono file only contains one waveform, but you have the same
flexibility to load it into either channel or either buffer. When opening a
mono waveform file, the right half of the dialog box will be gray.

If acquisition in a file to be opened is greater than the length

of the specified buffer, an error warning will be displayed and

the file will not be opened. If the acquisition length in the file

is shorter than the buffer size, erroneous analysis will result if

the selected FFT length extends beyond the last data sample

in the buffer. You can view the data in the time domain to

determine exactly where the signal ends.

Combining Mono to Stereo

To compare two single-channel acquisitions made at different times or
under different conditions, open the file containing the first acquisition
data. Assign the waveform to FFT channel A or B and load the data. Then
open the second waveform file and do the same, this time loading the data
into the opposite FFT channel.

The resulting two-channel acquisition can be transformed, processed
and viewed, and can be saved as a new stereo waveform file.

Compatibility of Acquired Waveform Files

The waveform files used by both the Spectrum Analyzer and the
Multitone Audio Analyzer have the same format, and with certain
restrictions on length, can be used by either instrument.

The Spectrum Analyzer has a larger acquisition buffer, and can open
waveform files up to 256k samples in length. Multitone is limited to
opening files with acquisitions of 32k or fewer samples.

Also, although any multitone waveform can be analyzed by the
Spectrum Analyzer, only properly-formatted waveform files are useful in
Multitone. See Chapter 13 for more information about the Multitone
Audio Analyzer.
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Chapter 12

The Digital Interface Analyzer

Overview

The Digital Interface Analyzer is an optional DSP instrument
selection on the Analyzer panel. It is named “Intervu” on instrument
browser lists and in OLE references.

The Digital Interface Analyzer brings to ATS-2 the capability for in-depth
analysis of the serial digital interface signal.

The Digital Interface Analyzer is included with the ATS-2

Performance Upgrade Option package. Check the serial

number / option label on the rear of the ATS-2 chassis to

verify the presence of the Performance Upgrade Option. If

this option is not installed, the Digital Interface Analyzer will

not be available on the Analyzer panel.

ATS-2 Digital Interface Analyzer Analysis Tools

The AES3/IEC60958 serial digital interface signal which carries the
embedded audio can be analyzed as a signal in its own right.

The ATS-2 digital input is connected to a receiver circuit that recovers
the timing information, the audio data and the non-audio data from the
serial digital interface signal. Basic information about the interface signal is
reported to the DIO panel, which displays real-time voltage and jitter
amplitude measurements, and flags up to four defined errors with panel
indicators. Also, the jitter signal appears as an input selection to the
Spectrum Analyzer for further analysis. For more information, see
Chapter 7 regarding interface measurements on the DIO panel, and
Chapter 11 for jitter analysis with the Spectrum Analyzer.
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The optional Digital Interface Analyzer provides additional capability,
adding powerful interface signal acquisition and analysis tools that are
discussed in this chapter.

See Appendix B for a discussion of digital audio and the serial digital
interface signal.

Digital Interface Analyzer Components

The Digital Interface Analyzer includes two key components: a
dedicated analog-to-digital converter (ADC) connected to the digital input,
and specialized FFT analysis and display tools.

The Digital Interface Analyzer ADC

The dedicated Digital Interface Analyzer ADC digitizes the interface
waveform as it enters ATS-2, providing a source of acquisitions for the
Digital Interface Analyzer FFT analysis. The ADC is an 8-bit converter with
an 80.00 MHz sample rate, providing an analysis capability with
approximately 30 MHz bandwidth. The Digital Interface Analyzer acquires
1,572,864 samples into its FFT acquisition buffer, resulting in 19.66 ms of
data.

Digital Interface Analyzer Capabilities

The Digital Interface Analyzer provides analysis results in three different
types of displays:

� time-domain waveform displays, including interface signal
waveforms, interface signal eye patterns and jitter signal waveforms,

� frequency-domain displays, including interface signal spectrum and
jitter signal spectrum, and

� statistical displays, including histograms of interface amplitude,
interface rate, interface bit width and jitter amplitude.

The Digital Interface Analyzer uses FFT analysis techniques that have
much in common with the techniques discussed in Chapter 11. Also see
Appendix C for a conceptual overview of FFTs.
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Loading the Digital Interface Analyzer

To use the Digital Interface Analyzer, first open the Analyzer panel.
The Analyzer panel is a command selection on the Panel menu, and is also
available by the keyboard shortcut Ctrl+Y, or by clicking the Analyzer
button on the Toolbar.

Now select INTERVU Digital Interface Analyzer from the list on the
Analyzer panel. This loads the Digital Interface Analyzer program into DSP.

The Digital Interface Analyzer panel

Unlike the other Analyzer instruments, the Digital Interface Analyzer
panel has no real-time meter displays. Although a number of settings and
preferences are made on the panel, all the results are displayed on the
Graph panel in conjunction with settings on the Sweep panel.
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Later in this chapter we will look at the Digital Interface Analyzer panel
in detail, but first we will look at the Sweep panel settings necessary to
create the nine basic Digital Interface Analyzer views.

The chart in Figure 149 shows the nine views and the Sweep Source 1
and Data 1 (and Data 2, for Eye Pattern) settings which define the views.
Also see InterVuMenu.atsb on page 192. InterVuMenu.atsb is a macro
that makes the Digital Interface Analyzer setup a one-click process,
combining a graphical menu interface with automated setup for the nine
Digital Interface Analyzer views.

Digital Interface Analyzer Waveform Views

The Digital Interface Analyzer offers two waveform views of the digital
interface signal and one of the interface jitter signal.

Interface Waveform

The interface waveform view shows the bi-phase mark encoded
bitstream which is the serial digital interface signal. The 3 UI-wide
preamble cell is clearly visible in this view, shown in Figure 150. See page
394 for an explanation of the unit interval, or UI.

As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Time, and

� Data 1 = Intervu.Amplitude.
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Figure 150. Digital Interface Analyzer interface waveform display.

‘Y” preamble followed by six data cells shown.



Source 1 range should be about ±5 V.

Data 1 range will vary according to your requirements, signal
conditions, sample rate, triggering choices and so on. A range of 0 s to
4 µs with a 48 kHz sample rate will show a preamble and a few data cells,
as in Figure 150; shorter spans will show pulse aberrations and rise and fall
times; a range of 0 s to 25 or 35 µs displays an entire frame.

On the Digital Interface Analyzer panel, Wave Display can be set to
any choice except Eye Pattern.

Eye Pattern

The eye pattern is a special view of the interface waveform which gives
a quick estimation of the quality of the signal.

With conventional oscilloscopes, the eye pattern is created by setting the
horizontal sweep to about one UI, triggered at the cell rate (2 UI). The
persistence of the screen phosphors (or the storage capabilities of the
scope) display an overlay of hundreds or thousands of data cells.

This produces a one-cell-wide display with a shape like an eye. The
inside of the eye is reduced horizontally by jitter (which moves the left and
right sides of the eye in and out); the eye is reduced vertically by noise
(which moves the top and bottom of the eye up and down) or by reduced
signal level; bandwidth reductions tip the leading or trailing sections of the
eye opening.

The Digital Interface Analyzer collects a long series of data cells (about
120,000 at a 48 kHz sample rate) and produces a graphic display
equivalent to the inside of an eye pattern on an oscilloscope.

AES3 specifies a minimum eye opening of 200 mV vertically by 0.5 UI
horizontally. The AES3 minimum can be superimposed as a reference on
the eye pattern display by entering these values into a Limit file. The file
48kAES3 Eye-Pattern.atsl is provided as a sample of such a Limit file.

On the Digital Interface Analyzer panel, Wave Display must be set to
Eye Pattern.
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As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Time,

� Data 1 = Intervu.Lower Eye Opening, and

� Data 3 = Intervu.Upper Eye Opening.

If you set Wave Display to Eye Pattern and then check Stereo Sweep
on the Sweep panel, these selections will be made.

Source 1 range should be 0 ns to about 165 ns, and Data 1 and
Data 3 ranges should be about ±3 V. These will vary according to your
requirements, signal conditions, sample rate, triggering choices and so on.
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Jitter Waveform

The jitter modulating the interface waveform can be recovered and
viewed as a signal in its own right. This selection shows the jitter waveform
in the time domain.

As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Time, and

� Data 1 = Intervu.Jitter(sec) or Intervu.Jitter(UI)

Jitter is a time modulation, and jitter amplitude is expressed in units of
time, either in seconds or in UI. You choose between the two expressions
when you make your jitter selection in the Data instrument browser.

The Source 1 range will vary with the frequency of the jitter signal.
Jitter frequencies can range from almost 0 Hz to several tens of kilohertz.
Figure 152 shows a jitter sinewave with a period of about 100 µs, giving a
fundamental frequency of about 10 kHz; Source 1 Stop is set at 200 µs.
The Data 1 range will vary with the jitter amplitude. Typical jitter
amplitude ranges from 5 ns to 20 ns or more; Figure 152 shows a range of
±20 ns.

On the Digital Interface Analyzer panel, Wave Display can be set to
any choice except Eye Pattern.

See Jitter Detection on page 194 for more information.
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Figure 152. Digital Interface Analyzer jitter waveform.

10 kHz sinewave jitter from DIO jitter generator.



Digital Interface Analyzer Spectrum Views

The Digital Interface Analyzer provides spectrum (frequency domain)
views of the both the digital interface signal and the jitter signal extracted
from the interface signal.

Interface Spectrum

The interface spectrum view shows a spectrum analysis of the serial
digital interface signal, covering a frequency range extending from 0 Hz to
over 30 MHz.

As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Frequency, and

� Data 1 = Intervu.Amplitude.

Source 1 range should be 0 Hz to about 35 MHz; Data 1 range
about 0 dBV to –100 dBV. These will vary according to your
requirements, signal conditions, triggering choices and so on.

On the Digital Interface Analyzer panel, Wave Display can be set to
any choice except Eye Pattern.

Jitter Spectrum

The jitter spectrum view shows a spectrum analysis of the jitter signal
modulating the interface signal, covering a frequency range extending
from 0 Hz to over 1.5 MHz, depending on the jitter detection employed.
When excessive jitter has been determined to be a problem, spectrum
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Figure 153. Digital Interface Analyzer interface signal spectrum analysis, 48 kHz rate.



analysis of the jitter signal is a powerful tool in locating the probable
source.

As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Frequency, and

� Data 1 = Intervu.Jitter(sec) or Intervu.Jitter(UI).

Source 1 range should be 0 Hz to about 1.5 MHz; Data 1 range
about 1 ps to 20 ns on a log scale. These settings will vary according to
your requirements, signal conditions, sample rate, triggering choices and
so on.

When jitter signals below 120 kHz are being studied, use of the
Spectrum Analyzer instrument with the Jitter Signal source will
provide superior frequency resolution compared to the Digital Interface
Analyzer. Jitter signal analysis using the Spectrum Analyzer is discussed in
Chapter 11.

Calibration for Digital Interface Analyzer jitter measurements

is in terms of rms values, contrasting with the peak or

average values selectable for the DIO panel jitter meter. The

DIO panel jitter generator is calibrated in peak values.
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Digital Interface Analyzer Histograms

A histogram is a statistical view, showing the probability of occurrence of
a set of events throughout a range of possibilities.

Here’s an example: the interface waveform nominally moves across a
5 Vpp range with very quick transitions. The probability of the
instantaneous voltage being either +2.5 V or –2.5 V is high, and all other
voltages have a low probability. The interface amplitude histogram shown
in Figure 155 displays these probabilities.

Interface Amplitude Histogram

The interface amplitude histogram view shows a graph of the
probability of the interface signal being at particular points across a range
of amplitudes. When characterizing the squareness of a digital signal it is
often convenient to view a histogram of the signal amplitude.

With no impairment of the interface signal, the resulting histogram will
consist essentially of two vertical spikes. One is located at approximately
the signal negative peak value and the other at the positive peak value.

If the interface signal pulse top and bottom are clean and level (no tilt or
aberrations), the spikes will be narrow and of high probability values.
Slower rise and fall times cause each spike to broaden in the direction of
zero volts. Normal-mode noise causes broadening of each spike to both
lower and higher amplitude values. If these impairments are severe
enough, the two spikes will merge into a low probability lump spread
across the peak-to-peak voltage range of the signal.

Digital Interface Analyzer Histograms Chapter 12: The Digital Interface Analyzer

ATS-2 User’s Manual 187

Figure 155. Digital Interface Analyzer interface signal amplitude probability, 5 Vpp signal.



As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Amplitude(Prob), and

� Data 1 = Intervu.Probability.

Source 1 range should be about ±5 V; a Data 1 range of 0% to
about 20% on a linear scale is useful for this view.

Interface Pulse Width Histogram

The interface pulse width histogram view displays the probability of
various values of width for interface signal pulses.

With no impairment of the interface signal, the resulting histogram will
consist essentially of three vertical spikes at the 1 UI, 2 UI, and 3 UI points
on the horizontal axis. The height of each UI spike shows the probability of
pulse widths of that value occurring. For typical audio data, the 1 UI and
2 UI spikes will be approximately equal, indicating approximately equal
numbers of one and two UI-wide pulses (logical ones and zeros in the
embedded audio data). The 3 UI spike is significantly shorter (lower
probability) since pulses of that width occur only in the preamble. Impaired
rise and fall time and/or interfering noise will cause each spike to become
wider, at correspondingly lower probability for any specific pulse width
value.

The displayed time resolution of the pulse width histogram depends
upon the span between the Source 1 Start and Stop values and the
Source 1 Steps value.

Chapter 12: The Digital Interface Analyzer Digital Interface Analyzer Histograms

188 ATS-2 User’s Manual

Figure 156. Digital Interface Analyzer interface pulse width (interface timing) probability,

48 kHz rate.



As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Time, and

� Data 1 = Intervu.Probability.

Source 1 range should be about 0 to 600 ns; a Data 1 range of
0.01% to about 10% on a logarithmic scale is useful for this view.

On the Digital Interface Analyzer panel, Wave Display can be set to
any choice except Eye Pattern.

Interface Bit-Rate Histogram

The interface bit-rate histogram view displays the probability of
occurrence of the various instantaneous frequency values of the interface
waveform.

The Digital Interface Analyzer can “invert” the pulse width histogram
described above to obtain a bit-rate histogram. The time between each
successive pair of zero crossings of the interface signal is measured and
these times are sorted into bins depending upon their value.

Figure 157 shows three spikes, corresponding to the frequency
equivalents of the 3 UI, 2 UI, and 1 UI pulses that make up the signal. At a
48 kHz sample rate, the 3 UI pulses are equivalent to a frequency of about
2.07 MHz, the 2 UI pulses correspond to a frequency of about 3.10 MHz,
and the 1 UI pulses are equivalent to a frequency of about 6.16 MHz. Jitter
will spread each spike across the nearby spectrum.

As indicated in Figure 149, this view requires these Sweep settings:
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Figure 157. Digital Interface Analyzer interface rate probability, 48 kHz rate.



� Source 1 = Intervu.Amplitude, and

� Data 1 = Intervu.Probability.

Source 1 Stop should be set to about 7 MHz; a Data 1 range of 0%
to about 100% on a linear scale is useful for this view.

Jitter Histogram

The jitter histogram view displays the probability distribution of the
amplitude of the jitter signal.

The width of the histogram represents the peak-to-peak jitter amplitude.
The breadth of the display near its mid-section is indicative of the average
jitter amplitude.

A jitter signal with low average jitter will be represented by a high
probability of near-zero values. Signals with high average jitter are
represented by values falling into bins farther away from zero.

Squarewave jitter will tend to produce a strong pair of peaks at the
positive and negative peak jitter amplitudes, with a low amplitude area
between them. Sinewave jitter will also produce a graph with two peaks,
but the curve between them will follow a gentle arc. Random jitter
histograms will vary from acquisition to acquisition, while jitter dominated
by a coherent signal will tend to be more consistent.

As indicated in Figure 149, this view requires these Sweep settings:

� Source 1 = Intervu.Jitter, and

� Data 1 = Intervu.Probability.
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Figure 158. Digital Interface Analyzer jitter probability.



An initial Source 1 range should be about ±50 ns. Data 1 should be
set on a linear scale, with 0% at the bottom, and a top value between a
few percent up to 50%.

When comparing histograms to the DIO panel jitter meter,

remember that the DIO panel meter calibration is in terms of

peak or average values, while the Digital Interface Analyzer

jitter calibration is in terms of rms values.

InterVuMenu.atsb

Audio Precision Technical Support have written an AP Basic macro
which acts as a simple and powerful “front end” to access the different
Digital Interface Analyzer views.
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InterVuMenu.atsb provides a graphical user interface (shown above)
that loads a selection of sample tests that can be viewed as an introduction
to the Digital Interface Analyzer, or that can be modified and saved for
your own interface measurements. Remember to rename files you modify
to preserve the original samples.

Digital Interface Analyzer panel settings

Wave Display (Time Domain view only)

Four modes are available in the Digital Interface Analyzer for processing
the amplitude-versus-time relationship of a sampled signal before
displaying the waveform. These modes are applicable only to time domain
(oscilloscope) views and have no effect on Digital Interface Analyzer
spectrum analysis or histogram views.

The display processing setting determines how the data is modified for
display when the spacing of the sweep points is different from the spacing
of sample points in the acquisition.
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Figure 160. The Digital Interface Analyzer

panel.

Figure 161. Digital Interface Analyzer panel

Wave Display selections.



The four modes available in the Wave Display field are:

� Interpolate

� Display Samples

� Peak Values

� Eye Pattern

Interpolate, Display Samples, and Peak Values offer the same
wave display processing as do those choices in the Spectrum Analyzer.

Interpolate

When Interpolate is selected the DSP compares the density of sweep
points requested with the density of sample points available in the
acquisition, for the time span of the current sweep and graph.

If the requested points are much fewer than the acquisition points, the
DSP uses a bipolar peak sensing mode to eliminate potential graphic
aliasing problems; otherwise, it interpolates.

In the bipolar peak sensing mode, the signal waveform is not faithfully
represented but is replaced with an approximation indicating the positive
and negative peak excursions of the signal. See Graphic Aliasing on
page 166.

If you use the graph Zoom and Zoomout commands, the time span
represented on the graph changes. When Interpolate is selected, Wave
Display automatically switches between bipolar peak sensing mode and
interpolation mode for the best display.

The Interpolate selection produces a much more accurate display of
the signal waveform than the Display Samples mode when the signal
frequency is high (such as sample rate/100 or higher).

Display Samples

When Display Samples is selected, for each display point requested
the DSP sends the amplitude of the nearest-in-time acquired sample to the
computer for plotting. Acquisition points may be repeated or dropped,
depending upon the relationship of acquisition point density to display
point density.

When the signal frequency is low compared to the sample rate, this may
produce an acceptable representation of the original signal waveform. At
high signal frequencies, the waveform may be entirely unrecognizable in
the Display Samples mode because of graphic aliasing (see page 166).
Interpolation mode should normally be used in this case.
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Peak Values

When Peak Values is selected, the DSP searches all sample amplitudes
in the acquisition buffer between each pair of X-axis time values plotted,
and sends to the computer for plotting the largest positive or negative
value in that span, preserving the sign.

Since all sample values are examined, no signal peaks can be missed.

Eye Pattern

When Eye Pattern is selected, an entirely different sort of processing
takes place in the DSP. Eye Pattern overlays many one-UI-segments of
the acquired data on top of one another.

Following acquisition of the digital interface signal and extraction of an
average clock signal from it, the worst-case (nearest to 0 V) amplitude is
determined for each time increment relative to the beginning of each data
cell. These values are plotted when Intervu.Upper Eye Opening and
Intervu.Lower Eye Opening are selected as Data 1 and Data 3
parameters, resulting in a plot of the worst-case inside of the eye.

See page 182 for more information on the eye pattern.

The Intervu.Upper Eye Opening and Intervu.Lower Eye

Opening selections will not be available in the Data browser

unless Eye Pattern is selected in the Wave Display field on

the Digital Interface Analyzer panel. Conversely, if Eye

Pattern is selected, conventional amplitude vs. time displays

will not be available.

Jitter Detection

The Digital Interface Analyzer is capable of measuring jitter both on
AES3/IEC60958 interface signals and on simple squarewave clock signals
typically used in ADCs and DACs. The Jitter Detection interface signal
selections are:

� Stable Bits

� All Bits

� Preambles
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Jitter Detection selections.



The Jitter Detection squarewave selections are:

� Squarewave Rising

� Squarewave Falling

These modes are described in the following sections.
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AES3/IEC60958 Jitter Detection

The AES3/IEC60958 digital interface encodes two channels of
digital audio into a single serial data stream. The serial signal consists of
32 cells (bits) per subframe and two subframes (left and right channels)
per frame, for a total of 64 data cells per frame.

The frame rate is equal to the sample rate of the embedded audio.

There are 64 cells (bits) in a complete frame, and the cell rate is
1/64 the audio sample rate. The first four cells of each subframe are the
preamble. The preamble always starts with a 3 UI (1.5 cell) wide pulse
followed by sequences of 1 UI, 2 UI, and 3 UI pulses which are
different among the three possible preambles. See Appendix B for
more information on the serial digital interface signal.

An ideal pulse train would have regular transitions at exactly equal
intervals corresponding to a master clock frequency. Jitter is the
difference in timing of actual transitions of the pulse train from the
instants when the transitions should theoretically have occurred.
Therefore, jitter measurements require a stable, ideal clock signal to use
as a reference for comparison of the actual transition times.

Part of the Digital Interface Analyzer’s acquisition and processing of
the digital interface signal involves reconstruction of an ideal clock for
use as the reference for jitter measurements. The first three choices in
the Jitter Detection field select the transitions at which the clock
timing is compared to the interface signal.

VUCPAUDIO DATA 20 MSBs
AUX or
LSBs

VUCPAUDIO DATA 20 MSBs
AUX or
LSBs

X PRE Y PRE

DATA

PREAMBLE
JITTER
DETECTION

STABLE BITS
JITTER
DETECTION

ALL BITS
JITTER
DETECTION

Figure 163. Digital Interface Analyzer Jitter Detection Selections



Stable Bits

The Stable Bits selection derives the stable reference clock at 1/4 the
actual cell (bit) rate, which is 8 times the audio sample rate. Stable Bits is
synchronized to the beginning transition of the preamble. If Stable Bits is
used, the upper jitter detection frequency limit is reduced by 4:1 compared
to All Bits. This provides an analysis frequency range of approximately
380 kHz at a 48 kHz sample rate.

Stable Bits and Preambles will result in the lowest residual
measurement jitter. Stable Bits will be sensitive to all sources of jitter in a
typical system, including jitter induced on an interconnect cable.

All Bits

The All Bits selection derives the stable reference clock at the actual
cell (bit) rate, which is 64 times the audio sample rate. All Bits provides
the maximum jitter detection analysis frequency range of approximately
1.5 MHz at a 48 kHz sample rate.

Preambles

The Preambles selection uses the average rate of the trailing edge of
the first 3-UI-wide pulse in each preamble as the stable clock reference.
Signal transitions at the same point are compared to that average reference
to obtain jitter values for display. Since this derived reference clock rate is
low (only twice the audio frame rate), the effective jitter measurement
bandwidth equals the audio frame rate (sample rate) when Preambles is
selected.

Preambles and Stable Bits will result in the lowest residual
measurement jitter. Since the 3-UI pulse in a preamble is the most robust
portion of the digital interface signal and is least affected by reduced
bandwidth in the cable or system, Preambles will be relatively immune to
cable effects and will be dominated by jitter in the source.

The filter algorithm used for the Wave Display: Interpolate

setting requires seven samples of input signal before

displaying an output. This may make the jitter vs. time display

show zeros for the first few microseconds.

Squarewave (Converter Clock) Jitter Detection

In addition to measuring jitter on an AES3 or IEC60958 digital interface
signal, the Digital Interface Analyzer can also measure jitter on any
squarewave connected to the digital input connector, for a range of 5 kHz
to 15 MHz. This feature permits measurement of jitter directly on the clock
signal of ADCs and DACs. The waveform of the jitter may be displayed in
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the time domain view, or a spectrum analysis of the jitter may be
performed using the frequency domain view.

Select Squarewave Rising to measure jitter on rising edges of the
signal and Squarewave Falling to measure on falling edges.

Averages (spectrum view only)

The Digital Interface Analyzer enables you to average the results of
multiple acquisitions for frequency domain (spectrum) displays, in order to
reduce the variance of noise and to make coherent signals stand out more
clearly. The Averages field selects the number of acquisitions to be
averaged, from 2 to 128. A selection of 1 disables averaging.

FFT Windows for the Digital Interface Analyzer

The Digital Interface Analyzer has the several FFT windowing functions
available for its frequency domain views, listed here:

� Blackman-Harris
The Blackman-Harris window provides a good trade-off between a
window’s ability to separate closely spaced spectral peaks and its
ability to discriminate between moderately-spaced spectral peaks that
are quite different in amplitude. Depending on whether or not the
tone being measured is centered in the bin, there can be as much as
0.8 dB of error in the amplitude measurement.

� Hann
The Hann window provides good selectivity near the top of the main
lobe (about –6 dB one bin away from center and about –30 dB two
bins away), with no sidelobes. Its skirts more than 3 bins off center
are not as steep as the Blackman-Harris window. The Hann
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Figure 164. Digital Interface Analyzer panel

Averages selections.

Figure 165. Digital Interface Analyzer panel

Window selections.



window causes approximately –1.5 dB maximum amplitude error
due to window attenuation, if the signal is at the extreme edge of the
bin.

� Flat-Top
The Flat-Top window provides measurements accurate to a few
hundredths of a decibel for any spectral peak, but sacrifices selectivity
for closely spaced tones.

� Equiripple
The Equiripple window has the narrowest main lobe width for a
given maximum sidelobe depth. The main lobe is approximately 12
bins wide; that is, the first null is about six bins from the main lobe
center. The first sidelobe, which is also the highest, is –147 dB from
the main lobe. The maximum amplitude error with a signal at the bin
boundary is about 0.5 dB.

� None
The None selection (sometimes called a rectangular window) does
not apply any window function before the FFT. This mode is
normally used only with synchronous signals; it is not generally useful
for non- synchronous signals since energy will be spread across the
entire spectrum unless the signal is exactly at bin center. The
amplitude error due to the rectangular window attenuation is about
4 dB.

General purpose spectrum analysis applications, such as displaying the
interface signal spectrum, can use the Blackman-Harris window. When
making FFT-based amplitude measurements of a discrete-frequency jitter
component, the Flat-Top window should be used.

See the discussions of FFT windowing in Chapter 11 and in Appendix C
for more information on the window shapes and their relative advantages
and disadvantages.

The amplitude calibration for FFT spectrum analysis of jitter

is in terms of the rms value of the jitter signal, such that a

1 kHz sinewave jitter signal measured at 10 ns peak on the

DIO panel and displayed as a waveform of 20 ns

peak-to-peak in waveform display mode will have an FFT

peak at 1 kHz of about 7 ns (rms peak� �0707. ).
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Trigger Source

The Digital Interface Analyzer has an extensive trigger source list with
the additional capability of triggering on up to four error conditions from
either the digital input or the SYNC/REF input. These selections are
identical to the choices on the Main Trigger panel; both panels control the
same functions interactively. See Main Trigger panel on page 327 in
Chapter 22 for a detailed description of every trigger source.

When Go is pushed, the timing of the beginning of the Digital Interface
Analyzer acquisition is determined by the Trigger Source and Receive
Error selections, the Trigger Slope buttons and the Data Acquisition
buttons. The various Trigger Source choices include several points in the
digital interface from the received digital input, the transmitted digital
output or the Sync/Ref received input; from an external clock reference,
the AC mains frequency and internal generators. The trigger from the
digital interface signals can be extracted from the X- and Z-preambles
(Channel A subframe), the Y-preambles (Channel B subframe) or the
“block” Z-preambles (Block 192 frames).

Most of these alternative triggering sources will not cause any difference
display of either spectrum analysis or waveform display of the jitter signal,
or of spectrum analysis of the interface signal waveform. The differences
will be seen only when displaying the interface signal waveform (time
domain) with a narrow span (a few microseconds) between the Source 1
Start and Stop times so that the 3-UI, 2-UI, and 1-UI pulse widths that
make up the preamble can be distinguished.

On the various preamble trigger sources, the trigger operation is such
that the trailing edge of the first 3-UI pulse of the preamble occurs
nominally at time zero. The first information displayed after time zero in
these cases will be the remaining 5 UIs of the selected preamble, followed
by the first bit in the data area. Depending on the nature of the interface
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signal, that could be the LSB of the audio signal if full 24-bit resolution
audio is transmitted, or the beginning of the 4-bit Auxiliary data area if
audio is restricted to 20 bits or fewer.

The transmit preamble selections have the same triggering
characteristics. This triggering selection permits measurement of time delay
through a digital device or system under test.

The Transmit and Receive Block selections cause signal to be acquired
at the first Channel Status Block Preamble transmitted or received.

The Receive Block is delayed by two full frames by the AES

receiver.

The Jitter Generator signal triggers at every cycle of the sinewave signal
generated by the DIO jitter generator. This selection provide a stable
display of the received jitter waveform when measuring through a digital
device.

Triggering for squarewave acquisitions

None of the serial digital interface trigger sources (receive and transmit
block, error and sub-frame sources) is useful when measuring squarewave
jitter.

For stable triggering on a squarewave signal, split the connection with a
BNC “T” adapter and connect the two resultant lines to the ATS-2
DIGITAL INPUT and the TRIG IN rear panel connection. Select Trig In
(Ext) as the Trigger Source.

The Jitter Generator trigger selection works only when AES3 Jitter on
the DIO panel is turned on. This trigger mode can be useful when looking
at jitter on a squarewave clock that is derived from an AES3 signal fed
from ATS-2’s digital generator output.

Trigger Slope

The Trigger Slope buttons allow you to select whether the Digital
Interface Analyzer acquisition triggers on the positive-going (rising) or
negative-going (falling) slope of the trigger waveform selected in the
Source field.
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Data Acquisition

The Digital Interface Analyzer data acquisition length is fixed at
1,572,864 samples, which, at the 80 MHz sample rate of the Digital
Interface Analyzer ADC, gives an acquisition duration of 19.66 ms. The
Data Acquisition buttons select whether the acquisition is the 19.66 ms
before the trigger event, or the 19.66 ms after the trigger event.

See Figure 167.

Receive Error Triggers

The receive error selections cause data to be acquired when the AES3
receiver of the DIO module detects one or more parity, coding, lock, or
confidence errors. The checkboxes permit the selection of any or all these
types of error to cause triggering.

Sync Error is identical to Receive Error, but pertains to a signal
connected to the rear panel SYNC/REF IN connector rather than the front
panel input connector.

Depending upon whether Pre-Trigger or Post-Trigger Data
Acquisition was selected, the data in the buffer will precede or follow the
first error detection.

References

The Freq. value serves as the reference for relative frequency units used
in the Digital Interface Analyzer. Relative frequency units are useful for
displaying the spectra relative to the interface sample rate or relative to the
jitter frequency.

There are several choices of relative frequency units in ATS-2, including
F/R, dHz, %Hz, octs, decs, d% and dPPM. These are available any
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Receive Error Trigger selections.

Figure 169. Digital Interface Analyzer panel

References.



time that the Sweep Source or Data parameter is set to
Intervu.Frequency. For a complete discussion of these units and their
definitions see Appendix A.

Saving and Loading Interface Waveforms

As with other ATS-2 tests, you can save the setup and results of any
Digital Interface Analyzer test as an .ats2 test file. The acquired waveform
in the Digital Interface Analyzer acquisition buffer, however, is not saved as
part of a test. If you want to keep the acquired data record for further
analysis, you must save it as an .aai (Audio Precision Acquisition
Interface) acquired waveform file.

When the Digital Interface Analyzer is selected as the Analyzer
instrument, the File > Open > Intervu Waveforms and File > Save
As > Intervu Waveforms menu commands become available.

These commands allow you to save a Digital Interface Analyzer
(Intervu) acquisition waveform to disk as an .aai file, or to open an existing
.aai (Intervu) file and load the waveform into the acquisition buffer.

Audible Monitoring in the Digital Interface Analyzer

It can be useful to listen to the audio on the digital interface signal being
measured, enabling you to make a quick confidence check. It can also
help you determine if the errors being measured correspond to the
particular audible defect detected.

When the Digital Interface Analyzer is selected as the Analyzer
instrument, the audio embedded in the digital interface signal appears at
the Source A and Source B selections on the Headphone/Speaker panel
and at the SOURCE A and SOURCE B MONITOR OUTPUT BNCs.
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Chapter 13

The Multitone Audio Analyzer

Introduction

The Multitone Audio Analyzer is a DSP instrument selection on the
Analyzer panel. Multitone is an FFT-based analysis instrument for use
with both analog and digital audio signals. It is named “Fasttest” on
instrument browser lists and in OLE references.

This chapter examines the Multitone Audio Analyzer in detail. For
an overview of the concepts used in multitone analysis, see Multitone
Testing in Appendix C starting on page 415.

Multitone Capabilities

Using one of many special multitone waveforms as a stimulus signal, the
Multitone Audio Analyzer acquires the output of the DUT and
performs a synchronous FFT on the signal, then uses post-FFT processing
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to make measurements including frequency response, total distortion and
noise, noise in the presence of test signal, and crosstalk. Multitone can also
generate psychoacoustic masking curves for a particular test and compare
the test results against the masking curves. Different Multitone
measurements can be made quickly from the same short acquisition.

The use of synchronous FFTs ensures that the maximum theoretical
selectivity is achieved. A frequency error-correction technique enables
synchronous analysis even when the test signal frequencies have been
shifted by as much as ±4% in passage through the DUT.

Multitone provides time domain (oscilloscope) or frequency domain
(spectrum analyzer) views of the signal, but the time domain views are
rarely used.

Trigger modes include external, digital generator-synchronized and free
running. The multitone Analyzer can also be configured to trigger only
upon receipt and recognition of the specific multitone signal presently
stored in the generator as a reference. Variable trigger delay may be set to
allow devices such as audio processors to settle before measurement.

Generator Setting

As explained on page 416, Multitone must have detailed information
about the multitone waveform being used so that the DSP can acquire and
process the signal correctly.

In most circumstances, this signal is being generated from an arbitrary
waveform file by either the Analog or the Digital Generator, and the
Multitone Analyzer obtains the necessary information from the generator.

When the multitone signal is being received from an external source
(such as the playback of an audio recording or a transmitted signal), an
identical multitone waveform must be loaded in one of the ATS-2
generators as an arbitrary waveform file. In this case, the audio output of
the ATS-2 generator is not used, but the file information made available by
loading the file is essential to multitone operation.

Loading the Multitone Audio Analyzer
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To use the Multitone Audio Analyzer, first open the Analyzer panel.
The Analyzer panel is a command selection on the Panels menu, and is
also available by the keyboard shortcut Ctrl+Y, or by clicking the
Analyzer icon on the Toolbar.

Now select FASTTEST Multitone Audio Analyzer from the list on
the Analyzer panel. This loads the Multitone Audio Analyzer program into
DSP.

The Multitone Audio Analyzer panel

Signal Inputs

The Input field of the Multitone Audio Analyzer offers two signal
input selections:

� Digital, and
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Figure 172. The Multitone Audio Analyzer

panel.

Figure 173. Multitone Audio Analyzer

Signal Inputs.



� Analog.

These choices access the signals routed from the Digital Input/Output
(DIO) panel or the Analog Input panel, respectively.

Digital signals are applied directly to the Multitone Audio Analyzer
DSP; analog signals are first digitized by precision ADCs (selected on the
Analog Input panel) before being applied to the Multitone Audio
Analyzer.

To configure analog input connectors, range, coupling, select ADCs,
bandwidth, etc., go to the Analog Input panel (see Chapter 6). To
configure digital input connectors, digital input format and other aspects of
interface, go to the DIO panel (see Chapter 7).

Peak Level Monitors

The two Peak Mon meters on the Multitone panel continuously display
the peak amplitude of the digital signal as it is presented to the Multitone
Audio Analyzer. Only digital domain units (FFS, dBFS, %FS, or bits)
are available for these meters.

The primary purpose of the peak monitors is to avoid overload of the
input analog-to-digital converters (ADCs). When signal is being acquired
from the analog source and Auto Range is in use on the Analog Input
panel, ADC over-range should never be a problem. If any of the Analog
Input range controls is fixed, you must verify that the maximum signal
amplitude never exceeds digital full scale.

Multitone Measurement Selection
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Multitone waveforms, by their nature, contain many

frequencies. You may often want to focus your

measurements to particular frequencies by attaching a

sweep table (.atss file) to your test, as several of the

following discussions recommend. See page 251 for more

information on sweep tables, and page 416 for an overview

of using sweep tables for multitone testing.

The Measurement field selects the type of post-processing performed
on the FFT results before they are displayed, or compared to limits. The
Measurement selections are:

� Spectrum
Spectrum provides a normal FFT spectrum display with no
processing, except for peak picking (see page 166) when necessary.
This selection is typically used without a sweep table, and with a
relatively large number of sweep Steps (typically 250 to 500) at
Source 1 of the Sweep panel to provide good frequency resolution.
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� Response
The Response selection is always used with a sweep table, listing the
exact frequencies of the sinewaves in the multitone signal which are
to be used for frequency response measurements. Only the
amplitudes of the FFT bins containing those frequencies are plotted,
resulting in a frequency response graph.

� Distortion
The Distortion selection excludes the amplitudes of the FFT bins
identified as containing fundamental signals. The analyzer receives
this identifying information from the arbitrary waveform in the ATS-2
generator or from an attached sweep table. The amplitudes of all
other are summed using the rss or root-sum-square technique.
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� Noise
The Noise mode requires that the Multitone FFT Length be set to
twice the length of the waveform file that generates the multitone
signal; the Auto FFT Length selection accomplishes this
automatically. Under such conditions the analyzer frequency
resolution is twice the resolution of the generated signal, with twice
the bins of an FFT which matches the waveform length. The extra
bins fall between the bins containing the multitone frequencies and
their distortion products. The power in these bins is due to the noise
generated in the DUT, and is unaffected by fundamental signals or
their distortion products.
If the same sweep table is used in Noise mode that is used for
Response and Distortion measurements, the resulting graph will
be a plot representing noise (between the fundamentals) in the
presence of test signal. If a two-point sweep is made with Start at
20 Hz and Stop at 20 kHz, for example, the plotted value at 20 kHz
represents the rss integration of all empty bins across the audio band.

� Masking Curve
The Masking Curve selection generates a composite masking curve
for the particular multitone signal in use. The masking curve is
normally used by saving it as a limit (.atsl) file, then comparing noise
and distortion integrated across critical bands (determined using the
Distortion measurement selection, above) to the limit curve.
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� Crosstalk
For the Crosstalk measurement function to work properly, there
must be at least one unique frequency in each of the generator
channel waveforms. The Crosstalk function automatically
determines from the two generator waveform buffers which
frequencies are unique to each channel. Then, Crosstalk measures
the amplitude on the opposite (non-driven) channel at each of those
unique frequencies.

If Crosstalk is used without a sweep table, the resulting

graph consists of a series of horizontal plateaus, each

centered around the frequency of a crosstalk tone and scaled

vertically to the measured crosstalk level of that tone. Results

are easier to interpret when a sweep table is used. The table

consists of a list of the approximate frequency of each pair of

unique tones, assuming that the left-only and right-only tones

in the test signal are fairly closely-spaced pairs.

Frequency Resolution

The Freq Resolution control has two functions:

� Setting Multitone triggering frequency resolution

� Setting root-sum-square (rss) summing frequency resolution
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Resolution field.

Figure 180. Typical Multitone Crosstalk measurement. The use of a sweep table has

modified the stair-step look of an unmodified Crosstalk measurement, and has limited the

traces to the range above 500 Hz. There were no crosstalk tones below 500 Hz.



Setting Multitone triggering resolution

The Multitone Audio Analyzer has the ability to recognize a specific
multitone waveform in the received signal by comparing the signal to the
multitone file information passed from the ATS-2 generator. When the
frequencies in the received signal match the generator frequencies, the
analyzer recognizes the incoming multitone and issues a trigger to begin
the acquisition and analysis procedure.

If the frequency of the incoming signal has been shifted, Multitone will
not recognize the waveform and will not trigger. A setting greater than zero
in the Frequency Resolution field broadens the range of acceptance, so
that Multitone will recognize and trigger from a frequency-shifted
waveform. The maximum value is limited to 13%.

Setting root-sum-square summing resolution

The Frequency Resolution control also sets the range of frequencies that
are rss summed together at each specified frequency in Response and
Distortion measurement modes. This allows integration of the amplitudes
of the close-in modulation products created when flutter spreads the
original tones into sidebands, and provides more accurate readings in
these modes when flutter is present. Once again, the maximum value is
limited to 13%.

FFT Length

The FFT Length field value controls the record length used when signal
is acquired or a re-transformation is initiated. Longer transform lengths
produce greater frequency resolution (more bins) in the resulting FFT, but
require longer times to acquire and transform the signal.

Auto

The Auto selection automatically sets the acquisition buffer and
transform length to be exactly twice the length of the arbitrary waveform
presently loaded into the generator. This condition is essential for the
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Noise measurement function of the Multitone Audio Analyzer, and will
also work well with any other Multitone test. Auto is the recommended
selection when speed is not important.

Fixed FFT lengths

One of the seven fixed FFT lengths can be selected.

For Multitone to provide useful results, a selected fixed FFT length must
be an integral multiple of the multitone waveform length. See Appendix C
for more information on transform length for synchronous FFTs.

Processing

The Processing choices for the Multitone Audio Analyzer are

� Synchronous

� Freq Corrected

� Windowed

Synchronous is the normal selection. Synchronous processing uses
no window function and assumes that the multitone waveform length is
the same as or an integral sub-multiple of the selected FFT length.

Freq Corrected is also a synchronous selection, but, similar to the
None, move to bin center selection in the FFT Analyzer, this choice first
corrects the frequency of the received signal by ±4% in an attempt to
make the waveform length and the FFT length synchronous. This process
takes more time than the Synchronous selection, and should be used
only if the received signal has passed through a device which has slightly
shifted its frequency.

Windowed applies a Hann window to the signal before transformation.
This choice offers poorer selectivity than the two synchronous selections,
and should only be used in situations where frequency shifting of the
multitone signal has occurred and the use of the Freq Corrected mode
offers insufficient frequency-shifting range or is otherwise undesirable.
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Triggering

The Multitone Audio Analyzer has seven triggering modes:

� Digital Gen

� Analog Gen

� Tight

� Normal

� Loose

� Trig In (Ext)

� Off

Digital Gen and Analog Gen

The ATS-2 generators issue a trigger when the first sample of the
Multitone waveform is generated. When Digital Gen or Analog Gen is
selected, the Multitone Analyzer triggers from that source. Digital Gen
and Analog Gen triggers provide consistent, stable operations and should
be used whenever a Multitone test is using a generator waveform. These
are the only triggering modes that will return a correct result in an
Independent phase measurement.

Tight, Normal and Loose

Tight, Normal and Loose triggering are for use when receiving a
multitone waveform that is not currently being output from an ATS-2
generator—a waveform from an audio recording or a distant transmitter,
for example. The Multitone Analyzer compares the incoming signal with
the multitone waveform in memory to decide when to start.

Normal is the recommended setting for receiving an external multitone.
If the signal is degraded and will not trigger properly, Loose relaxes the
triggering criteria and may provide more consistent triggering. Tight
enforces the criteria more strictly, and will provide better triggering when
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the multitone burst is very short, or when program material on the line
might cause false triggering.

The Off triggering mode provides untriggered or free-running operation.
Acquisition and processing begin as soon as the Go button pushed.

The Trig In (Ext) triggering selection responds to a trigger event at the
Trig In (Ext) connector on the ATS-2 rear panel.

Trigger Delay

Audio processors (compressors, limiters, etc.) require time to stabilize
following any change of level, such as between the multitone burst and the
preceding program material.

If you want to allow processors in an audio chain to stabilize before
measurement, a delay can be inserted between recognition and acquisition
of the signal. The Trigger Delay field controls the interval between initial
recognition of the incoming multitone signal and capture of the portion of
signal which will finally be analyzed for response, distortion, noise, etc.

If you set a Trigger Delay, be sure that the duration of the multitone
burst transmitted is increased by the same amount over the normal
minimum burst duration; see below.

Multitone Minimum Duration Requirements

The minimum duration of multitone signal which must be present to
guarantee analyzer triggering depends primarily upon the generator record
length used to create the multitone signal. The required signal duration
also varies inversely with the sample rate at which the signal was
generated (and, in the case of digital inputs, will be received). Small
variations in required duration are also a function of whether the signal is
acquired from an analog or the AES3 serial digital source, and whether or
not the frequency correction function of the Processing field is in use.

Table 1 shows the minimum multitone signal duration as a function of
generator record length in samples, assuming a 48 kHz sample rate and
the use of Freq Corrected. Multiply the values shown by 0.5 at a 96 kHz
sample rate, by 1.088 with the 44.1 kHz sample rate, and by 1.50 if the
32 kHz sample rate was used.
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If a Trigger Delay is set, the amount of the delay must be added to the
minimum multitone signal duration.

Channel B Phase

The Channel B Phase selections determine whether Multitone measures
the absolute phase from the generation of the multitone to its acquisition,
or the relative phase between the two channels.

� Independent
This selection measures the absolute phase of the Channel B
multitone signal tones in the acquisition to the corresponding tones in
at the ATS-2 generator. This requires that the multitone signal
originate from an ATS-2 generator, and that the Multitone Analyzer
be set to trigger from that generator.

� Interchannel
This selection measures the phase of the Channel B multitone signal
tones relative to the corresponding tones in the Channel A signal.

References

Analog and digital amplitude and frequency references for the Multitone
Audio Analyzer are the same as for other Analyzer instruments. See
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selections.

Generator Record
Length

Minimum Burst
Duration

Lowest Freq. &
Minimum Freq.

Spacing

16384 2.1 s 2.92 Hz

8192 1.05 s 5.86 Hz

4096 520 ms 11.7 Hz

2048 260 ms 23.4 Hz

1024 135 ms 46.9 Hz

512 70 ms 93.7 Hz

256 40 ms 187.5 Hz

Table 1. Generator record length versus attributes.

Conditions are 48 kHz sample rate and use of Freq Corrected.



Analyzer Analog References on page 142 and Analyzer Digital
References on page 143.

Acquired Waveform Files

As with other ATS-2 tests, you can save the setup and results of any
Multitone Audio Analyzer tests as an .ats2 test file. The acquired waveform
in the Multitone acquisition buffer, however, is not saved as part of a test. If
you want to keep the acquired data record for further analysis, you must
save it as an .aam (Audio Precision Acquisition Mono) or .aas (Audio
Precision Acquisition Stereo) acquired waveform file.

Single-channel “mono” waveforms saved at different times can later be
individually loaded into the two channels of the Multitone acquisition
buffer to become “stereo” acquisitions for comparison in the time or
frequency domains.

Saving Acquired Waveforms

To save an acquisition, select the File > Save As menu command,
choosing either the Stereo Waveforms (.aas) or Mono Waveforms
(.aam) as the file type.

A stereo acquisition waveform file consists of two waveforms joined
together into a single file; a mono acquisition waveform file contains a
single waveform. To simultaneously save the waveforms from both
acquisition buffer channels A and B, select the stereo choice. To save only
one of the channels, select mono.

The left half of the dialog box defines what will be saved into the first
section of a waveform file and the right half defines what will go into the
second section of a stereo waveform. If the File > Save As > Mono
Waveform option was selected, the right half of the dialog will be gray.

You can save the entire acquisition record or just the portion currently
designated for transformation from either the channel A or channel B
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acquisition data. If the transform length is shorter than the acquisition
record length, the waveform file will be correspondingly smaller.

Opening Acquired Waveforms

To open an acquired waveform file, select the File > Open menu
command, choosing either the Stereo Waveforms (.aas) or Mono
Waveforms (.aam) as the file type.

You can load one waveform or simultaneously load both waveforms
into memory from a stereo file, and you can choose to assign the
waveform to either FFT channel and to the acquisition or the transform
buffers. A mono file only contains one waveform, but you have the same
flexibility to load it into either channel or either buffer. When opening a
mono waveform file, the right half of the dialog box will be gray.

If acquisition in a file to be opened is greater than the length

of the specified buffer, an error warning will be displayed and

the file will not be opened. If the acquisition length in the file

is shorter than the buffer size, erroneous analysis may result.

Combining Mono to Stereo

To compare two single-channel acquisitions made at different times or
under different conditions, open the file containing the first acquisition
data. Assign the waveform to FFT channel A or B and load the data. Then
open the second waveform file and do the same, this time loading the data
into the opposite FFT channel.

The resulting two-channel acquisition can be transformed, processed
and viewed, and can be saved as a new stereo waveform file.
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Compatibility of Acquired Waveform Files

The waveform files used by both the Spectrum Analyzer and the
Multitone Audio Analyzer have the same format, and with certain
restrictions on length, can be used by either instrument.

The Spectrum Analyzer has a larger acquisition buffer, and can open
waveform files up to 256k samples in length. Multitone is limited to
opening files with acquisitions of 32k or fewer samples.

Also, although any multitone waveform can be analyzed by the
Spectrum Analyzer, only properly-formatted waveform files are useful in
Multitone. See Chapter 11 for more information about the Spectrum
Analyzer.
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Creating Multitone Waveform Files

Many useful multitone waveforms are provided with ATS-2 and can be
found in the folder \ATS\Waveforms. You can also make your own custom
multitone waveforms using the ATS-2 Multitone Creation utility. On the
Main Menu, choose Utilities > Multitone Creation.

Multitone Creation Utility opening dialog box

Figure 188 shows the opening dialog box for the Multitone Creation
Utility. The key options are:

� Waveform Name
This is the filename you choose for your multitone waveform and for
all the associated files created by the utility. The filename extension(s)
will be chosen according the file options you choose in other dialogs.

� Sample Rate
Set the sample rate of your multitone waveform to any rate from
28.8 kHz to 108 kHz.

� Margin Headroom
Margin Headroom specifies in decibels the difference between the
highest peak in the finished waveform and digital full scale.

� Multitone Waveform Length
Choose from this list the length of one iteration of your multitone
waveform. 8192 samples is a typical choice. The Multitone
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Waveform Length cannot be longer than the Record Length,
below.

� Record Length
Choose from this list the total file length (for one channel, if a stereo
waveform) for your multitone. 8192 is a typical choice. The file may
contain multiple iterations of the multitone waveform.

On the left of the panel are four checkboxes:

� Create Sweep Table File
This option generates a sweep table file, with entries corresponding
to each of the tones in the multitone file.

� Create MS_RIFF (.wav) File
In addition to any Audio Precision generator waveform files, this
option generates a Microsoft .wav sound file containing the same
multitone as the .agm or .ags file.

� Minimize Crest Factor
A complex waveform such as a multitone can have a high crest
factor, making an overall low level necessary to prevent overload.
Different phase relationships among the component tones can reduce
the crest factor. The Minimize Crest Factor command enables an
automatic feature which randomizes the phase relationships of the
component tones repeatedly, then chooses the result with the lowest
crest factor. In the small entry field to the right you can set the
number of times to repeat the phase randomization before selection
of the best candidate.

� Create Stereo Waveform
By default, the Multitone Creation Utility generates a mono Audio
Precision generator waveform file, with the filename extension .agm.
If this box is checked, a stereo waveform file is generated, with the
filename extension .ags. When Create Stereo Waveform is
checked, two option buttons appear below the checkbox:

� Stereo Waveform Amplitude: Make both equal
The A and B channels of a waveform, unless identical, will have
different crest factors. This choice optimizes the level of the
channel with the higher peak amplitude at the selected
Headroom setting, then modifies the amplitude of the opposite
channel by the same factor.

� Stereo Waveform Amplitude: Optimize individually for
Headroom
This choice optimizes the peak level of each channel individually
with respect to the Headroom setting. Since the channels will likely
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have different crest factors, the level of the fundamental tones in
the two channels will likely be different after optimization.

At the bottom of the panel, there are four buttons:

� Use existing file data
This command begins the file creation process, using the data from a
test or data file for tone frequency, level and phase settings. See Use
existing file data, below.

� OK
Like Use existing file data, this command begins the file creation
process, but uses the settings you make on the Frequencies Menu for
tone frequency, level and phase settings. See Frequencies Menu,
below.

� Cancel
This command exits the Multitone Creation Utility, making no
changes in your current test or files on disk.

� File options
This command opens the Supporting File Creation Options dialog
box. See below.

When you have made the settings you want from this panel, click OK
to create a waveform from the Frequencies Panel, or Use existing file
data to create a waveform from existing data.

As you initiate the file creating process (by clicking OK or Use existing
file data), the Multitone Creation Utility will save the current ATS-2 test as
a temporary file named Makewave.tmp, displaying a dialog box to inform
you of this. This frees up the ATS-2 workspace and memory buffers for file
creation tasks. When the Multitone Creation Utility is finished, the file
Makewave.tmp is reloaded into ATS-2.

Using Existing File Data

This command begins the file creation process by using the data in
memory or in a data file for tone frequency, level and phase settings. To
create a new list of frequencies in Multitone Creation Utility, click OK
instead.

First the current test is saved as Makewave.tmp. Then you are presented
with the following dialog box:

Creating Multitone Waveform Files Chapter 13: The Multitone Audio Analyzer

ATS-2 User’s Manual 221



Choose File > Open from the ATS-2 Main menu and select the test or
data file which has the information you want in it, and then click
Continue Macro. Go to Editing the Frequency list, below.

File Options

The File Options button opens the Supporting File Creation Options
dialog box, which offers the following options:

� Data File(s), containing Frequency, Amplitude and Phase
Information (.atsa)
In addition to the .agm or .ags generator files and sweep table files,
this option specifies the creation of an Audio Precision data file.

� ASCII Data file(s) containing Frequency, Amplitude and
Phase Information (.atsx)
This is an ASCII text file containing the same information as the data
file in a text table.

� ASCII Waveform statistics file(s) (.wfs)
This is a text listing of statistics concerning the waveform files created.
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� ASCII Sweep Table statistics file(s) (.sts)
This is a text listing of statistics concerning the sweep table file
created.

� Retain (.agm) files when making Stereo files
When making a stereo generator waveform file, this option enables
you to also generate two mono files, each containing the waveform
information for one channel.

Frequencies Menu

First, define the range of your multitone signal. Enter the lowest
frequency in the Start Frequency field, and the highest in the Stop
Frequency field. Select Log or Linear Frequency Spacing, and set the
Number of Frequencies by entering a positive integer in the field.

Editing the Frequency List

Click OK when you have made your settings. The Multitone Creation
Utility will open the Data Editor, displaying the frequencies you have
defined, and also the Edit Waveform Definition Menu, as shown in Figure
192.
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The first three buttons on the Edit Definition Menu affect all the
frequency selections in the Data Editor.

� Randomize Phase values
To help minimize the waveform crest factor, this command
randomizes phase values. This is the same as one iteration of the
Minimize Crest Factor function.

� Set Phase values to 0.0 deg
This sets all phase values to 0.0 degrees.

� Set all Magnitude values to 0.0 dBV
This sets all tone amplitudes to 0.0 dBV.

� Edit Data Values
This command gives you access to the Data Editor, where you can
edit the waveform data, adding or deleting rows, and changing
frequencies, amplitudes and phase values.

If you add new frequencies using Edit Data Values, be sure

that the frequencies you choose are synchronous.

When you are done editing the data, click OK. A dialog box will
confirm that the file is being created.

Sweep Table Definition

If you have requested a sweep table, a dialog box will open to enable
you to define the frequencies listed in the sweep table. Your options are as
follows:
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� Fundamental Frequencies
This will list all of the fundamental frequencies in your waveform in
the sweep table.

� Harmonics
If you select Harmonics, the Multitone Creation Utility will calculate
the harmonics you specify for each of the fundamental tones, and
will list these frequencies in the sweep table. You can specify the
range of harmonics you desire and the utility will generate them up
to the Nyquist frequency. You can optionally select to only list the
odd harmonics.

� IM Products
If you select IM Products, the Multitone Creation Utility will calculate
the intermodulation sum and difference products to the order you
specify for each combination of fundamental tones, and will list these
frequencies in the sweep table. You can specify a listing of IM
Products up to the order you desire, and the utility will generate
them up to the Nyquist frequency.

You must choose at least one of these selections for a valid sweep table
definition. If you want only a subset of these frequencies, you can delete
rows from the sweep table using the Data Editor or the Attached File
Editor.

Creating an MS RIFF (.wav) File

If you have requested a .wav file, the following dialog box will open:

You can specify the length of the file, the resolution in bits, and the type
of dither to be used. See page 109 for more information about dither.
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Final Options

A final series of dialog boxes will open, with some examples shown
here.

You may reply Yes or No to any of these boxes. At this point in the
process, all the files you have requested have been created and saved, so
replying No will not change or abort multitone creation. The Yes options
enable you to continue directly with your testing or to immediately view
the statistics files.
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Chapter 14

The Harmonic Distortion Analyzer

Introduction

The Harmonic Distortion Analyzer is a DSP instrument selection on
the Analyzer panel. The Harmonic Distortion Analyzer permits
flexible, highly selective measurement of the amplitude of user-specified
harmonic orders. You can choose to measure any individual harmonic or
the sum of any arbitrary selection of harmonic distortion products from the
2nd through the 15th.

The Harmonic Distortion Analyzer uses FFT techniques to isolate
and measure each harmonic. The FFT bins are very narrow, and
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measurement of residual noise is almost entirely excluded. This means
that the Harmonic Distortion Analyzer can measure harmonic
distortion without noise for any specified set of harmonic products. If all
the harmonics are selected, the Harmonic Sum meters read THD (Total
Harmonic Distortion) without noise.

Even though it is internally based on FFT technology, the Harmonic
Distortion Analyzer effectively operates as a real-time program. The
analyzer drives constantly-updating panel meters and its results can be
displayed on bargraphs or plotted as traces on a graph. See Appendix C
for more information on FFTs.

The Harmonic Distortion Analyzer will accept either digital or
analog domain audio input signals, as selected by the Input field at the
top of the panel. It is a two-channel instrument, capable of performing
measurements on both channels of a stereo signal at the same time. For
an analog signal, the Harmonic Distortion Analyzer can measure a
frequency range from dc to half the converter sample rate (FS/2). set on
the Analog Input panel; for digital signals, the Harmonic Distortion
Analyzer can measure a frequency range from dc to half the signal
sample rate (FS/2).

There are four pairs of meters on the Harmonic Distortion
Analyzer which measure the input signal simultaneously:

� The Fundamental Amplitude meters.
These meters display the signal amplitude at the selected
fundamental frequency. The frequency that the Harmonic
Distortion Analyzer identifies as the fundamental is determined
by the selection made in the Steering Control field, discussed
below.

� The Fundamental Frequency meters.
These meters display the frequency of the highest-amplitude
component of the applied signal. These frequency meters (or
counters) are only enabled when Counter Tuned is selected in the
Steering field.

� The Harmonic Sum 1 meters.
These meters display the sum of the amplitudes of the harmonics
selected in the Harmonic Sum 1 fields, and

� The Harmonic Sum 2 meters.
These meters display the sum of the amplitudes of the harmonics
selected in the Harmonic Sum 2 fields.

As on other ATS-2 panels, you can select the units of measurement
you prefer for each reading display.
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Figure 195. Loading the Harmonic

Distortion Analyzer

The two Harmonic Sum readings will correctly sum and

display only the distortion products which are within the

bandwidth limitations determined by the sample rate. See

page 231 for more information on bandwidth limitations.

Loading the Harmonic Distortion Analyzer

To use the Harmonic Distortion Analyzer, first open the Analyzer
panel by choosing Panels > Analyzer or by the keyboard shortcut
Ctrl+Y, or by clicking the Analyzer button on the Toolbar.

Now select Harmonic Distortion Analyzer from the list on the
Analyzer panel. This loads the Harmonic Distortion Analyzer program into
DSP.

Signal Inputs

The Input field of the Harmonic Distortion Analyzer offers two
signal input selections: Digital and Analog. These choices access the
signals routed from the Digital Input/Output (DIO) panel or the Analog
Input panel, respectively.

Digital signals are applied directly to the Harmonic Distortion
Analyzer DSP; analog signals are first digitized by precision ADCs
(selected on the Analog Input panel) before being applied to the
Harmonic Distortion Analyzer.

To configure analog input connectors, range, coupling, select ADCs,
bandwidth, etc., go to the Analog Input panel (see Chapter 6). To
configure digital input connectors, digital input format and other aspects of
the interface, go to the DIO panel (see Chapter 7).
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Figure 197. Harmonic Distortion Analyzer

Fundamental Amplitude Meters.

The Fundamental Amplitude Meters

Two Fundamental Amplitude meters are located near the top of the
Harmonic Distortion Analyzer panel, one for each input channel.

The Fundamental Amplitude meters display the rms value of the
input signal component at the frequency defined by the Steering control
(described on page 233). This is typically the stimulus signal frequency,
generated by ATS-2’s analog or digital generator. This amplitude value is
used as the reference for all ratio units (%, dB, ppm, X/Y) when the Ratio
box is checked for any Harmonic Sum meter.

The Fundamental Frequency Meters

Immediately below the Fundamental Amplitude meters are the
Fundamental Frequency meters (or counters) for the two channels.
These display the frequency of the dominant component of the input
signal, normally the fundamental signal. This is the frequency that the
Harmonic Distortion Analyzer’s selective analysis capability will track
when Counter Tuned is selected for the Steering mechanism.

The Frequency meters are only enabled when Counter Tuned is
selected.

Harmonic Distortion Product Amplitude

Below the Frequency meter displays are panel sections labeled
Harmonic Sum 1 and Harmonic Sum 2. Each section contains a
meter display and control fields for input channels A and B, for a total of
four Harmonic Sum meters. Each meter consists of the digital display, a
Ratio unit checkbox, and controls for selecting the harmonic orders that
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the meter will measure. The meter display has the usual ATS-2 selections
of amplitude units. When the Ratio units box is checked, the meter will
display in units of %, dB, X/Y, or ppm, referenced to the fundamental
amplitude.

Harmonic Order Control

The rows of numbers below each Harmonic Sum meter provide the
means to select the harmonics the meter reads.

The upper row of numbers selects the even harmonic orders through
the fourteenth—2, 4, 6, 8, 10, 12, and 14. The lower row selects the odd
harmonic orders through the fifteenth—3, 5, 7, 9, 11, 13, and 15. You can
select or deselect any harmonic order by clicking on the number of the
order. Clicking the checkbox at the beginning of a row selects or deselects
the entire row of harmonic orders.

When only one harmonic order has been selected for a particular meter,
the display in the meter is the amplitude of the specific harmonic signal
selected. For example, clicking 3 in the lower row causes the associated
display to continuously measure the amplitude of the third harmonic only.

Clicking the 2, 8, and 10 in the upper row and the 7 and 13 in the
lower row of a meter causes a continuous display of the rms sum of the
2nd, 7th, 8th, 10th, and 13th harmonics of the signal. Checking the boxes
at the left end of both rows causes a THD (total harmonic distortion,
without noise) measurement that includes the effects of the 2nd through
the 15th harmonics.

Distortion Product Bandwidth Limitations

Note that only those harmonic components within the measurement
bandwidth of the analyzer can be measured, even if all the harmonic
orders are selected.

For example, assume that an analog signal is being measured using the
HiRes@65536 converter selected on the Analog Input panel, which
establishes a bandwidth to about 30 kHz.

If the fundamental frequency is 9 kHz, only the 2nd (18 kHz) and 3rd
(27 kHz) harmonics fall within the measurement bandwidth. Selecting any
harmonic orders above the 3rd will have no effect on the measurement.
When the fundamental is below about 2 kHz, all harmonics up to and
including the 15th will be measured. When the stimulus signal frequency is
swept during a test, higher-order harmonics will be included while the
stimulus frequency is low but excluded by the fixed bandwidth when the
stimulus frequency is high.
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With analog signals, measurement bandwidth may be increased to as
high as approximately 120 kHz with the HiBW@262144 selection, if the
optional high-bandwidth converter is installed in ATS-2.

With digital signals, bandwidth is intrinsically determined by the sample
rate of the device or system being measured.

The four Harmonic Sum meters are completely independent from one
another. On a given channel, one may be set for even harmonics and the
other for odd harmonics; or, one may measure a single individual
harmonic while the other measures an arbitrary group of harmonics that
may or may not include the single harmonic selected on the other meter.
Each Harmonic Sum reading for each channel may be simultaneously
plotted as a separate trace on the graph during a single sweep.

Amplitude Units

If you click on the arrow to the right of any amplitude or Harmonic
Sum meter reading field, a list of measurement unit choices will drop
down. The units shown on the list depend upon whether Analog or
Digital is selected in the Input field.

With Digital selected, the units list displays:

� digital domain units: FFS, dBFS, %FS and Bits;

� relative units: dBr A and dBr B; and

� units relative to the analog domain: V, dBu, and dBV.
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These analog domain units are calculated using the value you enter in
the V/FS field in the References area of the panel, and can be helpful in
cross-domain measurements.

With Analog selected, the units list displays:

� analog domain units: V, dBu, dBV, and W (watts).

� relative units: dBr A, dBr B, dBg A, dBg B;

� and units relative to the digital domain: FFS, dBFS and %FS.

For an explanation of the units of measurement used in ATS-2 and the
references for the relative units, see Appendix A, Units of Measurement.

Click the Ratio checkbox of any of the Harmonic Sum meters to select
the ratio units %,dB, X/Y, and ppm for that meter. The reference of these
ratio units is the Fundamental signal amplitude of that channel.

References

Analog and digital amplitude and frequency references for the
Harmonic Distortion Analyzer are the same as for other Analyzer
instruments. See Analyzer Analog References on page 142 and
Analyzer Digital References on page 143.

Steering Control

The Harmonic Distortion Analyzer must identify the fundamental
frequency that you have selected for your measurement. The amplitude of
the fundamental component is used as the basis of the Ratio
measurements, and the precise frequency of the fundamental must be
known to calculate the frequencies of each of the harmonics to be
measured.

The Steering control determines how the Harmonic Distortion
Analyzer identifies the fundamental signal component. The Steering
control field is centered just above the References section on the
Harmonic Distortion Analyzer.

The Steering control enables you to choose a source of frequency
“steering” for the identification of the fundamental frequency. The five
selections available in this field are:
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� Counter Tuned
Counter Tuned uses the measured frequency value displayed in the
Fundamental Frequency field as the steering source for the
fundamental and harmonic selectivity. Choose this mode when
making harmonic distortion measurements from an external signal
such as playback of a Compact Disc or audio tape, or the received
signal from a distant source.

� Sweep Track
With Sweep Track selected, the fundamental frequency value tracks
the frequency of whichever generator is selected in the Source 1 or
Source 2 fields of the Sweep panel.

� AGen Track
With AGen Track selected, the fundamental frequency will
automatically track the frequency of the Analog Generator.

� DGen Track
With DGen Track selected, the fundamental frequency will
automatically track the frequency of the Digital Generator.

� Fixed
Fixed sets the fundamental frequency to the value you enter in the
field to the right.

High Speed/High Accuracy Control

The Harmonic Distortion Analyzer is normally configured to
provide accurate results quickly.

When making measurements of distortion products which are lower
than –90 dB or –100 dB (lower than 0.003% to 0.001%) relative to the
fundamental, you can choose to set the instrument to a mode of even
higher accuracy, at the price of some sweep speed.

In the field to the left of the Steering control, choose High Accuracy to
enable this mode. The default mode is High Speed.
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THD vs THD+N

Measurements of THD+N (total harmonic distortion plus noise) vs.
THD (total harmonic distortion, not including the effects of noise) on the
same signal may differ for two reasons—one theoretical, and the other
due to the architecture of typical THD+N analyzers.

The theoretical difference between THD and THD+N lies in the
“+N” term—the noise. If distortion products are much higher in
amplitude than the wide-band noise in a signal, the two techniques
should give essentially identical results. In many cases with modern,
well-designed audio equipment, actual distortion is very low across most
of the normal operating dynamic range and wide-band noise dominates.

A THD+N analyzer operates by removing the fundamental signal
with a notch (bandreject) filter, then measuring everything left over. The
left-over signal, in this case, is the wide-band noise and distortion
products.

A THD analyzer makes highly selective amplitude measurements
only at each specific harmonic product frequency. The bandwidth of
these selective measurements is so narrow that noise has almost no
effect. In such a noise-limited case, a THD analyzer (such as Harmonic
Distortion Analyzer) may produce a much lower value than a THD+N
analyzer (such as the Audio Analyzer in THD+N functions).

Another difference comes about only when Ratio units (%, dB, X/Y,
or ppm) are selected. Practical THD+N instruments make a
compromise with the actual definition of distortion ratios in the interest
of circuit economy. The definition of THD and THD+N ratios computes
the amplitude of the distortion or distortion and noise products with
reference to the amplitude of the fundamental signal component.
However, practical THD+N analyzers use the amplitude of the input
signal, including all distortion products, as the reference instead of the
fundamental component alone. At total distortion values of 10.0% and
lower (–20 dB and below), the difference between these two approaches
is negligible. At higher distortion values, the difference may become
large.

For example, when the distortion products are at 10.0%, the
difference in amplitude between the fundamental component and the
complex signal including distortion is less than 0.5%, so distortion
values stated as a percentage of either value are nearly the same. At
45%, typical of a squarewave, there is about a 9.6% difference between
stating distortion ratios relative to the fundamental rather than to the
entire, distorted input signal.

The ATS-2 Harmonic Distortion Analyzer makes a selective
amplitude measurement of the fundamental signal and refers all Ratio
units to that value, conforming to definitions. The ATS-2 Audio Analyzer
in the THD+N Ratio function, like all other commercially available
THD+N analyzers, refers the distortion product measurements to the
raw input signal that includes fundamental and harmonics.



Sweeping and Graphing Results

The fundamental and the harmonic products measured by the
Harmonic Distortion Analyzer can be swept and graphed in ATS-2.

The Harmonic Distortion Analyzer must be selected as the Analyzer
instrument. Choose Harmonic as the instrument in the Sweep Data or
Source browser, and the following Parameter selections will be available
for sweeps:

� ChA Fund Ampl

� ChA Fund Freq

� ChA Harm Sum1

� ChA Harm Sum2

� ChB Fund Ampl

� ChB Fund Freq

� ChB Harm Sum1

� ChB Harm Sum2
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Chapter 15

Sweeps and Sweep Settling

Introduction: Sweeps and Graphs

A “sweep” is a measurement which includes a number of points of data,
the result of varying or “sweeping” one (or more) test parameters across a
certain range and reporting the value of other test parameters at regular
points during the sweep.

You can force ATS-2 to perform a “single-point sweep” for

special purposes, but generally the term sweep indicates that

a number of data points are included in the measurement.

The results of a sweep can be listed in a table and viewed in the Data
Editor; more commonly, the results are plotted on a Graph. As you will

ATS-2 User’s Manual 237

Figure 202. Graphical display of sweep results.



see, ATS-2’s Sweep, Data Editor and Graph functions are closely tied.
When the Data Editor and the Graph panel are open next to your Sweep
panel, you can watch the data values and the graph coordinates and
traces respond to your Sweep panel settings. See Sweep Display Mode,
page 247; Graphs, page 267, or Editing Data and Setting Limits,
page 289.

Many times aspects of sweep functions can be described in graphic
terms; for example, the Source divisions are called “X-axis divisions;”
Data results are often called “traces” and so on.

The ATS-2 Sweep function gives you the following capabilities:

� You can sweep a parameter as an independent variable across a
range you define. This can be an ATS-2 instrument parameter, set in
Source 1, a table of pre-defined values, an external signal tracked as
a sweep source, or a time base to generate chart-recorder type plots.

� As many as six other parameters (called Data 1 through Data 6)
can be measured during the sweep.

� You can choose from extensive lists of settings or readings for either
Source or Data selections;

� You can set the number of sweep steps (or the distance between the
steps) made within your range.

� You can impose pass / fail limits on your results.

� You can specify the units and divisions displayed on your graph.

� You can set sweeps to automatically repeat.

� You can append subsequent sweeps on your graph.

� You can “nest” sweeps to generate curve “families.”
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Batch-Mode “Sweeps”

The ATS-2 Sweep panel is also used to initiate and display batch mode
DSP measurements for the Spectrum Analyzer and Multitone Audio
Analyzer instruments. Although these are unlike real-time sweeps in that
there is not a swept generator signal or discrete channels of resulting data
to be graphed, batch-mode measurements are similar from an operational
point of view, and in the graphical requirements for an X-Y type plot with
scaled and calibrated axes.

This chapter focuses on real-time sweeps. For setup and operation of
the Sweep panel in batch mode measurements, see the material in The
Spectrum Analyzer, Chapter 11; The Digital Interface Analyzer,
Chapter 12; and The Multitone Audio Analyzer, Chapter 13.

Batch mode sweeps are selected by choosing FFT-based instruments in
the Sweep Source and Data browsers. There are a few Sweep controls
(Transform Data w/o Acquire, Reprocess Data and
Spectrum<=>Waveform) which only affect batch mode
measurements. The operation of these controls is briefly mentioned in this
chapter and explained in more detail in the specific Analyzer chapters.

Plan Your Sweep

When you begin a sweep, you should ask yourself questions like these:

� What parameter will the test sweep? In other words, what is the
independent variable?

� Over what range?

� What data results do I want to see? That is, what will the dependent
variables be?

� What range do I expect the results to cover?

� How many points of data do I need?

� How close together must they be?

� Would my sweep be more useful on a linear or a logarithmic scale?

With this type of information at hand it will be easy to set up the Sweep
panel for your test. We’ll start by looking at the ATS-2 Sweep panel and its
controls and displays.
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The Sweep Panel

The ATS-2 Sweep panel is available by selecting Panels > Sweep
from the Menu bar or by clicking the Sweep button on the toolbar; you
can also launch the Sweep panel by selecting Sweep > Show Panel
from the Menu bar or by using the keyboard combination CTRL+S.

Normally, the Sweep panel is used to control a Generator and to collect
readings from the Analyzer to produce sweeps for graphing. It also sets the
parameters for External Sweeps, and sets the parameters to control FFT
graphing for batch-mode instruments.

The compact display of the ATS-2 Sweep panel (which is the left half of
the panel shown in Figure 204) allows you to set up a single-Source
sweep with one or two sets of Data results. If you expand the panel as
shown above, you can use two sweep Sources and up to four more Data
result traces, and you have access to additional controls and settings on
the Sweep panel.

Source 1

Every sweep must have at least one sweep Source and one set of Data
results. The Source 1 area on the Sweep panel is where you will select
and define your primary swept parameter, the independent variable
deliberately changed during a sweep test. In a graph of a sweep, Source
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1 usually defines the X-axis (the horizontal graph axis). Source 2 is used
for nested sweeps, which are discussed on page 250.

Settings or Readings?

Source 1 will typically be an internal ATS-2 setting, such as Analog
Generator frequency or amplitude. It could just as well be a Digital
Generator setting, or a Digital I/O setting such as Output Sample Rate,
for example.

It is also possible to use an external signal as the swept parameter (the
independent variable). In this case Source 1 is set to an ATS-2 reading
such as Audio Analyzer frequency or amplitude. A sweep which uses
readings for a source is called an External Sweep. External Sweeps are
discussed beginning on page 245.

Selecting a Sweep Source

When ATS-2 is first loaded, the default sweep source in Source 1 is the
Analog Generator frequency. To select a different source, click on the
Source 1 browser button.

A dialog box will open that displays the instruments and parameters
available as sweep sources. Click on a instrument and you will see the
settings associated with it in the right browser window.
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For ordinary sweeps be sure that you have selected your

source from the instrument settings list. Instrument readings

are used for External Sweeps, page 245. The check boxes

on the browser allow you to choose the settings or readings

lists.

Start and Stop Values

The values entered in the Source 1 Start and Stop fields set the
sweep range and direction, and also become values for the graph X-axis
end points.

In a frequency sweep, for example, the default settings are 20 kHz in the
Start field and 20 Hz in the Stop field.

With these settings, the sweep will move downward in frequency from
20 kHz to 20 Hz. If you would like your sweep to move upward from low
to high, enter 20 Hz as the Start value and 20 kHz as the Stop value.

Source 1 Log or Lin Scales

If neither the Start nor the Stop value is zero or a negative number,
you have the option of calibrating the Source 1 axis on a logarithmic or a
linear scale. Click on the Log or Lin option buttons to change the scale.

If either value is zero or negative, or if decibel units are chosen (these
are available for an amplitude source), the Log and Lin option buttons
will not be available and the scale will be set to linear.

The choice of scale affects the way that step size is calculated for the
sweep and also the distribution of the vertical divisions on the resultant
graph.

Sweep Resolution

The range between the Start and Stop values will be stepped through
in:

� equal-size increments, in Lin scale mode, or

� equal-percentage increments, in Log scale mode.

The number of steps, the size of each step, the Log / Lin selection and
the range between the Start and Stop values are all interrelated.

Linear Scale Steps

When using a linear scale, you can set the step size by entering the
number of steps in the Steps field. Only integer numbers between 1 and
65,000 are accepted. After you have made an entry, the value in Stepsize
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will be recalculated. Alternately, you can enter a value in the Stepsize
field and ATS-2 will calculate the correct number of steps to produce this
step size.

If the value you enter does not result in an integer number of steps,
ATS-2 will round the calculated value of steps to the next lower integer
value to maintain the exact step size you have entered. ATS-2 then takes
care of the arithmetical remainder by adding a final, smaller step to the
Stop value.

Logarithmic Scale Steps

When using a logarithmic scale, the field which had been called
Stepsize in Lin mode is renamed Multiply. You can set the step size by
entering the number of steps in the Steps field just like the Lin setting. Or,
you can enter a value in the Multiply field and ATS-2 will calculate the
correct number of steps to produce this step-to-step multiplier.

If the value you enter does not result in an integer number of steps,
ATS-2 will round the calculated value of steps to the next lower integer
value to maintain the exact step-to-step multiplier you have entered, and
then takes care of the remainder by adding a final, smaller step to the
Stop value.

X-Axis Divisions

In Log mode, the placement of grid lines for the graph X-axis divisions
is pre-determined and the Div field and the Auto checkbox are not
available.

In Lin mode if Auto is checked, the grid lines are selected automatically
based on the Source 1 settings. If Auto is not checked, you can specify a
number of grid lines by entering a value into the Div field.

Data 1

As mentioned before, every sweep must have at least one sweep
Source and one set of Data results. The Data 1 area on the Sweep
panel is where you will select and define your primary data result, the
dependent variable which changes in response to Source 1. In graphing a
sweep, Data 1 is shown as a trace or curve whose values are always read
on the graph left Y-axis. Data 2 through Data 6, though similar, have
enough differences to warrant their own discussions. Data 2 begins on
page 245, and Data 3 through Data 6 are on page 246.
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Selecting the Data 1 Reading

The default reading for Data 1 is the Analyzer Level A amplitude. To
select a different reading, click on the Data 1 browser button.

A dialog box will open which displays the instruments and parameters
available as data readings. Click on a instrument and you will see the
readings associated with it in the right browser window.

Top and Bottom Values

Enter the graph top and bottom values in the Top and Bottom fields in
the Data 1 section of the Sweep panel. Drop the arrow list to change units
of measurement.

Since Data 1 displays the results of measurements, it is not always
possible to predict the range of the values. If you set the Top or Bottom
values too low or high, the data will still be acquired and saved, but the
graph trace will not extend beyond the set values. In this case you can
re-enter the Top or Bottom values and the graph will re-draw itself to
correctly plot your results.

You can also use the Optimize function on the Graph panel

to reset the Y-axis extents to accommodate your results.

You can also have ATS-2 automatically set the Top and Bottom values
on this panel in response to the Data 1 readings. Click the Autoscale
checkbox to enable this function.

Chapter 15: Sweeps and Sweep Settling Data 1

244 ATS-2 User’s Manual

Figure 206. The Sweep Data 1 browser dialog box.



Data 1 Log or Lin Scales

If neither the Top nor the Bottom value is zero or a negative number,
you have the option of calibrating the Data 1 axis on a logarithmic or a
linear scale.

If either value is zero or negative, or if decibel units are chosen (these
are available for amplitude data), the Log and Lin option buttons will not
be available and the scale will be set to linear.

Y-Axis Divisions

In Log mode, the placement of grid lines for the graph Y-axis divisions
is pre-determined and the Div field and the Auto checkbox are not
available.

In Lin mode if Auto is checked, the grid lines are selected automatically
based on the Data 1 settings. If Auto is not checked, you can specify a
number of grid lines by entering a value into the Div field.

These controls affect scaling for real-time data acquisition. The graph
can be rescaled to accommodate the data in the graph buffer memory
using the graph Optimize function, page 270.

Data Limits

The Limits button opens a dialog box enabling you to attach
acceptance (pass / fail) limits to a test. See Setting Limits, page 292.

Data 2

Data 2 enables you to plot a second trace of data on your graph
against its own scale and calibration, on the right-hand graph axis.

Data 2 operates in exactly the same way as Data 1, with these
exceptions:

� Data 2 plots against the scale on the graph right Y-axis,

or, if the X-Y Data2 on X option button is selected,

� Data 2 determines the X-axis calibration to enable you to plot two
measured values, or readings, as an X-versus-Y graph. See below for
an explanation of plotting data X-Y.

When Data 1 and Data 2 are plotted together on a graph, the Data 1
Top and Bottom range settings and intermediate values are displayed on
the graph left Y-axis. The Data 2 Top and Bottom range settings and
intermediate values are displayed on the graph right Y-axis.
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Plotting Data as X-versus-Y

Sometimes it is useful to plot two measured values against one another
under stimulus from a third signal.

In a Data X-versus-Y graph, Data 1 is still plotted on the left Y-axis.
Source 1 is still the independent variable, stepping through the Start /
Stop range and driving the test to create the changes in the Data 1 and
Data 2 dependent variables which will be plotted. However, Source 1
values and calibration will not be displayed on the graph at all; instead,
Data 2 values are used to calibrate the X-axis.

As an example, you can perform an amplitude sweep (Source 1) on a
power amplifier and plot the measured percent distortion (Data 1 on the
Y-axis) against the measured power output (Data 2 on the X-axis). The
amplitude sweep itself is never displayed as such; however, the two sets of
results are graphed to show their dynamic relationship.

You can switch between the conventional X-Y mode and the
X-Y Data2 on X mode at any time using the option buttons on the
expanded Sweep panel.

Limits cannot be graphed, and data cannot be compared to

limits when the graph is in X-Y Data2 on X mode.

Data 3 through Data 6

Data 3 through Data 6 enable you to plot up to six variables when
used with Data 1 and Data 2. These additional Data functions operate
in exactly the same way as Data 1 and Data 2, with this exception: they
must share a graph calibration scale with either Data 1 or Data 2.

Since there are only two data calibration scales available on a graph
(the left and right Y-axes), Data 3 through Data 6 can only be plotted if
they share a “measurement domain” with either Data 1 or Data 2. This
is why the Data 3 through Data 6 sections of the Sweep panel have no
Top and Bottom or scaling fields.

For example, if Data 1 is percent distortion and Data 2 is level, it will
not be possible to also plot phase on Data 3. If, however, you wanted to
plot channel A and B level and the phase difference between them, you
could assign channel A level to Data 1, phase to Data 2 and channel B
level to Data 3. The Data 3 measurements would be plotted against the
left-hand Y-axis calibration set in Data 1.

If you are viewing the Sweep panel in its compact mode and one or
more or the Data 3 through Data 6 functions are in use, these will be
listed in the Sweep panel title bar.
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If you are creating a table rather than a graph with your

sweep, there is no longer the limitation of two “measurement

domains.” You can simultaneously list up to six sets of

measurement data with any mix of unit domains. See Sweep

Display Mode, below.

Sweep Display Mode

When ATS-2 makes a sweep, the results can be displayed as a graph, as
a table, or both.

Click the Create Graph and / or Create Table checkboxes on the
expanded Sweep panel to choose the sweep display mode. When you run
a sweep you will be able to view the data entering your display in real
time.

The tabular display is shown in the ATS-2 Data Editor panel (see page
289). If you have made a sweep without Create Table set, you can still
choose to view the data in the Data Editor, which is opened by clicking the
Data Editor button or by using the Menu command Panel > Data
Editor.

When using a graph for display, you are limited to two sets of unit
choices (Volts, dBr, etc.) for your data results, since ATS-2 can use only the
left and right Y-axes to calibrate data values. However, in tabular form this
constraint does not exist, and you can specify different units for each of the
Data 1 through Data 6 columns, if you wish.

If you are running sweeps in an automated or manufacturing

test situation where speed is most important, you can set

both sweep display modes OFF for fastest performance.

Go / Stop / Pause

Once you have your Source and Data settings made, all that remains
is to trigger the sweep. Simply click the Go button on the Sweep panel or
the toolbar; you can also start the sweep by selecting Sweep > Start
from the Menu bar or by pressing function key F9.

To stop the sweep, click the Stop button on the Sweep panel or the
toolbar; you can also stop the sweep by selecting Sweep > Stop from the
Menu bar or by pressing the ESC key.

To pause or unpause a sweep, press function key F10.
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Repeat

You can set ATS-2 to repeat your sweep indefinitely. Click the Repeat
check box on the Sweep panel to enter the Repeat mode.

Selecting Sweep > Start with Repeat from the Menu bar or pressing
the key combination ALT+F9 sets the Repeat mode and starts the
sweep.

When you need to interrupt repeated batch-mode processing such as
FFT or multitone tests, do it by unchecking the Repeat box and letting the
sweep completely finish. If you use Stop you will leave invalid data in the
DSP which will result in a meaningless graph.

Append

You can set ATS-2 to append your sweeps to the graph, retaining your
previous data and appending the new data to the old. Normally, when not
using Append, ATS-2 clears the existing sweep data from the graph and
from memory before beginning a sweep.

To enter the Append mode, click checkbox on the Sweep panel. Click
the box a second time to remove the check and exit the Append mode.

Selecting Sweep > Start with Append from the Menu bar or pressing
the key combination CTRL+F9 sets the Append mode and starts the
sweep.

Appending a File

You can also append previously saved data to a current sweep by using
the File > Append command, which opens a file browser dialog box.

Select a test (.ats2) or data (.atsa, .atsq, .atss or .atsl) file to be
appended.

The data currently in memory and the file to be appended must be
compatible in these ways:

� they must both have compatible Source 1 selections; for example,
both set to frequency or both to amplitude, not one and the other.

� they must both have the same structure of Data 1 and Data 2
selections; for example, a data file with data plotted at both Data 1
and Data 2 can not be appended to current data in memory which
has Data 2 set to None.

� they must both have compatible “measurement domains;” for
example, a measurement of distortion shown in percent units, which
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expresses a ratio, may not be appended to a measurement of level in
amplitude units, which does not express a ratio. However, distortion
shown in absolute units, such as volts or dBu, can be appended to
amplitude data.

Data appended from a file will be graphed in the same color used in the
original test or data file. Both the original and the appended data can be
viewed in the Data Editor.

Stereo Sweeps

ATS-2 has the ability to sweep two channels of a device simultaneously
with the Stereo sweep function. Although you could manually set up two
sweep Data functions and get the same results, using the Stereo sweep
function brings some additional advantages.

� Automatic selection and setup of opposite channel data settings,
including Limit file selection.
If you have entered a channel of only one reading instrument (in
Data 1), ATS-2 will set up the opposite channel in Data 3 to match.
Since both of these readings are of the same measurement domain,
they will both be plotted against the calibration and scaling on the
left-hand Y-axis. This leaves Data 2 and the right-hand Y-axis
available for other use.
If you also set up a channel from a second reading source (in
Data 2) during a stereo sweep, ATS-2 will automatically set up the
opposite channel in Data 4 to match.

� In stereo sweep crosstalk tests, ATS-2 performs automatic input and
output switching and runs two cross-channel measurements in
succession. The two passes are plotted as separate data in one graph
and saved in one file.

To make a Stereo sweep:

� Set up Source 1 and Data 1 (and Data 2, if you want to plot two
different pairs of variables) for your sweep.

� Click the Stereo checkbox on the Sweep panel.

Some reading parameter selections (such as Phase or DCX-127 DMM
Volts) are not stereo signals. If you select such a parameter for Data 1 or
Data 2, the Stereo sweep function will not be available.

Opposite-channel Limit files which have been automatically attached
to Data 3 or Data 4 in Stereo sweep can be changed or disabled by
clicking the Limits button for that Data function.
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Single Point Sweeps

A single point sweep is an ATS-2 sweep in which the independent
variable, Source 1, is held at only one value. ATS-2 can then acquire the
measurement data for any dependent variables you have set in Data 1
through Data 6.

Single point sweeps are often used in AP Basic macros to “grab” a
value or set of values. Single point sweep results differ from meter readings
in several ways:

� The single point Data result is dependent upon the Source value
specified.

� The data can be displayed in a tabular format in the Data Editor.

� The data can be saved as an .atsa file, and recalled or exported.

� Sweep settling delays and algorithms can be applied.

� The data results can be compared against Limit files.

To make a single point sweep, click the Single Point checkbox on the
Sweep panel. Then select an instrument setting parameter for Source 1.
Enter the value at which you want to make your measurement in the
Source 1 Start field, and set up whatever Data functions you want.

Since an X-Y graph cannot be drawn for a single point measurement,
the result will only be displayed in a table. Select Create Table on the
expanded Sweep panel. Click Go, and data will be acquired and displayed
in the Data Editor table. See Sweep Display Mode on page 247 and
Data Editor on page 289.

Nested Sweeps using Source 2

ATS-2 can generate a “family” of curves using Source 1 and Source 2
together in what is called a nested sweep. An ATS-2 nested sweep controls
two different setting parameters in an interrelated manner.

You can use nested sweeps to generate a set of frequency response
curves made at a number of different amplitudes, for example; or you can
graph overlaid response measurements for a multichannel recorder, using
an Audio Precision SWR-122 switcher under ATS-2 control.

The nested sweep feature is enabled simply by entering settings into
Source 2.

In a nested sweep, Source 1 is still used as the primary independent
variable. When the sweep starts, ATS-2 looks first to Source 2 for the
initial Start setting, then begins the first Source 1 sweep. When that is
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completed, ATS-2 then increments by one Source 2 step. Then the
Source 1 sweep is made again. This process is repeated until all the steps
defined in Source 2 have been completed.

The X-axis scaling and calibration are taken from the Source 1 settings.
The Source 2 parameter values are not directly visible on the graph, but
these values are displayed in the Graph Legend (see page 277).

The Source 1 and Source 2 controls and browser operate identically.

Pre-Sweep Delay

The pre-sweep delay setting enables you to specify a time delay
between the Go command and the actual beginning of the sweep, to allow
for stabilization of the generator or the device under test, if necessary. This
can help eliminate transient “glitches” at the start of a sweep. The
allowable pre-sweep delay range is 0.000 seconds to 4.000 seconds; the
default setting is 200 ms.

The pre-sweep delay is also applied before batch-mode DSP sweeps.
Acquisition of signal into any of the Analyzer FFT (batch-mode) programs
will not begin until the pre-sweep delay period (or 200 ms, whichever is
greater) has passed.

In nested sweeps (using Source 2), the pre-sweep delay is applied at
the beginning of each nested sweep.

Table Sweeps

The sweeps we’ve looked at so far step through a range of values set in
Source 1, controlling ATS-2 instrument settings as the independent
variable.

In a table sweep, the points of measurement are read from a table rather
than taken from Source 1 the Start / Stop settings. You must still use the
Source 1 browser to choose the ATS-2 instrument parameter that is to be
used, but the range, direction, number of steps and the step size are all
determined by the values entered in the sweep table.

This allows you to specify exact values and precise step sizes, which do
not need to be regularly spaced. The sweep will move in whatever
direction the values dictate, including forward or backward.

A sweep table is assigned to a sweep by “attaching” an appropriate AP
data file. This is usually a file saved as an AP sweep data file, with the
extension .atss. Click Table Sweep on the Sweep panel to view the file
attachment browser. Find the .atss file you want to attach to your sweep
and select it.
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Other AP data file types can also be attached as sweep files.

See More About Using AP Data Files on page 296.

Before you attach the file, you must indicate to ATS-2 which column of
data in the table will be your independent variable, that is, which values
will drive your sweep. Drop the Column field list on the browser and
choose the column. If you are not sure which column you want, click the
Edit button on the browser. This opens a panel called the Attached File
Editor. You can view the table in the Attached File Editor and decide which
column to choose. For more information on using the Data Editor and the
Attached File Editor, go to Chapter 18.

The Attached File Editor is similar in appearance to the Data

Editor, but they have different functions and should not be

confused.

When you are ready, click OK. The table will be attached to your sweep.
You will notice that the Steps and Stepsize (or Multiply) fields have
disappeared from Source 1, since they are no longer needed.

The Start, Stop and scale controls (Log, Lin, Div and Auto) are still
available, but they no longer affect the performance of the sweep; they are
only used to set the graph calibration and divisions. If you set the graph
range in Start and Stop narrower than the range of the values in the
sweep table, there will be points beyond the range which will not be
plotted.

If, instead of attaching an existing sweep table you would like to create
your own, open the Data Editor panel by clicking the Data Editor button
or using the Menu command Panel > Data Editor. You can enter, edit
and delete values in the Data Editor to create your sweep table. Save the
contents of the Data Editor as a sweep data file (.atss) using the Menu
command File > Save As > Sweep Tables.

External Sweeps

All the sweeps we’ve discussed are internal sweeps; that is, the
parameters and settings for the Source 1 independent variable come
from within the ATS-2 system, whether they are generator settings or data
from a sweep table.

It is also possible to use an external signal as the independent variable.
For example, a CD alignment disc may have a frequency sweep as a test
track, and to test the playback capabilities of the CD player you may want
to perform a response sweep with the disc as the signal source. This is
called an external sweep.
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The Sweep panel settings for an internal sweep not only set and sweep
the generator parameters but also configure the sweep and graph engines
for the display you desire. Start or Stop values and sweep direction, for
example, are clearly defined. An internal sweep is defined by panel
settings.

The Source 1 independent variable in an external sweep, however, is
driven by meter measurements, not by generator settings. In the case of
the CD test disc, the measured frequency of the received test signal
becomes the Source 1 information, and the measured channel A and B
amplitudes become the Data 1 and Data 3 results.

So in an external sweep, ATS-2 must monitor the input signal readings
to extract sweep controls from that signal. ATS-2 has no way to predict the
behavior of an external signal, and you must specify considerations such
as the range and direction of the sweep, when to graph a point, or when to
start and end the sweep.

Even with these specifications, extracting usable sweep controls from
input signals can be difficult. Noise, flutter, or level changes can all cause
an external sweep to act erratically or graph spurious points.

ATS-2 provides a number of special controls to set up an external sweep
and produce stable results.

External Sweep Operation

To enable the External Sweep mode choose an instrument reading
instead of a setting for the independent variable in the Source 1 browser.
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When this is done, the controls available in the Source 1 section of the
Sweep panel will change to External Sweep controls. The Steps,
Stepsize / Multiply and Table Sweep controls disappear, and Spacing,
End On, Min Lvl and the Min Lvl I.D. fields appear in their place, as
shown in Figure 208.

For a frequency sweep, the Source 1 instrument reading will be an
Analyzer frequency counter; for amplitude-controlled sweeps a level or
amplitude reading is normally used.

Before acquisition the reading must also satisfy the

requirements entered in the Settling panel for that instrument.

See Sweep Settling, page 259.

Start and Stop

In an External Sweep, the extent and direction of the sweep is not under
ATS-2’s control. You must inform the Sweep panel of the range in which
you expect the signal, and the direction you expect it to move. This allows
ATS-2 to track the signal for proper plotting on the graph.

Enter the expected values in the Start and Stop fields. If the value of
Start is less than Stop, ATS-2 will expect that the sweep will proceed
upward, in the direction of lesser to greater. If Start is greater than Stop,
ATS-2 assumes that the sweep will proceed downward.

If the sweep actually moves in the direction opposite to that indicated by
the Start and Stop field values, ATS-2 cannot plot a meaningful graph.
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The Start and Stop values and associated units also set the graph
scales and calibration, and the field values provide references for other
External Sweep controls such as End On.

Spacing

The Spacing field helps to determine the step size within the sweep.
Spacing is entered as a percentage, and the range for each new data
point is the value of the last point plotted, plus or minus the Spacing
percentage. At the beginning of a sweep, the Start On rules (below)
determine whether or not Spacing affects the acquisition of the first
plotted point.

End On

The End On field in the Source 1 section of the Sweep panel allows
you to set the conditions under which an External Sweep test will
terminate. An External Sweep test can be manually terminated by pressing
the Esc key or clicking on the Stop button when it is apparent that the
sequence of test tones has ended, but End On can terminate the sweep
automatically.

End On follows this logic:

� if the value set in End On equals the Stop value (plus or minus the
Spacing percentage), the sweep will terminate when the End On
value occurs;

� if the value set in End On does not equal Stop (±Spacing) and is
outside the range set by Start and Stop, the sweep will terminate
when the End On value occurs;

� if the value set in End On does not equal Stop (±Spacing) and is
within the range set by Start and Stop, the sweep will terminate on
a second occurrence of the End On value.

This produces several different behaviors:

� The first case, where End On equals Stop (±Spacing), allows you
to set End On at the end of your desired sweep. The last value
acquired (Stop ±Spacing) will be graphed.

� The second case, where End On does not equal Stop (±Spacing)
and is outside the Start–Stop range, allows you to set End On
beyond your desired sweep. You can, for example, place an
out-of-band cue tone after the swept tones to terminate the sweep.

� The third case, where End On does not equal Stop (±Spacing)
and is within the Start–Stop range, allows you to set End On to a
value in the mid-range of your desired sweep. This accommodates,
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for example, a frequency test which sweeps across the desired
spectrum and then returns to a mid-spectrum tone. If End On is set
to that mid-spectrum tone, it will note the first occurrence of that tone
as the sweep passes through it, and at the return the second
occurrence of the tone will terminate the sweep. Many pre-recorded
test tapes and CDs are made just this way, with, for example, a 20 Hz
to 20 kHz sweep followed by a 1 kHz reference tone. When
performing split-site measurements with ATS-2 or another Audio
Precision System, the remote generator can be set up so that the
generator dwells at its Generator panel setting (which can be a
mid-band reference frequency) before and after a Source 1 frequency
sweep.

Min Lvl

The value set in the Min Lvl (minimum level) field allows you to
exclude any measurements below a preset level, as measured by the meter
specified in the field just to the right of Min Lvl. This acts as a “noise
gate,” preventing noise or low-level signals from interfering with the
process. When Min Lvl is set very low, all signals will exceed the setting
and will be plotted; when Min Lvl is set very high, no signals will exceed
the setting and nothing will be plotted. This is useful in directing the sweep
to ignore the silence between tracks on a test CD, for example.

Start On Rules

Additional external sweep controls called the Start On Rules have
been added as OLE commands available to ATS-2 through the AP Basic
language. A macro has been created to give you easy access to the Start
On Rules.

On the ATS-2 Menu bar, click File > Open > Macro and select the
file xstart-onrules.atsb. Then, on the Menu bar, click Macro > Run. The
following dialog box will appear:
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Selection of a Start-On Rule remains in effect until a new selection has
been made or until the ATS-2 measurement software has been closed. The
default Start-On Rule is Within Start Tolerance.

In an external sweep, the Go button enables the acquisition of sweep
measurements; however, no data will be acquired until the
externally-generated signal satisfies the conditions set by the Start On rule
which is in effect.

There are three Start On rules:

� Within Start Tolerance.
The sweep starts on a settled reading that is above the Min Lvl
value, and that is also within the tolerance set by applying the
Spacing percentage to the Start value. For example, if Start is
20 Hz and Spacing is 5%, a reading between 19 Hz and 21 Hz will
start the sweep. Or, if Start is 1 V rms and Spacing is 10%, an
amplitude between 0.9 and 1.1 V rms will start the sweep.

This rule governs the normal behavior of external sweeps. The other
two Start On rules are:

� Beyond Start Value.
The sweep starts on a settled reading that is above the Min Lvl value
and exceeds the Start value in the sweep direction (up or down, as
determined by the relative values of the Start and End settings). No
data is collected until the Source1 meter reading passes (or equals)
the Start value.

� Any Settled Reading.
The sweep starts on a settled reading that is above the Min Lvl
value, without regard to the value in the Start field. Sweep
measurements are collected in the direction set by the Start and
Stop field values. In a sweep with Start at 20 Hz and Stop at
20 kHz, a 1 kHz measurement will not accept the next value until
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1 kHz +Spacing is satisfied. Under this rule, the data collected can
include values above or below the sweep graph limits set in Start
and Stop.

Some Hints

Internal sweeps, and some external sweeps, are called step sweeps
because the independent variable is moved across the sweep range in
discrete steps. Many external sweeps, however, move across their range in
a continuous change of values. These are called continuous sweeps or
glide sweeps.

Since the signal is gliding continuously from one value to another in a
glide sweep it will never stabilize and settle as it will in a step sweep, which
pauses at each step for some period of time. To enable to acquire these
continuously changing values, ATS-2’s sweep settling features must be
disabled. See Sweep Settling on page 259.

On the Settling panel, set the Analyzer.Frequency settling Algorithm
to None and Delay to 0.00.

Also, check your Min Lvl settings. The default meter assigned to make
the Min Lvl reading is Anlr A, but a browser can offer you a selection of
other sources. Be sure the meter that you have selected is the appropriate
meter for your test, that you have considered the effect of any filters you
may have attached to the meter, and that the Min Lvl threshold setting is
correct.

External Stereo Sweep

External sweeps can also be configured as stereo sweeps by clicking the
Stereo Sweep checkbox on the Sweep panel. ATS-2 will automatically
set the Data 3 (and Data 4, if necessary) settings to match the Data 1
(and Data 2) settings for stereo pairs. See Stereo Sweeps on page 249
for a full discussion.

Since ATS-2 is entirely dependent upon the External signal in an
External sweep, the automatic switching for the Stereo sweep crosstalk
feature (page 249) for ordinary sweeps is not available for external sweeps.

External Single Point Sweeps

External sweeps can also be configured as Single Point sweeps by
clicking the Single Point checkbox on the Sweep panel. See Single
Point Sweeps on page 250 for a full discussion.

When set up for an External Single Point Sweep, ATS-2 will wait until
the input signal satisfies all the criteria you have set, including MinLvl, the
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operative Start-On Rule, and Settling. When the Source 1 reading
fulfills these requirements, a Data reading will be taken.

An external single point sweep is useful to extract a single reading under
a specific condition, or permit an AP Basic macro to continue only at the
point that a measured parameter reaches a certain value.

An X-Y graph will not be drawn for a single-point measurement. View
the result in the Data Editor table.

Time Sweeps

In addition to generator sweeps and external sweeps, ATS-2 can graph
data against time in a Time Sweep, which produces a “chart recorder”
style measurement. Time Sweeps are commonly used to measure
instability or drift of audio parameters over time, or to plot
moment-to-moment variations such as wow and flutter or phase jitter.

To run a Time Sweep, open the Source 1 browser and select Time as
your instrument and Sweep Time as the parameter. Neither the Show
Readings nor Show Settings checkboxes have any effect on your
parameter choices, since you are neither setting a generator nor tracking a
measured reading.

The time interval starts when you click the Sweep Go button. You can
view the Time Sweep from the very beginning if you have entered
0.000 sec as your Start value. The sweep will continue until your Stop
value is reached.

As with generator sweeps, you can enter the number of Steps (or step
Multiply, in Log mode) or Stepsize as Source 1 settings. For very
closely spaced readings, ATS-2’s ability to make measurements will be
limited by other factors, such as Sweep Settling or meter detector reading
rates. For example, if your selected reading rate is 8 readings per second,
two consecutive readings cannot be closer than 125 ms.

At the very short reading intervals which are necessary to acquire
measurements which are close together, the speed of your computer and
the number of panels open in ATS-2 and the windows open in other
software running will have a noticeable effect on the speed of acquisition.

Sweep Settling

Most of the measurements in ATS-2 are taken continuously, often at
rates as high as 32 or 64 readings per second. The real-time numeric meter
displays show this “raw” data, and you will notice that the readings jump
around when the signal contains transients or other momentary
disruptions. We mentally “settle” these measurements as we observe them,
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ignoring the brief extremes and taking the perceived average or trend asignoring the brief extremes and taking the perceived average or trend as
the reading.

If raw readings like this were plotted without some way of excluding the
transients, there would often be meaningless points spread across the
graph.

The process of sweeping can also add spurious results to the
measurement. This is because the Sweep panel is stepping through
Source 1 parameter changes, with each change both the system
generators and typical DUTs need a moment to stabilize.

To address these considerations, ATS-2 has a sweep Settling panel to set
a list of criteria which the measured parameter must satisfy before being
acquired. These settling values can be adjusted for various measurement
conditions and goals, with the result that clear and meaningful graphs (or
tables of data) can be obtained.

ATS-2 normally obtains settled data by discarding early measurements
and plotting only later, repeatable values after both the DUT and the
ATS-2 generator and analyzer have stabilized. ATS-2 has default settling
values in place when you launch the software, but these can be adjusted to
optimize different measurements on the ATS-2 Settling panel. Settling
values are saved when you save a test file, and are recalled when a test file
is loaded.

The settling values only affect real-time sweep measurements, and, in
AP Basic macros, OLE meter readings. ATS-2 panel meter readings and
batch mode instrument readings are not settled.
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The Settling Panel

The ATS-2 Settling panel is available by selecting Panels > Settling
from the Menu bar or by clicking the Settling button on the toolbar; you
can also launch the Settling panel by selecting Sweep > Show Settling
Panel from the Menu bar.

The Settling panel allows you to set a number of settling parameters for
each of the meters available in an ATS-2 sweep. The Analyzer meters
available on the Settling panel will change with the Analyzer instrument
you have selected.

Settling Concepts

Although the Settling panel looks complicated, the concept is simple.
Since much of the signal disruption occurs at the beginning of a sweep
step because of instrument and DUT stabilization, the ATS-2 settling
function is designed to:

� Ignore early readings, and then to

� Calculate when a reading should be considered stable enough for
data to be acquired.
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The Settling panel offers two independent controls to accomplish this for
each ATS-2 meter: the Settling Delay time and the Settling Algorithm
selection.

Settling Delay Time

The first task in settling is to ignore all early readings, and any
measurements which arrive within the period between the beginning of a
sweep step and the time set in the Delay field are discarded.

Typical default Delay settings are in the 20 ms to 100 ms range,
depending on the instrument selected.

The Delay value is independent of the Algorithm choice, and is
effective even if the Algorithm selection is None. To completely disable
the sweep settling delay for a particular instrument, enter 0.00 as the
value in the Delay field.

For Time Sweeps where it is desired to make as many measurements
per second as possible, the Delay value should be set to 0.00 and the
Algorithm selection should be None.

All settling functions must be disabled when performing an External
Sweep which has a continuously moving independent variable (a glide
sweep). See Some Hints on page 258.

Algorithm Selection

In addition to setting a Delay time, you can also select one of three (or
None) Settling Algorithms to evaluate the stability of your signal.

The three Settling Algorithms are:

� Exponential
Exponential usually provides consistent results in the minimum
length of time. Since typical device transients tend to fall off in an
exponential fashion, this can be a very useful settling algorithm,
especially for analog signals.

� Flat
Flat provides highly repeatable results, but often requires more
settling time than Exponential. Flat is the default algorithm
selection.

� Average
Average is useful for noise measurements and for other random or
aperiodic signals.

The algorithms look to the Settling panel for values to use in making
their evaluation of signal settling. Average uses only the Points value;
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Exponential and Flat also look to the values set in the Tolerance and
Floor fields.

As mentioned in Settling Delay Time, above, all measurements taken
during the initial Delay period are discarded before ATS-2 begins
evaluating the signal with any of the selected algorithms.

Exponential Settling Algorithm

The Exponential Algorithm reports a data point after a certain
number of readings (the value set in the Points field) fall within an
exponential settling criteria envelope, an example of which is shown in
black in Figure 211. The shape and calibration of this envelope are
determined primarily by the value set in the Tolerance field. The Floor
field, which is explained below, keeps the size of the envelope from
decreasing to zero as the value being measured becomes very small.

To satisfy the Exponential criteria, a measurement N must agree with
the immediately preceding measurement N �1, within the Tolerance
value; and must also agree with measurement N � 2, within twice the
Tolerance value; and with measurement N � 3, within four times the
Tolerance value, and so on. This relationship must hold for the number of
consecutive measurements set in the Points field. Figure 211 shows a
series of points which have fallen within the specified Exponential settling
criteria envelope.
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Flat Settling Algorithm

The Flat Algorithm reports a data point when the signal is so stable
that the difference between any two consecutive readings, when expressed
as a percentage, is:

� less than the percentage value specified in the Tolerance field, and

� that this degree of stability is held through the number of readings
specified in the Points field.

The settling criteria envelope for the Flat algorithm is a pair of
horizontal lines at the plus-and-minus tolerance percentage values. The
gray lines on Figure 211 illustrate the Flat envelope for a 1% Tolerance
setting.

The Flat algorithm guarantees that the signal transients have been
settled to the specified Tolerance for some time. This tends to take longer
than the Exponential algorithm.

Average Settling Algorithm

The Average settling algorithm simply takes the mathematical average
of the number of consecutive measurements entered in the Points field
and reports the result as a data point. The Average algorithm is particularly
useful when the signal is fundamentally noisy and might never settle within
a practical tolerance.

Settling Tolerance

Settling Tolerance represents the amount of variability you are willing to
accept from test to test. A tolerance of 0.1 % (about 0.01 dB) may be
appropriate for frequency response tests on a DUT with excellent
characteristics; at the other extreme, tolerances of 10 % to 25 % may be
necessary to obtain data under noisy conditions. The default value of 1 %
is a good starting place.

Settling Floor

When working near the very bottom of the dynamic range for a
particular ATS-2 instrument, the difference between two adjacent values or
quantization levels can be large compared to the criteria in the settling
algorithm. At levels greater than a few percent of full scale on the
instrument, the value set in the Tolerance field is normally the
determining parameter, but close to the bottom of a measurable range
another technique is needed to keep the settling from slowing down the
sweep or even stopping it entirely.
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The Floor setting provides this protection. Whenever the value set in
the Floor field is larger than the product of the measured signal multiplied
by the Tolerance percentage, the algorithm uses the Floor value instead
of waiting for the signal to satisfy the Tolerance criteria.

For example, with a Tolerance of 1% and a Floor setting of 1 µV, the
Floor takes over when the measured signal drops to 100 µV.

The default values of Floor for each ATS-2 meter are chosen to be
approximately the resolution of that meter on its most sensitive range.
Since resolution increases as the reading rate slows, it may be appropriate
to change the default Floor values when the reading rate is fixed at a
specific value.

Settling Issues for Specific Instruments

Settling for each meter in ATS-2 is independently controlled by its own
row of fields on the Settling panel.

Audio Analyzer Reading meter settling values are stored independently
for each Audio Analyzer mode. For example, the settling values for Audio
Analyzer Amplitude A and B are independent of the settling values for
Audio Analyzer THD+N Amplitude A and B.

The Audio Analyzer Phase mode has no Tolerance field. The
acceptable variability for this meter should be entered in the Floor field in
degrees. An entry of +10.00 deg, for example, sets a 10-degree-wide
window of acceptance for the selected algorithm to use in calculation.

Timeout

It is possible with extremely noisy signals that the instability of the
measured parameter is consistently greater than the Tolerance value
entered on the Settling panel, and that it is impossible to satisfy the Settling
algorithm and get a settled reading.

The Timeout control exists to keep your sweep from running slowly or
even locking up under these conditions. If a settled reading cannot be
made within the period of time entered in the Timeout field, ATS-2 will
calculate the average value of the last 6 measurements, enter that value as
a data point and move on to the next sweep step.

The default Timeout value (per step) is 4.000 sec.

“Timed-out” points are marked with a white “T” at the top of the graph,
above the plotted point. In the Data table, each timed-out point is
indicated with the letter T following the data.
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The Log File can also indicate timed-out data with several notices. See
The Log File, page 344.
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Chapter 16

Graphs

The graph is a central feature of the ATS-2 test and measurement
system. As mentioned in Chapter 15, the functions of the Graph panel and
the Sweep panel are closely related.

To configure and initiate any measurement to be plotted on a graph,
you must go first to the instrument panels and then to the Sweep panel.
Whether real-time Analyzer measurements or batch-mode FFT
measurements, the Sweep panel is the control center.

Besides collecting the data for the graph display, the Sweep panel also
sets the graph scaling and calibration; that is, the number and spacing of
the vertical and horizontal graticule lines, and the X-axis and Y-axis
numerical calibration and unit domain.

To change these graph parameters you must go to the Sweep panel.

Chapter 16 discusses the display controls available on the Graph panel.

The Graph Panel

The ATS-2 Graph panel is available by selecting Panels > Graph
from the Menu bar or by clicking the Graph icon on the toolbar.

The Graph panel plots the Source and Data information provided by
the Sweep panel as X-Y relationships and provides a number of controls to
modify the display, examine the traces with cursors, and add labels,
comments and descriptive legend information both to the graph and to
exported and printed versions.
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The Graph panel itself can be resized to any practical dimension or
aspect ratio you prefer by dragging the borders with the mouse pointer.
Similarly, the Legend and Comment areas within the Graph panel can
be adjusted for size.

Zoom

You can “zoom in,” or magnify, any area of the graph by dragging the
mouse pointer diagonally across the area you would like to magnify.
Dragging the mouse pointer will draw a rectangle surrounding the area, as
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shown in Figure 213. When you release the mouse button the graph will
re-size itself to the rectangle you have drawn. You can perform this
operation repeatedly to zoom further and further in.

When you are zooming into graphs of batch-mode FFT measurements,
the Sweep Reprocess Data (Ctrl-F6) command is normally sent to the
Analyzer, requesting new data at the new sizing, so that the zoomed view
will consist of the maximum possible resolution. This automatic
reprocessing can be disabled on the Configuration panel by unclicking the
Reprocess FFT data on zoom.

The Sweep Reprocess Data command is only effective if

the acquired signal is still in the DSP memory. A test file

loaded from disk, for example, will only contain the Graph

data of the FFT being viewed when the test was saved, and

increasing the resolution during a zoom is not possible.

The Graph Options Menu

Click the right mouse button anywhere within the graph itself and the
Graph Options menu will appear at the mouse pointer. This menu
provides a number of graph display and control options, as shown in
Figure 214.

Zoomout

Choose Zoomout to reverse the last Zoom operation and reduce the
magnification of the graph. If you have Zoomed repeatedly, clicking
Zoomout repeatedly will back you out of your Zoom operations, one at a
time.
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If you are viewing a batch-mode FFT, the Zoomout command will also
send the Sweep Reprocess Data command, following the same
behavior as with the Zoom command.

Zoomout to Original

Choose Zoomout to Original to return to the original graph sizing
and coordinates in one step.

If you are viewing a batch-mode FFT, the Zoomout to Original
command will also send the Sweep Reprocess Data command,
following the same behavior as with the Zoom and the Zoomout
commands.

Optimize

The Optimize graph option is a method of zooming or magnifying the
scale of the graph relative to the signal currently on the graph. An
optimized graph will replot with new Y-axis coordinates for a
maximum-resolution display of the signal.

Although you can optimize your graph at any time, it is usually most
effective to optimize after the conclusion of a sweep. There are four
Optimize choices:

� Optimize Individually.
This option is only available if both Y-axes are in use, displaying data
mapped to the Data 1 or Data 2 coordinates. Optimize
Individually sets the left Y-axis calibration for the best display of the
Data 1 set of values, and sets the right Y-axis calibration for the best
display of the Data 2 set of values.

� Optimize Together.
This option is only available if both Y-axes are in use, displaying data
mapped to Data 1 or Data 2 and which use the same unit
domains. Optimize Together sets both the left and right Y-axis and
calibration for the best display of the entire range of values. This
feature provides the ability to graphically compare traces (of the same
unit domain) plotted against both left and right Y-axes.

� Optimize Left Only.
This option is only available if the left Y-axis (displaying Data 1 and
other data plotted against the Data 1 axis) is in use. Optimize Left
Only sets the left Y-axis calibration for the best display of the Data 1
set of values.

� Optimize Right Only.
This option is only available if the right Y-axis (displaying Data 2
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and other data plotted against the Data 2 axis) is in use. Optimize
Right Only sets the right Y-axis calibration for the best display of the
Data 2 set of values.

Unlike the Zoom features, the Optimize options do not issue a Sweep
Reprocess Data command to the DSP for batch-mode FFT
measurements. Optimize only operates on the graph display and does
not plot new data.

There is no need to reprocess batch-mode measurements

after Optimizing. Reprocessing is necessary when the

X-axis scale is changed; Optimize only re-scales the Y-axis.

To return to your original display, click Zoomout or Zoomout to
Original.

Copy to Sweep Panel

It is often the case that after zooming or optimizing your graph, you
decide that you should re-run your sweep with Start, Stop, Top and
Bottom settings which correspond to the coordinates on your resized
graph. A shortcut to this adjustment is provided with the Copy to Sweep
Panel selection. Copy to Sweep Panel takes the modified graph
calibrations provided by Zoom or Optimize and writes these as settings
in the Sweep panel. A new sweep will create a new graph with the X and
Y-axis calibrations from the zoomed or optimized graph.

Display Cursors

ATS-2 provides two cursors as aids in interpreting your graph. On the
Graph Options menu, click Display Cursors. A green vertical line will
appear, with two display boxes at the top and the bottom of the graph,
adjacent to the cursor position.

The green line is actually two cursor lines right on top of each other. The
value in the bottom display box on the graph is the X-axis position of the
cursors. The value in the top display box is the difference between the
X-axis positions of the two cursors. Since the cursors begin in the same
position, the initial difference is 0.00000.
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You can move the cursors simply by placing the mouse pointer on the
green line and dragging sideways. The mouse pointer changes from the
standard arrow to a dragging pointer, which indicates by a number
whether you are dragging cursor 1 or cursor 2. When you have dragged
the cursors off one another, each cursor is assigned its own X-axis display
box.

The cursors are shown as vertical lines whenever no Data traces are
selected. To select a trace, simply click on the corresponding row shown in
the graph legend; the legend row then appear highlighted to indicate that
it is selected. See Graph Legend later in this chapter on page 277. The
selected trace will be displayed as a thicker line, and the cursors will be
assigned to that trace, displayed as crossed circles rather than vertical lines.
The crossed circles can be dragged along the trace with the mouse pointer.

Chapter 16: Graphs The Graph Options Menu

272 ATS-2 User’s Manual

Figure 215. Graph Cursors on a deselected trace.



To deselect a trace, simply click the selected row a second time in. Click
in the Data or Axis cells for deselection to take effect.

When a trace is selected, the Y-axis values at both cursor intersections
are shown in new display boxes at the left side of the graph. A new display
box also appears at the top of the graph, showing the difference between
the two cursor Y-axis values.

You can also move the cursors on the graph using the keyboard. When
the graph window is selected (click anywhere in the graph), the left and
right arrows move a cursor horizontally across the trace. To select the other
cursor, press an arrow key while holding the SHIFT key depressed, then
move the cursor as before.

To move the cursors to another trace, press the up or down arrow keys.

One or both cursors can be deselected entirely, or the two cursors can
be assigned to different traces. In the Legend box, there are two columns
labeled Cursor 1 and Cursor 2. The data in these columns are the Y
values for that particular cursor position. Two of the cells in the Cursor
columns also have an asterisk (*) leading the numeric values. This asterisk
indicates the cursor assignment.
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To reassign one cursor to a different trace, first click the Cursor 1 or
Cursor 2 column header, which will change to read ***Select***. The
entire column will be highlighted. Then, in that column, click the cursor cell
in the row which corresponds to the trace where you would like to move
the cursor.

To unassign cursors, select a cursor column as in the previous paragraph
and click on the cell displaying the “cursor selected” asterisk. The cursor
for that trace will be unassigned.

Cursors may be assigned to different traces only if the two traces have
compatible parameters or unit domains.

If the graph is a nested sweep, the Source 2 value for the selected trace
is shown in a display box at the top of the graph.

Scroll Bars

If you have zoomed to a particular graph region and would like to view
another region, open the Graph Options menu and click Scroll Bars. This
provides an easy way to move around a graph which extends beyond the
Graph panel window.

If you don’t need to scroll, click again on Scroll Bars. The scroll bars
will disappear and the graph will be displayed slightly enlarged.
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Title and Labels

You can modify or add titles and labels to your graph. On the Graph
Options menu, click Title and Labels. A dialog box will appear for you
to make your entries. The Company Name setting has its source in the
ATS-2 Configuration panel, where you can enter a company name or
other information.

Comment

You can optionally enter comments in the Comment Edit box, which
is displayed on the Graph panel below the Graph Legend. On the Graph
Options menu, click Comment to view the Comment Edit box on
screen.

Your comments will always print at the bottom of a tabular data printout
(File > Print > Data). When printing a graph (File > Print > Graph),
you have the option of printing the comments or not, depending on your
selections on the Page Setup dialog box, discussed on Page 312.

New Data

To clear the graph and the Data Editor, click New Data in the Graph
Options menu. This has the same function as the command File > New
> Data. This command actually removes the data from memory, not just
from the display, and cannot be undone.
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Graph Buffer

The Graph Buffer is a dedicated display memory in which you can store
a trace (or set of traces) as a reference, and then recall the reference for
comparison to a graph of current data. When you click Graph Buffer a
small submenu appears with these choices:

� Store Trace
Click Store Trace to put the traces currently on the Graph panel into
the Graph Buffer memory. You may also use the keyboard
combination ALT+F8.

� Recall Trace (Hide Trace)
This choice toggles between Recall Trace and Hide Trace. The
stored reference trace appears in the color gray on the screen, and
can be switched on and off with this command. You may also use the
keyboard shortcut F8 as a toggle.

� Delete Trace
Click Delete Trace to clear the Graph Buffer memory. You may also
use the keyboard combination CTRL+F8.

This feature allows you to use a measurement of a specific unit or
condition as a visual reference for comparison or adjustment of other units.

Reference traces are retained and properly plotted even if you change
graph scaling and calibration, including the use of zooming and
optimization. Units of measurement can be changed as long as the unit
domain remains the same (volts to watts to dBu, for example).

Reference traces are NOT retained through changes between analog
and digital domain, or when plots are changed from absolute units to ratio
units.

Reference traces are displayed in the color gray.
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Graph Legend

On the Graph panel immediately beneath the graph itself is a display
called the Graph Legend. The Legend displays one row for each graph
trace in memory, showing information about the display of that trace and
providing drop-down lists to modify some of the display parameters. If a
limit file has been loaded, the limit traces appear in the Legend as well.

The Legend columns are:

� (No Title)
The leftmost column selects which Data rows are plotted on the
graph. Selected rows show an “X” in this column. The title box for
this column is blue when the Graph Legend is selected and gray
otherwise.

� Color
The Color column shows the color currently assigned to each trace,
and offers a drop-down list so that you can change a trace’s color.

� Line Style
The Line Style column shows the line style currently assigned to
each trace, and offers a drop-down list so that you can change a
trace’s line style.

� Thickness
The Thick column shows the line thickness currently assigned to
each trace, and offers a drop-down list so that you can change a
trace’s line thickness. Thicknesses greater than 1 can only be applied
to Solid line style traces.

� Data
The Data column shows the ATS-2 instrument and parameter
associated with that trace.

� Axis
The Axis column shows whether the trace is calibrated and scaled
on the left or right Y-axis.

� Source 2
If Source 2 is used (a nested sweep), the ATS-2 instrument,
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parameter and value associated with that trace are shown in this
column.

� Cursor 1
If cursors are enabled, this column shows the value of the associated
trace at its intersection with Cursor 1. An asterisk in the cell
indicates that the cursor is assigned to that trace.

� Cursor 2
If cursors are enabled, this column shows the value of the associated
trace at its intersection with Cursor 2. An asterisk in the cell
indicates that the cursor is assigned to that trace.

The Source 2 column and the Cursor 1 and Cursor 2 columns will
only be displayed if these options are in use.

The Graph Legend box can be resized by dragging its top border with
the mouse pointer. If the list of traces in the Legend is too long to display,
scroll bars will appear on the Legend box for navigation. Column widths
can also be resized by dragging the border between column headings with
the mouse pointer.

Graph Legend / Data Editor Linkage

The display of information in the graph Legend is visually linked with
the tabular sweep data display shown in the Data Editor. For appended or
nested sweeps, this can help in identifying which line shown in the Data
Editor is associated with a particular trace.
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This linkage in the displays identifies the correspondence between data
and traces in two ways:

� Normal Type or Bold Type.
Alternate sets of traces in both the graph Legend and the Data Editor
are displayed in alternating bold and normal typefaces. A bold
typeface is used for odd-numbered sets of traces; a normal typeface
is used for even-numbered sets of traces.

� Data Editor scrolling.
The Data Editor automatically scrolls so that the set of data
corresponding to the trace selected in the Graph Legend is shown at
the top of its window.

Trace Colors

ATS-2 traces are normally displayed in one of six colors:

� cyan

� green

� yellow
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� red

� magenta, and

� blue.

These colors can be automatically assigned by ATS-2 according to the
type of sweep and the settings made on the Configuration panel. The
order of these colors is called the “color cycle,” and when ATS-2
automatically increments colors it always does so following this order. The
cycle “wraps back” from blue to cyan when the end of the cycle is
reached.

The color gray is also available and can be manually assigned to any
trace. However, gray is not part of the color cycle and is normally reserved
as the color for reference traces recalled from the Graph Buffer.

Color Assignment for a New Test

When a single sweep is made in a new test, ATS-2 normally chooses
cyan as the color for the trace. However, if you have assigned a different
color to a trace and subsequently run a new test without closing ATS-2, the
color you have previously chosen will be the trace color for the new test.

Color Assignment for Multiple-Data-Set Sweeps

In a single sweep with more than one set of Data values being plotted,
by default ATS-2 assigns the Data traces colors according to this pattern:

Data 1 cyan

Data 2 green

Data 3 yellow

Data 4 red

Data 5 magenta

Data 6 blue

If the Reset color cycle checkbox in the Configuration panel is
checked, each new sweep will assign colors to the Data sets in this way,
whether or not you have made manual color changes in the Graph
Legend.

If the Reset color cycle checkbox in the Configuration panel is
unchecked, ATS-2 will use this assignment of colors initially. If you
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manually change any color-to-Data assignment, ATS-2 will maintain your
new color assignments throughout subsequent sweeps.

See Chapter 25, Configuration.

Color Cycling in Nested and Appended Sweeps

When nested or appended sweeps are made, each Data trace in each
sweep follows the color cycle pattern, picking up at the place in the pattern
where the same Data trace of the previous sweep left off. For example, a
Data 1 trace which was green in a particular sweep would be displayed in
yellow in the next appended or nested sweep.

When a test file is opened, the first display will be the traces from the
loaded test using the colors saved in that file. If new sweeps are appended
to this test by sweeping with the Append box checked, the colors assigned
to the appended sweeps traces depend on a Configuration setting:

� If the Use Test Colors Only checkbox on the Graph tab of the
Configuration panel is unchecked, the trace colors will rotate through
the color cycle, using the test colors as the starting point.

� If the Use Test Colors Only checkbox is checked, color cycling is
disabled and each appended trace will maintain the trace color
loaded in the test.
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See Chapter 25, Configuration.

Color Cycling with Appended Files

When a current sweep is appended with sweep data from disk using the
File > Append command, the colors assigned to the sweep traces from
the appended file depend on a Configuration setting:

� If the Cycle Trace Colors checkbox on the Graph tab of the
Configuration panel is unchecked, the appended file trace colors will
come in without change.

� If the Cycle Trace Colors checkbox is checked, the colors of the
traces appended from disk will move through the color cycle, using
the last set of traces currently in memory as the starting point.

See Chapter 25, Configuration.
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Chapter 17

Bar Graphs

Each ATS-2 instrument has a number of settings and readings on its
control panel; the Analog Generator, for example, has fields to set
frequency and amplitude, and the Audio Analyzer has fields to read these
parameters.

Bar Graphs are graphical display panels that can be associated with
instrument settings and readings for easier control and observation. Up to
32 Bar Graphs can exist simultaneously, associated with any combination
of instrument parameters. Bar Graphs can be set to any size.

Bar Graphs are not related to the graphs controlled by the

Sweep panel and displayed on the Graph panel.

Creating a Bar Graph

A Bar Graph can be associated with any ATS-2 field that sets or reads a
signal parameter.
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To create a Bar Graph, click on the setting or reading field to be
associated with the Bar Graph, then either click on the Bar Graph icon or
choose Panels > Bar Graphs > <new>. A new Bar Graph will be
created and associated with the parameter that you highlighted. If no
appropriate field was highlighted, the default new Bar Graph association is
with the Audio Analyzer Level Meter, Channel A. You can change the
association at any time using the Bar Graph Setup panel, discussed below.

Another way to make a new Bar Graph is to right-click the setting or
reading field in which you are interested, and click Create Bargraph from
the menu which appears.

Bar Graph Setup

Click the Setup button to access the Bar Graph Setup panel. The
Setup button may not be visible if the Bar Graph panel is sized too small.

Chapter 17: Bar Graphs Bar Graph Setup

284 ATS-2 User’s Manual

Figure 225. Creating a Bar Graph by

right-clicking the mouse.

Figure 226. Bar Graph Setup panel.



At the top of the Bar Graph Setup panel is a Connection browser,
similar to the instrument browsers at Source and Data in the Sweep
panel. You can select the instrument and setting or reading parameter for
this Bar Graph using the Connection browser.

Checkboxes allow you to Display Digits Only or toggle the
Comment display.

Target Range displays a dark bar on the Bar Graph to give a visual
indication of a range of interest. You can turn the Target Range display on
or off by checking the Range On checkbox. Set the extents of the Target
Range in the Lower and Upper fields in this area.

Target Range is enabled only on a Bar Graph configured for readings.

In the Axis area you can set up the range of the Bar Graph display, or
click Autoscale to let ATS-2 scale the display in response to the signal.

For most parameters you can make the choice between a logarithmic or
linear scale by clicking the Log or Lin option buttons.

The Increment field is only available for settings, and enables you to
specify the minimum increment by which the setting can be changed.

Using a Bar Graph for Readings

To use a Bar Graph for readings, you must create the graph while an
instrument reading field is highlighted, or you must select an instrument
reading parameter from the Connection browser in the Bar Graph Setup
panel.

Bar Graph readings are displayed as green digits and also as a
horizontal magenta bar. The bar will respond to the signal reading in real
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time, simulating an analog meter. You can remove the bar display by
selecting Display Digits Only on the Setup panel.

When the magenta bar moves to show a changing signal, a narrow gray
horizontal bar will appear on the magenta bar to indicate the history of
minimum and maximum readings. This can be reset by clicking the Reset
button or the Reset Min/Max button on the Setup panel.

You can also add a Target Range display bar to a readings Bar Graph.
Target Range displays a dark bar over the magenta bar to give a visual
indication of a range of interest. Refer to the previous Bar Graph Setup
topic for information on setting a Target Range.

Using a Bar Graph for Settings

To use a Bar Graph for settings, you must create the graph while an
instrument setting field is highlighted, or you must select an instrument
setting parameter from the Connection browser in the Bar Graph Setup
panel.

Bar Graph settings are displayed as green digits and also as a horizontal
white bar with a slider control. Moving the slider along the bar will adjust
the signal setting in real time, simulating an analog control. You can
remove the slider bar display by selecting Display Digits Only on the
Setup panel.

You can move the slider by dragging it with the mouse pointer, or, if the
slider has been most recently selected, by using the left and right keyboard
arrows.

The minimum setting step can be changed by entering a new value into
the Increment field on the Bar Graph Setup panel.

When the slider has been moved, a blue horizontal bar will appear on
the white bar to indicate the history of minimum and maximum settings.
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This can be reset by clicking the Reset button or the Reset Min/Max
button on the Setup panel.
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Chapter 18

Editing Data and Setting Limits

The Data Editor

Any data collected by the Sweep panel, including stimulus and response
data from real-time sweeps, and bin centers and values in batch-mode
FFTs, is temporarily stored in memory during an ATS-2 session. This data
can be replaced, deleted, appended to, stored on disk, and so on. ATS-2
data which has been stored on disk as an .atsa file or within a test can be
loaded to become the current data in memory.

The Data Editor panel gives you a detailed view of the current data in a
table, much like a spreadsheet page. The Graph panel uses these values
to draw the traces on the X-Y graph display, and if you change a value in a
Data Editor cell the corresponding point on the graph will move.

Certain data will not graph, including a single point sweep, a sweep
which contains changes of direction in Source 1 values, or, in graphs
where two unit domains already occupy the left and right Y-axes, another
data set expressed in a third unit domain.

The Data Editor, however, shows all the data in current memory, even
data which will not graph. If you have accidentally configured a sweep
which will not graph, the Data Editor is an excellent tool to verify that the
sweep has actually executed, and to examine the data to find your error.

The Data Editor is closely tied to both the ATS-2 Sweep and Graph
functions, which are discussed in Chapter 15 and Chapter 16.
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The Data Editor Panel

The ATS-2 Data Editor is available by selecting Panels > Data Editor
from the Menu bar or by clicking the Data Editor icon on the toolbar.

Columns

Data Editor columns cannot be edited. You cannot add, delete, move or
rename a Data Editor column. These columns correspond to the Source
and Data settings in the Sweep panel; to add or remove a column you
must reconfigure the sweep.

The column width can be adjusted by dragging the column header
delimiters with the mouse pointer.

Rows

Data editor rows correspond to Sweep measurement points (or, in FFT
measurements, bin centers). You may add or remove Data Editor rows.
Adding or removing rows changes the data in memory, and the graph and
stored data files will reflect your modifications.

Data

The settings and reading values shown in the Data Editor cells can also
be edited. Editing the value in a cell changes the data in memory, and the
graph and stored data files will reflect your modifications.

The displayed values in the cells can appear in a normal type font, in a
bold font, and, under some conditions, in a red font.

The normal and bold typefaces alternate between sweeps (or changes
in sweep direction) for easy identification of data sets when performing
appended or nested sweeps. These normal/bold designations also
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correspond to the normal/bold designations in the Graph Legend display.
The Data Editor will also scroll to the first data point in a trace when the
row for that trace is selected in the Graph Legend. See Graph Legend /
Data Editor Linkage, page 278.

Data values may also be flagged with letters to indicate special
conditions:

� B (Bad) indicates invalid data.

� U (Upper) indicates that the measurement value has exceeded the
Upper limit. This condition is also marked by a red typeface. See
Limits on page 292.

� L (Lower) indicates that the measurement value has passed below
the Lower limit. This condition is also marked by a red typeface. See
Limits on page 292.

� T (Timeout) indicates that settling has timed out for this
measurement. See Timeout on page 265.

� R (Regulation) indicates that the attempt to regulate this data reading
was unsuccessful. See Regulation on page 335.

Graph cursor locations are indicated in the Data Editor by highlighting
the cursor cells with a light gray background.

Editing the Current Data in Memory

In the Data Editor window, you can enter or change data in any cell by
selecting the cell with the mouse pointer and entering or deleting the value.

For other editing options, right click within the Data Editor window and
the Data Editor menu will open and provide the following choices:

� New Data
New Data erases all the information in memory and cannot be
undone.

� Insert Row Before

� Insert Row After

� Add Row to the End will add one row to an empty data table, or
will add one row below the last existing row.

� Delete Row

� Select all rows

� Unselect all rows

The Data Editor Chapter 18: Editing Data and Setting Limits
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Saving ATS-2 Data

The information in the Data Editor is saved on disk, along with other
information, as part of an (.ats2) ATS-2 test file. When a test is loaded, the
test information becomes the current data and is viewable in the Data
Editor.

The current data shown in the Data Editor can also be saved in several
types of data-only files, which ATS-2 uses for different purposes, as
follows:

� Data (.atsa) file. Data files can be reloaded as current data.

� Limit (.atsl) file. Limit files can be attached to a sweep to provide
upper and lower pass/fail limits against which to compare the current
measurements. Limits are discussed below.

� Sweep (.atss) file. Sweep files are used to store data for Table
Sweeps, which are sweeps that get their Source data from a table
rather than Sweep panel settings. See Table Sweeps, page 251.

� EQ (.atsq) file. EQ files are used to modify sweep measurements by
computing the sweep data against the data in an EQ table. See
Compute Equalize, page 308.

Setting Limits

You may want to compare a graph of a DUT’s performance with an
ideal device or with a published standard. Of course, you can always
append one graph to another and make a visual comparison, but ATS-2
provides a more powerful technique: setting limits and performing a
pass/fail test.

To set limits in ATS-2, you must attach a limit file to your sweep. See
Chapter 15 for a detailed discussion of sweeps.

When a measured sweep value exceeds a set limit value, the
measurement is flagged as having failed the limit. This flag can be viewed
in the Data Editor or reported in more detail in the Log file. If your
pass/fail test is part of an automated AP Basic macro, the flag can be
reported, or it can be used as a trigger for some other command. A limit
can also be configured to immediately stop the sweep on failure. See
Actions Upon Failure, page 296.

Making a Limit File

Any ATS-2 data which can be viewed in the Data Editor or saved as a
data file can be a Limit File. This enables you to use actual measured data
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from a test on one DUT as the limits or standards for a test on a different
DUT.

Instead, you may want to use published standards or arbitrary values as
your limits. In these cases you can enter the data manually into the Data
Editor, or edit an existing Limit File in the Attached File Editor, or even
create limit values in a spreadsheet or text editor program and import the
file into ATS-2.

As an example we will create a limit file in the Data Editor.

First set up a new sweep with two data traces. The default sweep starts
with only one trace, Data 1; to add a second trace go to the Data 3
browser and set it to DSP Analyzer Level B. Click Single Point and
Go; this will inform the Data Editor that you are using two data columns.

Open the Data Editor. The display will have three column headings and
one row of data, the single point sweep you just performed. Click the right
mouse button to open the Data Editor menu, and add five more rows
using the Add Row to the End command.

To enter a value just set the cursor in a cell and type. To make a
complete trace, you must enter all the Source and Data values necessary
to describe the limit you want. If the Graph panel is open, you can view
the trace as you create it

Create a limit trace by entering the values shown in Figure 230.

This will produce the limit traces shown in Figure 231.
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When you are satisfied with the limits you have created, save the data
as an AP limit file using the command File > Save As > Limit Data.

When making a limit file, there are some constraints you must
remember:

� The Source 1 column of the limit data must correspond with the
Source 1 parameter of the sweep the file will be attached to. For
example, a frequency-sweep test will have generator or FFT
frequency as Source 1, and any limit files used with this test must
also have frequency at Source 1.

� There must be a Data column heading for each limit.

� The units of measurement for each limit data column must be in the
same unit domain as the corresponding data in the sweep the file will
be attached to.

You can save upper and lower limits in two separate files; or, you can
save upper and lower limits as two different data columns in the same file.

If two measurements are to be compared against exactly the same limits,
as is often done in stereo sweeps, the same data column can be used as a
limit for multiple measurements. If you have checked the Stereo Sweep
checkbox on the Sweep panel, the limit attached to Data 1 will also be
attached to Data 3. See Stereo Sweeps, page 249.

Attaching a Limit File

Limits are attached to specific data traces on a sweep. To attach a limit
file, choose the data in your sweep that you would like to compare to a
limit (Data 1, for example) and click the Limit button for that Data.

The Limit File Attachment dialog box will appear. Browse to the data file
that contains the limit data you would like to use. You can select any type
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of AP data file, not just an “.atsl” Limit file, as the source of your limit
values.

You can attach upper limits, lower limits, or both. Just select a data file
in the appropriate area of the dialog box. Check the box labeled Upper
and Lower Limit are from same file if you are using data from a single
file for both upper and lower limits.

Once you attach a data file, a list of the available data columns in the
file will be displayed in the list box under the file selection field. If there is
more than one data column, you must indicate the column you would like
to use as limit data for your sweep.

Using the Attached File Editor

Once a file is attached, you have the opportunity to edit the data in the
file. Click on the Edit Upper Limit or Edit Lower Limit button to edit
the attached file. The Attached File Editor will open.

The Attached File Editor is very similar in appearance to the Data Editor
(page 289), but the two windows have different functions. The Data Editor
displays the data in memory, while the Attached File Editor displays the
data in the upper or lower attached file. The Attached File Editor is also
available from the Table Sweep dialog box (see page 251) and the EQ
Curve dialog box (see page 76).
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You can view and edit the attached limit data in the Attached File
Editor. In the Attached File Editor display, the column corresponding to the
limit data you have selected is marked with two asterisks (**).

Changes you make in the attached file values will not be effective until
you save the file. To save a file from the Attached File Editor, close the
editor window. A dialog box will open and prompt you to save the file.
The file is always saved under its current file name, overwriting the
previously saved file.

The commands on the File menu (File > Save > Limit, etc.)

save the data in current memory, not the edited data in an

attached file. Close the Attached File Editor to properly save

this data.

Actions Upon Failure

A pass/fail test fails when the measured data exceeds a limit value
during a test. Depending upon the system settings and configuration,
ATS-2 will indicate a limit failure in several ways:

� Terminate Sweep
Normally, the sweep will continue even if limits are exceeded.
However, if you click the Terminate Sweep on Failure box on the
Limit File Attachment dialog box, the sweep will end if a limit is
exceeded.

� Tabular Display Flags
Any measurement that exceeds a limit will be marked with a U (for
upper) or an L (for lower) in the Data Editor table. See Data Editor,
page 289.

� Log File Indicators
If Log Errors is set in the Configuration panel, limit failures will be
shown in detail, displaying Source, Data and Limit values and the
amount and sign (+ or –) of the error for each limit failure. See The
Log File, page 344.

More About Using AP Data Files

Data files include the four types listed on page 292. Data saved to any
of these filetypes is maintained in an identical format; the extensions are
different as an administrative aid to help you and the ATS-2 software
determine the intended purpose of a particular data file, sort your files
meaningfully and so on.

A consequence of this is that you can use an EQ file (.atsq) for a Table
Sweep, or a Data file (.atsa) for setting limits.
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This is particularly useful as it enables you to save all your data,
including Sweep data, EQ and Limit data, in one file. You can then attach
the file as a Sweep Table or Limit or EQ file and select the appropriate
data column from the list within the file browser.

AP data files are binary files, and it is not possible to edit the files
without using the Data Editor or the Attached File Editor.

However, it is possible to export the current data in memory as an
ASCII text file for use in a spreadsheet or text editor program. The ASCII
file contains AP data file header information and the data in a
comma-delimited format. The extension for the ASCII file is .atsx.

You can open the ASCII file in Microsoft Excel, for example, edit the
data and save the file, and then re-import the file into ATS-2 and save it
once more in one of the native AP data file formats.

When editing the ASCII version of an AP data file in an external
program, you must keep the correct column/row relationships and
maintain or insert a correct file header at the top of your data. Here is an
example of the information in the ASCII version of an AP data file:
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Chapter 19

Performing Computations on Data

Chapters 15, 16 and 18 explain how ATS-2 can gather, display, edit and
perform other operations on a set of data. Using the commands on the
Compute menu, you can also process the current data in memory with a
number of useful mathematical algorithms.

Use of the Compute algorithms does not change the acquisition of data.
Instead, the acquired data points are changed according to the applied
algorithms by averaging, for example, or inversion or normalization.

The Compute algorithms irrevocably change the data in

memory. Save the original data on disk if you wish to keep it.

See Comparing Computed Results with Original Data,

page 309.

ATS-2 provides 10 different computations which you can apply to your
data as selections on the Compute menu, as shown in Figure 235.
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Additionally, the menu provides a Compute Status command, which
opens a dialog box to view and edit the list created by applying the Apply
After Sweep option to one or more Compute algorithms. At the bottom
of the menu is the Clear All and Reset command.

These commands are discussed on page 308.

The Compute Dialog Boxes

Although each of the 10 Compute dialog boxes has different features
associated with a particular compute algorithm, all the boxes are similar
and have the following checkboxes and buttons in common:

Each Compute dialog box has a list of six checkboxes labeled Data 1
through Data 6. The Compute algorithms will only operate on the data
trace or traces you have selected, leaving the other data untouched.

You can select different combinations of data traces in different
Compute algorithm dialog boxes.

Four buttons give you the following commands:

� Cancel
Abort the operation.

� Close
Keep the settings made and close the dialog box.

� Compute
Perform the computation while leaving the dialog box open for
further operations.

� Compute and Close
Keep the settings, perform the computation and close the dialog box.
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It is possible to perform a Compute operation repeatedly, or to perform
several different compute operations in sequence. You can do this
manually by opening and configuring Compute dialog boxes and clicking
the Compute button.

It is also possible to construct a series of computations which will be
performed on the data automatically at the end of the sweep. Checking
the Apply After Sweep checkbox in a Compute dialog box and then
clicking Close will place that computation in a list which will be executed
after the sweep is completed. The order in which the computations are
listed and executed is determined by the order in which you set and close
the various compute functions. This list can be viewed and edited in the
Compute Status dialog box, page 308.

Compute: Normalize

Compute: Normalize allows you to move a trace up or down against
the Y-axis or “normalize” the data in relation to a new value. For example,
you may have made a frequency response sweep at some arbitrary level,
but now wish to display the trace in relation to a 0 dBr A reference at the
mid-frequencies.

As another example, you could make a sweep of a “golden unit” to get
a practical reference response, and then normalize the trace 3 dB above
and then again 3 dB below a nominal zero level. These upper and lower
traces could be saved in a Limit file as upper and lower limits for
subsequent tests of other units.

To normalize a trace, you must select the horizontal (X-axis) value of the
data point you want to be the normalized reference, and then enter the
Y-axis value you want as a “target value.” In the case of the “golden unit”
to make an upper limit you might choose 1 kHz as the Horizontal Value
and +3 dB as the Target Value.
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You may normalize more than one trace to the same Target Value by
checking the appropriate Data checkboxes. However, all the traces
selected must be of the same unit domain as the Target Value.

Compute: Invert

Compute: Invert turns a curve “upside down.” Specifically, Compute:
Invert reciprocates data expressed in linear units, and negates data
expressed in decibel units.

A typical application is to invert a measured frequency response and
save the inverted trace as an EQ file, which can then be attached to a
sweep to correct for system response variations.

To invert a trace, first decide what the “pivot point” of your inversion
should be; that is, which data point you would like to remain constant
when the trace is flipped. Enter the X-axis value of that data point in the
Horizontal Value field. The trace inversion will be performed around this
point when the data is computed.

Compute: Smooth

Compute: Smooth “smooths out” a trace by assigning each data
point a new value, which is the value of the average of that point and the
two points on either side of it.
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The data can be passed through this process repeatedly, with each pass
increasing the smoothing. The default number of passes is 1; you can
specify a greater number of passes by entering a higher number in the
Passes field. If the Auto box is checked, the Passes field will not be
available for entry and ATS-2 will automatically select a number of passes
based on the number of measurement points in the data; specifically, if
Auto is checked, the number of passes is the integer nearest

� �1 2 � number of points, but is never fewer than 3.

Smoothing is useful when you suspect some of the more extreme data
points are spurious. Loudspeaker measurements, for example, often show
large peaks and dips which are often attributed to room reflections rather
than speaker response. Smoothing out such a trace may provide a more
useful view of the speaker response.

Compute: Linearity

Compute: Linearity graphically displays the variance of each of the
measurement data points from a linear response across all the data.

In the first of two mathematical operations, the best straight line is fitted
to the data, across a range you can specify. This line is computed using the
least squares method.

Next, the value of every data point is subtracted from this straight line;
the result is a graph of deviation from perfect linearity. This is useful to
evaluate input-output amplitude linearity of an ADC or DAC; or of the
input-output phase shift of a loudspeaker, for example.
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Typically, a DUT will have its greatest nonlinearity at the measurement
extremes. To keep this atypical data from affecting the initial straight-line
fitting, you can enter values in the Start Value and Stop Value fields to
limit the range of data examined. These values only limit the straight-line
computation; after the line is derived, every data point in the trace is
subtracted from the line value.

Since the values of the data linearity deviations are often small, you
may want to optimize the graph view for better resolution. See Optimize,
page 270.

Compute: Center

Compute: Center can only be used with data sets that have both
upper and lower limit files attached. See Limits, page 292.

Compute: Center moves the data trace to center it evenly between
the upper and lower limits. This is useful in situations where the shape of
the curve and its general agreement with the limits are more important
considerations than the absolute amplitude of its data points.
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For example, in comparing microphones an evaluation of the overall
microphone response as compared to limits is often more important than
focusing on any minor level differences which may exist.

To keep data from the measurement extremes from skewing the
centering process, you can enter values in the Start Value and Stop
Value fields to limit the range of data examined. These values only limit
the centering computation; every data point in the trace is moved together.

When the data is compared to limits for a Pass/Fail test, all the data
specified in the data files are used to make the Pass/Fail decisions. See
Limits, page 292.

Compute: Delta

Compute: Delta calculates the difference, or delta, between two sets
of data. ATS-2 can do this in two different ways:

� by subtracting the data in a specified data file from the current data
in memory; or

� by subtracting the data in one column (data trace) of the current data
in memory from another column of the current data in memory.

With Compute: Delta you can shift your data by an offset, using a
constant saved in a file, for example; or subtract one channel of a stereo
signal from the other, to measure interchannel differences. If you first
normalize your trace at 0 dBV or 1 V at the pivot point, you can use
Compute: Delta to apply an EQ curve to your measurement after the
fact. See Compute: Equalize, below.
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First select the Delta Source; that is, the data to be subtracted from
the current data in memory. The list under Delta Source initially contains
two choices: None and SweepData.

If you want to perform a Delta computation on two data traces of the
current data in memory, select SweepData.

To use a data file, click the browser button and navigate to the file.

In either case, once you have chosen a Delta Source, you must then
select which data trace in current memory and which data column from
the Delta Source you wish to compare.

Compute: Average

Compute: Average calculates the average value for all the data points
within the range you specify in the Start Value and Stop Value fields.
All the values for the entire data set will be replaced with this computed
average, including data points which may be outside the range you set for
calculating the average.
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Compute: Minimum

Compute: Minimum will find the minimum value in a data set,
examining all the data points within the range you specify in the Start
Value and Stop Value fields. All the values for the entire data set will be
replaced with this minimum value, including data points which may be
outside the range you set for examining the data.

Compute: Maximum

Compute: Maximum will find the maximum value in a data set,
examining all the data points within the range you specify in the Start
Value and Stop Value fields. All the values for the entire data set will be
replaced with this maximum value, including data points which may be
outside the range you set for examining the data.
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Compute: Equalize

Compute: Equalize shifts the value of each point in the selected data
set by the value at the corresponding point in the EQ Source data set.
This gives a result similar to attaching an EQ file to the Analog or Digital
Generator (see Attaching an EQ Curve, page 76); however, the
Compute: Equalize technique allows you to apply an EQ curve to your
measurement after the fact, rather than equalizing the swept tone.

Compute: Equalize can use either a data column from an attached
EQ file or a data column from the current data in memory as an EQ
source.

Select the EQ Source using the browser in the Compute: Equalize
dialog box. The list under EQ Source initially contains two choices: None
and SweepData. To use a data file, click the browser button and navigate
to the file.

If you want use data from another column of the current data in
memory, instead select SweepData from the EQ Source list.

In either case, once you have chosen a EQ Source, you must then
select which data trace in current memory and which data column from
the EQ Source you wish to compare.

Compute: Equalize interpolates between data points in the EQ
Source data as necessary to produce Y-axis values precisely at the
specified X-axis values.

Compute Status

The Compute Status command on the Compute menu brings up the
Compute after Sweep Status panel, which lists all the Compute operations
you have selected to Apply After Sweep.

Chapter 19: Performing Computations on Data Compute: Equalize
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The list shows the order in which the computations will be performed.
This initial order is determined by the order in which you have set up and
enabled Compute operations and set them to Apply After Sweep.

You can add new Compute operations to the list, change the order of
the computations, and clear the entire list.

Note that the Compute After Sweep Status list shows only those
Compute operations which have their Compute After Sweep checkbox
checked. Adding a Compute operation from within the list sets the
checkbox in the specified operation panel. Clicking the Clear List button
does not clear all your Compute settings, but simply unchecks the
Compute After Sweep checkbox in every Compute panel.

Click Add to put a new Compute operation on the list.

To change the sequence of computations, select a Compute operation
on the list and click the up or down arrow to move that operation.

Clear All and Reset

The Clear All and Reset command at the bottom of the Compute
menu clears all existing settings on every Compute panel.

Comparing Computed Results

with Original Data

The Compute operations actually change the current data in memory,
applying the computations you have selected to the data points you have
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chosen. If you will need your original data again, be sure to save it before
you apply a Compute operation.

Since the data in memory is changed after a Compute operation, a
comparison between the original data and the computed result requires
that certain steps be taken before the Compute operation is performed.

One easy way to view both the original data and the computed result is
to duplicate the original data in a unused data column, for reference
purposes. Do this by setting both Data 1 and Data 3 to the same
instrument and channel, for example, before sweeping. When your sweep
is completed you will have the same values in two columns in the Data
Editor.

Now, if you perform your computation on Data 1, you can view it
against Data 2, which displays the reference duplicate of the original data.
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Chapter 20

Printing and Exporting

ATS-2 graphs can be printed to any Windows-compatible printer in
black-and-white or in color. As an option, the underlying data can be also
printed as a table.

ATS-2 graphs can be copied to the Windows Clipboard as well, in either
bitmap or vector graphics format. Graphs can also be directly exported as
a Windows Metafile or Enhanced Metafile.

ATS-2 panels can be captured as bitmapped “screen shots” by the Edit
> Copy Panel to Clipboard command on the Edit menu. Once the
panel is on the Windows clipboard, it can be pasted into a word processing
program such as Microsoft Word or into one of many “paint” or “draw”
graphics programs for editing or printing.

Printing ATS-2 Graphs

When printing an ATS-2 graph, the key information shown on the graph
panel is carried through unchanged to the printed page. This information
includes

� the parameters to be graphed; and

� X-axis and left and right Y-axis calibrations and scaling.

This information cannot be changed from the print menus.

However, display aspects of the graph can be made independent of the
graph, and elements such as trace visibility, color and line style, graph
labeling and legend, graticule visibility and so on can be modified at print
time. These changes are made on the Page Setup panel.

ATS-2 User’s Manual 311



Figure 248. Page Setup

panel, Display page.

Page Setup

The Page Setup panel is available by the menu choice File > Page
Setup. The page settings you make are saved when you save your work
as an ATS-2 test file, along with the current data and the various
instrument panel settings also included in a test file.

The Page Setup panel has three tabs. On the Display page, shown in
Figure 248, you can select the page orientation, the text and labels to be
included, and how the graticule lines are to be printed.

Figure 249 shows the Layout page, where you can set margins, center
the graph on the page or resize the graph to fill the page.

You can set margins either by entering numbers in the margin boxes or
by dragging the page margins (shown as dotted lines) on the preview
panel with the mouse pointer.
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To resize the graph, drag the corner of the graph with the mouse
pointer. To move the graph on the page, set the mouse pointer within the
graph and drag the graph to a new location.

The Center and Fill Page checkboxes override any existing or
manually set size and position adjustments.

On both the Display and Layout pages you have the option of saving
your settings (in the file ATS.ini) as new default settings. You can also reset
your page settings by restoring these defaults, by loading the settings from
the current graph screen display, or by loading the page settings from a
previously saved ATS-2 test file.

The Trace page, shown in Figure 250, gives you the ability to choose
which traces will be visible in the printed graph. An “X” on a trace row
selects that trace to be visible. You can also specify trace color, line style
and thickness.

If you check the Track Display Changes checkbox, the trace settings
on this page will be unavailable, and instead the printer trace settings will
be set to the trace settings on the screen display graph.

Print Setup

Click File > Print Setup to change your printer or access your
printer’s configuration settings. You can also do this from the Print dialog
box.

Printing a Graph

Click File > Print > Graph to send an ATS-2 graph to the printer. If
you have not yet set up your page layout, you should first go to File >
Page Setup (see page 312).

Printing ATS-2 Graphs Chapter 20: Printing and Exporting
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The Print dialog box will appear. Click OK to print the graph, or first set
other parameters such as number of pages, page range, printer selection
and setup and so on.

Print Preview

Click File > Print Preview to view an on-screen preview of your
printed page. You can zoom to different magnifications by clicking the
Zoom buttons or by clicking the mouse pointer on the preview page.

Printing ATS-2 Data as a Table

You also have the option of printing the ATS-2 data in a tabular format.
Click File > Print > Data. The Data Editor will appear, and then the
Print dialog box. Click Print to print the table, or first set other parameters
such as number of pages, page range, printer selection and setup and so
on.
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Printing to a File

You have the option of routing your print job to an HPGL or Postscript
file rather than to your printer.

Click Print to File. A file browser dialog box will open.

The type of file which will be created depends on the printer driver
software which you have chosen. For example, if you have a Postscript
laser printer selected in your Print Setup and then click Print to File, the
file you create will be a Postscript file.

Postscript and HPGL files can be saved and later directly outputted to a
printer. Additionally, many word processing and graphics programs will
import HPGL and Postscript print files.

A Postscript file can also be converted to an Adobe Acrobat PDF file
using the Adobe utility Acrobat Distiller®.

Printing to a File Chapter 20: Printing and Exporting
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Exporting a Graph

An ATS-2 graph can be exported as a vector graphics file, which can
then be imported by a graphics software “draw” program for editing and
printing. ATS-2 will export vector graphics files in either the Windows
Metafile (*.wmf) format or in the Enhanced Metafile (*.emf) format.

From the Menu bar, choose File > Export > Graphics to export a
graph as a metafile.

Copying a Graph to the Clipboard

To copy an ATS-2 graph to the Windows Clipboard, use the command
Edit > Copy Panel to Clipboard.

This command can copy the graph to the clipboard as either a bitmap
or as a metafile vector graphic image. To make this choice, you must first
set your preference on the Graph tab in the ATS-2 Configuration panel at
Utilities > Configuration, which is discussed in Chapter 25.

The images captured in this way can be viewed and saved using
Microsoft Clipboard Viewer, or the contents of the Clipboard can be pasted
into word processing or graphics documents.

Copying a Window or Screen to the Clipboard

Microsoft Windows provides keyboard shortcuts for copying the entire
screen or a selected window to the Windows Clipboard as a bitmap image.

To copy the entire screen to the Clipboard, press Print Scrn. To copy
the active window to the Clipboard, press Alt+Print Scrn. Third-party
screen capture programs will enable you to copy other screen areas to the
clipboard.

Chapter 20: Printing and Exporting Exporting a Graph

316 ATS-2 User’s Manual

Figure 254. Export Graph

Browser



The bitmaps captured in this way can be viewed and saved using
Microsoft Clipboard Viewer, or the contents of the Clipboard can be pasted
into word processing or graphics documents.
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Bitmaps and Vector Graphics

A bitmap graphics file is a bit-by-bit image of the graph displayed
on the ATS-2 graph panel. The resolution of a bitmap is set at its
creation, and magnifying the image will reveal the individual pixels
comprising the image. Bitmap files can be edited with “paint” graphics
software. An ATS-2 bitmap graph looks like the screen image, showing
the graph as white and colored lines on a black background. Files with
the filename extension *.bmp are bitmap files.

A vector graphics file describes the image in programming code,
and such an image can be resized with no degradation. The resolution
of a printed vector graphics file is dependent only on the resolution of
the printer. Vector graphics files are edited with “draw” graphics
software, and are usually easier to modify than bitmap files. An ATS-2
vector graphics image shows the graph as black and colored lines on a
white background. Metafiles with the filename extensions *.wmf or
*.emf are vector graphic files.
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Chapter 21

Monitoring

Headphone/Speaker Monitoring

ATS-2 has an internal speaker and a rear-panel headphone jack for
audible monitoring of audio signals at different points in the system.

The speaker and the headphone jack carry a monaural signal, selected
from the list on the Headphone/Speaker panel.

The headphone jack is a standard 3.5 mm tip-ring-sleeve (TRS) jack
wired to apply the monaural signal to both the left and right sides of
ordinary stereo headphones. When a plug is inserted into the headphone
jack, the internal speaker is disconnected.

The Volume Bar

The headphone output and the internal speaker share a common
volume control and mute switch, which are available on both the Volume
Bar and on the Headphone/Speaker panel, discussed below.

The Volume Bar is a toolbar that is enabled on the View menu. By
default the Volume Bar is visible, and it will appear on every Workspace
page. Like the other ATS-2 toolbars, the Volume Bar can be attached at
the top of the Workspace or can be dragged to float at any location in the
page.
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Drag the Volume slider with the mouse pointer to change volume.
When the slider is selected, the left-right arrow keys will also adjust the
volume.

Put a check in the Mute box to turn off the Headphone/Speaker
outputs.

Headphone/Speaker panel

The Headphone/Speaker panel is available at Panels >
Headphone/Speaker or by clicking the Headphone/Speaker button on
the Panels toolbar.

The Headphone/Speaker panel repeats the Volume slider and Mute
switch. These are the same controls that are on the Volume Bar, and the
indicators on the two displays track each other.

Below the Volume slider is the Monitor list, which makes several
audible monitor source choices available:

� Source A
This is the audio signal as it appears at the input to the Analyzer
instrument in use, after ranging—the point where the Channel A
Level or Peak meter readings are taken. If the Digital Interface
Analyzer is the instrument, the monitored signal is the Channel A
embedded audio.
Source A is the same signal that is at the MONITOR OUTPUTS:
SOURCE A rear-panel BNC connection.

� Source B
This is the audio signal as it appears at the input to the Analyzer
instrument in use, after ranging—the point where the Channel B
Level or Peak meter readings are taken. If the Digital Interface
Analyzer is the instrument, the monitored signal is the Channel B
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embedded audio.
Source B is the same signal that is at the MONITOR OUTPUTS:
SOURCE B rear-panel BNC connection.

� Function A
The channel A signal as it appears after a given Audio Analyzer
function is applied. This is the same point as the MONITOR
OUTPUTS: FUNCTION A rear-panel BNC.
Signal is only available at this point when using the Audio Analyzer
instrument.

� Function B
The channel B signal as it appears after a given Audio Analyzer
function is applied. This is the same point as the MONITOR
OUTPUTS: FUNCTION B rear-panel BNC.
Signal is only available at this point when using the Audio Analyzer
instrument.

� Source A + Source B
The sum of these signals.

� Function A + Function B
The sum of these signals.

� Source A + Function A
The sum of these signals.

� Channel B + Source B
The sum of these signals.

The Monitor Outputs

There are four MONITOR OUTPUTS available on BNC connectors
on the ATS-2 rear panel. These are unbalanced outputs with a voltage
range up to 4 Vpp and a source impedance of 422 �.

The MONITOR OUTPUTS are intended for oscilloscope or other
monitoring. These outputs are not calibrated and should not be used for
measurements.

The Monitor Outputs Chapter 21: Monitoring
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The SOURCE Outputs

The SOURCE A and SOURCE B outputs carry the audio signals as
they appear at the inputs to the Analyzer instrument in use, after
ranging—the point where the Level or Peak meter readings are taken. If
the Digital Interface Analyzer is the instrument, the monitored signals are
the embedded audio.
The SOURCE monitor outputs are the same signals as can be selected on
the Headphone/Speaker panel Monitor: Source selections.

The FUNCTION Outputs

The FUNCTION A and FUNCTION B outputs carry the audio signals
as they appear after a given Audio Analyzer function is applied. The
FUNCTION monitor outputs are the same signals as can be selected on
the Headphone/Speaker panel Monitor: Function selections.

Signal is only available at the FUNCTION monitor outputs when using
the Audio Analyzer instrument.
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Chapter 22

Sync/Ref, Trigger and Aux Connections

In addition to the main analog and digital signal connections on the
front panel, ATS-2 provides a number of utility connections on the rear
panel. These include the APIB connector, which is discussed in the
installation section of Getting Started with ATS-2, and the MONITOR
OUTPUT connectors, which are discussed in Chapter 21.

In this chapter we will look at the remaining connections:

� SYNC/REF IN

� TRIG IN

� TRIG OUT

� AUXILIARY CONTROL OUTPUT

� AUXILIARY CONTROL INPUT

SYNC/REF IN

The SYNC/REF IN BNC connection and the Sync/Ref Input panel
provide the ability to synchronize ATS-2’s master clock to several types of
external reference signals, including the sample rate or the frame rate of an
AES3 or IEC60958 reference signal, the horizontal sync frequency of
NTSC, PAL, or SECAM analog video signals, or to a squarewave or other
periodic signal.

The master clock controls ATS-2’s internal sample rate and is the
reference for all ATS-2 frequency measurements. Synchronizing the master
clock to an external reference is often necessary when making
measurements in an installation where “house sync” is used.

An AES3 or IEC60958 digital audio signal applied to the SYNC/REF
IN connector can also be used as the Pass Thru signal available to the two
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signal generators. This feature enables you to use an external signal as the
generator “waveform.” See Wfm: Special: Pass Thru on page 83 for
the Analog Generator or page 105 for the Digital Generator.

Sync/Ref Input Panel

When synchronizing ATS-2’s master clock to an external source, two
settings are always necessary:

� You must select the format of the external sync signal in the Source
field.

� You must enter the exact nominal frequency of the external sync
signal in the Frequency field.

In addition to these settings, the Sync/Ref Input panel enables you to set
termination impedance options, and select the Frame Lock option for
digital audio reference signals. There is also an Input Frequency display
field, a Delay field and an Out of Range indicator to provide you with
more information as you make the synchronization settings. A master
ON/OFF button allows you to enable and disable synchronization. These
settings and displays are discussed in detail below.

Reference Input Source
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Select the format of the external synchronization signal from the
Source list.

� AES Sync Rate
This selection will synchronize the ATS-2 master clock to the sample
rate of a properly formatted AES3 or IEC60958 signal applied to the
SYNC/REF IN BNC.
This choice synchronizes the sample rates, but does not ensure that
the signal frames are aligned in time. To align the frames, the ATS-2
digital output signal must be set to the same sample rate as the
reference signal and the Frame Lock box on the Sync/Ref Input
panel must be checked.
The rear panel AES3/IEC60958 reference input signal may also be
used as a reference for timing measurements of the front panel XLR,
BNC, or optical digital inputs. See Delay, In from Ref below.

� Squarewave
This selection will synchronize the ATS-2 master clock to a TTL
squarewave signal or other repetitive signal applied to the
SYNC/REF IN BNC. This signal may be between 8 kHz to 10 MHz.
A bit clock output from a digital device applied to the SYNC/REF
IN connection in Squarewave mode will synchronize the ATS-2
sample rate to the device sample rate.

� NTSC Video Sync Horiz Rate
This selection will synchronize the ATS-2 master clock to the
horizontal sync pulse (nominally 15.7343 kHz) of an NTSC analog
video signal applied to the SYNC/REF IN BNC.

� PAL/SECAM Video Sync Horiz Rate
This selection will synchronize the ATS-2 master clock to the
horizontal sync pulse (nominally 15.6250 kHz) of a PAL/SECAM
analog video signal applied to the SYNC/REF IN BNC.

Frame Lock

As discussed above, synchronization of AES3 or IEC60958 rates alone
does not time-align the interface signal frames. Each AES3 or IEC60958
frame begins with a preamble pattern, and in time-aligned or frame-locked
signals the X, Y and Z preambles start at the same moment.

When using AES Sync Rate for synchronization in ATS-2, checking
Frame Lock time-aligns the frames as well. The ATS-2 digital output
signal must be set to the same sample rate as the reference input signal for
frame lock.
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Input Termination Impedance

Set the termination impedance to 75 � (or terminated) if ATS-2 is the
only device connected to the reference source, or if it is the last device in a
chain of devices. If ATS-2 is in a chain of devices but is not the last device
in the chain, set the impedance to HiZ (or bridging).

Frequency

Set the exact nominal frequency of the synchronization signal in this
field. For an AES3 signal, for example, it might be 44.100 kHz or
48.000 kHz. For a squarewave, set Frequency to the rate of the external
clock.

If the actual reference signal is slightly different (less than 15 PPM) from
the value entered here, synchronization will be achieved but all ATS-2
sample rates and readings will reflect the difference. If the value entered is
more than 15 PPM away from the actual reference signal frequency, the
internal crystal oscillator may not lock to the reference.

ATS-2 automatically enters the two video sync rates for you. These may
be changed by entering a new rate, if necessary.

Input Frequency

When a suitable reference signal is present at the SYNC/REF IN BNC
for the selected Source format, the Input Frequency field will display
that signal’s frequency. This display aids in verifying the presence or
absence of a sync signal and in determining the nominal frequency before
synchronization is achieved.

Once ATS-2 has synchronized to the reference, the Input Frequency
field is grayed out, since the measured frequency would be identical to
Frequency setting.

Delay, In from Ref In

This field displays the time delay between an AES3 or IEC60958 signal
applied at the SYNC/REF IN BNC and the signal applied to the ATS-2
digital input. The signals must be at the same sample rate.

Out of Range Indicator

The Out of Range indicator on the Sync/Ref Input panel is lighted if
the actual reference signal frequency is outside ±15 PPM of the value
programmed in the Frequency entry field on the Sync/Ref panel, or
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outside the amplitude range required for reliable operation. The indicator
may require several seconds to indicate an out of range condition.

TRIG IN

The TRIG IN BNC provides an input for triggering data acquisitions in
the FFT-based batch-mode Analyzer instruments: the Spectrum Analyzer,
the Multitone Audio Analyzer and the Digital Interface Analyzer.

The TRIG IN input will accept standard 3 V or 5 V TTL/CMOS logic
signals. ATS-2 instruments normally trigger on the rising edge of the signal
transition, although option switches on each instrument panel enable
inversion of the trigger function.

TRIG OUT and the Main Trigger Panel

The ATS-2 trigger output signal appears at the TRIG OUT BNC
connector on the rear panel. This signal is intended to trigger an
oscilloscope or other monitoring device at the occurrence of a specific
condition in the course of measurement.

The source for the trigger output signal is selected on the Main Trigger
panel. These selections are identical to the trigger choices on the Digital
Interface Analyzer panel (see page 199). Both panels control the same
functions interactively.

The Trigger Output is a 5 V TTL/CMOS logic signal with a 50 � source
impedance. The rising edge of the signal transition is always the trigger
instant.
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The Trigger Output sources are:

� Analog Gen
A trigger transition is generated for each cycle of the current Analog
Generator waveform.

� Digital Gen
A trigger transition is generated for each cycle of the current Digital
Generator waveform.

� Jitter Gen
A trigger transition is generated for each cycle of the current Jitter
Generator waveform.

� Trig In (Ext)
A trigger transition is generated for each external trigger transition
received at the TRIG IN BNC connector.

� Line (Mains)
A trigger transition is generated for each cycle of the AC mains line
voltage.

� ChA Rcv Sub-Frame
A trigger transition is generated at the beginning of each Channel A
subframe (each X-preamble plus each Z-preamble) in the interface
signal received at the digital input. If there is jitter in the received
waveform, that jitter will be reflected in the trigger waveform.

� ChB Rcv Sub-Frame
A trigger transition is generated at the beginning of each Channel B
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subframe (each Y-preamble) in the interface signal received at the
digital input. If there is jitter in the received waveform, that jitter will
be reflected in the trigger waveform.

� ChA Rcv Sub-Frame DeJitt
A trigger transition is generated at the beginning of each Channel A
subframe (each X-preamble plus each Z-preamble) in the interface
signal received at the digital input, after the signal has been
re-clocked to remove jitter.

� ChB Rcv Sub-Frame DeJitt
A trigger transition is generated at the beginning of each Channel B
subframe (each Y-preamble) in the interface signal received at the
digital input, after the signal has been re-clocked to remove jitter.

� Rcv Block (192 frames)
A trigger transition is generated at the beginning of each Status Block
frame (each Z-preamble) in the interface signal received at the digital
input. This occurs once every 192 frames.

� Rcv Error
Four “receive error” conditions in the interface waveform are defined
and flagged. See Error Indicators on page 59. Select the error
conditions which you wish to use as triggers in the check boxes on
the Main Trigger panel. When any of these selected conditions occur
in the interface signal received at the main digital input, a trigger
transition will be generated.

� ChA Xmit Subframe
A trigger transition is generated at the beginning of each Channel A
subframe (each X-preamble plus each Z-preamble) in the interface
signal transmitted at the digital output. If jitter has been added to the
digital output, that jitter will be reflected in the trigger waveform.

� ChB Xmit Subframe
A trigger transition is generated at the beginning of each Channel B
subframe (each Y-preamble) in the interface signal transmitted at the
digital output. If jitter has been added to the digital output, that jitter
will be reflected in the trigger waveform.

� ChA Xmit Subframe DeJitt
A trigger transition is generated at the beginning of each Channel A
subframe (each X-preamble plus each Z-preamble) in the interface
signal transmitted at the digital output, before the addition of any
jitter.

� ChB Xmit Subframe DeJitt
A trigger transition is generated at the beginning of each Channel B
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subframe (each Y-preamble) in the interface signal transmitted at the
digital output, before the addition of any jitter.

� Xmit Block (192 frames)
A trigger transition is generated at the beginning of each Status Block
frame (each Z-preamble) in the interface signal transmitted at the
digital output. This occurs once every 192 frames.

� ChA Sync/Ref Rcv Sub-Frame
A trigger transition is generated at the beginning of each Channel A
subframe (each X-preamble plus each Z-preamble) in the interface
signal received at the SYNC/REF IN input.

� ChB Sync/Ref Rcv Sub-Frame
A trigger transition is generated at the beginning of each Channel B
subframe (each Y-preamble) in the interface signal received at the
SYNC/REF IN input.

� Sync/Ref Rcv Block (192 frames)
A trigger transition is generated at the beginning of each Status Block
frame (each Z-preamble) in the interface signal received at the
SYNC/REF IN input. This occurs once every 192 frames.

� Sync/Ref Rcv Error
Four “receive error” conditions in the interface waveform are defined
and flagged. See Error Indicators on page 59. Select the error
conditions which you wish to use as triggers in the check boxes on
the Main Trigger panel. When any of these selected conditions occurs
in the interface signal received at the SYNC/REF input, a trigger
transition will be generated.

AUXILIARY CONTROL OUTPUT

The Auxiliary Control Output is not implemented at this writing.

AUXILIARY CONTROL INPUT

The Auxiliary Control Input is not implemented at this writing.
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Chapter 23

Automating Tests

Introduction

Almost every ATS-2 command and panel setting has a corresponding
OLE (Object Linking and Embedding) command. OLE automation can be
used by programming languages such as Microsoft Visual Basic to control
and automate software functions in independent applications, such as
ATS.

AP Basic is a programming language specifically designed for ATS-2
and included with the ATS software. If you are familiar with Visual Basic
you will find many similarities in the languages; you can also use programs
written in Visual Basic to control ATS-2.

Using AP Basic, you can write macros (automation programs, also
called scripts or procedures) which issue ATS-2 OLE commands, open
files, wait for data readings to satisfy necessary conditions, create reports,
save information to disk, communicate with other Windows programs. You
can design and use custom user interfaces to simply and direct macro
operation. Using OLE, it is possible to control ATS-2 from other programs
such as word processors or spreadsheets. Virtually every function of ATS-2
can be automated with AP Basic.

AP Basic macro files for ATS-2 are saved with the filename extension
.atsb.

Learn Mode

An experienced programmer with a good knowledge of AP Basic can sit
down at a text editor and write a macro to run an ATS-2 test. It’s much
easier, though, to use Learn Mode.
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Learn Mode records every appropriate operation of the ATS software to
an AP Basic macro file. It is similar to features in other applications called
macro recorders. Learn Mode is often the easiest way to create a macro,
whether simple or complex.

To enter Learn Mode, click the Start Learn Mode button on the
Learn Mode toolbar; or, from the Main menu, choose Macro > Learn
Mode or Utilities > Learn Mode. An AP Basic macro will open in the
Macro Editor, and each ATS-2 keystroke and mouse click will be entered
into the Macro Editor as a line of AP Basic code, as you set up and run a
test.

On the Macro and Utilities menus a checkmark will remain next to the
Learn Mode choice while ATS-2 is in Learn Mode, and the shape of the
mouse pointer will change to that of an audio cassette, indicating that a
recording is being made. To prevent a particular mouse click from being
entered into the macro, press and hold the keystroke combination
Ctrl-Shift while clicking. This temporarily suspends Learn Mode.

To exit Learn Mode, click the Stop Learn Mode button on the Learn
Mode toolbar; or, from the Main menu, choose Macro > � Learn Mode
or Utilities > � Learn Mode. The mouse pointer will return to its
normal shape, the checkmark next to the Learn Mode menu choice will
disappear and you will be prompted to save the macro.

The Macro Editor
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The Macro Editor is a text editor with dedicated features for editing AP
Basic macros, including macro navigation and debugging tools. You can
begin a macro “from scratch” in the Macro Editor, or edit macros created
by Learn Mode or opened from disk.

AP Basic Documentation

The AP Basic User’s Guide and Language Reference is the primary
reference for using automation with Audio Precision instruments.

Since each instrument has different capabilities, each has a different set
of OLE commands. For ATS-2, these are discussed in detail in the AP
Basic Extensions Reference for ATS-2.

Both of these documents are included as PDF files on the ATS-2
distribution CD-ROM.

AP Basic Documentation Chapter 23: Automating Tests
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Chapter 24

Regulation

Regulation is a software servo-mechanism which enables you to
automatically steer test parameters toward a specific measured value.

Let’s say, for example, that you would like to find the point at which a
power amplifier produces 1% THD+N at its output. With regulation,
ATS-2 can adjust a generator output amplitude while monitoring the DUT
THD+N, guiding the generator up and down to the level where 1%
THD+N is measured. At this point, the DUT output wattage can be
measured and noted as the power level at 1% THD+N.

Here’s another example: you’d like to find the exact frequency at which
the DUT response is 3 dB down from the midband level reference. ATS-2’s
regulation function can adjust a generator frequency while monitoring the
DUT output amplitude, guiding the generator up and down to the precise
frequency at which –3 dB is measured.

The Regulation panel enables you to select:

� a Target parameter
This is the parameter ATS-2 is monitoring as it is steered toward the
target value. Use the target browser to select the target parameter
from the ATS-2 instrument readings provided.

� a target Value
This is the reading from the DUT you are attempting to reach.

� a target value Tolerance
This is the range around the target value that is acceptable for your
test.

� a Source parameter
This is the ATS-2 setting which will be varied in an attempt to steer
the target parameter toward the desired value. Use the source
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browser to select the source parameter from the ATS-2 instrument
settings provided.

� source High and Low Bounds
These are the extremes between which you want to confine the
source variations.

There are also several panel settings which affect regulation
performance:

� Operation
Operation sets one of five algorithms which determine how the
regulation operation proceeds:

� Linear
The assumption for Linear operation is that any change in the
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Regulation Source parameter will cause the same change in the
regulated Target parameter. This is the normal relationship, for
example, in the input and output amplitudes of an amplifier: a
+2 dB change at the input should make a +2 dB change at the
output.
Linear is the best choice and the fastest option for setting DUT
outputs to a reference level, or making frequency response
measurements at a constant output level.
In Linear operation, the regulation algorithm is directed to jump
to the Target value in a single step, and the Stepsize field is
unavailable.

� +Normal
The assumption for +Normal is that any change in the
Regulation Source parameter will cause a proportional change in
the regulated Target parameter. This is the normal relationship
between generator amplitude and measured THD of an amplifier
near its maximum power point, or between generator frequency
and measured high-pass filter output amplitude on the attenuation
skirt.

� – Normal
The assumption for – Normal is that any change in the
Regulation Source parameter will cause an inverse proportional
change in the regulated Target parameter. This is the normal
relationship between generator frequency and measured low-pass
filter output amplitude on the attenuation skirt, or between
generator amplitude and measured THD+N in relative units (dB
or %) in the lower, noise-limited range of a DUT.

� Maximum
Maximum regulates in search of a maximum or peak value,
steering the Source parameter to find the peak.

� Minimum
Minimum regulates in search of a minimum peak value, steering
the Source parameter to find the minimum peak.

� Stepsize
The Stepsize field controls the initial size of the increments which
will be made to the regulation Source parameter. When the
regulated parameter reading first passes beyond the Target value,
the actual step size will be decreased and the direction of change
reversed as the algorithm goes into a binary search mode to
determine the final value to regulate the measurement. Stepsize
may be set in a number of ratio units including %, X/Y, and dB. The
optimum value for Stepsize depends upon the DUT and the
distance to the Target value from the initial starting value. Large steps
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will reach and pass the Target rapidly, but more iterations will bewill reach and pass the Target rapidly, but more iterations will be
required to reduce the step size and bring the measurement into
regulation. Smaller steps will take longer to reach the approximate
area near the Target value but may regulate the measurement more
rapidly.

� Iterations
Iterations determines the maximum number of regulation steps
which will be made for each measurement. Regulation is considered
successful if the target Value is attained within Tolerance without
exceeding Iterations. If Regulation is unsuccessful an “Unregulated”
message is issued, and an “R” is entered at the measurement on the
Graph, in the Data Editor and in the Log file, if enabled.
For +Normal, – Normal and Linear operations, the Iterations
field limits the maximum number of steps which the regulation
algorithm will make in the search for the Target value. Iterations
should be large enough to permit successful regulation.
In Maximum and Minimum modes, the Iterations field
determines the number of times that the measured value passes
through the target value before the algorithm halts. A larger
Iterations value will produce a more precise location of the target,
but will take longer to complete. Generally, broad peaks and dips can
be located with a smaller Iterations value, and sharper peaks or
dips require a larger Iterations value.

� Timeout (per step)
The instrument readings used for regulation are first processed
through the sweep Settling algorithm. See page 259 for a discussion
of Settling. In some circumstances, depending upon the variability of
the readings and the Settling settings, Settling cannot be satisfied and
no data for that step will be forwarded to the Regulation panel. The
Timeout field enables you to enter a time interval beyond which
regulation will not wait for a settled reading. When a reading times
out, the most recent stream of up to 32 readings from the instrument
will be averaged and used as input to regulation.

Once you have made all your settings, click the Regulate button to
perform regulation.

Check Regulate at each sweep step to set the automatic option for
sweep operation.
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Examples of Regulated Sweeps

Here are several applications of regulated sweeps:

� Using Regulation to hold power amplifier output distortion constant
(at 1.0%, for example) by varying generator amplitude, but plotting
amplifier output power versus generator frequency to produce a
graph of power bandwidth.

� Using Regulation to find a –3 dB point on a DUT, then making a
single-point sweep to display the measured frequency at that point.

� Using Regulation to hold the modulation percentage (or deviation) of
a preemphasized broadcast transmitter constant while measuring and
plotting THD+N versus frequency.

� Using Regulation to hold the modulation percentage (the deviation)
of a preemphasized broadcast transmitter constant while measuring
and plotting the generator amplitude versus frequency required to
obtain that constant modulation value.
This curve is essentially a modulation sensitivity test. Plotting the
generator amplitude using normal units will result in a curve that is
inverted from the actual preemphasis curve shape of the transmitter.
Use dBrInv (relative decibels, inverted) for the generator units to
invert the trace and produce a preemphasis curve.
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Chapter 25

Configuration and the Utilities Menu

The Utilities menu offers access to the system Configuration panel and
also to several utility functions and programs. We’ll look first at the
Configuration panel. Go from the Main Menu to Utilities >
Configuration.

The Configuration panel

The Configuration panel allows you to set your preferences for ATS-2
behavior. There are three tabbed pages on the Configuration panel.
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General

The General configuration page enables you to set a number of general
behaviors for ATS-2. These are:

� Prompt to Save Test when a test is closed
Several commands (such as File New Test, File Open Test or File
Open Data) will close the current test, clearing the test data from
memory. If this box is checked, a dialog box will open when a test is
about to be closed, prompting you to save the test before closing it.

� Load “LAST.ATS2” on startup
If this box is checked, when ATS-2 is launched the program will
automatically load the test named Last.ats2.

� Save “LAST.ATS2” on exit
If this box is checked, when ATS-2 is closed the program will
automatically save the current test in memory as Last.ats2.

� Keep all readings active during real-time sweeps
Normally, ATS-2 meters are constantly updating their readings. If this
box is checked, all meters on all open panels will continue to update
their readings during the progress of real-time sweeps. This enables
you to view non-swept parameters during a sweep.
If the box is not checked, only the instrument readings selected as
sweep parameters will update their readings, which enables sweeps
to run faster.
This setting does not apply to batch mode sweeps.
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� Display data in graph on test open
If this box is checked, data in a test is automatically graphed (and
compared to limits, if any) when the test is opened. If the box is not
checked, the data is loaded with the test but is not automatically
graphed.

� Reprocess FFT data on zoom
If this box is checked, each time a Graph zoom is initiated for an FFT
plot, the data acquisition is re-processed with an automatic Sweep
Reprocess Data (Ctrl-F6) command. Although this processing
takes more time, it assures that the plotted resolution is always the
maximum supported by either the number of points graphed or by
the FFT length. See Retransforming and Reprocessing Data on
page 147 and Zoom on page 268.

� Do not load panels on Open Test
Normally, when a test is opened, all the instrument panels, bar
graphs and graphs are loaded on each page at the location and size
that they were when the test was saved. If this box is checked, the
instrument control settings, including waveform, amplitude,
frequency, Analyzer instrument and function, sweep settings and so
on, are loaded without changing the current panel and graph size
and location.

� Set Sample Rate when loading generator waveforms
Most applications using arbitrary waveforms require that they be
played back at the same sample rate at which they were created.
Audio Precision waveform files contain information on the design
value of the sample rate. If this box is checked, ATS-2 automatically
sets the correct internal sample rate when a waveform file is loaded.
See Arbitrary Waveforms on page 80 and page 102.

At the bottom of the page is the Company Name field, where you can
enter the name you would like to appear on ATS-2 graphs. If a name is
entered here, you have the option enabling or disabling screen or print
display in the Graph Label dialog box or in the Page Setup dialog box.

The Configuration panel Chapter 25: Configuration and the Utilities Menu
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Log

The Log File

The log file is an optional record of many important ATS-2 operations,
including test names, date and time of each running of tests, limits failures,
file loading and saving activity and error messages. New information is
appended to the log file, so a log file can become a complete record of an
entire audio testing procedure.

The log file is a standard ASCII text file, readable by text editors such as
Windows Notepad and other applications. A log file has the extension .alg.
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The Log configuration page enables you to set Log file options for
ATS-2. These are:

� Enable Logging
Check this box to enable logging. Type the filename and path of the
log file. The ATS-2 default is *.alg, with a path of C:\ATS\Log.

� Include in Log File

� Error Messages
If this box is checked, any Windows or ATS-2 error messages that
occur during the logging period will be written to the log file.

� File I/O Activity
If this box is checked, a text message will be written to the log file
for every disk file opened and every file saved to disk. The
message includes the name and full path of the file and the date
and time at which it was saved or opened.

� Sweep Activity

� Test Name
If this box is checked, the filename and full path of the executed
test is written to the log file.

� Graph Title, Time and Date
If this box is checked, the graph title, date and time of the test are
written to the log file.

� Pass/Fail Message
If this box is checked, an error summary message will be written to
the log file each time a test is run. The message will say PASS or
FAIL, followed by the number of measurements below the lower
limit, the number of measurements above the upper limit, and the
number of timeouts which occurred.

� Sweep Data

� None
If this box is checked, no sweep point values will be written to the
log file.

� All
If this box is checked, all sweep point values will be written to the
log file.

� Failed Only
If this box is checked, only those sweep point values that have
failed the limits will be written to the log file.
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Graph

The Graph configuration page enables you to set the Graph color
assignment and copy options for ATS-2. See Trace Colors on page 279,
Copying a Graph to the Clipboard on page 316 and Bitmaps and
Vector Graphics, page 317.

The Graph Trace Colors options are:

� On Sweep:

� Reset color cycle
If Reset color cycle is checked, each new sweep will reset the
color cycle, so that the first trace of the sweep is cyan.
If the Reset color cycle is unchecked, new sweeps will use the
color cycle. If you manually change any color-to-Data
assignment, ATS-2 will maintain your new color assignments
throughout subsequent sweeps.

� Use test colors only
When you are appending current sweeps to a test file loaded from
disk using the Append checkbox on the Sweep panel and Use
test colors only is checked, the newly appended sweeps will
maintain the colors used in the file you have loaded.
If Use test colors only is unchecked, any newly appended
sweeps will move through the color cycle.
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� On Append file data:

� Cycle trace colors
When you are appending a sweep from disk to a sweep in
memory using the File Append command and Cycle trace
colors is checked, the appended sweep will start at the next color
in the current sweep and move normally through the color cycle.
If Cycle trace colors is unchecked, the colors of the sweep you
are appending from disk will be maintained and not overridden by
the color cycle.

The Graph Copy to clipboard options are:

� Background Color:

� White “As Metafile”
If White “As Metafile” is checked, the Copy command copies
the current graph to the Windows clipboard as a vector graphic
drawing in the Windows metafile format. The graph is rendered as
black and colored lines on a white background.

� Black “As Bitmap”
If Black “As Bitmap” is checked, the Copy command copies the
current graph to the Windows clipboard as a bitmap image in the
Microsoft bitmap format. The graph is rendered as white and
colored lines on a black background, as it appears in the Graph
panel.

Restoring the ATS-2 Hardware

If the ATS-2 hardware has lost power or its APIB connection, the
Utilities > Restore Hardware command will set the instrument to the
current software settings.

Utilities > Restore Hardware can also be used as a hardware reset if
the instrument does not appear to be responding normally.
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Hardware Status

The Utilities > Hardware Status command opens the System Status
and Information dialog box, which reports a number of ATS and ATS-2
conditions.

Turn All Outputs OFF / ON

The Utilities > Turn All Outputs Off issues the same command as
the function key F12, the “panic button.” Either of these turns off all
generator outputs.

The Utilities > Turn Outputs Back On issues the same command
as the key combination Ctrl-F12. Either of these turns on any generator
outputs previously turned off by the panic button.

Clear Log File

This command clears all the information from the log file. It does not
delete the file, but leaves it empty. See The Log File on page 344.

View Log File

This command opens the log file in Notepad for viewing or printing.
See The Log File on page 344.
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Learn Mode

Learn Mode records every appropriate operation of the ATS software to
an AP Basic macro file. It is similar to features in other applications called
macro recorders. Learn Mode is often the easiest way to create a macro.

Choose Utilities > Learn Mode to enter Learn Mode. An AP Basic
macro will open in the Macro Editor, and each ATS-2 setting you make is
entered in AP Basic in the Macro Editor, as you work.

On the Utilities menu a checkmark will remain next to the Learn Mode
choice while ATS-2 is in Learn Mode, and the shape of the mouse pointer
will change to that of an audio cassette, indicating that a recording is being
made.

Choose Utilities > Learn Mode to exit Learn Mode. The mouse
pointer will return to its normal shape, the checkmark next to Learn Mode
will disappear and you will be prompted to save the macro.

See Chapter 23 for more information on automating tests with AP
Basic.

Multitone Creation

A comprehensive multitone creation utility has been provided with
ATS-2 to facilitate making custom waveform files for multitone testing.
Choose Utilities > Multitone Creation to open the program.

See Creating Multitone Waveform Files on page 219.
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Chapter 26

Switchers

The SWR-2122 family of switchers are high-performance 2 x 12 relay
switching matrices, stackable up to 16 units. The switchers allow ATS-2’s
two input and two output connections to address up to 192 DUT inputs,
outputs or insertion points under software control, making multichannel
measurements and production line testing easy and fast.

The SWR-2122 switchers are available in four versions:

� SWR-2122M Output Switcher
This is a balanced Output Switcher with 12 male XLR connectors,
designed to fan out the two analog outputs to as many as 12 device
inputs. “Complement mode” may also be selected, which drives all
except one output connector.

� SWR-2122F Input Switcher
This is a balanced Input Switcher with 12 female XLR connectors,
designed to fan into the two analog inputs from as many as 12
device outputs.

� SWR-2122P Patch Point Switcher
This is a balanced Patch Point, or insertion, switcher with 12 5-pin
XLR connectors carrying both input and output circuits. Each output
pair of pins is normalled through to the input pins on the same
connector when the control relay is not operated. When the relay is
switched the normalled path is broken to insert a signal.
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� SWR-2122U Unbalanced Switcher
This is an unbalanced switcher with female BNC connectors instead
of XLR connectors. This switcher can be configured to operate as an
Input or Output switcher by changing rear-panel switch settings.

The Switcher Panel

The ATS-2 Switcher panel controls from 1 to 32 switcher modules (up
to 16 input and 16 output). Each unit is an independently powered
external accessory, connected in “daisy chain” fashion to the same Audio
Precision interface bus as the ATS-2 and computer.

The Switcher panel permits selecting any desired input and output
connector. The switchers may also be controlled as a swept parameter in
order to scan a measuring instrument across many device outputs, or to
scan a stimulus parameter across many device inputs. The Sweep panel,
not the Switcher panel, determines this type of operation. The Switcher
panel settings will determine the switcher conditions before a switcher
sweep begins and after it ends.

Input Channel

The channel numbers entered in the Input: Ch A and Input: Ch B
fields determine the Input switcher connections (unless a switcher sweep is
in progress). The range of numbers for each field is from 1 to 192, since
up to 16 Input switchers may be used. The practical range depends upon
how many switchers are connected and the configuration of the rear panel
DIP switches on each switcher. Typically, the rear panel switches are set at
installation so that the first Input switcher responds to control as channels
1–12, a second Input switcher (if present) is set as channels 13–24, etc.
Entering a zero or a number beyond the range of Input switchers actually
present results in no connection.

To sweep across switcher channels during a sweep test, the Sweep panel
Source 1 or Source 2bBrowser must be used to select Switcher as the
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instrument and the particular channel and sweep mode desired as the
parameter.

Output Channel

The channel numbers entered in the Output: Ch A and Output: Ch
B fields determine the Output switcher connections in exactly the same
way as described for the switcher Input channels, above.

Output Modes (Switcher)

Switcher output channels A and B may have certain specific
relationships defined between them, controlled by the three option buttons
at the top of the Output section of the Switcher Panel. These three
relationships are:

� B independent from A
Channels A and B may be independently set to any channel number
within their range. This is the normal mode for most operation.

� B = All outputs driven, A = Off
The switcher B generator input is connected to all 12 outputs on each
Output switcher module. The switcher A generator input is
disconnected. This mode enables connection of a single signal to all
device inputs, which may be a requirement of a burn-in rack or a life
test.

� B = All outputs driven except # selected for A
The switcher A analyzer input connects to the channel number
entered in the Switcher panel A Output field. The switcher B
generator input connects to the remaining 11 output channels on that
switcher and to all 12 channels of all other Output switchers
connected.
The purpose of this mode is for worst-case crosstalk measurements,
so that all channels except one of a multitrack or multi-channel
recorder or mixing console are driven, while the output signal from
the one undriven channel is measured. This mode is normally used
with a nested sweep with Source 2 on the Sweep panel set to scan
Channel A input and output through all possible device channels,
while Source 1 is commonly set for a frequency sweep to measure
selective crosstalk across the audio spectrum.

Sweep Offsets

When the switchers are selected as the instrument at Source 1 or
Source 2, a number of Parameters are available in which both Channels
A and B, or both Input and Output switchers, may be simultaneously
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swept. These complex switcher sweeps often require that Channel A and
Channel B are not connected to the same channel, or that the Input and
Output switchers are not connected to the same channel. The two offset
fields on the Switcher panel set the relationship between the switcher
parameters being swept. Before a sweep starts or after a sweep is
completed, the switcher channel selection will be determined only by the
Output and Input sections of the Switcher panel.

� Sweep Offset: Out to In
This field determines the channel number difference between the
Output switcher and the Input switcher at any moment during a
sweep. For example, if the value 1 is entered in the Offset: Out to
in field, the Output switcher will always be connected to the next
higher channel number than the Input switcher connection (if Input is
at 7, Output is at 8, etc.) An Out to In offset of 1 would permit
crosstalk measurement scans of a multitrack tape recorder, measuring
the adjacent higher channel. A value of –1 would permit
measurement of the adjacent lower channel during a scan.

� Sweep Offset: B to A
This field determines the channel number difference between
Channel B and Channel A at any moment during a sweep. A B to A
offset of 1 is often used, along with a Stepsize of 2, when testing
stereo devices which are connected with stereo pairs going to
adjacent switcher channels (device 1 Left and Right to switcher
channels 1 and 2, device 2 Left and Right going to switcher channels
3 and 4, etc.).

Switcher Control During Sweeps
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The switchers may be controlled in a variety of ways during a sweep, by
selecting the parameters at Source 1 or Source 2 in the Parameter
column for the type of sweep desired. The available sweep control
parameters and their functions are as follows.

� ChA Input
The Channel A connector on the Input switchers will be scanned
across the range of switcher input connectors specified by the Start
and Stop values at the Source settings of the Sweep panel. All other
switcher connections will remain as set on the Switcher panel. This is
a common selection to check the same audio parameter on a
number of single-channel devices in sequence.

� ChB Input
The Channel B connector on the Input Switchers will be scanned
across the range of switcher input connectors in the same way as
described for the ChA Input scan above.

� ChA Output
The Channel A connector on the Output Switchers will be scanned
across the range of switcher output connectors specified by the Start
and Stop values at the Source settings of the Sweep panel. All other
switcher connections will remain as set on the Switcher panel. This is
a common selection to drive the inputs, one at a time, of a number of
single-channel devices in sequence.

� ChB Output
The Channel B connector on the Output Switchers will be scanned
across the range of switcher output connectors in the same way as
described for the ChA Output scan above.

� ChA Input/Output
The Channel A connector on the Input switchers and the Channel A
connector on the Output switchers will both be scanned across the
range of switcher output connectors specified by the Start and Stop
values at the Source settings of the Sweep panel. If the
Input/Output Offset field on the Switcher panel is zero, both input
and output switchers will be set to the same connector number at any
given moment. If the Input/Output Offset value is not zero, the
selected Output channel number will be greater or smaller than the
Input channel number by the value of the Out to In field and the
Input channel number will correspond to the present command from
the Sweep panel Source section. This is a common selection, using
an Out to In value of zero, to perform tests across the channels of a
multitrack tape recorder or a number of monaural devices. All other
switcher connections will remain as set on the Switcher panel.
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� ChB Input/Output
Identical to Ch. A Input/Output, except that it is the Channel B
connectors which are swept.

� ChA+B Input
The Channel A and Channel B connectors on the Input switchers will
both be scanned across a series of input connectors. If the B to A
Offset field on the Switcher panel is zero, both channels A and B will
connect to the same input connector. If the B to A Offset field is
not zero, the Channel B connection will always be to a connector
higher or lower in number than the Channel A connection, by the
value in the B to A Offset field. For example, if the B to A Offset
value is set to –2, the Channel B Input connector will always be
connected to the Input connector two steps below the Channel A
connection. All other switcher connections will remain as set on the
Switcher panel. This selection could be used to sequentially monitor
the output signals from a group of stereo power amplifiers on a
burn-in rack, all of whose inputs are constantly driven. For that
application, the B to A Offset value would be set to 1 and the
Stepsize parameter would be 2. Under these conditions the first
sweep step channel A connects to switcher channel 1 (device number
1 left channel output) and B connects to switcher channel 2 (device
number 1 right channel output). At the next sweep step, channel A
connects to switcher channel 3 (device number 2 left channel output)
and B connects to switcher channel 4 (device number 2 right channel
output), etc.

� ChA+B Output
Identical to ChA+B Input, except that it operates on the Output
switchers.

� ChA+Ch. B Input/Output
Both the A and B connections of both Input and Output switchers are
swept across the defined sequence of input and output connections.
The difference between Channel A and Channel B settings and
between Input and Output settings will be as determined by the two
Offset fields on the Sweep panel. This is a common selection to test
audio parameters of a number of stereo devices such as power
amplifiers in sequence. For this application, the Out to In Offset
value would be zero, the B to A Offset value would be 1, and the
Step Size parameter would be 2. At the first step of the sweep, A
input and output are connected to switcher channel 1 (device
number 1, left channel) and B input and output are connected to
switcher channel 2 (device number 1, right channel). At the second
step of the sweep, A input and output connect to switcher channel 3
(device number 2, left channel) and B input and output connect to
switcher channel 4 (device number 2, right channel), etc.
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Sweeps on Many Switcher Channels

A common application is to measure some characteristic, such as
frequency response or distortion or noise versus frequency, on a number of
nominally identical switcher channels. The results can all overlay on the
same graph for channel-to-channel comparisons. Any individual channel
traces or combinations of traces may be displayed or printed.

This type of test is set up as a nested sweep with the switcher selected at
Source 2 on the Sweep panel. To measure frequency response on all 24
tracks of a tape recorder, for example, select Switcher as the instrument
and ChA Input/Output as the parameter. Enter 1 for the start, 24 for
stop, and 1 as the step size. For frequency response, Source 1 would be
Analog Generator Frequency and Level A would be plotted at Data 1.
When the sweep is started, Source 2 causes the switcher to connect the
channel A input and output to channel 1 and frequency is swept between
the Source 1 Start and Stop values. When data at the stop point is
measured, Source 2 steps channel A input and output to channel 2 and
the Source 1 sweep repeats. This process continues until all 24 tracks
have been measured and plotted.

Switcher with Multitrack Recorder

Multitrack recorders can be quickly tested by use of switchers and nested
sweeps using both Source 2 and Source 1 on the Sweep panel. The
diagram shows typical switcher connections to test multitrack recorders.
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32 and 48 track recorders would require three each and four each,
respectively, of both input and output switchers. The generator drives the
selected recorder input channel via the Output switchers and the analyzer
selects the output of the same channel via the Input switchers. Additional
switchers necessary are stacked by having their rear panel A and B
channels connected in parallel. The 8-4-2-1 rear panel binary address
switches must be set to the proper code to make the switchers respond to
address 1–12, 13–24, etc., as required. See Setting Switcher
Addresses, page 364.

A typical frequency response measurement across all tracks would be set
up with:

� a Level meter connected to Audio Analyzer input channel A.

� that Level meter then selected at Data 1 on the sweep panel.

� a generator frequency sweep set up at Source 1 on the sweep
panel.

� a switcher channel A input/output sweep set up at Source 2 on the
sweep panel, starting on switcher channel 1 and stopping at the last
channel of the recorder, with a step size of 1.

The response curves for all channels would then be overlaid on the
same graph and could be compared for level balance, response shape, etc.
The Graph Legend can be used to temporarily turn off unwanted traces or
to highlight the trace for a particular channel in a different color or by
making the trace thicker.

Switcher Hardware

The switching in an Audio Precision SWR-2122 is performed by
high-reliability relays, which preserve the signal integrity of the generator
and signals from the DUT for transparent operation. Unlike conventional
industrial signal routing switchers, the SWR-2122 series switchers achieve
exceptional crosstalk performance, exceeding 140 dB at 20 kHz in
balanced operation.

The switchers are controlled by an APIB interface and integrate
smoothly into the ATS-2 measurement software. Convenient
channel-in-use LEDs indicate crosspoint activity.

There are four versions of switchers, as described below. The switchers
differ from one another primarily in connector configuration and in
attributes set by internal jumpers or rear-panel switches. These differences
define them as an input switcher (connecting multiple device-under-test
outputs to the analyzer inputs), an output switcher (connecting generator
outputs to multiple inputs of devices under test), or a patch-point switcher.
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Each of the switchers is a balanced 12 x 2 crosspoint matrix. Either of
the two common points can be connected, under software control, to any
of the twelve selectable points. The circuit boards are of balanced design
but may be used with unbalanced circuits with the BNC connector version,
which has floating shells. Up to 16 modules of the input and/or output
switcher may be stacked and connected in daisy-chain fashion to permit
testing devices with up to 192 inputs and/or outputs (up to 96 stereo
pairs). Rear panel switches permit setting the address of each module for
the desired channel number selections 1 through 12, 13 through 24, etc.
Simplified diagrams of the switchers are shown in the following
subsections. The contacts shown as single switches are actually multiple
relay contacts connected in a more complex arrangement. This is
necessary to obtain the isolation and crosstalk required for practical
professional and high-grade consumer applications.

XLR Connector Pin Assignments

The following XLR connector pin assignments are common throughout
the Audio Precision product line:

� Pin 1: Chassis ground (not signal ground)

� Pin 2: Signal high, or +

� Pin 3: Signal low, or –

The pin assignments of the five-pin XLR connectors, used on the
SWR-2122P Patch-Point Switcher, are given on page 361.

SWR-2122F Input Switcher

Each input switcher module connects any of 12 channels to the two
analyzer input channels (A & B). Input switcher modules have two male
XLR connectors and 12 female XLR connectors on the front panel.
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Figure 276. Input Switcher front panel.

Figure 277. Input Switcher rear panel.



SWR-2122M Output Switcher

Each SWR-2122M module routes two generator output channels (A &
B) to any of 12 channels. They have two female XLR connectors and 12
male XLR connectors on the front panel. Complement mode allows all but
one channel to be driven while measuring the undriven channel for
worst-case crosstalk on multichannel devices.
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Figure 278. Input Switcher simplified schematic.
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Figure 279. Output Switcher front panel.

Figure 280. Output Switcher rear panel.

Figure 281. Output Switcher simplified schematic.



Unbalanced Switcher

The SWR-2122U Unbalanced switcher module can be used as either an
input or output switcher. Floating BNC connectors help prevent ground
loops. When used in the output mode, this module is also capable of the
complement mode described above for the SWR-2122M.

Patch Point Switcher

The SWR-2122P Patch Point Switcher module allows a signal path to be
interrupted and a test generator inserted, while a measuring analyzer
accesses the output of a previous device. The patch point switcher differs
considerably from the input and output switchers in that the twelve
connectors of the patch point version are 5-pin XLR connectors. They are
designed for connection at major circuit nodes of a console, or between
series-connected devices in an audio chain in a studio, transmitter, or
sound reinforcement system.

Pins 1 (high) and 2 (low) connect from a balanced output of the
preceding device.

Pin 3 is ground.
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Figure 282. Unbalanced Switcher front panel.

Figure 283. Unbalanced Switcher rear panel.

Figure 284. Unbalanced Switcher simplified schematic.



Pins 4 (high) and 5 (low) are the signal to a balanced input of the
following stage or device.

The two common connectors of the patch point switcher are a female
3-pin XLR (INPUT) connector for connection to an output of the
generator, and a male 3-pin XLR connector (OUTPUT) for connection to
an input of the analyzer.

The patch point switcher is fail-safe in that in its normal mode (power
off, or no channel selected), the previous stage or device is directly
connected to the input of the following stage or device.

APIB Card

ATS-2 controls the switchers through the APIB (Audio Precision
Interface Bus), connected to the interface card mounted in the computer.
See Getting Started with ATS-2 for more information about the APIB
interface card.
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Figure 285. Patch Point Switcher front panel.

Figure 286. Patch Point Switcher rear panel.

Figure 287. Patch Point Switcher simplified schematic.



Connecting the APIB Interface

Each SWR-2122 switcher has two APIB connectors on its rear panel.
This is to permit connecting them in a daisy-chain fashion between the
computer’s APIB card connector and the ATS-2 APIB connector. Each
switcher’s connectors pass the APIB lines through, and the switcher
responds only when specifically addressed, as described below. Normally,
the computer connects to the first switcher with an APIB cable, the first
switcher connects to the second, and so on. The last switcher connects to
the ATS-2 APIB connector. See Figure 288.

Input/Output/Patch Point Jumpers

Remove the AC power cord from the AC Mains Connector before
removing the cover to inspect or change the jumper settings.

A common circuit board design is used in all models of the switchers;
two jumpers on the circuit board select whether the switcher functions as
an input switcher, output switcher, unbalanced switcher, or patch point
switcher. These jumpers, marked P62 and P63, are shown in Figure 290.
The jumper positions are shown for reference only and will normally not
need to be changed.
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Figure 288. Block diagram, typical APIB “daisy chain” connections.



Figure 289. P62 and P63 jumper locations inside SWR-2122 switchers.

Setting Switcher Addresses and Modes

A binary DIP switch is located on the switcher rear panel. The first four
switches on this bank select which group of channel numbers the module
responds to, as described in the following table. The last two switches
function as described in the appropriate subsection below.
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Figure 290. P62 and P63 jumper placement for

Output, Input, Patch Point and Unbalanced switchers.



These switches are marked 1 through 6 on the switch itself; on the
panel, the first four are labeled 1, 2, 4, and 8, which corresponds to their
bit value in the address word. The up, or ON, position corresponds to a
logic 0 (low).

Input, Output, and patch point switchers may all be combined in the
same system. Input and output switchers may share the same addresses. A
patch point switcher must not have the same addresses as either an input
or output switcher. Two patch point switchers may be set to the same
address if one is set as Channel A and the other as Channel B (see the
section Input, Output, and Patch Point Switcher Mode Switches).

Switcher Hardware Chapter 26: Switchers

ATS-2 User’s Manual 365

Channel
Numbers

Rear Switch Settings
Binary
code1

(Switch 1)
2

(Switch 2)
4

(Switch 3)
8

(Switch 4)

1–12 Up Up Up Up 0000

13–24 Down Up Up Up 0001

25–36 Up Down Up Up 0010

37–48 Down Down Up Up 0011

49–60 Up Up Down Up 0100

61–72 Down Up Down Up 0101

73–84 Up Down Down Up 0110

85–96 Down Down Down Up 0111

97–108 Up Up Up Down 1000

109–120 Down Up Up Down 1001

121–132 Up Down Up Down 1010

133–144 Down Down Up Down 1011

145–156 Up Up Down Down 1100

157–168 Down Up Down Down 1101

169–180 Up Down Down Down 1110

181–192 Down Down Down Down 1111

Table 2.



Switcher Address Settings

Each switcher module consists of 12 channels. Up to 16 modules may
be stacked to provide up to 192 channels. Rear panel address switches
must be set to select to which channel commands from the software each
switcher module should respond. For example, the first switcher is
normally set to channels 1–12, the second module to channels 13–24, etc.

The following figure shows a typical rear-panel APIB Address switch.
Table 1 shows relationships among APIB Address switch positions, binary
codes, and channel numbers on the ATS-2 software panels.

Input, Output, and Patch Point Switcher Mode Switches

Switches 5 and 6 of the switch bank set the switcher mode as described
in the following table.

� *Either A or B
This mode is valid only for Input and Output switchers. The
switcher’s channel A responds to the A channel addresses, and
channel B responds to B channel addresses. This is the normal
mode.
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Figure 291. Typical

switcher rear panel

APIB DIP switch.

Input, Output Mode
Rear Switch

Switch 5 Switch 6

Either A or B* Up Up

Channel A Down Up

Channel B Up Down

Off Down Down

Table 3.



� Channel A
The switcher’s channel A and channel B both respond to A channel
addresses.

� Channel B
The switcher’s channel A and channel B both respond to B channel
addresses.

� Off
Neither channel responds to any address.

Unbalanced Switcher Mode Switches

The SWR-2122U unbalanced switcher may be used for generator
output or analyzer input switching. Switch 6 in the DIP switch bank selects
between these modes:

� Set Switch 6 to the UP position to operate as an input switcher
(switcher will use Input switch channel numbers for Channel A and
Channel B on A Channel and B Channel addresses).

� Set Switch 6 to the DOWN position to operate as an output switcher
(switcher will use Output switch channel numbers for Channel A and
Channel B on A Channel and B Channel addresses).

Switch 5 disables the switcher; in the DOWN position, the switcher will
not respond to any addresses.

Also note the labeling on the rear panel describing the difference in
cable connections to the four rear-panel BNCs when used as an input
versus output switcher. See the following figure.
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Chapter 27

DCX-127 Multifunction Module

The DCX-127 Multifunction Module is an external accessory which is
connected to ATS-2 in “daisy chain” fashion using the Audio Precision
Interface Bus (APIB). The DCX-127 is controlled from ATS-2 by the DCX
panel.

The primary functions of the DCX-127 include an autoranging digital
multimeter (DMM), two independent dc voltage outputs variable across a
±10.5 V range, 21-bit (plus sign bit) low-speed digital inputs and outputs,
and three 8-bit digital output control ports.

The DCX-127 also provides pulses and dc levels whose timing depend
upon key software actions such as end of sweep or data settling. These
may be used for synchronization and sequencing of external devices or
portions of the ATS-2 test system. See the hardware discussion later in this
chapter.
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Figure 293. Audio Precision DCX-127 Multifunction Module.



The DCX Panel

The DCX panel gives you control over all the DCX-127 features. The
DMM section is at the top of the panel. Next are the dc output controls,
followed by the 21-bit digital inputs and outputs and the 8-bit digital
outputs.

DMM Operation

The DCX-127 digital multimeter is a 4 ½ digit dc volt-ohmmeter. You
can select the DMM function (or turn it off) using the three option buttons
located under the DMM reading display.

When DCV is selected, the DCX-127 will measure dc voltage across the
range of ±500 V dc. The reading may be displayed either in volts, shown
as the unit choice Vdc, or as a function of the measured voltage, shown as
the unit choice f(V).

When Ohms is selected, the DCX-127 will measure resistance in ohms.
The reading may be displayed either in ohms, shown as the unit choice
Ohms, or as a function of the measured resistance, shown as the unit
choice f(O).

See Offset and Scale Values below for explanation of the f(V) and
f(O) unit choices.
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Autorange or Fixed Range

The DMM may operate in autoranging mode or may be fixed on any
one of its full-scale ranges. Check the Range checkbox to enable
autoranging.

When the DMM autoranging function is disabled, you can manually
enter a maximum in the range field. The ATS-2 software will select and
display the most sensitive range which can handle the entered value.

Offset and Scale Values for f(V), f(O)

When f(V) (function of volts) or f(O) (function of ohms) units are
selected for the DMM, the ATS software computes the value to display
from the formula

� �display measurement Offset Scale� � � .

The measurement term is the value of the absolute voltage or resistance
measurement. The Offset and Scale terms are the values entered in the
Offset and Scale fields.

This feature allows you to convert a dc voltage or resistance which
represents some other variable to meaningful terms. For example, if you
have a thermometer with a voltage output, you could set the Offset and
Scale fields with the thermometer calibrations so that the DCX readings
would represent degrees Kelvin. Or, if you have a fluid level meter which
varies a resistance, you could calibrate the Offset and Scale fields to
represent the fluid level in centimeters.

Reading Rate

The DMM can operate at 6 or at 25 readings per second. DMM
resolution will change with reading rate. At 6 readings per second the
resolution is the full 4 ½ digits; at 25 readings per second, 4 ½ digits are
still displayed, but the least significant digit is limited to displaying either 5
or 0.
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Figure 295. DCX-127 manual range entry with Auto

Range disabled.



DC Outputs

The two dc outputs may be independently set to any voltage within the
range of ±10.5 V dc. Enter the value for either output in the appropriate
field. The outputs can be switched ON and OFF individually.

The 21-bit Digital I/O

The 21-bit Digital Input

The 21-bit digital input word connected to the DCX-127 front panel
25-pin D-Sub DIGITAL I/O: INPUT connector may be displayed in
decimal, hexadecimal, or octal units or as a scaled function g(x) of the
decimal value at the digital input.

Digital Input Data Format Selection

The binary values at the 21 active pins of the DIGITAL I/O: INPUT
connector may be interpreted as 2’s complement or in 8-4-2-1 binary
coded decimal (BCD) format.

Digital Input Scaling

When g(x) units are selected at the Digital In display, ATS-2 software
computes the displayed value from the relationship

� �display measurement Scale g� �

where measurement is the decimal value of the binary data in the
selected format and Scale(g) is the value entered in the Scale (g) field just
below the Digital In display.

The 21-bit Digital Output

The 21-bit digital output word presented to the DCX-127 front panel
25-pin D-Sub DIGITAL I/O: OUTPUT connector may be controlled in
decimal, hexadecimal or octal units, or as a scaled function h(x) of the
decimal value entered in the Digital Out field.

The value sent to the DIGITAL I/O: OUTPUT connector, in the unit
selected, is determined by the value entered into the Digital Out field. It
may also be swept from the Sweep panel.
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Digital Output Data Format

The value and units entered in the Digital Out field will be presented
to the front panel DIGITAL I/O: OUTPUT connector in either 2’s
complement or 8-4-2-1 BCD format.

Scale Factor for Digital Output

When h(x) units are selected at the Digital Output control field, ATS-2
software computes the actual transmitted value from the relationship

� �output value entry value Scale h� �

where entry value is the decimal value entered into the Digital Out
numeric field and Scale(h) is the value entered in the Scale (h) field just
below the Digital Out control field.

Binary Control for Ports A, B, C

Port A, Port B, and Port C are independent 8-bit digital control ports
at separate 9-pin D-Sub connectors on the rear of the DCX-127. The
settings of the 8 bits may be controlled from the DCX panel or they may
be swept over a range via the Sweep panel.

Settings from the DCX panel may be made as binary, octal, decimal, or
hexadecimal numbers. The binary control and display button-indicators
are functionally in parallel with the octal-decimal- hexadecimal field. Any
changes made to the binary buttons are immediately reflected in the
octal-decimal-hex field, and vice-versa.

Program Control Output and Gate Delay

The front-panel PROGRAM CONTROL: OUTPUT 9-pin D-Sub
connector provides several pulse or gate signals controlled from ATS-2
software.

Pin 6 on this connector is a sweep gate which goes high at the
beginning of each ATS-2 sweep and drops low at the end of the sweep.

Pin 1 is a delayed sweep gate, similar to pin 6 but with an additional
user-settable delay time between sweep start and the leading edge of the
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Figure 296. DCX-127 Output ports,

showing decimal, hexadecimal, octal and

binary controls.



gate signal. That delay time is controlled by the Gate Delay field at the
bottom of the DCX panel.

DCX-127 Hardware

The DCX-127 multi-function module is a separate unit packaged in a
1.75" (1 U)-high case which may be rack-mounted or used as a bench
instrument. Control of the DCX-127 is via the same Audio Precision
Interface Bus (APIB) which controls ATS-2 from the computer. The
DCX-127 functions include:

� dc voltage measurement (from the millivolt range to 500 Volts).

� dc resistance measurement (from less than 1 � to 2 M�).

� dc outputs from two independent sources, adjustable across a
±10.5 V range.

� Digital input and display of static or low-speed parallel input, word
width up to 21 bits.

� Digital output of a parallel digital word of 21 bits.

� A program control input of 8 lines which can trigger execution of
software macros.

� A program control output port which provides signals coincident with
a number of different software activities such as sweeping, settling of
data during a sweep, etc.

� Digital control outputs (four 8-bit ports) for general-purpose control
of external devices.

All the DCX-127 output functions are controlled from ATS-2 software,
and all of the inputs are displayed in ATS-2 software and may be displayed
as bargraphs or plotted values during a sweep when appropriate.
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DC Voltage Measurements

The DCX-127 includes a 4 ½ digit autoranging dc voltmeter- ohmmeter.
In voltage mode, the meter will automatically select among its ranges for
best resolution of the measured signal:

� 200 mV

� 2 V

� 20 V

� 200 V, or

� 500 V

The DCX-127 may also be fixed on any of its ranges.

The meter has selectable reading rates of 6 or 25 readings per second.
The 6/second selection provides full 4 ½ digital resolution, with 20,000
counts for full scale. The 25/sec selection still displays 4 ½ digits, but the
last digit will always be limited to 0 or 5. Normal mode rejection and
common mode rejection also degrade by approximately a factor of four
when the 25/sec reading rate is selected. Resolution versus range and
reading rate are shown in Table 4.

Resistance Measurements

The DMM resistance mode operates by forcing a calibrated value of
current through the unknown resistance and measuring the consequent
voltage drop.

The ohmmeter is autoranging and will automatically select among its
ranges:

� 200 �
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RANGE RESOLUTION
6/SEC RATE

RESOLUTION
25/SEC RATE

200 mV 10 µV 50 µV

2 V 100 µV 500 µV

20 V 1 mV 5 mV

200 V 10 mV 50 mV

500 V 100 mV 500 mV

Table 4. DMM Resolution for various reading rates and voltage ranges.



� 2 k�

� 20 k�

� 200 k�, or

� 2 M�

depending on the value of the unknown resistance being measured. It
may also be fixed on any range.

Reading rates of 6 readings per second or 25 readings per second may
be selected. The DCX-127 input configuration permits making these
resistance measurements on either a 2-wire or 4-wire basis.

Two-wire connection

If only one pair of test leads is used, connected from the (+) and (–)
terminals of the DCX-127 to the unknown resistance, a 2-wire
measurement results.

In a 2-wire measurement, current from the internal current source flows
through an internal resistor, through the test leads and resistance being
measured, and through another internal resistor back to the current source.
The two internal resistors are indicated schematically on the front panel of
the DCX-127. Voltage drop across these internal resistors, produced by
this current, is internally measured at the (+) and (–) terminals.

The resistance of the two test leads is included in the measurement. For
moderate and high values of unknown resistance, the additional error
introduced by resistance of the test leads is usually negligible.
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Four-wire (Kelvin) connection

For the highest accuracy when measuring low values of resistance, a
4-wire measurement (or Kelvin lead connection) is recommended. For this
measurement, one pair of test leads is connected from the two current
source connectors (marked �-SOURCE) to the unknown resistance. A
second pair of test leads is connected from the voltmeter input terminals
(+ and – jacks) to the unknown resistance. Current from the current
source now does not flow through the voltmeter leads, so the resistance of
the test leads is not included in the measurement.

The resolution of the reading varies with the range and with the reading
rate as shown in Table 5.
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RANGE RESOLUTION
6/SEC RATE

RESOLUTION
25/SEC RATE

200 � 1 � 5 �

2 k� 10 � 50 �

20 k� 100 � 500 �

200 k� 1 k� 5 k�

2 M� 10 k� 50 k�

Table 5. DMM Resolution for various reading rates and resistance ranges.
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DC Voltage Outputs

Two independent dc voltage outputs are available at the DCX-127 front
panel. Each may be set with 20 µV resolution (approximately 20 bits
equivalent) to any voltage in the ±10.5000 V range.

Example applications of the dc outputs include:

� sweep control of the gain, offset, or both ports of voltage-controlled
amplifiers (VCAs) while measuring their gain, distortion, or noise and
plotting those values versus control voltage;

� controlling the position of a dc-controlled turntable while measuring
polar response patterns of a loudspeaker or microphone;

� controlling manually operated test equipment with a dc control port
(such as the VCF input of a function generator);

� controlling dc-controllable bias oscillators in tape recorders, enabling
MOL, SOL, sensitivity, and other data to be taken automatically.

The dc outputs may be floated up to 2 V away from ground. See Figure
299 for the equivalent output circuit of both dc outputs.

The maximum current which may be drawn from them is 20 mA. The
maximum current which the dc outputs can sink is 10 mA.
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Digital Input

A parallel digital word of up to 21 bits (plus sign bit), at LSTTL-
compatible levels, may be connected to the digital input connector on the
front panel of the DCX-127. The value of this word may be displayed in
decimal or hexadecimal representations. A user-entered scale factor may
be entered and a function of actual input displayed, multiplied by the scale
factor. The digital word presented to the connector may be in either two’s
complement (binary plus a sign bit) or 8-4-2-1 binary coded decimal
(BCD) format. The word at the connector may either be asynchronously
sampled at any of four different selectable reading rates or, in external
mode, displayed each time a “data good” or “conversion completed”
pulse is presented at pin 25. The maximum sampling rate depends largely
on computer speed. A common application of the digital input is in static
(dc) linearity testing of analog-to-digital converters (ADCs). The digital
input may also be used to interface readings from a BCD-display
instrument such as a capacitance meter to the audio test system. The pin
connections are shown in Table 6.

Digital Output

An LSTTL-compatible parallel digital output word of up to 21 bits plus
sign may be created at the digital output connector. The value of the word
may be entered into the software in either decimal or hexadecimal
representations or scaled decimal. The format of the word (bit-to-pin
relationship) may be selected as two’s complement or 8-4-2-1 binary
coded decimal (BCD). The pin connections are shown in the Table below.
The strobe line (pin 25) is pulsed low each time a new value is entered into
the software panel or stepped to during a sweep.
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PIN NUMBER FUNCTION, TWO’S
COMPLEMENT MODE FUNCTION, BCD MODE

1 Ground Ground

2 Bit 0 (LSB) LS digit, 1

3 Bit 1 LS digit, 2

4 Bit 2 LS digit, 4

5 Bit 3 LS digit, 8

6 Bit 4 5th digit, 1

7 Bit 5 5th digit, 2

8 Bit 6 5th digit, 4

9 Bit 7 5th digit, 8

10 Bit 8 4th digit, 1

11 Bit 9 4th digit, 2

12 Bit 10 4th digit, 4

13 Ground Ground

14 Bit 11 4th digit, 8

15 Bit 12 3rd digit, 1

16 Bit 13 3rd digit, 2

17 Bit 14 3rd digit, 4

18 Bit 15 3rd digit, 8

19 Bit 16 2nd digit, 1

20 Bit 17 2nd digit, 2

21 Bit 18 2nd digit, 4

22 Bit 19 2nd digit, 8

23 Bit 20 (MSB) MS digit, 1

24 Sign Sign

25 Strobe Strobe

Table 6. Digital I/O connector pin assignments.



A typical application of digital output is in static (dc) linearity testing of
digital-to-analog converters (DACs). The digital output word drives the
converter; the analog output of the converter is measured with the
DCX-127 DMM.

For high-resolution converters at output voltages more than ±200 mV
away from zero, it will be desirable to use one of the DCX-127 dc outputs
in conjunction with the DMM input in differential voltmeter fashion so that
the DMM can be set on its highest resolution range.

Another application of the digital output is control of digitally-
controllable turntables during polar response testing of microphones and
loudspeakers.

Still another application is in testing multiplying digital-to-analog
converters (MDACs) used as variable resistors, attenuators, or in other
audio applications. Each bit output has a 5 mA current drive capability
and a 390 � output impedance.

Program Control Outputs

The PROGRAM CONTROL: OUTPUT connector provides five pulse
or gate signals controlled by various actions of ATS-2 software. The pin
assignments are shown in Table 7, above. All lines are LSTTL- compatible.

The Reset output, pin 2, pulses high when the DCX-127 power is turned
on and whenever a Utilities > Restore ATS-2 Hardware menu
command is executed. The Reset output would typically be used to
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CONNECTOR PIN FUNCTION

1 Delayed sweep gate

2 Reset

3 Data acquired

4 Trigger

5 Undefined

6 Sweep gate

7 Undefined for ATS-2

8 Ground

9 Ground

Table 7. Program Control Output connector pin assignments.



normalize the condition of external logic devices connected to an ATS-2
test station at power up. It may also be invoked in a macro by inserting an
ATS.Application.Restore command into the macro.

The Data Acquired output, pin 3, pulses high each time that a set of
data satisfies the settling algorithm. See Sweep Settling in Chapter 15 for
full details on the settling algorithm. This signal could be used, for
example, to cause a Compact Disc player to automatically advance to the
next track whenever a successful set of measurements is completed on the
preceding track. This is useful during an external frequency or external
amplitude test across a series of tracks of a test disc.

The Trigger output, pin 4, pulses high at the end of each delay portion
of the settling process. Settling delay, in a generator-based sweep, is the
time after the generator steps to a new value before the software starts
examining data samples to see if they are settled. This signal could be
viewed on a dual-trace oscilloscope along with the signal being measured,
to verify that the delay has been optimally set to discard left over data from
the previous generator step when measuring systems such as 3-head tape
recorders or satellite paths which have large time delays. The Trigger
output could also be used to strobe an external device being tested, such
as an analog-to-digital converter. This will help insure that the source is
stable before the conversion takes place.

The Sweep Gate output, pin 6, drops low at the beginning of a sweep
test and goes high at the completion of a test. In a nested sweep, it will go
high momentarily at the end of each Source 1 sweep and drop low again
for the next Source 1 sweep after the Source 2 parameter is
incremented.

The Delay Gate output, pin 1, is similar to the Sweep Gate signal but
with the addition of a user-settable delay time between the actual
beginning of a sweep test and the leading edge of the gate output signal.
This delay time is entered at the bottom of the DCX software panel, in the
Gate Delay field.

An example application is power amplifier turn-on and turn-off transient
(thump) testing. The amplifier power could be turned on by the sweep
gate and off by the delayed gate. The output of the amplifier may be
measured during a time sweep.

Another example application is to start a tape machine for run-up time
testing. The basic measurement technique is to perform a time sweep
while measuring frequency from a pre-recorded tape or disc. Use of the
Delayed Sweep Gate to start the recorder permits the instrument to draw
the graph when Go is pressed, start the time sweep, and then start the
machine at a predetermined time into the sweep when the software is
ready to take continuous, rapid measurements.
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Digital Control Output Ports

Three rear-panel 9-pin D-Sub connectors are provided on the DCX-127
for control of external devices. These output ports are intended for direct
interface to LSTTL circuitry, or via LSTTL-compatible drivers to relays.
Applications could include control of mains power, indicator lights,
annunciators, and so on.

The pin connections of these ports are shown in the table above. The
current drive capability of each bit line is 5 mA; the output impedance is
390 �.
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CONNECTOR PIN FUNCTION

1 Bit 7 (MSB)

2 Bit 6

3 Bit 5

4 Bit 4

5 Bit 3

6 Bit 2

7 Bit 1

8 Bit 0 (LSB)

9 ground

Table 8. Output port connector pin assignments.
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Appendix A

Units of Measurement

Introduction

Many different units of measurement are used to describe audio signals
and audio system components and characteristics. ATS-2 offers a wide
choice of units of measurement for both setting and reading values.

� Values can be expressed in absolute terms such as the volt, the watt,
the ohm, the hertz and the second.

� Values can also be displayed as the ratio of one value to another with
units like the decibel or percent.

� In addition, ATS-2 provides relative units which express the
relationship of a value to a user-supplied reference, or to another
ATS-2 setting.

Depending on the current ATS-2 configuration and the parameter you
are setting or observing, different units choices will be available. Any
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Figure 300. Selecting Units of

Measurement for ATS-2

readings and settings.



reading display or setting field which has a drop-down arrow offers a list of
units of measurement. Click the arrow to display the list and choose the
units you prefer. When you request a value in different units, ATS-2 does
the calculation for you.

Analog Amplitude Units

V—volts (unqualified). This unit is used only on the Audio Analyzer and
the Harmonic Distortion Analyzer panels. Because of the detector
differences between the Audio Analyzer Function meters and the other
meters on these panels, in some configurations V may have different
meanings. Specifically, on all Audio Analyzer and the Harmonic Distortion
Analyzer reading and reference fields except the Function meters, V means
volts (rms). Since the Function meters have switchable detectors, the V
units selection takes its qualification, that is, V (rms) or V (quasi-peak) from
the detector selection.
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The decibel

The decibel or dB, in one form or another, is arguably the most
widely-used unit of measurement in the field of audio. The ear’s
response to both sound amplitude and frequency is usually best
examined in logarithmic terms, and the dB, being a logarithmic unit of
measurement, is often the right choice.

It is important to remember that the dB is always a ratio of two
values, and for a meaningful expression both of the values must be
known. While “8 dB” means nothing, “8 dB below the input signal”
gives us a reference and is a meaningful statement. Whenever using the
simple dB unit, the expression must identify the reference value.

A large collection of units of measurement (we’ve seen it referred to
as “the dB zoo”) uses the decibel ratio with the reference stated as part
of the definition of the unit. Examples include dB V (decibels in relation
to 1 V rms); dB u (decibels in relation to .7746 V rms); dB FS (decibels
in relation to digital full scale); dB spl (decibels of sound pressure in
relation to 20 micropascals of pressure) and so on.

The formula for decibels in voltage amplitudes is

dB
V
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�
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log

where V1 and V2 are the two related voltages.

The formula for decibels in power amplitudes is
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where P1 and P2 are the two related powers.



Vrms—volts (rms). This unit is used only on the Analog Generator and
Digital Generator panels, and this setting accurately calibrates the
generator output in Vrms when a sinewave is being generated. When
using other waveforms (such as noise, squarewaves, multitone, IMD test
signals, and so on) with Vrms, the signal has the same peak-to-peak
voltage as a sinewave at that setting, as shown in Figure 301. Vrms is an
open-circuit value and the actual output voltage will be less with a load.

Vp—volts (peak). This unit is used on the output setting fields on the
Analog Generator and Digital Generator panels and on the Peak Mon
meters on the Analog Input panel. This calibration assumes a sinewave,
and is arithmetically scaled to the Vrms value by 2, approximately

1.414. Since non-sinusoidal waveforms are calibrated to have the same
peak-to-peak value as a sinewave, the Vp unit should be correct for most
non-sinusoidal waveforms. When used with the Analog Generator, Vp is
an open-circuit value and the actual output voltage will be less with a load.

Vpp—volts (peak-to-peak). This unit is used on the output setting fields
on the Analog Generator and Digital Generator panels and on the DIO
Input meter. This calibration assumes a sinewave, and is arithmetically
scaled to the Vrms value by 2 2� , approximately 2.828. Since

non-sinusoidal waveforms are calibrated to have the same peak-to-peak
value as a sinewave, the Vpp unit should be correct for most
non-sinusoidal waveforms. When used with the Analog Generator, Vpp is
an open-circuit value and the actual output voltage will be less with a load.

W—watts. This unit of power is used on the Analog Generator and the
Audio Analyzer panel. Watts is calculated based on the P V R� 2

relationship. On the Analog Generator panel, V is the setting in Vrms, and
R is the combination of the ATS-2 source resistance and the resistance of
the external load; for an accurate setting, you must enter the value of the
load resistance in the References: Watts field on the generator panel. On
the Audio Analyzer panel, V is the measured rms voltage and R is the
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GENERATOR AMPLITUDE SETTING 1.000 V (0 dBV) IN ALL CASES

SIGNAL AMPLITUDE 2.828 Vpp IN ALL CASES

SINEWAVE
rms AMPLITUDE
1.000 V (0 dBV)

SQUAREWAVE
rms AMPLITUDE

1.414 V (+3.01 dBV)

500 Hz / 3 kHz 1:1 RATIO
IMD TEST SIGNAL
rms AMPLITUDE

0.707 V (–3.01 dBV)

2.828 Vpp

Figure 301. ATS-2 generator output calibrations



value of the source resistance, which you must enter in the References:
Watts field on that panel.

dBm—decibels relative to 1 mW. This unit of power is not used in
ATS-2, but it is so common that it is included here as a reference.

dBm is rarely the correct choice of units for audio

measurements. dBm units are often mistakenly chosen when

dBu units should be used. See the sidebar dBm versus dBu

on page 389.

dBu—decibels relative to 0.7746 V rms. This is usually the correct
choice of units for audio levels in professional audio equipment and
systems. The dBu is a voltage unit and, unlike the dBm, is independent of
circuit impedance. When used with the Analog Generator, dBu is an
open-circuit value and the actual output voltage will be less with a load.
See the sidebar dBm versus dBu on page 389.

Appendix A: Units of Measurement Analog Amplitude Units

388 ATS-2 User’s Manual



dBV—decibels relative to 1.000 V rms. This is usually the correct choice
of units for audio levels in consumer audio equipment and systems. The
dBV is a voltage unit and, like the dBu, is independent of circuit
impedance. When used with the Analog Generator, dBV is an open-circuit
value and the actual output voltage will be less with a load.

Analog Amplitude Units Appendix A: Units of Measurement
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dBm versus dBu

The dBm unit of measurement is a legacy from earlier days of
audio technology, when measuring the audio power transferred in
impedance-matched circuits was important. The dBm is a unit of power
(referenced to 1 mW), and the audio circuits of the day often had an
impedance of 600 �. The voltage drop across a 600 � resistor
dissipating 1 mW is 0.7746 V, and this voltage (which reads 0 dBm on a
dBm meter across 600 �) came to be regarded as “zero level” in
professional audio circles.

However, many audio circuits do not have a 600 � impedance.
Microphone circuits may be 150 �, and headphone circuits may be
50 �. This is even more true in modern design, where circuit outputs
often have very low impedances (from almost zero to a few tens of
ohms) and input circuits often are “bridging,” with impedances of
1500, 10,000 or even 50,000 �. A milliwatt dissipated in any of these
circuits will not read 0.7746 V, and the dBm meter (which is simply a
voltmeter calibrated for a 600 � circuit) will be in error. The circuit
impedance must always be taken into account in power measurements.

Because of this, the dBm can be misleading. It has fallen out of use
in the last 20 years (except for specific applications where power
transfer is an important consideration and the circuit impedances are
known) and its place in professional audio has been taken by the dBu,
where the “u” can be taken to mean “unloaded.”

The value of 0 dBu, 0.7746 V rms, is the voltage developed across
a 600 � resistor when 1 mW is being dissipated in that resistor, the
same voltage as 0 dBm in that impedance; in 600 �, dBu = dBm. The
advantage of the dBu is that it is a valid measurement in audio circuits
of any impedance.

Unless you know the circuit impedance and have a clear reason to
use the dBm reference, use dBu.



Digital Amplitude Units

FFS—fraction of full scale, simply the ratio of the rms value of the signal
to the full-scale value, expressed as a decimal fraction. A sinewave half the
value of full scale would be indicated as 0.5 FFS. The lower levels often
encountered in practical audio applications may be displayed as mFFS
(milli fractions-of-full-scale, or FFS / 1000) and µFFS (micro
fractions-of-full-scale, or FFS / 1000000).

%FS—percent of full scale. This is the FFS value multiplied by 100. For
example, a signal at 0.8 FFS is 80 % FS.

dBFS—decibels relative to full scale. This is a logarithmic measurement
defined as � �20 10� log FFS . For example, a signal at 0.1 FFS equals
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FS: Digital Full Scale

All of the units for digital domain audio amplitudes refer to digital
full scale. In pulse-code-modulation (PCM) audio, the amplitude of
each audio sample is represented as a number. The maximum and
minimum values of these numbers vary with the digital word length,
but they are precisely defined. A signal which attempts to exceed these
values can drive a digital system into overload; in a popular expression,
the signal “runs out of numbers.”

Word Length
Positive Full-Scale

Value
Negative Full-Scale

Value

16-bit 7FFF Hex 8000 Hex

24-bit 7FFFFF Hex 800000 Hex

The Audio Engineering Society defines digital full scale in terms of
a sine wave whose peaks just reach the maximum positive and negative
digital codes. The rms value of this sine wave is the full-scale reference,
defined as 1 FFS or 0 dB FS. Note that other waveforms (noise or
music, for example) have different crest factors than a sine wave (crest
factor is the ratio of a signal’s peak amplitude to its rms amplitude) and
will have different rms values at the amplitude at which their peaks just
reach the maxima.

A consequence of defining full scale as an rms value is that
high-level signals that have a lower crest factor than a sine wave can
display rms values greater than 1 FFS or 0 dB FS, even though the
digital maximum and minimum codes are not exceeded. For example,
a square wave whose top and bottom are at the maximum digital codes
will have an rms value of 1.414 FFS or +3.01 dB FS. See Figure 302.



–20 dB FS. dB FS is probably the most common unit of measurement
used for digital audio amplitudes. 0 dB FS is the full-scale reference.

bits—“Bits” is another way of discussing the dynamic range of a digital
converter, by converting a measured dynamic range value to the
equivalent number of bits (the digital word length) that a signal would
theoretically require to attain that dynamic range. The calculations take
into account the effect of quantizing noise in the LSB by the 1.76 dB
offset.

For example, the theoretical dynamic range of a 16-bit system can be
calculated to be about 98.1 dB, using this formula:

Dynamic Range number of bits� � �602 176. . dB.

Conversely, a dynamic range of 98.1 dB can be expressed as 16 bits.

Levels can also be expressed in this notation. The ATS-2 bits unit is
computed from dB FS using the following relationship, where dB is the
level to be expressed, relative to full scale:

bits
dB

�
�	



�

�



�

176

602

.

.
.

For example, a signal at 0.0001 FFS, or –80 dB FS, can also be stated
as –12.99 bits.

A consequence of the 1.76 dB offset is that a 0 dB FS signal

displays a bits value of +0.29. A signal at –1.76 dB reads

exactly zero bits.
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rms reading
= 0 dB FS

rms reading
= 3.01 dB FS

MAXIMUM DIGITAL CODE

MINIMUM DIGITAL CODE

Figure 302. The squarewave has a lower crest factor than the sinewave.

Since dB FS is defined in rms terms, a squarewave with the same peak value as a

0 dB FS sinewave will have a value of 3.01 dB FS.



Digital Data Units

dec, hex—decimal and hexadecimal (or hex). In addition to the digital
domain units listed above, which are values integrated over one or more
signal cycles, the ATS-2 Digital Generator also has decimal and
hexadecimal units available. These units express the numerical value of the
embedded audio at each sample in either base 10 (decimal) or base 16
(hexadecimal) notation. The decimal and hexadecimal values refer to the
peak value when used with the AC waveforms of the Digital Generator.
The units dec and hex are used with the Special: Constant Value
(digital dc) waveform selection, and with the Offset parameter of the
Sine: Offset waveform.

Ratio Units

%—percent. The percent unit expresses the ratio of two numbers
multiplied by 100. For example, a ratio of 0.7 is expressed as 70%.

dB—decibel. The decibel is always a ratio of two amplitudes, expressed
logarithmically. For voltage amplitudes, decibels are computed by

dB
V

V
�
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See the sidebar on decibels, page 386.

PPM—parts per million. Parts per million expresses the ratio of two
numbers, multiplied by 1,000,000. For example, a ratio of 0.00005 equals
50 PPM.

X/Y—The X/Y unit is the simple ratio between two numbers.

Specific ratio units, such as dBu or %Hz, are discussed in

more detail in the relevant sections on amplitude or

frequency units.

Relative Units

dBg—decibels relative to the Analog Generator amplitude setting.

dBr—decibels relative to a user-defined reference. The generators and
the analyzer have separate, independent dBr or dBr A/dBr B fields in the
References area of their respective panels. You can manually enter dBr
values from the keyboard, or you can capture current ATS-2 values for
certain Reference fields as follows:
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� Analog Generator dBr: Function Key F3 or Edit Menu command Set
Generator dBr Ref.

� Analyzer dBr: Function Key F4 or Edit Menu command Set
Analyzer dBr Ref.

dBrInv—decibels relative to a user-defined reference, inverted. This is
exactly as described under dBr just above, but plotted upside down so
that smaller or negative values are at the top of the graph, and larger or
positive values are at the bottom.

The dBrInv units are commonly used in conjunction with Regulation
mode, such as when measuring frequency response of a pre-emphasized
broadcast transmitter. Inverted plotting of the generator levels required to
produce constant modulation percentages produces the expected shape of
the transmitter frequency response.

Frequency Units

Hz—hertz. This is the basic frequency unit, expressing the number of
cycles of a signal in one second.

The rest of the frequency units used in ATS-2 measurements

are relative units, expressing the relationship of the

measured frequency to a reference frequency you have

entered into the References > Freq: fields in the generator

and analyzer panels.

F/R—This is a frequency ratio unit, obtained by dividing the measured
frequency F by the reference frequency R.

dHz—delta hertz. dHz is the difference in frequency between the
measured frequency and the reference frequency; dHz F R� � .

Delta (�) is the Greek symbol often used to signify change or

difference.

%Hz—percent hertz. %Hz is obtained by dividing the measured
frequency by the reference frequency and multiplying the result by 100;

� �100 � F R . For example, a measured frequency of 950 Hz would be
expressed as 95.0 % of a reference frequency of 1 kHz.

cent—the cent unit is 1/100 of a musical half-tone interval, which in
turn is the 12th root of 2:

cent �
2

100

12

Hz.
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octs—octaves. An octave is a frequency ratio of 2:1. For example, with
a reference frequency of 1 kHz, a 2 kHz tone is expressed as +1.0 octave
and a 500 Hz tone is expressed as –1.0 octave.

decs—decades. A decade is a frequency ratio of 10:1. For example,
with a reference frequency of 500 Hz, a 5 kHz tone is expressed as +1.0
decade and a tone of 50 Hz is –1.0 decade.

d%—delta percent. d% is 100 times the ratio of dHz (or F R� ) to the
reference frequency R:

d
F R

R
% � �

�	



�

�



�100 .

For example, with a reference frequency of 1 kHz and a measured
frequency of 950 Hz, the d% value is –5 %.

dPPM—delta parts per million. The dPPM unit is 1,000,000 times the
ratio of dHz (or F R� ) to the reference frequency R:

dPPM
F R

R
� �

�	



�

�



�1 000 000, , .

For example, with a reference frequency of 1 kHz and a measured
frequency of 1,001 Hz, the dPPM value equals 1,000 dPPM.

Phase Unit

deg—degree. The degree is the basic unit of phase measurement,
representing 1 360/ of a complete revolution of phase.

Time Units

sec—seconds. Seconds are the basic time unit, abbreviated s. At values
common in audio, the display may be in ms (milliseconds), µs
(microseconds) or ns (nanoseconds).

UI—unit interval. The unit interval is a convenient unit when examining
digital interface signal timing, because by definition the UI is relative to the
signal you are measuring; it scales with the interface data rate. The UI is
defined as the shortest nominal time interval in the coding scheme. For an
AES3 or IEC60958 signal there are 2 subframes of 32 bits per frame giving
64 bits per frame; after bi-phase mark encoding the pulse rate is nominally
128 pulses per frame. This interval, 1 128 of a frame, is the unit interval for
AES3 and IEC60958 signals.

For a 44.1 kHz sampling rate, � �1 128 44100 177 2UI ns/ .� � ;

For a 48 kHz sampling rate, � �1 128 48000 1628UI ns/ .� � ;
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For a 96 kHz sampling rate, � �1 128 96000 814UI ns/ .� � .

dBUI—decibels relative to 1 unit interval. The dB UI provides a
logarithmic time unit scaled to the interface signal and is primarily used for
FFT plots of jitter amplitude.

DCX-127 Units

The DCX-127 Multifunction Module brings additional measurement
capabilities to ATS-2, and with these features come additional units of
measurement.

DCX-127 Amplitude Units

Vdc—volts, dc. This is the basic unit of direct current (dc) electromotive
force.

f(V)—“f of V ” is a value which is a function of voltage. f(V) is
computed from

� � � �f V V offset scale� � � .

See DMM Offset and Scale Values on page 371.

DCX-127 Resistance Units

Ohms—ohms. This the basic unit of electrical resistance, also shown by
the symbol �.

f(O)—“f of O ” is a value which is a function of resistance. f(O) is
computed from

� � � �f O ohms offset scale� � � .

See DMM Offset and Scale Values on page 371.

DCX-127 Digital Input and Output Units

dec—decimal. The decimal (dec) unit converts the DCX-127 digital
input and output between binary and decimal representation.

hex—hexadecimal. The hexadecimal (hex) unit converts the DCX-127
digital input and output between binary and hexadecimal representation.

oct—octal. The octal unit converts the DCX-127 digital input and
output between binary and octal representation.

g(x)—(input). Like the scaled voltage and resistance units, g(x) enables
you to scale digital input units. The g(x) unit is computed from
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� �g x x scale� � .

h(x)—(output). Like the scaled voltage and resistance units, h(x)
enables you to scale digital output units. The h(x) unit is computed from

� �h x
x

scale
� .
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Appendix B

The Digital Audio Signal

Almost all digital audio signals are a form of pulse code modulation
(PCM). When an analog signal is digitized, the waveform is sampled at a
regular rate (the sample rate) and the amplitude of the waveform at each
sampling instant is acquired. Each value is encoded as a binary number,
and each number is called a digital word. Placed end-to-end, the words
form a string of pulses representing the binary numbers at each sampling
instant.

PCM audio can be characterized in a number of ways, chief among
them the sampling rate used and the degree of resolution of the numbering
system. The sample rate can be low, such as the 8 kHz rate used in
telecommunications; or high, such as the 192 kHz sometimes used for
high-performance music recordings. Common sample rates are the
44.1 kHz rate used in Compact Disc (CD) recording, or the 48 kHz rate
used in much broadcast and professional audio recording. A key
consideration in sample rate selection is signal bandwidth, which is always
limited to one-half the sample rate, referred to as Fs/2 or the Nyquist
frequency.

The numerical resolution of the signal depends on the number of bits
assigned to encode the signal value. This is called the word length. Word
length (or resolution) also varies between different systems, from perhaps 8
bits (256 discrete levels) to as high as 24 bits (16,777,216 discrete levels).
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The Serial Digital Interface Signal

For reliable transmission and reception the PCM audio is encoded into
an interface signal according to one of several international standards. The
interface signal adds channel and synchronization identification, status
information, error correction, and embeds the clock signal into the data
stream.

The AES3 and IEC60958 standards define the digital audio interface
signal for both professional and consumer use. There are several variations
set out in the standards that are, for the most part, compatible.

The professional format is most often referred to as AES3, but is also
called AES/EBU or IEC60958-4. There are also other variations of the
professional format, such as AES3id and SMPTE 276M. These have the
same data pattern but different electrical characteristics.

The consumer format is defined by IEC60958-3, and is also called
S/PDIF or EIAJ. The consumer format differs from the professional in
electrical characteristics and in the interpretation of Status Bits.

The standards specify not only the pattern and encoding of the PCM
audio and other data, but also the electrical and mechanical aspects of the
interface. The ATS-2 balanced digital connectors conform to AES3, and
the unbalanced connectors (including the SYNC/REF BNC on the rear
panel) satisfy AES3id. All ATS-2 digital inputs and outputs will work with
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the data patterns of either the AES3/IEC60958-4 professional format or
the IEC60958-3 consumer format. Output format is selectable in software.

We will use the AES3 professional standard as a model for this
discussion. For the purposes here, only the Status Bits interpretation is
different for the consumer format.

Bi-phase Mark Encoding

To carry a consistent clock and provide for a robust transmission signal,
the interface data is processed by bi-phase mark encoding. This scheme
provides a transition at the beginning of every data bit, and a second
transition in the center of the bit if the bit is a data “1.” Bi-phase mark
encoding ensures that there is at least one transition for each data bit, no
matter what the state of the bit.

The bi-phase mark pattern is broken for the three types of preambles, as
a means of identifying the frame, subframe and block beginnings.

The Frame and Subframe

Figure 304 shows the AES3 data pattern. The frame is the basic subunit,
and is comprised of two subframes, called subframe A and subframe B.
The frame rate is normally the same as the sample rate: a signal sampled
at 44.1 kHz will normally be carried on an interface signal running at
44,100 frames per second.

Each subframe carries one word of audio. Normally subframe A will
carry a word of audio A, nominally the left channel; subframe B usually
carries audio B, the right channel. Other assignments may be made,
though, and in dual connector operation both subframes A and B may be
subsequent words of the same audio channel, with the second channel
carried on the second connector. In multitrack applications, subframes A
and B may carry audio channels 7 and 8, for example.

Each subframe has the following structure:

First there is a preamble, which has a length of 4 data bits. The
preambles are used for identification and synchronization of the frames
and subframes. The X preamble indicates the subframe A beginning, the Y
preamble indicates subframe B, and the Z preamble indicates subframe A
and the beginning of the Channel Status and User blocks.
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Following the preamble are 24 bits reserved for the audio word; with
shorter audio words the remaining bits are unused, although bits 4–7 can
be re-assigned as auxiliary bits. The audio word is arranged with the least
significant bit (LSB) first.

After the audio word are four administrative bits, the V bit (Validity), the
U bit (User), the C bit (Channel Status) and the P bit (Parity).

The V bit and the P bit carry data which apply only to their particular
subframe. If the V bit is 1, the audio data in that subframe is marked as
invalid. The P bit is set to give even parity for the subframe.

The C and U bits do not carry information about one particular
subframe; instead, these bits are gathered together in blocks of 192 bits.
The block beginnings are identified by the Z preamble.

The C bits and the U bits are gathered separately into the Channel
Status block and the User block. Although Status and User blocks built by
subframes A and B usually contain the same information, it is possible to
carry different Status or User data in the A and B subframes.

ATS-2 reads and sets all Channel Status conditions, but does not display
or set User bits.

Channel Status

The Channel Status information differs substantially between the
professional and the consumer formats. The first bit in the block indicates
professional format by a 0 and consumer format by 1.

The following tables show the channel status fields and their
interpretations for both the professional and consumer formats.
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Category code

Pro/con
= 0

Non-
audio = 0

EmphasisCopyright Channel status
mode = 00

Source number Channel number

Sampling frequency

Word length

Clock accuracy

(Future original sampling frequency?)

Reserved

bit 8

bit 0

bit 16

bit 24

bit 32

bits 40–191

9

1

17

25

33

10

2

18

26

34

11

3

19

27

35

12

4

20

28

36

13

5

21

29

37

14

6

22

30

38

15

7

23

31

39

0

1

2

3

4

5–23

Byte Consumer format channel status fields
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pro/con

non-audio

emphasis

copyright

category code The category code depends on the equip-
ment type. For most codes the MSB of
the category code carries information
about generation status of the material
(refer to SCMS), and is called the L-bit.
The following are common codes:

LSB MSB
CD player 1000 0000
DAT player 1100 000L
DCC player 1100 001L
Mini disc 1001 001L

channel status mode

0: consumer; 1: professional format

0: asserted; 1: not asserted

0: suitable for conversion to analog
audio using linear PCM
1: not suitable

000: Emphasis not indicated
100: emphasis—CD-type

00: mode zero; other values reserved

Consumer format channel status field interpretations

Bits label interpretation

0

1

2

3–5

6–7

8–15

sampling frequency

channel number

source number

clock accuracy

reserved

reserved

reserved

word length

word length (field size) 0: Maximum length 20 bits
1: Maximum length 24 bits

0000: 44.1 kHz
0100: 48 kHz
1100: 32 kHz

(bit 16 is LSB)

(bit 20 is LSB)

10: Level I, ±50 ppm
00: Level II, ±1000 ppm
01: Level III, variable pitch shifted

16–19

20–23

24–27

28–29

30–31

32

33–35

40–191

36–39

if bit 32 = 1
not indicated
24 bits
23 bits
22 bits
21 bits
20 bits

if bit 32 = 0
not indicated
20 bits
19 bits
18 bits
17 bits
16 bits

000:
101:
001:
010:
011:
100:
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Channel mode

Pro/con
= 1

Non-
audio

Emphasis Lock Sample frequency

User bit management

Source word length Alignment levelUse of auxiliary mode sample bits

Channel Identification for multichannel application

Alphanumeric channel origin data (first character)

Alphanumeric channel origin data

Alphanumeric channel origin data

Alphanumeric channel origin data (last character)

Alphanumeric channel destination data (first character)

Alphanumeric channel destination data

Alphanumeric channel destination data

Alphanumeric channel destination data (last character)

Local sample address code (32-bit binary, LSW)

Local sample address code (32-bit binary)

Local sample address code (32-bit binary)

Local sample address code (32-bit binary, MSW)

Time of day code (32-bit binary, LSW)

Time of day code (32-bit binary, MSW)

reserved

bytes
0-5

bytes
6-13

bytes
14-17

bytes
18-21

Cyclic redundancy check character (CRCC)

Reliability flags

Time of day code (32-bit binary)

Time of day code (32-bit binary)

Reserved

= 0

= 0

= 0

= 0

= 0

= 0

= 0

= 0

DARS fs scalingSample frequency (fs)

bit 8

bit 0

bit 16

bit 24

bit 32

bit 40

bit 48

bit 56

bit 64

bit 72

bit 80

bit 88

bit 96

bit 104

bit 112

bit 120

bit 128

bit 136

bit 144

bit 152

bit 160

bit 168

bit 176

bit 184

9

1

17

25

33

41

49

57

65

73

81

89

97

105

113

121

129

137

145

153

161

169

177

185

10

2

18

26

34

42

50

58

66

74

82

90

98

106

114

122

130

138

146

154

162

170

178

186

11

3

19

27

35

43

51

59

67

75

83

91

99

107

115

123

131

139

147

155

163

171

179

187

12

4

20

28

36

44

52

60

68

76

84

92

100

108

116

124

132

140

148

156

164

172

180

188

13

5

21

29

37

45

53

61

69

77

85

93

101

109

117

125

133

141

149

157

165

173

181

189

14

6

22

30

38

46

54

62

70

78

86

94

102

110

118

126

134

142

150

158

166

174

182

190

15

7

23

31

39

47

55

63

71

79

87

95

103

111

119

127

135

143

151

159

167

175

183

191

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

Byte Professional format channel status fields
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pro/con

non-audio
(or, more accurately,
"not linear PCM")

emphasis

lock

sampling frequency

Channel mode
(SCDSR = single channel
double sample rate)

use of aux sample word

user bit management

source word length

0: consumer; 1: professional format

0: audio data is linear PCM samples
1: other than linear PCM samples

000: Emphasis not indicated
100: No emphasis
110: CD-type emphasis
111: J-17 emphasis

0: not indicated
1: unlocked

00: not indicated (or see byte 4)
10: 48 kHz
01: 44.1 kHz
11: 32 kHz

0000: not indicated (default to 2 ch)
0001: 2 channel
0010: 1 channel (monophonic)
0011:
0100:
0101:

0111: SCDSR (see byte 3 for ID)
1000:
1001:
1111: Multichannel (see byte 3 for ID)

primary / secondary
stereo
reserved for user applications

0110: reserved for user applications

SCDSR (stereo left)
SCDSR (stereo right)

0000: no indication
0001: 192-bit block as channel status
0010: As defined in AES18
0011:
0100:

user-defined
As in IEC60958-3 (consumer)

0000: not defined, audio max 20 bits
0001: used for main audio, max 24 bits
0010: used for audio max 20 bits
0011:

coord,
user-defined

if max = 20 bits
not indicated
23 bits
22 bits
21 bits
20 bits
24 bits

if max = 24 bits
not indicated
19 bits
18 bits
17 bits
16 bits
20 bits

000:
001:
010:
011:
100:
101:

Professional format channel status field interpretations

Bits label interpretation

0

1

2–4

5

6–7

8–11

12–15

16–18

19–21
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Professional format channel status field interpretations (Cont.)

Bits label interpretation

sampling frequency

alignment level

digital audio reference
signal (DARS)

sampling frequency
scaling

alphanumerical channel
origin

alphanumerical channel
destination

local sample address
code

time of day code

reliability flags

CRCC

channel identification

0000: not indicated
1000: 24 kHz
0100: 96 kHz
1001: 22.05 kHz
0101: 88.2 kHz
1101: 176.4 kHz
1111: User defined

00: not indicated
01: –20 dB FS
10: –18.06 dB FS

00: not a DARS
10: DARS grade 2 (+ / –10 ppm)
01: DARS grade 1 (+ / –1 ppm)

0: no scaling
1: apply factor of 1 / 1.001 to value

four-character label using 7-bit ASCII
with no parity. Bits 55, 63, 71, 79 = 0.

four-character label using 7-bit ASCII
with no parity. Bits 87, 95, 103, 111 = 0.

32-bit binary number representing
the sample count of the first sample
of the channel status block.

32-bit binary number representing
time of source encoding in samples
since midnight

0: data in byte range is reliable
1: data in byte range is unreliable

00000000: not implemented
X: error check code for bits 0–183

if bit 31 = 0 then channel number is 1
plus the numeric value of bits 24-30.

if bit 31 = 1 then bits 4–6 define a
multichannel mode and bits 0–3 give
the channel number within that mode.

22–23

24–31

32–33

35–38

48–79

80–111

144–175

176–183

184–191

112–143

39



Serial Interface Measurements

ATS-2 provides tools to examine and test both the embedded audio
signal and the serial interface signal.

ATS-2 monitors and analyzes the embedded digital audio signal using
instruments in the Analyzer panel, such as the Audio Analyzer, the
Spectrum Analyzer, the Multitone Audio Analyzer and the
Harmonic Distortion Analyzer. Many interface-related problems can
show up as symptoms in these embedded audio measurements.

ATS-2 can also directly monitor the interface signal on the Digital
Input/Output (DIO) panel, which provides direct read-out and control of
interface configuration, format, voltage, resolution, sample rate, jitter,
status bits and more.

A more powerful tool is the Digital Interface Analyzer, available as part
of the ATS-2 Performance Upgrade Option.

This option adds an 80 MHz ADC to ATS-2, dedicated to digitizing the
interface data stream for DSP analysis, and enables an additional Analyzer
instrument, the Digital Interface Analyzer.

With the Digital Interface Analyzer, you can measure and display the
interface waveform and spectrum, create an eye pattern, show the jitter
waveform and spectrum and display histograms of interface amplitude,
interface rate, interface bit width and jitter.
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Appendix C

FFTs and Multitone

The Fast Fourier Transform

The Fast Fourier Transform, or FFT, is a mathematical technique that
deconstructs a complex waveform into its component sinewaves.
Presented with a segment of data which represents the amplitude vs. time
relationships of a complex waveform, an FFT will derive two sets of results:
the amplitude spectrum (amplitude vs. frequency) and the phase spectrum
(phase vs. frequency) of the signal. This information is sufficient to
describe the relationships of the sinewaves which make up the waveform,
and with further computation the FFT results can be interpreted for several
different types of display.

In ATS-2, the amplitude spectrum results and the phase

spectrum results are stored in a memory area called the

Transform Buffer. These results are read and recomputed for

the various display options.

Much of the signal analysis in ATS-2 is performed using FFT techniques.
The Spectrum Analyzer, the Digital Interface Analyzer, the Multitone
Analyzer and the Harmonic Distortion Analyzer all depend on FFTs. The
results are usually displayed as frequency-domain spectrum analysis
graphs, but with recalculation the same data can be interpreted and
displayed in other ways. Also, the acquisition can be displayed in the time
domain as “oscilloscope” or “waveform” views.

Real Time vs. Batch Mode

In ATS-2 an FFT does not work in “real time,” with continually updating
displays. Instead, a sample of the signal is acquired, then transformed
mathematically (the FFT), then processed for display and shown on the
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screen. In Audio Precision instruments this is called “batch mode,” since
the data is acquired and processed in discrete “batches.”

The Spectrum Analyzer instrument is the most straightforward and
flexible of the FFT-based tools in ATS-2, and we will use it as the example
of FFT processing throughout this discussion.

Acquiring Data

The first step in performing an FFT is to acquire signal data, which
consists of recording a sample of the signal to a special area in ATS-2
memory, called the acquisition buffer. ATS-2 has a 256k sample
acquisition buffer for each of the two audio channels.

You can specify the amount of memory to be used in an acquisition, in
steps from 800 samples to 256k samples; or you can set ATS-2 to have the
acquisition buffer length track the FFT record length, which is discussed
below. The duration of the signal acquired will depend upon the
acquisition buffer length and the sample rate of the signal, and can be
calculated from this formula:

Acquisition Duration
Aquisition Length

Sample Rate
�

At a sample rate of 48 kHz, a 256k acquisition will have a duration of
5.46 seconds.

The FFT Record

The FFT record is the section of signal upon which the FFT processing
is actually performed. Its length in samples is called the record length, or
FFT length, or transform length. The record length must be smaller than or
equal to the length of the acquisition.

FFT Bandwidth

The bandwidth of the signal, the sample rate, the record length and the
frequency resolution are all related.

As with any digital signal, the bandwidth is limited by the sample rate in
this relationship:

Bandwidth
Sample Rate

�
2

.

Appendix C: FFTs and Multitone Acquiring Data

408 ATS-2 User’s Manual



FFT Bin Width

The two results of an FFT consist of amplitude and phase values for a
number of frequencies. The number of frequencies is half the number of
samples in the FFT record length.

An FFT length of 8 samples would divide the range from DC to the
sample rate into 4 rather wide bands (which are called bins), and provide
the amplitude and phase values for each of the bins. For more resolution,
a greater FFT length is required. An FFT length of 16,384 samples would
result in 8,192 bins across the same frequency range.

The bin width (also called line spacing) is an expression of the frequency
resolution of the FFT, and has this relationship to sample rate and record
length:

Bin Width
Sample Rate

Length
�

Record
.

With an FFT length of 16,384 samples at a sample rate of 48 kHz, the
bandwidth of the FFT would be

48

2
24

kHz
kHz� .

The bin width would be

48

16 384
293

kHz
Hz

,
.� .

If a frequency-domain amplitude graph were plotted, it would span the
range from 0 Hz to 24 kHz and have 8,192 bins, each 2.93 Hz wide. The
amplitude of the energy falling within each bin would be plotted. A
spectrum graph of a 800 Hz squarewave made with these settings would
look like this:
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Figure 306. FFT spectrum of 800 Hz squarewave using the Equiripple window.



In this FFT you can clearly see the 800 Hz fundamental followed by the
series of odd harmonics which are the components of a squarewave.

FFT Record Looping

The mathematics of FFT processing see the record as an endless loop of
signal, just as if the end of the record was “spliced” to the beginning of the
record.

In audio editing, if there is any difference in the value or slope of the
signal at the moment of the splice, there will be a discontinuity or jump in
the waveform at that point. An audio edit will “pop” or “click” at such a
discontinuity. The same thing happens in FFT processing: the
discontinuity, like an audio pop, contains a great deal of energy spread
widely over the frequency spectrum. This energy swamps all but the largest
signal peaks and produces a useless set of results and a characteristic
spectrum.

Figure 308 shows an FFT of a 100 Hz sinewave with a discontinuity in
the record loop. Without a way to deal with loop discontinuities, almost all
FFTs would look something like this:

Appendix C: FFTs and Multitone FFT Record Looping

410 ATS-2 User’s Manual

A

B

C
Figure 307.

Truncation of non-synchronous waveform.



Two techniques have been developed to solve this problem. One is FFT
windowing; the other is the use of synchronous FFTs.

FFT Windowing

Let’s return briefly to the audio editing example. The click caused by an
abrupt transition can usually be eliminated by making the transition
gradual: with a razor blade edit, that means an angled cut; with a
computer edit, a brief fade-up or cross-fade is used.

FFT windowing is similar. An amplitude envelope called a window is
imposed upon the record data before the FFT processing. There are a
number of different window shapes with different characteristics, but they
all share this feature: they taper at the beginning and end of the record.
This means that the two ends of the windowed record data match so that
there is no discontinuity and the broadband noise is not introduced.
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The windows do modify the acquired signal, however, which is why
there are so many to choose from. Windowing spreads the energy in the
acquired signal over several bins, and window functions differ in the shape
of the resulting spreading. The Flat-Top window, for example, is optimized
for flat response at the top of the main lobe, but has poorer resolution of
closely-spaced frequencies than other windows; the Hamming window
resolves close tones well, but has greater main lobe amplitude error and
high side lobes.
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(raised cosine shape) to a sinewave,

viewed in the time domain.



See page 151 for illustrations and full descriptions of the FFT
windowing functions available with ATS-2.

Synchronous FFTs

Another solution to the FFT looping discontinuity problem is to choose
a signal frequency and FFT length such that an integer number of cycles of
the signal will exactly fit the record length. When this is accomplished, the
beginning and the end of the record will be at adjacent points in the signal,
and there will be no discontinuity.

This can only be done when you have precise control of the signal you
are using for analysis, and there are many circumstances when that is not
possible. But when synchronous FFTs can be used, they bring this great
advantage: because the signal has not been modified by a window
function, it is unchanged. Energy does not spread across the spectrum,
and tremendous low-level detail can be seen. Look at the following four
figures, all FFTs of the same 800 Hz sinewave signal:
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Graphing FFTs

ATS-2 FFT results are usually displayed as graphs. In ATS-2, the
number of samples in the record and the number of points or steps
requested for the graph not necessarily the same. You can set up an FFT
length of only 256 samples and a graph of 5000 steps, or an FFT 32,768
samples long displayed on a graph of only 10 steps.

The FFT length is determined by your frequency resolution needs and
the time involved in acquisition. 16,384 samples is a typical choice.

Here are some guidelines to selecting the number of graphed points:

� Use the fewest steps which result in a useful graph. Fewer steps
provide faster operation.

� There is no purpose in graphing more points than you have samples;
a 256 point FFT graphed at 512 steps will display 384 redundant
points.

� If your end use is a graph on a screen or printed on paper, there is no
purpose in graphing more points than your monitor or printer can
display. Selections of 500 to 1000 points typically provide excellent
graphs.

� If your end use is a table, you may want to specify more graph steps
than mentioned above, if you have a high-resolution FFT and you
would like a detailed table of values.
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Figure 311. FFTs of 800 Hz sinewave, with no window, Flat Top window, Hann window,

and, finally, adjusted very slightly in frequency (to 799.805 Hz) to be synchronous.



Multitone Testing

The digital generation and analysis techniques which make synchronous
FFTs possible open the door to a powerful new approach to audio
measurement: multitone testing.

A synchronous FFT can produce very narrow, accurate bins across the
spectrum, providing the capability for a great number of precise amplitude
vs. frequency and amplitude vs. phase measurements, all from the same
acquisition.

Multitone testing takes advantage of this by using special waveform files
for digital signal generation, and special processing and computations to
extract useful results from the synchronous FFTs. This technique can
provide detailed and accurate measurements of many signal characteristics
using a multitone “burst” which lasts less than a second.

Multitone Waveform requirements

A multitone test signal is a complex waveform, the combination of two
or more sinewaves. There are typically from 3 to 30 sinewaves in a
multitone signal.

The number and approximate frequencies of the sinewaves in a
multitone waveform are determined by the type of test you are
performing. If you wanted a 1/3 octave spectrum analysis, for example,
you would choose 31 sinewaves, each very near to one of the frequencies
specified for a standard ISO 31 test.

The precise frequencies chosen have one common requirement: they
must all be synchronous frequencies for the record length of the FFT.
Specifically, they must be integer multiples of a base frequency which is
synchronous. The lowest synchronous frequency for an FFT is the
frequency for which one cycle fits exactly in the transform buffer, and that
is calculated by dividing the signal sample rate by the transform length in
samples.

For example, a sample rate of 48 kHz and a transform length of 8192
samples gives a base frequency of 5.859375 Hz. That frequency and all
integer multiples of that frequency are valid tones to use in a 48 kHz
multitone waveform being measured by an FFT analyzer using an 8192
sample acquisition.

Analyzing a multitone

Once a multitone signal has been routed through the DUT, a
synchronous FFT is performed. Because this is a synchronous FFT, it has
these characteristics:
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� The energy at each fundamental frequency is contained within a very
narrow frequency or phase bin, and the amplitude of these bins can
be accurately determined.

� Since the fundamental frequencies are synchronous, all their
harmonics will be synchronous, too, and each will lie in its own
narrow bin.

� Since all the sinewaves and their harmonic products lie in discrete,
narrow bins, all the remaining bins can only contain energy which is
not harmonically related to the multitone signal. This includes noise,
crosstalk, intermodulation or aliasing products, and so on.

With a properly designed multitone waveform and proper interpretation
of the resulting FFT, a great number of measurements can be made from
one acquisition, including:

� Spectrum

� Frequency Response

� Phase Response

� Distortion

� Noise in the presence of signal

� Crosstalk

� Masking curve analysis

What’s more, the acquisition (and therefore, the duration of the actual
test in the DUT) can be very brief. Multitone acquisitions of less than a
second can provide all the information needed for much audio testing.

It is possible to use a general-purpose FFT analyzer to extract the
measurements you want from multitone waveforms, but ATS-2 makes it
easy by providing a dedicated Multitone Analyzer instrument. Sample
multitone waveform files are included, as is a Multitone Creation utility.

“Inside Information”

To make multitone analysis fast and consistent, the Multitone Audio
Analyzer in ATS-2 requires some information about the nature of the
multitone file in use; in some cases, you can add a file to specify your
measurement goals for a particular test so the analyzer “knows” what to
look for.

The Analyzer must have information about the original frequencies in
the multitone waveform, the sample rate and so on. In most cases, this
done automatically. Since most multitone waveforms are being generated
in one of the ATS-2 generators while the analysis is being done, the
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generator automatically passes information about the waveform to the
Multitone Audio Analyzer.

This is not possible when the multitone waveform is being played from
an audio tape or a CD, or if it is being transmitted from a remote location.
In these cases, ATS-2 requires that you load a multitone waveform into
one of the ATS-2 generators. This waveform must have exactly the same
characteristics as the multitone being used for the test. The audio output of
the generator is not used, but the waveform information is sent to the
analyzer and the analysis proceeds correctly.

You can also attach a sweep table (.atss) file to a multitone test. This
forces the sweep to plot only the information specified in your table, and
enables you to limit a test to only certain frequencies.

Typical Multitone Tests

As an example of using multitone, we’ll look at different ways of
analyzing the same waveform acquisition.

Our multitone waveform file will have ten frequencies on the Channel A
and ten on Channel B. For crosstalk measurements, two tones on each
channel are unique.

Multitone Testing Appendix C: FFTs and Multitone
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F1 F2 F3 F4 F5 F6 F7

CHANNEL B

F10

F1 F2 F3 F4 F5 F6 F7 F8
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F9

CHANNEL A

F10 F11

F11

F12

F12F9

Figure 312. Example of multitone

stimulus waveforms.



Spectrum

Spectrum provides a normal FFT spectrum display, showing all
amplitudes in all bins. For good frequency resolution, use a relatively large
number of sweep Steps.

Frequency Response

Frequency response reports the amplitude in each of the bins which are
known to have tones in the waveform. If you want to limit your response
measurements to specific tones, you can attach a sweep table listing only
the tones you want reported.

Phase Response

In ATS-2, you can measure a channel’s independent phase response
from generator output to analyzer input for any frequencies in the
multitone, or you can measure the interchannel phase response. As with

F1 F2 F3 F4 F5 F6 F7 F8

CHANNEL A
Figure 314. Example of a

multitone

frequency response graph.
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F1 F2 F3 F4 F5 F6 F7 F8

CHANNEL B–A
+ deg

– deg

Figure 315. Example of a

multitone

phase graph.

F1 F2 F3 F4 F5 F6 F7 F8

CHANNEL A

F9 F11

Figure 313. Example of a

multitone

spectrum graph.



frequency response, you can attach a sweep table listing only the tones
you want reported. The illustration in Figure 315 is of relative phase
response.

Distortion

In a distortion test where only a single tone is in the stimulus, only that
fundamental frequency needs to be removed. In our example multitone,
F4 is the choice for the distortion stimulus, since it was selected so that
none of its harmonics fell in the same bins as the tones at F5 through F10.

For a distortion reading for this multitone waveform, the bins
containing all of the tones F1 through F10 are rejected from the reading,
as shown in Figure 316. The residual is the noise and distortion products.

Noise in the presence of signal

In many devices, the noise is not constant but varies according to the
applied signal. Multitone is the only technique that can measure noise in
the presence of signal.

In most Multitone tests, the length of the waveform and the length of the
transform buffer are the same; in our example, 8192 samples, giving a
frequency resolution or bin width of 5.859375 Hz at a sample rate of
48 kHz.

For a measurement of noise in the presence of signal, the length of the
transform buffer is set to be exactly twice the length of the multitone
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F1 F2 F3 F4 F5 F6 F7 F8

CHANNEL A
Figure 316. Example of a

multitone

distortion graph.

F1 F2 F3 F4 F5 F6 F7 F8

CHANNEL A
Figure 317. Example of a

multitone

noise graph.



waveform. The FFT is still synchronous, but at 16384 samples, the
frequency resolution or bin width is now 2.9296875 Hz.

The effect of this is that any tone or any product of a tone from the
original 8192-sample long multitone must fall only into alternate bins in
the FFT, the bins that are 5.859375 Hz apart. The “in-between” bins
contain only noise. See Figure 317.

In the ATS-2 Multitone Audio Analyzer, settings to create these
conditions are made automatically when Noise is selected as the
Measurement.

Crosstalk

Crosstalk depends on at least one unique tone in the multitone
waveform for the channel opposite the crosstalk measurement.

In our example, F6 exists only on the A channel, and F8 exists only on
B. To measure crosstalk to A, the Multitone Analyzer rejects all bins but the
one at F8. In the same way, crosstalk to B is measured by rejecting all bins
but the one at F6. The only signal in these bins will be crosstalk from the
opposite channel.
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Figure 318. Example of a

multitone

crosstalk graph.



Masking curve analysis

Masking is a characteristic of human hearing. A louder sound close in
frequency to a quieter sound “masks” the quieter sound; in a case like this,
we only perceive the louder sound. For example, faint noise or distortion
products centered in a range around 7 kHz might be audible in an
otherwise quiet signal, but if a louder 7 kHz tone is added to the signal, the
noise will be masked.

The effects of masking vary with frequency and level, and with the
listener. Curves have been determined which quantify masking effects at
different frequencies and levels for an average listener.

It is important to understand and measure masking effects to evaluate
under what conditions noise is audible in a dynamic signal. The Multitone
Audio Analyzer tests low-bit-rate perceptual coders with multitone signals
by summing quantization noise and distortion and comparing it to an
embedded psychoacoustic model of the frequency masking effect.

In a masking test, ATS-2 determines the correct masking curve (the
shapes of which vary with frequency) for every tone to be evaluated, at the
levels they are received from the DUT. The upper illustration in Figure 319
shows an example of this.

A composite curve is created which represents the total masking which
would be in effect for the tones selected. You can then append to this
curve the original data in a spectrum or distortion view to produce a graph
like the lower illustration in Figure 319.
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F1 F2 F3 F4 F5 F6 F7

CHANNEL A

F1 F2 F3 F4 F5 F6 F7 F8

F8

CHANNEL A

F1 F2 F3 F4 F5 F6 F7 F8

Figure 319. Example of a

multitone

masking curve analysis.



You can also save the masking curve data as a limit file and attach it to
other tests.
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Appendix D

User Downloadable Filters

Creating User Downloadable Filters

A User Downloadable Filter consists of a properly formatted text file
containing information defining the characteristics of the filter. The filter
must be named with one of these extensions:

� for a low-pass filter, .afl;

� for a high-pass filter, .afh;

� for a weighting filter, .afw.

As long as the file meets the specifications set out below, you can create
the filter by any means, including the use of a text editor or third-party
software that has digital filter design capabilities.

User Downloadable Filter Design Constraints:

� Each file specifies a single infinite impulse response (IIR) filter at one
or more sample rates.

Each IIR filter can be implemented by cascading one or more
second-order sections, shown here:

H z
b b z b z

a z a z
( ) �

� �

� �

� �

� �
0 1

1

2

2

1

1

2

21
.

First-order sections are not allowed; a first-order section can be
implemented with the second-order section by setting b2 and a2 to zero.

� A low-pass filter may not have more than 6 poles or 6 zeros; that is, a
low-pass filter can have at most three second-order sections.

� A high-pass filter may not have more than 4 poles or 4 zeros; that is,
a high-pass filter can have at most two second-order sections.
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� A weighting filter may not have more than 8 poles or 8 zeros; that is,
a weighting filter can have at most four second-order sections.

� Unstable filters are not allowed. An unstable filter is a filter with poles
on or outside the unit circle on the z-plane.

� Filters with a gain of zero are not allowed. Such filters would result in
all zero outputs.

� No coefficient may be greater than 2.0 or less than –2.0.

A simple text file format is used for each user-designed filter. The file
format is specified by the following rules:

� All lines starting with # are comment lines.

� Blank lines, that is, lines consisting of zero or more spaces and tabs,
are ignored.

� The parameters for filters are specified in a line-oriented fashion, with
one entity specified per line.

� Each line has three components: a predefined keyword, followed by
a colon, followed by the keyword-dependent data. Any white space
surrounding these components is ignored. Three keywords are
defined: info, sample_rate, and biquad.

� The info keyword specifies a text string of printable ASCII characters
to be displayed on the User Downloadable Filters panel when the

“Filter Info” box is clicked. The info comment must be fewer than
1024 characters in length. Only the first info keyword found is used;
any others are ignored.

� A filter at a given sample rate is specified by the sample_rate
keyword line followed by one or more biquad keyword lines.

� The sample_rate keyword is followed by a colon and a
floating-point number expressing the sample rate in hertz. There is no
limit on the number of sample rates. ATS-2’s built-in filters are
provided at these sample rates:

� The biquad keyword is followed by a colon and five floating-point
coefficients a1, a2, b1, b2, and b0 in that order, as described in the
equation above.
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32000 Hz 44100 Hz 48000 Hz 65536 Hz 88200 Hz

96000 Hz 131072 Hz 176400 Hz 192000 Hz 262144 Hz

Table 9. Sample rates for ATS-2’s built-in filters.



A valid sample file is shown here:

As you can see, a digital filter can be specified by (5 · N + 1) numbers,
where N is the number of second-order sections.

User Downloadable Filters can also be created by specialized third-party
software such as MATLAB, available from The Mathworks, Inc. See
MATLAB Functions, below, for four MATLAB functions useful in
working with downloadable filters and Audio Precision waveform files.

Audio Precision has included with ATS-2 DSP a filter creation program
from Momentum Data Systems called Filter Design Package for Audio
Precision (FDP). See the separate Filter Design Package User’s Manual for
instruction in the use of this program.

MATLAB Downloadable Filter Support

MATLAB is a technical computing environment used in DSP design and
analysis. MATLAB is a product of The Mathworks, Inc., who can be
reached at 508-647-7000 or on the Web at http://www.mathworks.com.

Two MATLAB functions useful in creating and modifying downloadable
filters for use with ATS-2 have been provided as an aid to our customers
who also use MATLAB. ap_write_filter generates filter files from
within MATLAB, and ap_read_filter imports such files into MATLAB
for further manipulation. These functions can be found on the ATS-2
CD-ROM as MATLAB files, which have the filename extension .m.

MATLAB Downloadable Filter Support Appendix D: User Downloadable Filters

ATS-2 User’s Manual 425

info: 100 Hz Butterworth high-pass filter

sample_rate: 32000.0
biquad: -1.9819275 0.9820230 -1.9745094 0.9872547 0.9872547
biquad: -1.9924182 0.9925142 -2.0000000 1.0000000 1.0000000

sample_rate: 48000.0
biquad: -1.9879366 0.9879792 -1.9829700 0.9914850 0.9914850
biquad: -1.9949605 0.9950032 -2.0000000 1.0000000 1.0000000



ap_write_filter

Syntax

Description

ap_write_filter generates a text file in the format recognized by
the downloadable filters feature of ATS-2. Filters in any of the standard
MATLAB forms (second-order section, transfer function, zero-pole-gain,
and state-space) can be written to the file, along with the sample rate and
textual information.

The AP downloadable filter format consists of one or more sample rates,
with accompanying filter coefficients in the form of second-order sections.
ap_write_filter converts the filter into second-order section form
before writing it to the file. This will require functions found in the
MATLAB signal processing toolbox if the filter is not already in
second-order section form.

ap_write_filter accepts both filenames and file handles. If a
filename is supplied, any extension is replaced with .afl, .afh, or .afw,
depending on the filter type. If the filename ends in ‘+’, the file is
appended to, or created if non-existent. ap_write_filter closes the
file when the function exits. If a file handle is supplied,
ap_write_filter appends to the file, leaving it open on exit.

The arguments filter_type, info, and sample_rate are
required. filter_type is the string ‘l’, ‘h’, or ‘w’, for low-pass,
high-pass, and weighting filters respectively. ap_write_filter uses this
information to determine the filename extension, and to restrict the
number of second-order sections to the maximum allowed in the Audio
Precision hardware for each filter type. info is a character string that can
be viewed inside ATS-2 by clicking the Filter Info button after loading the
filter. This provides filter information to the ATS-2 user. sample_rate, a
scalar, is the sample rate in hertz for which the filter was designed. See
Multiple Sample Rates below for more information.

ap_write_filter uses the number of remaining arguments to
determine whether the filter is supplied in second-order section form, in
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size = ap_write_filter(filename,filter_type,info,sample_rate,sos)
size = ap_write_filter(filename,filter_type,info,sample_rate,b,a)
size = ap_write_filter(filename,filter_type,info,sample_rate,z,p,k)
size = ap_write_filter(filename,filter_type,info,sample_rate,a,b,c,d)
size = ap_write_filter(fid,filter_type,info,sample_rate,sos)
size = ap_write_filter(fid,filter_type,info,sample_rate,b,a)
size = ap_write_filter(fid,filter_type,info,sample_rate,z,p,k)
size = ap_write_filter(fid,filter_type,info,sample_rate,a,b,c,d)



transfer function form, in zero-pole-gain form, or in state-space form. The
transfer function form is not recommended for large filters because
factorization into second-order sections may cause the poles and zeros to
move slightly, deforming the filter response.

The total number of bytes written to the file is returned in size.

Multiple Sample Rates

A digital filter will have the intended frequency response only at the
sample rate for which it was designed. Thus, a unique filter must be
designed for each sample rate that will be encountered. If a filter file
contains filters for multiple sample rates, ATS-2 chooses the filter
coefficients corresponding to the sample rate closest to the current
hardware sample rate.

An Audio Precision filter file can contain a filter defined at any number
of sample rates. Either a file handle or the file append mode can be used
to add filters for other sample rates to an existing file. ap_write_filter
writes an info string for each sample rate; however, ATS-2 will only report
the first of these strings.

Filter Restrictions

The number of filter orders is limited to 6 for low-pass filters, 4 for
high-pass filters, and 8 for weighting filters. The sample rate must be
between 6750 Hz and 262144 Hz. All zeros must be on or inside the unit
circle, and all poles must be inside the unit circle. All coefficients must be in
the range [-2,2].

Examples

1. Compute a Chebyshev high-pass filter with a corner frequency of
200 Hz and a passband ripple of 0.1 dB for three common sample rates.

We use the zero-pole-gain form for accuracy, and the append mode to
attach the three sample rates to the same file.

2. Compute a voice-band boosting filter at two sample rates. Use the file
handle method to write to the output file.
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for sr=[32000 44100 48000]
[z,p,k]=cheby1(4,0.1,200/(sr/2),'high');
ap_write_filter('c:\filters\cheby200+','h','200 Hz Cheby highpass',sr,z,p,k)

end



Here we have the flexibility to write comments to the output file
(preceded by the ‘#’ identifier) which will not appear inside ATS-2. Note
that it is the user’s responsibility to create a file with the appropriate
extension, and to properly close the file.

ap_read_filter

Syntax

Description

ap_read_filter imports an Audio Precision downloadable filter text
file into MATLAB. It parses the file and returns a structure array of filters,
one structure for each sample rate contained in the file. It also returns the
info comment strings. The file is closed on exit.

The AP downloadable filter format consists of one or more sample rates,
with accompanying filter coefficients in the form of second-order sections.
ap_read_filter creates one structure in the output array for each
sample rate in the file. Each structure contains the sample rate and a
matrix consisting of the filter in second-order section form. If other forms
are required, such as state-space, the signal processing toolbox conversion
functions should be used.

Comments in the file are discarded, but info strings are concatenated
into the returned info variable. The info strings are used by ATS-2 to
provide information to the user when the Filter Info button is clicked.

ap_read_filter attempts to deal with syntax errors in the file by
issuing a warning of the line number of the error.
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[filter_array,info] = ap_read_filter(filename)
[filter_array,info] = ap_read_filter(fid)

ofp=fopen('c:\filters\voice.afw','wt');
fprintf(ofp,'# Voice band filter designed in MATLAB by yulewalk\n\n');
for sr=[48000 65536]

[b,a]=yulewalk(8,[0 500 1000 4000 8000 sr/2]/(sr/2),[0.5 0.5 1 1 0.25
0.25]);

ap_write_filter(ofp,'w','Voice band filter',sr,b,a)
end
fclose(ofp);



Example

To read the filter file generated by the first example in
ap_read_filter:

This returns a 1 3� structure array. Typing filters(1) at the prompt
returns

The second-order sections can be examined by typing
filters(1).sos at the prompt.
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[filters,info] = ap_read_filter('c:\filters\cheby200.afw');

ans = sample_rate: 32000
sos: [2x6 double]
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Appendix E

AP Waveform File Support

MATLAB is a technical computing environment used in DSP design and
analysis. MATLAB is a product of The Mathworks, Inc., who can be
reached at 508-647-7000 or on the Web at http://www.mathworks.com.

Two MATLAB functions supporting Audio Precision formatted wave files
for use with ATS-2 have been provided as an aid to our customers who
also use MATLAB. ap_write_wave generates AP wave files from within
MATLAB, and ap_read_wave imports such files into MATLAB for
further manipulation. These functions can be found on the ATS-2
CD-ROM as MATLAB files, which have the filename extension .m.

ap_write_wave

Syntax

Description

ap_write_wave generates a binary waveform file that can be loaded
into Audio Precision hardware. Files with extensions .agm (mono
generator waveform) and .ags (stereo generator waveform) are supported.

The AP waveform file format consists of a 256-byte header containing
sample rate and other information, and a 3n-byte payload, where n is the
number of samples in the waveform. Each sample is quantized to 24 bits
and is in the range [–1, 1–2–23].

ap_write_wave accepts both filenames and file handles. If a filename
is supplied, any extension is replaced with .agm or .ags, depending on the
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size = ap_write_wave(filename,sample_rate,normalize,data)
size = ap_write_wave(fid,sample_rate,normalize,data)



size of the data matrix. ap_write_wave closes the file when the function
exits. If a file handle is supplied, ap_write_wave appends to the file,
leaving it open on exit.

sample_rate, a scalar, is the sample rate of the waveform in hertz.

If normalize is 1, the data is scaled so that the peak of the waveform
reaches full scale. The data is also dithered before reducing the word size
to 24 bits. This preserves low-level information and eliminates harmonic
distortion due to quantization. This mode is recommended unless multiple
waveforms are being generated whose amplitude relative to one another is
important.

If normalize is 0, the data is written to the file unscaled. If any
samples are outside the allowable range, they are clipped and a warning is
issued.

data is a matrix containing the waveform. If the smaller dimension is 1,
a mono waveform file is generated. If it is 2, a stereo waveform file is
generated. Any other size will generate an error.

Example

At a sample rate of 40 kHz, create a sinewave of approximately 1 kHz in
channel A and noise in channel B. The length is 2048 samples.

This generates a file sin_noise.ags. The actual frequency of the sinewave
is 996.094 Hz. This is a frequency that is synchronous with the sample rate
and the waveform length. That is, when the waveform is repeated, there
are no discontinuities.

ap_read_wave

Syntax
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len=2048;
samp_num=0:len-1;
samp_rate=40000;
ch_A=sin(samp_num/len*2*pi*round(1000/samp_rate*len));
ch_B=randn(1,len);
ap_write_wave('c:\waveforms\sin_noise',40000,1,[ch_A; ch_B])

waves = ap_read_wave(filename, system)
waves = ap_read_wave(fid, system)
waves = ap_read_wave(filename)
waves = ap_read_wave(fid)



Description

ap_read_wave imports an Audio Precision waveform file into a
MATLAB structure array. One structure is created for each waveform in the
file. Files with extensions .aam (mono acquired waveform), .aas (stereo
acquired waveform), .agm (mono generator waveform), and .ags (stereo
generator waveform) are supported. The file is closed on exit.

When reading an acquired file (.aam or .aas), the case-insensitive
parameter system must be supplied to scale the results correctly. Choices
for system are:

� 'ATS2' for ATS-2

� 'S1' for System One

� 'S2' for System Two

� 'S2C' for System Two Cascade

If the wrong system is supplied, the results will be unpredictable. When
reading a generator file (.agm or .ags), system is not required.

Each structure consists of a sample rate, a trigger point, a time vector,
and the waveform vector. The sample rate and trigger point are
determined from the header information in the waveform file.

For acquired waveforms, the trigger point is the sample at which the
trigger occurred during acquisition. For generated waveforms (such as
arbitrary waveforms created by the Multitone Creation utility in ATS-2),
the trigger point is usually zero. The time vector is constructed from the
trigger point, the total number of points in the waveform, and the sample
rate. The data vector consists of the file payload converted to double.

If ap_read_wave determines that the file contains data acquired from
an analog source, it attempts to scale the data so that the value of a
sample represents the analog voltage at that time. Because some gain
constants are known only to the hardware on which the waveform was
acquired, however, this will only be approximate. Data originally from a
digital source is not scaled.

Example

Read the .ags file generated by the ap_write_wave example.

This returns a 1 2� structure array. Typing waves(1) at the prompt
returns
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waves=ap_read_wave('c:\waveforms\sin_noise.ags');



The data can now be examined:
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figure(1), plot(waves(1).time,waves(1).data)
figure(2), plot(waves(2).time,waves(2).data)

ans = sample_rate: 40000
trigger_point: 0

time: [2048x1 double]
data: [2048x1 double]
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